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What Is Microsoft Workgroup Add-On 
for Windows? 

Microsoft® Workgroup Add-On for Windows'M adds integrated networking 
capabilities and additional features to the Microsoft Windows version 3.1 
operating system to give you Microsoft Windows for Workgroups version 3.11. 

This book describes how to use these networking capabilities and additional 
features. 

This chapter describes how to get started if you are: 

• Using Microsoft Windows for the first time or upgrading from versions earlier 
than version 3.1. 

• Upgrading from Microsoft Windows version 3.1. 

• Upgrading from Microsoft Windows for Workgroups version 3.1. 

Windows for Workgroups version 3.11: 

• Offers networking that's easy to set up, use, and maintain. 

ix 

The Setup program detects which network-adapter you're using, making setting 
up easy. The familiar Windows interface and new toolbars make connecting to 
network resources as easy as pointing and clicking. There are many security 
features, such as password-protected logon. 

• Provides all the software you need to start a cost-effective network. 

Windows for Workgroups version 3.11 provides the networking software you 
need to gain acc.ess to files and printers on other computers and share files and 
printers on your own computer. 

You can communicate easily with other people, using applications such as Mail, 
Microsoft At Work™ PC Fax, and Schedule+, all included with Windows for 
Workgroups version 3.11. 

• Integrates easily with server-based systems when you're ready to grow. 

You can setup Windows for Workgroups without a network and add a network 
later, if needed. You can use a variety of networks, including server-based 
systems such as Windows NT'M Advanced Server and Novell® NetWare®, 
giving you room to grow without changing your desktop software. 

• Improves the performance of your computer. 

New 32-bit software components speed up access to network resources by as 
much as 100% aud speed up access to data on a hard disk drive by as much as 
50% over Windows version 3.1 and Windows for Workgroups version 3.1. 
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Using Microsoft Windows for the First Time 
If you are setting up Microsoft Windows for the first time or are using a version of 
Windows earlier than 3.1, read this section. 

The following table shows minimum software and hardware requirements. 

Component 

Computer 

MS-DOS 

Memory 

Disk space 

Components 

Network 
hardware 

Fax 

Options 

Requirement 

386SX or higher processor. 

Version 3.3 or later. Version 6.0 or later is recommended. (To check 
your version, type ver at the command prompt.) 

3 MB of RAM; 4 MB is recommended. With networking capability 
turned off, only 2 MB are required. 

10.5 MB of free disk space; 15.5 MB is recommended. 

One floppy disk drive. 

Display adapter (monitor) that works with Windows version 3.1. 
A color VGA or better resolution monitor is recommended. 

To connect your computer to other computers by using the Microsoft 
Windows Network or other networks, you need cables and a network 
adapter (network card) that are Microsoft Windows-compatible. 

To send or receive faxes, you need a Class 1, Class 2, or 
Communications Application Specification (CAS) fax modem or 
network access to one. You need a Class 1 fax modem for binary 
file transfers. 

Microsoft Mouse or compatible pointing device. A mouse is 
recommended. 
Hayes® or compatible modem. 
Audio board. 
CD-ROM drive. 

If you plan to set up Windows for Workgroups 3.11 with networking, read 
Appendix C of this guide, "Installing Network Hardware," and Chapter 2, 
"Setting Up and Starting Windows for Workgroups," followed by your 
Microsoft Windows User's Guide. 

If you plan to set up Windows for Workgroups 3.11 without networking, read 
Chapter 2 of this guide, "Setting Up and Starting Windows for W orkgroups," 
followed by your Microsoft Windows User's Guide. 

Upgrading from Microsoft Windows Version 3.1 
Before upgrading to Windows for Workgroups version 3.11, make sure your 
computer system meets the following requirements. 



Component 

Computer 

MS-DOS 

Memory 

Disk space 

Network 
hardware 

Fax 
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Requirement 

386SX or higher processor. 

Version 3.3 or later. Version 6.0 or later is recommended. (To check 
your version, type ver at the command prompt.) 

3 MB of RAM; 4 MB is recommended. With networking capability 
turned off, only 2 MB are required. 

4.5 MB of free disk space; 9.5 MB is recommended. 

To connect your computer to other computers by using the Microsoft 
Windows Network or other networks, you need cables and a network 
adapter (network card) that are Microsoft Windows-compatible. 

To send or receive faxes, you need a Class 1, Class 2, or 
Communications Application Specification (CAS) fax modem or 
network access to one. You need a Class 1 fax modem for binary 
file transfers. 

If you plan to set up Windows for Workgroups version 3.11 with networking, read 
Appendix C of this guide, "Installing Network Hardware," and then Chapter 2, 
"Setting Up and Starting Windows for Workgroups." 

If you plan to set up Windows for Workgroups version 3.11 without networking, 
read Chapter 2 of this guide, "Setting Up and Starting Windows for Workgroups." 

Upgrading from Microsoft Windows for Workgroups 
The network hardware that you used with Windows for Workgroups version 3.1 
should work with no modifications. 

Before upgrading, make sure your computer system meets the following 
requirements. Then read Chapter 2 of this guide, "Setting Up and Starting 
Windows for Workgroups." 

Component 

Computer 

Memory 

MS-DOS 

Disk space 

Fax 

Requirement 

386SX or higher processor. 

3 MB of RAM; 4 MB is recommended. With networking capability 
turned off, only 2 MB are required. 

Version 3.3 or later. Version 6.0 or later is recommended. (To check 
your version, type ver at the command prompt.) 

4.5 MB of free disk space; 9.5 MB is recommended. 

To send or receive faxes, you need a Class 1, Class 2, or 
Communications Application Specification (CAS) fax modem or 
network access to one. You need a Class 1 fax modem for binary 
file transfers. 
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New Features 
The networking features of Windows for Workgroups version 3.11 make it easy 
for you to communicate and share information with other people. 

Network Connectivity and Performance 
Networking is now much easier. 

• You can use Windows for Workgroups version 3.11 with a wide variety of 
leading network software. Using the Microsoft Windows Network, you can set 
up a network quickly with other people in your office who are using Windows 
for Workgroups. If you or other people are using compatible networks, such as 
Novell Net Ware or Banyan® VINES®, you can use Windows for Workgroups 
version 3.11 to gain access to information on those networks as well. If you're 
not ready to use a network now, you can easily set one up later from within 
Windows for Workgroups. 

• Network performance is improved. New 32-bit network software speeds 
performance and conserves memory so that more is available for your 
MS-DOS-based applications. 

Sharing Resources: File Manager and Print Manager 
Using File Manager and Print Manager, you can share resources, such as 
directories and printers. You can also monitor how shared resources are being used. 

File Manager now includes the ability to share directories on your computer so that 
other people can use your files. Also, you can use files and directories that others 
are sharing. An icon marks directories you are sharing. You can also view the 
names of people who are using your shared directories. 

Using Print Manager, you can designate a printer to be shared so that other people 
can connect to and print to it. Icons make it easy for you to see which printers are 
connected to your computer and which printers you are sharing. The printer queue 
shown in the Print Manager window lists documents that you and others have sent 
to shared printers. 

Using the toolbar in File Manager and in Print Manager, you can perform common 
file and print management tasks with a click of the mouse. The status bar (at the 
bottom of the File Manager or Print Manager window) displays information about 
the task you're performing. 
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Electronic Mail 
~ 

Mail 

Built-In Fax • Fax 

Mail is an application that you can use to exchange files and electronic messages 
with people on your network. You can also print your messages, organize and store 
messages in folders, and search for messages. 

Using object linking and embedding (OLE), you can embed objects, such as cells 
from a spreadsheet and text or graphics from a document, within a message. 

Windows for Workgroups version 3.11 has built-in fax software, called Microsoft 
At Work PC Fax. You can send and receive faxes whether or not you're using a 
network. PC Fax works just like Mail, so it's easy to learn and to use. If you are 
using the Microsoft Windows Network, you can share a fax modem with other 
people on the network, and you can send a message to a group of people-to 
some people via fax, and to some via electronic mail. 

You can send and receive faxes from a variety of fax machines and from computers 
equipped with fax modems. You have a choice of sending and receiving faxes as 
images or as copies of original documents (such as Microsoft Excel spreadsheets). 
You have a wide range of options for customizing your faxes, such as delaying their 
send times until phone rates are lowest or enhancing the image of a fax for printing. 

By using the security features, you can ensure that no one but the intended recipient 
can read the faxes you send. You can also use a digital signature to identify yourself 
legally as the sender of a fax. 

Scheduling Appointments Online: Schedule+ 

ti 
Schedule+ 

You can use Schedule+ to keep track of appointments and tasks and to record notes 
to yourself. If you want to carry your schedule with you, you can print copies in a 
size that fits your personal organizer. 

You can also set up meetings with others in your workgroup without leaving your 
desk, and share your schedule so that others in your group can view it or set up 
appointments and tasks for you. 
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New Network Applications 

& 
Chat 

~ 
Net Watcher 

WinMeter 

WinPopup 

~ 
Log On/Off 

A 
Network Set up 

The following network applications are included with Windows for Workgroups 
version 3.11. 

• Chat 

You can use Chat to communicate with up to seven other workgroup members 
at a time by typing messages back and forth. 

• Net Watcher 

You can use Net Watcher to monitor how other people are using your shared 
resources, such as files, directories, and printers. You can also view an event 
log that shows which resources have been used at what time. 

• WinMeter 

You can use WinMeter to monitor the performance of your system. WinMeter 
shows how much of your processing time is taken up by your tasks and by the 
tasks of people who are using your shared resources. 

• WinPopup 

You can use WinPopup to send and receive messages to and from another 
person or computer, or you can send a message simultaneously to all members 
of a workgroup. WinPopup can notify you when a printer has finished printing 
a document. 

• LogOn/Off 

You can log on to or off of Windows for Workgroups at any time, making it 
easy for more than one person to use a computer and protecting your resources 
that have passwords. 

• Network Setup 

You can choose which network you want to use, set up file and printer sharing, 
or change network drivers. 

Sharing Information: ClipBook Viewer 

ClipBook 
Viewer 

A Local ClipBook provides a personal notebook to store information you want 
to move, save, or use in other places. You can use your and others' Local 
ClipBooks to share information. Combined with the powerful tool of object 
linking and embedding (OLE), ClipBook Viewer makes it possible to keep 
shared information accurate and up-to-date. 
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Networking Enhancements in Control Panel 

Network 

Fax 

Control Panel has new features that help you configure your network hardware 
and Microsoft Windows Network software settings. 

Using the Network option in Control Panel, you can: 

• Change your computer name and the workgroup you belong to. 

• Provide a comment about your computer that other people can view when 
browsing through a list of workgroup computers. 

• Change your logon password. 

• Specify how much of your central processing unit (CPU) time is allocated 
to running applications and to sharing information and printers with other 
workgroup members. 

• Track how your shared resources are being used. 

• Specify Windows for Workgroups startup settings. 

Using the Fax option in Control Panel, you can: 

• Set up your network for sending and receiving faxes. 

Other Windows Documentation 
This guide is only part of the documentation that describes Windows for 
Workgroups version 3.11. There is also an online Tutorial and an extensive 
online Help system. In addition, several online documents (formatted for use 
with Write, an application included with Windows) are copied to your hard 
disk during Setup. 

Note Your Windows version 3.1 or Windows for Workgroups version 3.1 
documentation provides information about basic skills you need to use Windows. 
Because Windows for Workgroups version 3.11 includes enhancements and new 
applications, there may be minor differences between the illustrations in your 
version 3.1 documentation and what you see ou your screen. Note that because 
Windows for Workgroups runs in enhanced mode only, references to standard 
mode in the Microsoft Windows User's Guide are not applicable. 
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The following table lists the available online documents. 

Filename 

SETIJP.TXT 

README.WRI 

PRINTERS.WR! 

NETWORKS.WR! 

MAIL.WR! 

SYSINI.WRI 

WININl.WRI 

Contents 

Information about software aud hardware configurations that require 
special haudling in order for you to successfully set up aud start 
Windows for Workgroups version 3.11. (You can view this file by 
using any text editor.) 

Information updated after this guide was printed. 

Information about configuring particular printers and fonts. 

Information about running Windows for Workgroups version 3.11 
with other networks. 

Procedures for modifying settings in the MSMAIL.INI file 
(for advauced users only). 

Procedures for modifying settings in the SYSTEM.IN! file 
(for advauced users only). 

Procedures for modifying settings in the WIN.IN! file 
(for advauced users only). 



CHAPTER 1 

A Brief Overview of Microsoft 
Windows Networking 

This chapter contains an introduction to the basic concepts of the Microsoft® 
Windows'" for Workgroups version 3.11 operating system and the Microsoft 
Windows Network, such as workgroups, resources, sharing, and connecting. 
When you are familiar with these concepts, you can take better advantage of 
Windows for Workgroups features. 

Connecting Computers Together 
When two or more computers are physically conne.cted together, a network is 
formed. To connect computers together, you need cables, connectors, and network 
adapters, or cards. A network card fits inside your computer and enables you to 
send information to and receive information from other computers. 
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A network can include a few computers within a single department or many 
computers in several departments within your company. Using Windows for 
Workgroups, you can take full advantage of your network. 

Organizing Computers into Workgroups 
A network can contain one or more workgroups. A workgroup is a group of 
connected computers that is organized for a purpose. For example, a workgroup 
named SALES might be organized for everyone in your company's sales 
department. 

SALES 

Each computer in the workgroup is identified by a computer name. This can be any 
name, but it usually matches the name of the person using the computer. 
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Another way to organize workgroups is by project. For example, a project team that 
includes a writer named John, a graphic artist named Sue, and a financial analyst 
named Mary might be working on the company's annual report. Although these 
people work in different departments, they can create a temporary workgroup called 
REPORT to make it easier to share information during the course of the project. 

REPORI WORl<GROUP 

No matter how workgroups are organized, all the computers in your company can 
exchange information, as long as they are connected. For example, in the following 
illustration, the computers in the SHIPPING, SALES, and REPORT workgroups 
are all connected. Because of this, they can all exchange information. 
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A workgroup makes it easier for the people who are in it to find and use shared 
resources. You don't need to change the location of computers to form a workgroup. 
A workgroup is formed just by giving all the computers in the group the same 
workgroup name. You can do this when you set up Windows for Workgroups 
or later. 
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Exchanging Information 
By using Windows for Workgroups, sharing information is easy. For example, 
although they work in different departments, John, Sue, and Mary can take turns 
working on the company's annual-report document without leaving their desks or 
passing around a floppy disk. They can even design the report so that each time 
someone updates it on one computer, the information is automatically updated on 
every computer that contains a copy of the report. 

W 0 RI< GROUP 

In this example, John, who works in the marketing department, writes the text for 
the annual report. 

Sue, who works in the graphics department, opens the file and adds the illustrations. 

Mary, who works in the finance department, opens the file and adds financial 
information. Then she prints a copy of the report, using Sue's printer. 

Finally, John sends an electronic mail message notifying reviewers that the annual 
report is ready for them to see. John can even include the entire report within the 
mail message or use Windows for Workgroups to fax the report to reviewers who 
are not in the office. 
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Sharing Resources 
A resource is an item, such as a directory or printer, that you and others can use. If 
you have such a resource, you can make it available to others by sharing it. If you 
do not designate your resource as shared, only you can use it. 

When you share a resource, you assign a share name to it. Just as the computer 
name you assign identifies your computer to other people, the share name identifies 
the resource you are sharing. 

You can determine which people use your shared resource by assigning it a 
password. When you share your directories, you can assign different levels of 
access that require different passwords. If you do not assign a password, the 
resource is available to anyone using the network. 
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-. 
:2.hore Name: \A=N=N=U=A=L=====---- ., ___ _ 

Eath: l:=C=\=A=N=N=UA=L======:::: 
>;omment: I _________ _ 

0 Re~shareatStortup 
Access Type:-----------, 
@!Sead-Only 
OEull 
0 Qepends on Password 

Passwords. 

R~ad-Only Password: "O[p=ro=fit"====' 

Full Access Password: 
~----

£r'1nter: (HP Loser Jet l\ISi on LPTl 

.§hare as: \GRAPHPTR ·-1-~omment:~========----· -

John assigns the share name ANNUAL to his ANNUAL directory. The share name 
matches the name of the directory, for easy identification. John assigns read-only 
access and a password to his directory. Only those who know the password can 
view his files. 

Sue assigns the share name GRAPHPTR and a password to her graphics printer. 
Only those who know the password can print to her printer. 
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Connecting to Resources 
You can use directories and printers that are being shared by other people by 
connecting to them. You use different applications included with Windows for 
Workgroups to connect to different resources. 

Connecting to Directories 
To connect to a directory that someone is sharing on his or her computer, you use 
File Manager. When you connect to a directory, you assign it a drive letter, and 
specify the name of the computer that the directory is on and the share name 
assigned to the directory. When using an application, you use this drive letter to 
open or save files that are in the shared directory, just as you may use the drive 
letter C to open or save files on your hard disk. For example, Sue can use the drive 
letter J to connect to the ANNUAL directory on John's computer. 

If the directory is password protected, you also need to type the password to connect 
to the directory. 



FLOPPY DISK 
DRIVE A: 
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® annrpt.wri 
®apr.wri 
@) artwork.bmp 
@feb.wri 
® jan,Wf"i 
0 letters.log 
@mar.wri 
LJmkreport.exe 
@notes,tx1 
Qsales.dat 
Ejshowart.bat 

~ HARDDISI\ 

~EC: 

:: annrpt.wri 
®apr.wri 
@ artwork,bmp 
@)feb.wri 
@jan.wri 
0 letters.log 
@mar.wri 
LJmkreport.exe 
@notes,txt 
Qsales.dat 
L:]showart.bat 
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Connecting to Printers 
To connect to a printer that someone else is sharing, you use Print Manager. You 
can also use Print Manager to view the status of a document you are printing. 

The way you connect to a shared printer is similar to the way you connect to a 
shared directory: You specify the name of the computer that the printer is on, the 
printer's share name, and a password (if required). Instead of assigning a drive 
letter to the printer, you assign it a port Your computer uses this port to send your 
documents to the printer. 
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Network Choices 
The Microsoft Windows Network is part of Windows for Workgroups. You can 
also connect your computer to other networks, such as the Microsoft Windows NT'M 
operating system, Windows NT Advanced Server, Microsoft LAN Manager, 
Novell® NetWare®, 3Com® 3+0pen®, DEC® Pathworks®, or IBM® LANServer. 
When your computer is connected to a network, you have access to shared 
resources on the network, and, depending on the network, other people may have 
access to shared resources on your computer. 

Other networks might use different terms to describe how the network is organized. 
With some networks, the term domain is used instead of workgroup to describe 
groups of computers. The term server may be used for a computer that is primarily 
used to provide shared resources, and workstation for a computer that is used by an 
individual and does not provide shared resources for other people. 

For more information, see Chapter 9, "Using Other Networks." 

What to Do Next 
Now that you know what workgroups and resources are and you have an overview 
of how to share your own resources and connect to resources on other computers, 
you are ready for the next step: preparing your computer to exchange information 
and resources. 

You need to do the following: 

1. Install a network card and connect your computer to the network. 

For information, see Appendix C, "Installing Network Hardware." 

2. Set up Windows for Workgroups on your computer. 

For information, see Chapter 2, "Setting Up and Starting Windows for 
Workgroups." 

3. Start Windows for Workgroups, and then log on. 

Logging on identifies you to other people using the network, and gives you 
access to all the networking features in Windows for Workgroups. 





CHAPTER 2 

Setting Up and Starting Windows 
for Workgroups 

This chapter describes how to set up the Microsoft® Windows™ for Workgroups 
version 3.11 operating system on your computer. 

Running Setup 

13 

During Setup, your computer system is analyzed to determine whether it meets 
minimum system requirements. If your system does not meet these requirements, 
or if it contains features that are incompatible with the Setup program or Windows 
for Workgroups, a warning message is displayed. 

Caution If you use.any pop-up message programs that print directly to your screen, 
such as a printing notification message, make sure you turn the programs off before 
you start Setup. Such programs are incompatible with Setup. 

If you are setting up the full Windows for Workgroups version 3.11 product, you 
can choose Express Setup or Custom Setup. It is recommended that you use Express 
Setup. Both methods are described in. the follo:wing sections. 

If you are using Microsoft Workgroup AddcOn to upgrade a previous version of 
Windows to Windows for Workgroups version 3.11, Express Setup is the only 
option. You must set up Windows for Workgroups in the same directory as the 
previous version. 
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~ To set up Windows for Workgroups 

1. Insert Setup Disk 1 in a floppy disk drive. 

2. At the command prompt, type the letter of the drive you're using, followed by 
a colon (: ), and then press ENTER. For example: 

C> a: 

3. Type setup and then press ENTER. 

4. Follow the instructions on the screen. 

Note If you have problems setting up, see Appendix E, "Troubleshooting." 

Choosing the Setup Method You Need 
This section describes the two methods of setting up Windows for Workgroups 
version 3.11 on your computer. 

If you will be using Windows for Workgroups with a network, you need to know 
the following things, regardless of whether you use Express or Custom Setup: 

• The type of network you want to run with Windows for Workgroups. 

If you have no network software already installed on your computer, Setup can 
install the Microsoft Windows Network. 

If you already have a network installed, Windows for Workgroups will be set 
up to work with it. Networks you can use together with, or in place of, the 
Microsoft Windows Network include Novell® NetWare® and Banyan® VINES®. 

You can also use the Microsoft Windows Network to gain access to shared 
resources on networks that are compatible with Microsoft LAN Manager, such 
as the Microsoft Windows NT'" operating system, Windows NT Advanced 
Server, 3Com® 3+0pen®, DEC@ Pathworks®, and IBM® LANServer. 

You can also use any network that is 100% MSNet-compatible instead of 
the Microsoft Windows Network, or any network whose manufacturer 
provides Windows network drivers. For more information, see your network 
documentation and the NETWORKS.WR! online document. 

• The type of network adapter (card) you are using. 

• You may also need to specify the interrupt request level (IRQ), base 1/0 port, 
and base memory address for your network adapter if these settings are not 
detected during Setup. 
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Note For information about installing a network adapter, see Appendix C, 
"Installing Network Hardware." If you need to use multiple network adapters, 
you must either run Custom Setup or set up the additional adapters later from 
within Windows. 

Express Setup 
When you use Express Setup, all you do is type your name, answer a few basic 
questions (such as what type of printer and network card you have), and insert disks 
when requested. 

To use Express Setup, you need to know the following things: 

• What type of printer you have, if any. This includes any network printers you 
intend to use. 

• Which port your printer is connected to. 

Custom Setup 

Note A port connects hardware (such as a printer or mouse) to your computer. 
There are two kinds of ports: parallel (such as LPTl) and serial (such as 
COMl). A port can be a socket located on the front or back of your computer, 
or it can be an internal connection, defined by the software, such as your system 
connection to a network printer. 

Custom Setup is for experienced computer users who want to alter the standard 
Windows for Workgroups configuration. For example, if you want to control how 
your CONFIG.SYS and AUTO EXEC.BAT files are modified, use this method. 

If you have limited space on your hard disk, you can use Custom Setup to choose 
which optional Windows components (or individual files) you want to set up. 

During Custom Setup, you are prompted to verify or specify the following: 

• The type of computer you are using 

• Your display (monitor) type 

• Your mouse, if you are using one (highly recommended) 

• Your keyboard and keyboard layout 

• The language you will work in 

• Which optional Windows components to set up 



16 Microsoft Workgroup Add-On for Windows User's Guide 

• The printer and printer port you use, including network printers 

• Which applications on your hard disk you want to run with Windows 

• Changes to your AUTOEXEC.BAT and CONFIG.SYS files, if necessary 

Starting and Logging On to Windows for Workgroups 
After running Setup, you are prompted to either restart your computer or return to 
the command prompt. You should restart your computer before running Windows 
for Workgroups. 

~ To start Windows for Workgroups 

• At the command prompt, type win and then press ENTER. 

Logon Names and Passwords 
When you start Windows for Workgroups, the logon dialog box appears, displaying 
a logon name that matches your computer name. You can use this name or type a 
new one. If several people use your computer, each person can have his or her own 
logon name. 

The following illustration shows the logon dialog box, with the logon name 
Windows for Workgroups would assign if your name were John James. 

Choose a logon name and type a 
to log on to Windows for 'Workgr 

1.ogon Name: JOHNJAM 

Select this box, and then 
type your logon name. 

llllllill-t- When you are 

~------~ 

finished, click the 
OK button or press 
ENTER. e_as.:s:word: 

Select this box, and then 
type your password. 
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~ Tologon 

1. In the logon dialog box, type a logon name. Or use the default logon name that 
Windows for Workgroups supplies. 

2. If you want to create a logon password, type a password. 

3. Choose OK. 

The first time you log on to Windows for Workgroups and any time you log on 
using a new logon name, you are prompted to create a password-list file. You use 
the passwords in this list to connect to any shared resources, such as workgroup 
printers, that require passwords. 

If you choose to create a password-list file, the password for each shared resource 
you connect to is added to the list. You then do not have to type the password each 
time you connect to that resource. If you choose not to create a password-list file, 
you must type the password every time you connect to a shared resource that 
requires one. When you log off of Windows for Workgroups or off of the Microsoft 
Windows Network, the password list is "locked" so that nobody else can use it. 
Each person who uses your computer has his or her own password-list file. 

To protect your password list, you can use a logon password. When you log on, 
you supply this password. This unlocks your password list and restores your 
connections. Your logon password can contain up to 14 characters. Your password 
should be easy to remember and should be changed periodically for security. For 
information about changing your password or creating one at a later time, see 
Chapter 8, "Customizing Network Settings and Improving Performance." 

If you choose to create a password list and you do not specify a logon password, 
anyone can start your computer and gain access to these connections, because 
the password list will be unlocked automatically and the password-protected 
connections will be restored. 





CHAPTER 3 

New File Manager and Print 
Manager Features 

This chapter describes File Manager and Print Manager enhancements in 
Microsoft® Windows™ for Workgroups version 3.11. For basic information 
about File Manager and Print Manager, see your Windows or Windows for 
Workgroups user's guide. 

You can share your files, directories, applications, and printer with other people 
and gain access (connect) to the resources that others are sharing. 

19 

File Manager and Print Manager now include a too/bar. Buttons on the toolbar are 
available for common tasks, such as specifying what information is displayed for 
each file, or starting and stopping print jobs. You can also perform these tasks by 
using File Manager and Print Manager menu commands. 

Setting Up Sharing for Files and Printers 
If you did not select the file and printer sharing options when you set up Windows 
for Workgroups, you can set up your computer to share resources now. 

Note If you are not using the Microsoft Windows Network, you will not be able to 
share your resources. Also, if your network administrator has disabled file and/or 
print sharing for your network, you cannot share your files and/or printers. 
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,... To set up Windows for Workgroups to share files and printers 

1. In the Network group, choose the Network Setup icon. 

2. In the Network Setup dialog box, choose Sharing. 

3. To make sharing available, select one or both check boxes, and then choose OK. 

4. In the Network Setup dialog box, choose OK. 

A dialog box appears, notifying you that your SYSIBM.INI file has been 
modified. When you choose OK again, a dialog box appears, prompting you 
to restart Windows. 

5. Choose Restart Windows to restart. 

Sharing Resources by Using File Manager 

Drive bar 

Represents a directory 
that you are sharing 

with other people. 

Using the Microsoft Windows Network, you can share your directories with other 
people and connect to directories that other people are sharing. The File Manager 
window includes some new items relating to sharing resources. 

Click the drive list to display a list of drives 
you are using, or choose a drive to display 
in the directory window. 

L:lrecords 
E::Jtables 
Cl accounts.bak 
Cl account:s.dat 
BJ apr.wri 
1Rlleb.w1i 
~ian.wri 
IJ letters.log 
!Rlmar.wri 
t:ilmkreport.exe 

Toolbar 
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The following table shows toolbar buttons and commands available for managing 
shared resources. 

Use this button Or this command from 
the Disk menu 

Connect Network Drive 

Disconnect Network Drive 

Share As 

Stop Sharing 

Changing Drives and Directories 

To 

Connect to a shared directory. 

Disconnect from a shared 
directory. 

Share a directory with other 
people or add or change a 
comment or password. 

Stop sharing a directory with 
other people. 

The files you want to work with may be on a different drive or in a different 
directory. The File Manager toolbar enables you to easily view and work with 
the files you want. 

~ To change the current drive by using the toolbar 

• In the list of drives on the toolbar, select the drive you want. The contents of the 
active directory window change to reflect the new drive. You can also click a 
drive icon in the drive bar. Or you can double-click the icon to create a new 
directory window that displays information about the new drive. 

You can also press and hold down CTRL while typing the letter of the drive you 
want. This method works even if the drive bar is not displayed. 

Connecting to Shared Directories 
By using File Manager, you can connect to directories other people are sharing. 

When you connect to someone else's shared directory, File Manager assigns the 
directory the next available drive letter (or you can assign a letter of your choice). 
This creates a network drive. After you are connected to a shared directory, you 
can use the resulting network drive as you would any other drive. 

When you assign a network drive to a shared directory., you might need to know 
the shared directory's path. This path contains the computer name and the share 
name, with the format \ \computername\sharename. For example, the path 
\\HEADQTRS\TELLERl identifies HEADQTRS as the computer name and 
TELLER! as the share name. 

If you are using Novell® Net Ware® with Windows for Workgroups, see Chapter 9, 
"Using Other Networks," for information about connecting to shared directories. 
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To connect to a shared directory 

1. On the toolbar, click the Connect Network Drive button. Or choose Connect 
Network Drive from the Disk menu. 

2. If you want to use a drive letter different from the one shown in the Drive box, 
open the list, and then select the letter you want. Or type the letter. 

3. In the Path box, type the shared directory's path. Or, if you want to use a path 
that you've used recently, open the Path list, and then select a path. 

If the Always Browse check box is selected, the Show Shared Directories On 
box appears each time you use the Connect Network Drive dialog box. If you 
clear the Always Browse check box, you can choose Browse to see the Show 
Shared Directories On box. 

In the Show Shared Directories On box, you can expand (choose) a workgroup, 
select a computer listed below the workgroup name, and then, from the Shared 
Directories box, select a shared directory. 

To display directories on a computer not in your workgroup, type 
\ \computername and then choose OK Select the shared directory you 
want, and then choose OK 

4. To connect to the selected directory, choose OK 

For help, choose the Help button or press Fl while using the dialog box. 

If the Open New Window On Connect command (on the Options menu) is in effect, 
a new directory window appears, displaying the contents of the network drive. This 
command is in effect by default. 

You can also specify whether to automatically connect to the network drive every 
time you start Windows for Workgroups. For more information about this and other 
features, choose the Help button or press Fl while using the Connect Network Drive 
dialog box. 

To disconnect from a network drive 

1. On the toolbar, click the Disconnect Network Drive button. Or choose 
Disconnect Network Drive from the Disk menu. 

2. In the list, double-click the drive you want to disconnect from. Or select it, 
and then choose OK 

You can extend the selection to include more than one drive. 
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Sharing Your Directories 
With the Microsoft Windows Network, you can share your directories, making the 
files in them available to other people. You can use passwords to protect your files. 
If you assign a password to a shared directory, only those people who know the 
password can use files in that directory. If you do not assign a password, anyone 
on the network can use the files. 

You can also control whether people who have access to your shared directory can 
make changes to the files in it. 

Use this setting 

Read-Only 

Full 

Depends On Password 

To enable others to 

Read files and run applications. 

Create, change, delete, rename, move, or read files, and 
run applications. 

Have either read-only access or full access, depending on 
the password they nse. 

Note If you select Depends On Password, and leave one password blank, people 
requesting access to your directory will always be prompted to enter a password. 
Pressing ENTER at the password prompt will give them access to the file. 

To share a directory or change information about your shared directory 

1. In the directory window, select the directory you want to share or modify. 

2. On the toolbar, click the Share As button. Or choose Share As from the Disk 
menu. 

3. In the Share Name box, type the name you want to assign to this directory. 
Or you can use the name shown. 

4. If you want to control access to files, select the appropriate option. 

5. If you want password protection, type a password. 

You can also specify a comment to appear next to the directory in the Connect 
Network Drive dialog box and specify whether the directory will be auto­
matically shared every time you start Windows for W orkgroups. 

6. Choose OK. 

For help, choose the Help button or press Fl while using the dialog box. 
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II .,. To stop sharing a directory 

1. On the toolbar, click the Stop Sharing button. Or choose Stop Sharing from the 
Disk menu. 

If this button or command appears dimmed, no directories are shared. 

2. In the list, double-click the name of the directory you want to stop sharing. 
Or select it, and then choose OK. 

You can extend the selection to include more than one directory. 

Caution If other people are connected to your directory when you stop sharing it, 
a dialog box appears, prompting you for confirmation. If you choose the Yes button, 
these people may lose their data. 

Displaying the Names of People Using Your Shared Directory 
You can find out who is using files in your shared directory. For example, if you 
cannot open a file in your shared directory because someone else has it open, you 
may want to find out who that person is . 

.,. To find out who is using files in a shared directory 

1. In the directory window, select the directory. Or, if you only want to find out 
who is using a file, select the file. 

2. From the File menu, choose Properties. 

3. Choose Open By. 

The Open Files dialog box is updated every few seconds. 

Note Also, you can use the Net Watcher application to display names of people 
using a shared directory. For more information, see Help for Net Watcher. 

Closing Files in a Shared Directory 
You can close files in a directory you are sharing, even if someone is using them. 
For example, if you cannot open a file because someone is using it, you can close 
the file so that other people, including yourself, can use it. 

.,. To close files in a shared directory 

1. In the directory window, select the shared directory. Or, if you only want to 
close a file, select the file. 

2. From the File menu, choose Properties. 
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3. Choose Open By. 

4. In the Network Properties dialog box, select the file or files you want to close, 
and then choose Close Files. 

A dialog box appears, prompting you to confirm the closure. 

Caution If you choose Yes, anyone using the file may lose data. 

Additional File Manager Toolbar Buttons 

Imm m 

In addition to using some toolbar buttons to manage and view shared resources, you 
can use the following buttons to control how files are displayed. 

Use this button 

II 
II 
rm 

To 

Display only the names of each file. 

Display all the information about each file. 

Display files in alphabetic order, based on the filename. 

Display files in alphabetic order, based on the filename 
extension. 

Display files in order of size, from the largest to the smallest. 

Display files in chronological order, based on the last date 
each file was changed. 

Note These buttons affect only the list of files in the active directory window. If the 
directory window is displaying only the directory tree, the buttons do not affect the 
window. 

If you are using Mail, you can send mail directly from File Manager by using either 
the Mail menu or the Send Mail button on the toolbar. For more information about 
sending mail, see Chapter 4, "Mail." 

More Ways to Use File Manager 
There are many other features that you can use to customize File Manager to your 
needs and to perform various tasks. For more information, see your Windows or 
Windows for Workgroups user's guide, or see Help for File Manager. 
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Sharing Printers by Using Print Manager 

This line shows the 
status of a printer you're 

not sharing that is 
connected directly to 

your computer. 

You can share your own printer with others and connect to network printers that 
other people have shared. 

When you start Print Manager, the following window appears. 

This line shows the status of a printer 
you are sharing with others. 

QMS-PS 810 on LPT2 (not shared) Idle 

Toolbar 

1:46 PM 815192 

This line shows the 
status of a network 

printer you are 
connected to. 

> QMS·PS 810 on LPTJ !\\BARBARAl\QMS-PSl 
m > CHRISJOH: Paintb1ush -ARTWORK.BMP 

• Printing 
• Printin 

Ojobs 

2iobs 
67K 1:51 PM 815192 

• Each printer has its own print queue, which is a list of documents, both yours 
and others', that are printing or waiting to print. 

• You can use the buttons on the toolbar to manage shared printers and perform 
common printing tasks. These buttons are shortcuts for menu commands. 

The following table shows toolbar buttons and commands available for managing 
shared printers. 

Use this button 

II 
II 

Or this command from 
the Printer menn 

Connect Network Printer 

Disconnect Network Printer 

To 

Connect to a shared printer. 

Disconnect from a shared 
printer. 
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Use this button Or this command from 
the Printer menu 

Share Printer As 

Stop Sharing Printer 

To 

Share your printer with other 
people, or add or change a 
comment or password. 

Stop sharing your printer with 
other people. 

Note Print Manager must be running for you to share your printer. It is 
recommended that you do not put Print Manager in your Startup group. 

Before You Print 
With network printers, as with your own printer, you must do two things before you 
can print: 

1. Set up the printer driver on your computer. For information, see "Setting Up 
a Printer" in your Windows or Windows for Workgroups user's guide, or see 
Help for Print Manager. 

2. Connect to the printer. For information about how to connect to a network 
printer, see the following section. 

Connecting to a Network Printer 
Your own (local) printer is physically connected by a cable to a parallel or serial 
port in the back of your computer. The port is represented by a name in Windows 
(such as LPTl, LPT2, COMl, or COM2). 

A network printer is connected to a port in the back of another computer in a 
workgroup, and is connected to a port name in your computer by network 
hardware and software. 

When a port name in your computer is connected to a network printer, your 
computer does not need port hardware corresponding to that name. This allows 
you to use multiple network printers, even though your computer does not have a 
physical port for each one. For more information about using multiple network 
printers, see Help for Print Manager. 

When you connect to a network printer, you might need to know the network 
printer's path. This path contains the computer name and the share name, with the 
format \\computername\sharename. For example, \\HEADQTRS\PRINTERl 
identifies HEADQTRS as the computer name and PRINTERl as the share name. 

If you are using Novell NetWare with Windows for Workgroups, see Chapter 9, 
"Using Other Networks," for information about connecting to shared printers. 
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To connect to a network printer 

1. Make sure you have set up a printer driver on your computer for the network 
printer you want to connect to. For more information, see "Setting Up a Printer" 
in your Windows or Windows for Workgroups user's guide. 

2. On the toolbar, click the Connect Network Printer button. Or choose Connect 
Network Printer from the Printer menu. 

3. If the port shown in the Device Name box is not the one associated with the 
appropriate printer driver, open the list, and then select the port name you want. 
Note that this list shows workgroup connections that already exist. If you select 
a port that is already connected to a network printer, you are prompted later to 
replace that connection. You can also type the port number (1 for LPTl, 2 for 
LPT2, and so on) in the Device Name box. 

4. In the Path box, type the network printer's path. Or, if you want to use a path 
that you've used recently, open the Path list, and then select a path. 

If the Always Browse check box is selected, the Show Shared Printers On box 
appears each time you use the Connect Network Printer dialog box. If you clear 
the Always Browse check box, you can choose Browse to see the Show Shared 
Printers On box. 

In the Show Shared Printers On box, you can expand (choose) a workgroup, 
select a computer listed below the workgroup name, and then select a network 
printer from the Shared Printers box. 

5. Choose OK. 

For help, choose the Help button or press Fl while using the dialog box. 

You can also specify whether to automatically connect to the printer every time 
you start Windows for Workgroups. For more information about this and other 
features, choose the Help button or press Fl while using the Connect Network 
Printer dialog box. 

To disconnect from a network printer 

1. On the toolbar, click the Disconnect Network Printer button. Or choose 
Disconnect Network Printer from the Printer menu. 

2. In the list, double-click the name of the printer you want to disconnect. 
Or select it, and then choose OK. 

You can extend the selection to include more than one printer. 
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Sharing Your Printer 

II ~ 

You can share your printer with other people. This may be useful, for example, 
if yours is the only printer among a group of people. 

Note If you chose Yes in the Do You Want To Share Printer Now dialog box when 
you set up Windows for Workgroups, your printer is already shared. 

Before you can share a printer, you must set it up. For information, see "Setting Up 
a Printer" in your Windows or Windows for Workgroups user's guide, or see Help 
for Print Manager. 

To share a printer or change information abont your shared printer 

1. In the Print Manager window, select the printer you want to share or modify. 

2. On the toolbar, click the Share Printer As button. Or choose Share Printer As 
from the Printer menu. 

3. In the Share Printer dialog box, type any share name or password you want 
in the appropriate box, and then choose OK. 

For help, choose the Help button or press Fl while using the dialog box. 

You can also specify a comment to appear next to the printer in the Connect 
Network Printer dialog box and specify whether to share the printer automatically 
each time you start Windows for Workgroups. For more information, choose the 
Help button or press Fl while using the Share Printer dialog box. 

Note You can use the Net Watcher application to display the names of people 
using a shared printer. For more information, see Help for Net Watcher. 

To stop sharing a printer 

1. On the toolbar, click the Stop Sharing Printer button. Or choose Stop Sharing 
Printer from the Printer menu. 

If this button or command appears dimmed, no printers are shared. 

2. In the Shared Printers box, double-click the name of the printer you want to stop 
sharing. Or select it, and then choose OK. 

You can extend the selection. to include more than one printer. 
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Choosing the Default Printer 
Many Windows-based applications use the default printer when you choose the 
Print command. 

To choose a default printer 

1. In the Print Manager window, select the printer you want documents sent to. 

2. On the toolbar, click the Set Default Printer button. Or choose Set Default 
Printer from the Printer menu. 

Pausing and Resuming Printing 
You can pause the printing of another person's document on a printer you are 
sharing, or you can pause your entire printer. In the print queue for a network 
printer, you can pause only the printing of your own document-you cannot 
pause the printer or anyone else's document. 

For more information about pausing and resuming printing, see your Windows or 
Windows for Workgroups user's guide, or see Help for Print Manager. 

Canceling the Printing of a Document 
You can cancel the printing of a document by deleting it from the list of documents 
waiting to print. When using a network printer, you can delete only your own 
document and only before it starts printing. When using your own (local) printer, 
whether shared or not, you can delete any document at any time. 

To cancel the printing of a document 

1. In the Print Manager window, select the document you want to delete. 

2. On the toolbar, click the Delete Document button. Or choose Delete Document 
from the Document menu. You can also use the DEL key. 

A dialog box appears, prompting you to confirm the deletion. 

~ To cancel the printing of all documents on your printer, shared or not shared 

• From the File menu, choose Exit to quit Print Manager. All documents in the 
queue will be deleted. 

A dialog box appears, prompting you to confirm the deletion. 

Note If you quit Print Manager while a document is printing in graphics mode, you 
might need to restart your printer or select the reset option on your printer. 
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Additional Print Manager Toolbar Buttons 
In addition to using some toolbar buttons to manage shared printers, you can use the 
following buttons to control documents and printers. 

Use this button 

• • II 
II 

II 
II 

To 

Temporarily stop your printer from printiug . 

Start your printer again if it has been paused. 

Specify the selected printer as the default printer for your 
Windows-based applications. 

Temporarily stop a document from printing. 

Start a document printing again if it has been paused. 

Remove any document from the print queue for your printer, or 
your document from a queue for a network printer. 

Move a selected document closer to the top of the print queue, 
making it print sooner. 

Move a selected document closer to the bottom of the print 
quene, making it print later. 

More Ways to Use Print Manager 
There are many other features that you can use to customize Print Manager to your 
needs and to perform various tasks. For more information, see your Windows or 
Windows for Workgroups user's guide, or see Help for Print Manager. 
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CHAPTER 4 

Mail 

This chapter describes how to use Mail to read messages from and send mail to 
other people who are using the Microsoft® Windows™ Network. 

When you start Mail for the first time, you must do the following: 

• Connect to or create a post office. If a Mail version 3.0 post office has been 
assigned for your workgroup, or someone in your workgroup has already created 
a workgroup post office (WGPO), you need to connect to it. See Appendix A, 
"Maintaining Mail," if you are the person responsible for creating a post office, 
if you are creating a post office on a Microsoft LAN Manager or Novell® 
NetWare® network, or if you would like to set up your system to read mail 
from other message systems. 

• Create an account in the post office, if no one has set up one for you. 

If you have already connected to a post office and created an account, see "Signing 
In to Mail" later in this chapter. 

Connecting to a Post Office 
Before connecting to a post office, ask the person who is managing Mail to give you 
the computer name and the name of the shared directory where the post office is 
located, and verify that your computer has enough available disk space. You also 
need to find out the password for the shared directory, if there is one. 

The disk space that you need in order to use Mail depends on the number and type 
of messages you expect to store in Mail. A small number of messages requires 
about lOOK of disk space; a large amount may require several megabytes. 



34 Microsoft Workgroup Add·On for Windows User's Guide 

~ To connect to a post office 

Computer name 

Share name 

1. In the Network group, choose the Mail icon. 

2. In the Welcome To Mail dialog box, select Connect To An Existing Postoffice, 
and then choose OK. The following dialog box appears . 

.!!.etwork Path: l\\MARIA\WGPO 

[gJ Always Browse 

,S.how Shared Directories on: 

Peter Black's computer 

Isabelle Johnson's compute1 

3. Select the post office you want to connect to by doing one of the following: 

In the Network Path box, type the path (\\computername\:;harename) of the 
post office. 

Or 

In the Show Shared Directories On box, select the computer name for your 
post office. In the Shared Directories box, select the shared directory for your 
post office. 

4. Choose OK. 

If the shared directory requires a password, the Enter Shared Directory 
Password dialog box appears. Type the password, and then choose OK. 

5. A dialog box appears. If you already have an account, choose Yes. You will 
then be prompted for your password. If you have not specified a password, your 
password was set to the default password that your administrator specified. By 
default, the workgroup password is PASSWORD. 

If you need to create an account, choose No. The Enter Your Account Details 
dialog box appears. 

6. Create your account as described in the following section. 

For help, choose the Help button or press Fl while using the dialog boxes. 
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Creating Your Account 
After you have connected to a post office, you need to create an account. Before 
doing so, check with the person maintaining Mail to find out whether an account 
has already been set up for you. 

~ To create your account 

• In the Enter Your Account Details dialog box, fill in the appropriate 
information, and then choose OK 

Tip No distinction is made between uppercase and lowercase letters; for 
example, MARIAS, MariaS, and marias are considered to be the same. Choose 
a name that is easy to remember. 

The following is required information you must specify. 

Box 

Name 

Mailbox 

Password 

Description 

Type your full name. The maximum length is 30 characters, and 
the default is the name you used when setting up Windows for 
Workgroups. 

Type a name that is easy to remember; for example, your first name 
and the first initial of your last name. You will use this name to sign 
in to Mail. The maximum length is 10 characters, and the default is 
your Windows logon name. 

Type a password that is easy to remember; you will use it and 
your mailbox name to sign in to Mail. The maximum length is 8 
characters, and the default is PASSWORD. 

The following is optional information you can specify. 

Box 

Phone #1 

Phone#2 

Office 

Department 

Notes 

Description 

Type your phone number. The maximum length is 32 characters. 

Type your second phone or fax number. The maximum length is 32 
characters. 

Type yonr office number. The maximum length is 32 characters. 

Type the name of your department. The maximum length is 32 
characters. 

Type any comments about your account. The maximum length is 
128 characters. 
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Message folders 
make it easy to 

organize messages. 

After you have created an account, the Inbox appears, displaying your messages 
and folders. 

Signing In to Mail 
When you finish creating your account, you are automatically signed in to Mail. 
The next time you start Mail, you sign in by typing your password. You can choose 
to have your password automatically supplied when you start Mail. 

~ To sign in to Mail 

1. In the Network group, choose the Mail icon. The Mail Sign In dialog box 
appears. 

2. In the Password box, type your password. 

3. If you want your password to be supplied automatically each time you start 
Mail, select the Remember Password check box. 

Be aware that if you have selected the Remember Password check box, or if 
people know your password, they can read your mail. To protect your privacy, 
do not share your password with other people and do not select the Remember 
Password box. 

4. Choose OK. 
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Changing Your Password 
If security is a concern, change your password regularly. If you forget your 
password, see your Mail administrator. 

~ To change your password 

1. From the Mail menu in Mail, choose Change Password. 

2. In the Old Password box, type your previous password, and then press TAB. 
For security reasons, you do not see the characters you type. 

3. In the New Password box, type your new password, and then press TAB. 

4. In the Verify New Password box, type the new password again. 

5. Press ENTER. If your second attempt to type the new password does not match 
the first, the computer beeps; start over with a new password, and then verify it. 

Sending a Message 
Sending a message involves a few simple steps: addressing it, typing a subject line, 
typing the message, and sending it. 

~ To send a message 

Send button 

Type your 
message 

here. 

1. On the toolbar, click the Compose button. Or choose Compose Note from the 
Mail menu. The fol.lowing window appears. 

Type a title or phrase that describes 
the subject of the message. 
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2. In the To box, type the names of the people you want to receive the mail. Use a 
semicolon(;) to separate names. ff you want to send copies to other people, type 
their names in the Cc box. 

You can use the Personal Address Book in Mail to store names of people you 
send messages to. For more information, see Help for Mail. 

3. Click the Subject box or press TAB, and then type a title or phrase that describes 
the message. 

4. Click anywhere in the message area or press TAB, and then type your message. 
When your text reaches the right margin, the next word moves to the next line; 
you don't need to press ENTER at the end of each line. 

5. To send the message, choose Send. 

Reading a Message 
Your Inbox displays information about each message, including the name of the 
sender and the date and time the message was received. 

When you have an unread or new message, 
Mail displays a closed-envelope symbol and 
displays the sende~s name in bold type. 



Chapter 4 Mail 39 

~ To read the message 

• Double-click the message. Or use the arrow keys to select the message, and then 
press ENTER. 

The message heading displays the name 
of the person who sent the message. 

frhis is a test of the Mail system. I am sending a simple message to myself for 
this test. 

Replying to a Message 
When you send a reply, your message is addressed for you. Your response includes 
the original message, and you can add comments to it, if needed. If you choose the 
Reply All button or command, the message is addressed to everyone in the To and 
Cc boxes. 
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.,_ To reply to a message 

Choose the Send 
button to send 

your reply. 

Type your 
response 

here. 

• On the toolbar, click the Reply button. Or choose Reply from the Mail menu. 
The following window appears. 

From: John James 
To: John James 
Subject: Test Message 
Date: Thursday. November 18. 1993 10:08AM 

This is a test o1the Mail system. I am sending a simple message to myself for this 
test 

The original message appears here. 

Deleting a Message 
To keep your mailbox from becoming cluttered, you can delete messages you no 
longer need . 

.,_ To delete a message 

1. Select the message that you want to delete. 

2. On the toolbar, click the Delete button. Or choose Delete from the File menu. 

The message moves to the Deleted Mail folder. By default, the Deleted Mail 
folder is emptied each time you quit Mail. You can change this option by using 
the Options command on the Mail menu. You can retrieve the message from the 
Deleted Mail folder at any time until you quit Mail. 
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Quitting Mail 
There are two commands you can use to quit Mail. 

• Use the Exit command to quit Mail without signing out. 

This command is useful if you are running an application, such as Microsoft 
At Work™ PC Fax or Schedule+, that uses Mail to communicate with other 
people. The other application continues to run, even though you have quit Mail. 

If you use this command and you leave your computer unattended, another 
person can start Mail and read your messages without being prompted for 
a password. 

• Use the Exit And Sign Out command to quit Mail and sign out. 

If you use this command, any other application (such as PC Fax or Schedule+) 
that uses Mail to communicate with other people also stops running. If you 
restart Mail, you need to sign in. 

By default, all messages in the Deleted Mail folder are deleted when you quit Mail. 
You can change this option by using the Options command on the Mail menu. 

~ To quit Mail and remain signed in 
• From the File menu, choose Exit. 

~ To quit Mail and sign out 
• From the File menu, choose Exit And Sign Out. 

The Message File 
After you connect to your post office and sign in, an MSMAIL.MMF file is created 
in the directory where you set up Windows for Workgroups. This file is called your 
message file. It stores your messages, message folders, and Personal Address Book. 
The file is updated when you receive messages. If your message file becomes 
corrupted, you are given the option to fix it. 
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Additional Features of Mail 
There are many other features you can use in Mail. For information about the 
following tasks, see Help for Mail: 

• Using folders to organize your messages 

• Finding a specific message 

• Using lhe Address Book 

• Creating and using a message template 

• Embedding an object in a message 

• Sorting messages 
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CHAPTER 5 

Microsoft At Work PC Fax 

Using Microsoft® At Work'" PC Fax version 1.0, you can send faxes to and receive 
faxes from standard fax machines and computers equipped with fax modems. Using 
PC Fax is like using electronic mail. The only difference between a mail message 
and fax message is the way you address it. A fax consists of a typed message and 
can also include a cover sheet and attached documents, such as Microsoft Excel 
spreadsheets. 

This chapter describes how to: 

• Set up PC Fax for use with a fax modem attached to your computer or with 
a shared fax modem on the network. 

• Share your fax modem with other people. 

• Send and receive faxes and attach documents. 

• Use the security features to send and receive secured faxes. 

• Use PC Fax when you're traveling. 

Setting Up PC Fax 
This section describes how to set up your computer to use either a fax modem on 
your computer or a fax modem connected to another computer on the network. It 
also describes how to select which fax modem to use, if there is more than one fax 
modem available. 

Before starting to use PC Fax, make sure you: 

• Have enough disk space. You need approximately SOK of disk space for each 
fax page. 

• Disable any fax software other than PC Fax. You can use only one fax 
application with a modem at a time. 
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Using a Fax Modem Attached to Your Computer 
You can attach a fax modem to your computer and set it up either for yourself or 
for other people on your network as well. 

The modem must be a Class 1, Class 2, or Communication Application 
Specification (CAS) modem. For information, check your fax-modem 
documentation. 

You need to take the following steps in order to use a fax modem attached to your 
computer: 

1. Set up the hardware for the fax modem. 

2. If you have a CAS modem, set up the driver (software) for the fax modem. 

3. Configure the fax modem. 

4. If you plan to share your fax modem with other people using the network, 
specify that you're sharing your fax modem. For information about sharing, 
see "Sharing Your Fax Modem" later in this chapter. 

Setting Up Hardware for Your Fax Modem 
To install the hardware on a serial port (COMl, COM2, COM3, or COM4) on 
your computer, refer to your fax-modem documentation. 

Note Although you can use your telephone line with your fax modem, a separate 
line for your fax modem is recommended so that fax transmissions won't be 
interrupted accidentally. If you use the telephone line, it must be in analog format. 

Setting Up Software for Your Fax Modem 
Do not set up the fax driver (software) that accompanies a Class 1 or Class 2 fax 
modem; you will be using PC Fax instead. If you install a CAS modem, however, 
you must set up the fax driver supplied with it. For instructions, see your CAS 
modem documentation. 

Configuring the Fax Modem 
The configuration settings determine how your fax modem handles faxes. You can 
change these settings at any time. 

~ To configure your fax modem 

1. In the Control Panel window, choose the Fax icon. 

2. If you have set up Mail and connected to a post office, the Fax Modems dialog 
box appears. · 
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Otherwise, the Microsoft At Work Fax dialog box appears. Select Email And 
Fax if you plan to use Mail to send mail messages to other people on your 
network. Select Fax Only if you won't be using Mail to communicate with 
others via mail messages. You will still use Mail to read and send faxes. 
Choose OK. 

If you select Fax Only, you will be prompted to set up Mail when you finish 
configuring your fax modem. 

3. In the Fax Modems dialog box, choose Add. The Add Fax Modems dialog 
box appears. 

4. In the Type list, select the type of fax modem you want to add, and then 
choose OK. 

5. In the Fax Phone Number dialog box, type your fax number (including country 
and area code), and then choose OK. 

6. In the Fax Modems dialog box, choose Setup. A dialog box appears for the fax 
modem you are setting up. 

Under Answer Mode, you can select options to specify how your fax modem 
answers incoming calls. 

Choose Speaker to specify speaker mode and volume. 

Choose Dialing to specify dialing prefixes required for outgoing calls from 
your phone line and other dialing options. 

7. Choose OK. 

For help with the dialog boxes, choose the Help button or press Fl while using the 
dialog boxes. 

After you set up the fax modem, you need to specify it as the active modem. For 
more information, see "Specifying the Active Fax Modem" later in this chapter. 

Using a Fax Modem on the Network 
If you plan to use a fax modem located on another computer on your network, you 
need to specify the name of the computer and the name of the shared directory. You 
may also need to supply a password for the shared directory. Your workgroup 
administrator or the person whose fax modem it is can give you this information. 

... To set up your computer to use a shared fax modem 

1. In the Control panel window, choose the Fax icon. 

2. In the Fax Modems dialog box, choose Add. 

3. In the Type box, select Shared Network Fax, and then choose OK. The Connect 
Network Fax dialog box appears. 
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4. If the Connections list includes the path for the shared fax modem, go to step 6. 

If the Connections list does not include the path for the shared fax modem, 
choose Network. The Connect Network Drive dialog box appears. 

5. In the Path box, type the computer name and the name of the shared directory, 
and then choose OK. The Connect Network Fax dialog box appears. 

For information about using the Connect Network Drive dialog box to find 
the shared directory or how to reconnect to the directory each time you start 
Windows for Workgroups, choose the Help button or press Fl while using the 
dialog box. 

6. In the Connections list, select the path for the shared fax modem, and then 
choose OK. 

After you set up the fax modem, use the following procedure to specify it as the 
active modem. 

Specifying the Active Fax Modem 
Before you can use a fax modem you have just set up, you must specify it as active. 
Also, only one fax modem can be used at a time. If you have more than one 
available, you need to specify which one you want to be active. Make sure that 
Mail is closed and the Outbox is empty before you specify the active modem. 

~ To select a fax modem 

1. In the Control Panel window, choose the Fax icon. 

2. In the Fax Modems dialog box, select the modem you would like to use. 

3. Choose Set As Active Modem, and then choose OK. 

You must restart Mail after specifying the active fax modem. 

Sharing Your Fax Modem 
When you share a fax modem, anyone using the network can connect to it to send 
faxes. Because of this, you might receive faxes for other people in addition to faxes 
intended for you. You need to forward faxes intended for others. For information 
about forwarding faxes, see "Forwarding a Fax" later in this chapter. 
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~ To share a fax modem with other people on the network 

1. In the Control Panel window, choose the Fax icon. 

2. In the Fax Modems dialog box, select the modem you want to share, and then 
choose Share. 

This button appears only if file sharing is set up on your computer. To set up file 
sharing, see "Setting Up Sharing for Files and Printers" in Chapter 3, "New File 
Manager and Print Manager Features." 

3. The Share Local Fax Modem dialog box displays a directory name in the 
Directory box. If you want a different directory, type the path and name of 
the directory that you want to use for the fax modem. 

To share a local fax modem you must: 

1. Create a directOJy to store outgoing faxes. 

2. Create a nelwo1k share on that directory. The 
share must have full read and write privileges. 

3. Enter the directory name below. 

Q_irectory: lc:\WINDO\o/5\MSFAX 

Or 

Choose this 
button if the 
directory does 
not already exist. 

Choose this 
button if the 
directory is not 
already shared. 

If you have not already created the directory, choose Create Directory, and then 
choose OK. 

4. If you have not already shared the directory, see the following procedure. 
Otherwise, in the Fax Modems dialog box, choose OK. 

~ To create a shared directory 

1. In the Share Local Fax Modem dialog box, choose Create Share. 

2. The name of the shared directory is displayed in the Share Name box. If you 
want to share a different directory, type the name. 

3. The path of the shared directory appears in the Path box. If you want to share 
a different directory, type the path. 

4. Under Comment, you can type an optional description of the shared directory. 

5. If you want the modem to be shared automatically when you restart Windows, 
select the Re-Share At Startup check box. 
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6. Under Access Type, select Full or Depends On Password. 

If you select Depends On Password, type the password in the Full Access 
Password box. 

Note If you select Read-Only, other people will not be able to connect to your 
modem. 

7. Choose OK. 

8. In the Share Local Fax Modem dialog box, choose OK. 

9. In the Fax Modems dialog box, choose OK. 

For help with the dialog boxes, choose the Help button or press Fl while using the 
dialog boxes. 

Stop Sharing a Fax Modem 
You can stop sharing your fax modem with other people on the network. 

II> To stop sharing a fax modem 

1. In the Control Panel window, choose the Fax icon. 

2. In the Fax Modems dialog box, select the shared modem, and then choose 
Stop Sharing. 

3. Choose OK. 

Sending a Fax 
You can send a fax from Mail or from an application. When you send a fax from 
Mail, your fax can include other documents that you attach. When you send a fax 
from an application, the current document becomes the fax message. 

You can send the same message to both Mail and PC Fax recipients at the same 
tinle by using a combination of mail and fax addresses. 

If you send many faxes to the same recipients, you can avoid having to type the fax 
number each tinle by adding fax numbers to your Personal Address Book in Mail. 

The following two procedures describe the basic steps for sending a fax. If you are 
not familiar with using Mail, see Chapter 4, "Mail." 

II> To send a fax from Mail 

1. In the Network group, choose the Mail icon. 

2. On the toolbar, click the Compose button. 
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3. In the To box of the Send Note window, type [fax:name@number] or 
[fax:number]. For example: [fax:Chris Doe@555-1234] or [fax:555-1234]. 

4. In the Subject box, type the subject of the fax. 

5. In the message area, type the message. 

6. If you want to attach a document, click the Attach button on the toolbar. 

In the Attach dialog box, locate and select the document, and then choose 
Attach. 

Choose Close. 

7. On the toolbar, click the Send button. 

You can also send a fax that includes a document from within the application used 
to create the document. 

You still must have Mail running when you send a fax from an application. 

Caution When you send a fax or mail message from some applications, the text in 
the attached document may lose its formatting. Before using this method, you might 
want to test the application by sending a mail message to yourself. 

~ To send a fax from within an application 

1. Make sure that Mail is running. 

2. Open the document you want to send. 

3. If there is a Send command on the File menu, choose it. 

If there is no Send command on the File menu, specify your fax modem as your 
printer. Then choose Print from the File menu, and choose OK in the Print 
dialog box. 

4. In the To box of the Send Note window, type [fax:name@number] or 
[fax:number]. For example: [fax:Chris Doe@555-1234] or [fax:555-1234]. 

5. You can change the Subject line or add text to the message. 

6. On the toolbar, click the Send button. 

For more information about specifying a printer, see the documentation for your 
application. 

Tip If you use TrueType fonts, your printed fax will resemble the screen image, 
including page breaks. 
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Adding Fax Numbers to the Personal Address Book 
You can use the Personal Address Book in Mail to store commonly used fax 
numbers in addition to commonly used mail addresses. For information about the 
Personal Address Book, see Help for PC Fax and for Mail. 

For information about using the Personal Address Book to send faxes when you are 
traveling, see "Tips for Travelers" later in this chapter. 

Note You do not need to include the recipient's name when you type a fax address. 
However, if you have selected the option in Mail to add recipients automatically to 
the Personal Address Book, and you use a name in the fax address, the address is 
added by name rather than by fax number. 

Setting Fax Options 
You can customize your faxes by setting options that apply to all of your faxes 
(global). You can also set options for each fax message you send, temporarily 
overriding the global settings. 

~ To set global fax options 

1. In the Network group, choose the Mail icon. 

2. From the Fax menu, choose Options. 

3. In the Default Fax Options dialog box, set the options you want for sending 
faxes, and then choose OK. 

For help, choose the Help button or press Fl while using the dialog box. 

Message Format 
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Setting Options for an Individual Fax 
You can set options for the current fax message, temporarily overriding the global 
settings. If you want, you can save them as the global settings. 

~ To set options for an individual fax 

1. In the Network group, choose the Mail icon. 

2. On the toolbar, click the Compose button. 

3. On the toolbar, click the Options button. 

4. In the Options dialog box, choose Fax. 

5. In the Fax Message Options dialog box, set the options you want for 
the current fax. 

If you want to save the new settings for all future faxes, select the Save As 
Defaults check box. 

6. ChooseOK. 

7. In the Options dialog box, choose OK. 

8. Send the fax as usual. 

For help with the dialog boxes, choose the Help button or press Fl while using 
the dialog boxes. 

Managing Outgoing Faxes 
Whether you're using a fax modem installed on your computer or a fax modem on 
the network, you can view the queue, or list of faxes waiting to be sent. If the fax 
modem is installed on your computer, you can reschedule fax send times or delete 
any faxes in the queue. If you're using a fax modem on the network, you can only 
reschedule or delete faxes that you have sent. 

~ To delete or reschedule an outgoing fax 

1. In the Network group, choose the Mail icon. 

2. From the Fax menu, choose Queue. 

3. Select the fax you want to delete or reschedule. 

4. To delete the fax, choose Cancel Send. 

To reschedule the fax, choose Reschedule. In the New Time dialog box, select 
the new send time, and then choose OK. 
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Receiving a Fax 
You can receive a fax directly via a fax modem on your computer, or another 
person who has a fax modem on their computer can use Mail to forward a fax to 
you. In either case, incoming faxes appear exactly like incoming mail messages in 
your Mail Inbox. You can view a fax on your screen, print it, save it on your hard 
disk, reply to it, or forward it. For more information about using Mail, see Chapter 
4, "Mail." 

Note If you have a fax modem on your computer, in order to receive a fax, you 
must either have Mail running on your computer or have quit Mail without signing 
out. See "Quitting Mail" in Chapter 4, "Mail," for information about quitting mail 
without signing out. 

If you are using a phone line for both voice and fax, you can use the Answer Now! 
command on the Fax menu in Mail to switch the phone line to receive a fax. 

The fax you receive may be a secured fax that requires a password or key. For 
more information about receiving a secured fax, see "Using Security" later in this 
chapter. 

~ To read a fax 

1. In the Network group, choose the Mail icon. 

2. Double-click the fax message you want to read. 

3. If the message has an attached document, double-click the icon to read 
the document. 

Icon for an attached document 
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When you open an attached document, the application that was used to create the 
document starts up automatically, if the application is on your hard disk. For 
example, if the fax contains an attached spreadsheet created with Microsoft Excel, 
when you double-click the attachment, Microsoft Excel starts and opens the 
spreadsheet. The attached document has a filename extension that indicates its 
original application. In this example, the spreadsheet has an .XLS extension. 

An attachment that has a .DCX extension is in facsimile format. This is a standard 
format used for sending faxes when the recipient may not have the application the 
sender used; each page of the fax is stored as an image. When you double-click an 
attachment that has a .DCX extension, the Fax Viewer window opens, displaying 
the contents of the fax. 

The Fax Viewer window can be used to: 

• Scale or rotate a fax for viewing. 

• Enhance or reverse the fax image for viewing and printing, if the resolution 
of your printer is lower than the resolution of the received image. 

• Print a fax. 

• Save a fax. 

• Export a single page as a .PCX file. 

For more information about Fax Viewer, see Help for PC Fax. For more 
information about reading documents in other formats, see "Associating Files 
with Applications" in Help for File Manager. 

Forwarding a Fax 
If you have a shared fax modem on your computer, you need to forward any faxes 
you receive that are intended for other people. To forward a fax, you first need to 
open it so you can identify the recipient. 

~ To forward a fax 

1. In the Mail window, double-click the fax message. 

If the fax was sent from Mail or from an application, the To box displays the 
name of the intended recipient. If the fax was sent from a standard fax machine, 
you must double-click the attached fax icon in order to view the cover page and 
find the intended recipient's name. 

2. On the toolbar, choose the Forward button. 

3. In the To box, type the name of the intended recipient. 

4. On the toolbar, choose the Send button. 
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Using Security 
With PC Fax, you can ensure the security of the faxes you send by encrypting 
them. An encrypted fax cannot be read by anyone except the intended recipient. 
Encrypting "locks" a fax. The recipient must decrypt the fax to "unlock" it. There 
are two ways to encrypt a fax: password encryption and key encryption. You can 
also send a fax with a digital signature, which assures all recipients that only you 
could have sent it. 

To send or view a fax using key encryption or a digital signature, you must use 
advanced security. Advanced security uses two keys: a public key you give to fax 
recipients, and a private key, which only you use. 

Password encryption is less secure than key encryption, but it is sufficient for many 
situations. Password encryption is the easiest to set up, since it does not require 
establishing advanced security. Also, you choose the password (and it is short), so 
it is easy to give to another person over the phone. 

With advanced security, a key contains 154 computer-generated characters and 
is usually exchanged between sender and recipient on a floppy disk. For more 
information, see "Sending and Receiving Key-Secured Faxes" later in this chapter. 

Both sender and recipient must be using PC Fax to use any of these security 
options. 

Sending or Receiving a Password-Secured Fax 
You must select the Password option for each password-encrypted fax you send. 

~ To send a password-encrypted fax 

1. In the Network group, choose the Mail icon. 

2. On the toolbar, click the Compose button. 

3. On the toolbar, click the Options button. 

4. In the Options dialog box, choose Fax. 

5. In the Fax Message Options dialog box, choose Security. 

6. Select Password. 

7. In the Type Password box, type the password, and then type it again in 
the Verify box. 

8. Choose OK. 

9. In the Fax Message Options dialog box, choose OK. 

10. In the Options dialog box, choose OK. 

11. Send the fax as usual. 

12. Tell the recipient the password. 
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For help with the dialog boxes, choose the Help button or press Fl while using 
the dialog boxes. 

II> To read a password-encrypted fax 

1. In the Network group, choose the Mail icon. 

2. Double-click the fax message you want to read. 

3. In the Password box, type the password. 

4. Choose OK. 

5. A readable copy of the fax appears as a new message in your Inbox. 

Establishing and Maintaining Advanced Security 
To send or view a fax by using key encryption or a digital signature, you must 
establish advanced security to set up your public and private keys. After you have 
your keys set up, you must either start advanced security each time you send or 
view a fax, or set up your options so that advanced security is always on. 

Note A digital signature may be legally binding. If your computer is not in a secure 
environment, you may want to turn off security or quit Mail if you leave your 
computer unattended. 

II> To establish and start security 

1. In the Network group, choose the Mail icon. 

2. From the Fax menu, choose Advanced Security. 

3. In the Fax Security dialog box, choose Enable Security. 

The Enable Security button changes to Disable Security. 

Enable/disable security 
ieature:s for fax messages. 

Add. delete. copy and 
rename public keys. 

Create or import new private 
keys. 

Change your fax security 
sign-in password. 

Create a new hue security 
password and personal keys. 
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4. The first time you use advanced security, a message appears, prompting you to 
establish an account. Choose Yes. In the Password box, type and verify the 
password, and then choose OK 

If you've already established advanced security, the Password dialog box 
appears. Type and verify your password, and then choose OK 

5. In the Fax Security dialog box, choose Close. 

Tip If you leave security on when quitting Mail, the next time you start Mail 
you will be prompted for your fax security password to start advanced security. 

II> To quit security 

1. In the Network group, choose the Mail icon. 

2. From the Fax menu, choose Advanced Security. 

3. In the Fax Security dialog box, choose Disable Security. 

4. Choose Close. 

Managing Security Keys 
To send and receive key-secured or digitally signed faxes, you must exchange 
public keys with your correspondents. You and your correspondents must all be 
using PC Fax and must have established advanced security. 

The easiest way to exchange public keys is to export them to a floppy disk and then 
exchange disks with your correspondents. You can then import other people's 
public keys from the disks. 

You should accept public keys only directly from the sender or from a third party 
you know and trust. Otherwise, you could receive a fax with a digital signature 
from an unauthorized person, or you might send a secured fax that can be read by 
someone other than the intended recipient. 

Public keys can be either signed or unsigned. To help ensure integrity of public 
keys, you can put a digital signature on your public key before you export it, and 
request that anyone giving you his or her public key put a digital signature on 
the key. 

Note You should always back up your public and private security keys so that you 
can restore them in the event of a computer failure. Exporting the keys to a floppy 
disk and then locking the disk in a safe place is recommended. 
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.. To export your public key 

1. Insert a disk in a disk drive. 

2. In the Network group, choose the Mail icon. 

3. From the Fax menu, choose Advanced Security. 

4. In the Fax Security dialog box, choose Enable Security. 

5. Type your password, and then choose OK. 

6. In the Fax Security dialog box, choose Public Keys. 

7. In the Public Keys dialog box, select your fax account, and then choose Export. 

8. In the File Name box, type a name for the public-key file. The filename 
extension is .A WP for an unsigned key and .A WS for a signed key. 

9. In the Drives list, select the floppy disk drive. 

10. Choose OK. 

11. In the Public Keys dialog box, choose Gose. 

12. In the Fax Security dialog box, choose Close. 

For help with the dialog boxes, choose the Help button or press Fl while using 
the dialog boxes. 

.. To import a public key 

1. Insert the disk containing the public key into a disk drive. 

2. In the Fax Security dialog box, choose Enable Security, if security is not 
already on. 

3. Choose Public Keys. 

4. In the Public Keys dialog box, choose Import. 

5. In the Drives list, select the floppy disk drive. 

6. In the list, select the .A WP or .A WS file containing your public key. Or type 
the filename in the File Name box. 

7. Choose OK. 

8. In the Public Keys dialog box, choose Close. 

9. In the Fax Security dialog box, choose Close. 

For help with the dialog boxes, choose the Help button or press Fl while using 
the dialog boxes. 
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~ To back up or restore your private key 

• Follow the procedures for exporting and importing public keys, but instead 
of the Public Keys button, choose the Private Keys button in the Fax Security 
dialog box. The filename extension for a private key is .A WR. 

Store your private-key backup in a secure location. 

Important When you import a private key, you are prompted for the password that 
was in effect at the time you exported the key for backup. If you plan to change 
your password, make a note of the old password and store it with the key backup. 

Sending and Receiving Key-Secured Faxes 
When advanced security is on, you can send a key-encrypted or digitally signed 
fax. You can also read a secured fax that you have received. You can set the key­
encrypt and sign options as global fax options, but they are effective only when 
advanced security is on. 

With key encryption, the sender of a fax uses the recipient's public key to encrypt 
the fax. When the recipient receives the fax, he or she uses the private key to 
decrypt the message. 

Digital signature works in reverse. The sender uses his or her private key to "sign" 
the fax. Anyone can read it. But only recipients having the sender's public key can 
verify the sender's identity. 

You can also send a fax that is both digitally signed and encrypted. 

~ To send a key-encrypted or digitally signed fax 

1. In the Network group, choose the Mail icon. 

2. From the Fax menu, choose Advanced Security. 

3. In the Fax Security dialog box, choose Enable Security. 

4. Type your password, and then choose OK. 

5. In the Fax Security dialog box, choose Close. 

6. From the Fax menu, choose Options. 

7. In the Default Fax Options dialog box, choose Security. 

8. In the Fax Message Security Options dialog box, select the option(s) you want. 
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9. Choose OK. 

10. In the Default Fax Options dialog box, choose OK. 

11. Send the fax. 

For help with the dialog boxes, choose the Help button or press Fl while using 
the dialog boxes. 

~ To read a key-encrypted fax 

1. In the Network group, choose the Mail icon. 

2. From the Fax menu, choose Advanced Security. 

3. In the Fax Security dialog box, choose Enable Security. 

4. Type your password, and then choose OK. 

5. In the Fax Security dialog box, choose Close. 

6. Double-click the secured fax you want to read. If it is an encrypted fax, 
a readable copy will appear as a new message in your Inbox. 

If it is a digitally signed fax, the signature will be verified. Choose Launch 
to read the fax. 

Tips for Travelers 
If you plan to take your fax modem and computer to other locations, and you use 
the Personal Address Book in Mail, you need to use the international format when 
addressing the fax. 

The international format is: 

+countrycode-areacode-phonenumber 

Be sure to include the plus sign and the hyphens. 

• To have PC Fax dial your long-distance credit-card number for you, specify the 
number in the Long Distance Calls and International Calls boxes in the Modem 
Dialing Options dialog box when you set up your fax modem. 

• When you go to another country, you can use Control Panel to change your fax 
number, and numbers from your Personal Address Book will be used. 

For example, if you send a fax to a local recipient by using a Personal Address 
Book entry that has an international-format number, PC Fax determines that the 
country code and area code aren't required, so it doesn't dial them. If you go to 
another country and send a fax to the same recipient, PC Fax determines that it 
now needs to dial the access code for an international line, the country code, the 
area code, and then the number. 





CHAPTER 6 

ClipBook Viewer 

ClipBook Viewer provides temporary or long-term storage for information you 
want to move, save, or share. It includes: 

• Clipboard-A temporary storage location for information you cut or copy. 

61 

Information on the Clipboard remains there until you cut or copy another piece 
of information onto it or until you quit Microsoft® Windows"" for Workgroups. 

• Local ClipBook-A long-term storage location for information you want to 
save, share, or move. Each piece of information you paste onto your Local 
ClipBook is called a page. The Local ClipBook is like a personal notebook: 
It stores multiple pages of information. You copy a page of information back 
onto your Clipboard when you want to use it in another application. Unlike 
the Clipboard, the Local ClipBook stores the information even when you quit 
Windows for Workgroups. 

• ClipBook Viewer-An application that enables you to view information on 
the Clipboard, the Local ClipBook, and ClipBooks on other computers. 

When you use the Microsoft Windows Network, you can use your Local ClipBook 
to share information, such as a drawing, a chart, or a section of text, with other 
people on the network. You can also create links in your documents to information 
that is already being shared by other people on their ClipBooks, ensuring that your 
documents are updated whenever the information changes. 

For basic information about using the Clipboard, see your Windows or Windows 
for Workgroups documentation. 

Using the ClipBook Viewer Window 
ClipBook Viewer has two windows-the Clipboard window, which displays the 
current contents of the Clipboard; and the Local ClipBook window, which displays 
the contents of your Local ClipBook. 
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When you choose the ClipBook Viewer icon in the Main group, the following 
window appears. 

The toolbar contains buttons 
corresponding to common 
menu commands. 

Each piece of 
information on the { 
Local ClipBook is 

called a page. 

The Local ClipBook 
stores information you 

want to save. 

Double-dicking the 
Clipboard icon 

displays the current 
contents of the 

Clipboard. 

Clipboard 

This icon indicates that the page is shared. 

~ To view the contents of the Clipboard or Local ClipBook 

L In the Main group, choose the ClipBook Viewer icon. 

2. From the Window menu, choose Clipboard or Local ClipBook. 

You can also select the window or choose the icon you want 

The ClipBook Viewer toolbar contains the following buttons, which are shortcuts 
for menu commands. 

Use this button Or this command 

Connect 

Disconnect 

Share 

Stop Sharing 

To 

Connect to a ClipBook on another 
computer. 

Disconnect from a ClipBook on another 
computer. 

Share a Local ClipBook page. 

Stop sharing a Local ClipBook page. 
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Use this button Or this command To 

II Copy Copy the selected ClipBook page onto 
the Clipboard. 

II Paste Paste the contents of the Clipboard onto 
the Local ClipBook. 

II Delete Delete the contents of the Clipboard or 
the selected Local ClipBook page. 

El Table Of Contents Display the titles of the pages saved on 
aClipBook. 

II Thumbnails Display small pictures (thumbnails) of 
each page on a ClipBook. 

• Full Page Display the contents of the selected page 
on a ClipBook. 

Note Sometimes the line length of the information you copy or cut changes so that 
all of it is visible in the Local ClipBook window. When you paste the information 
from the Clipboard into an application, the formatting is intact. 

The Clipboard accepts several text and graphics formats. To view the available 
formats, use the View menu in ClipBook Viewer. 

Saving the Contents of the Clipboard 
There are two ways to save the contents of the Clipboard-you can save it as 
a page on the Local ClipBook or save it to a file (with a .CLP extension). The 
advantages of saving to the Local ClipBook are that the information is easier to 
retrieve, and you can share the information on the Local ClipBook with others. 
You might want to save the contents of the Clipboard to a file if you need to share 
information with someone whose computer can read information only in the 
Clipboard file format. For more information about saving to a file, see Help for 
ClipBook Viewer. 

... To save the contents of the Clipboard to the Local ClipBook 

1. In the Main group, choose the ClipBook Viewer icon. 

2. From the Window menu, choose Local ClipBook. Or click the window to 
select it. 

3. On the toolbar, click the Paste button. Or choose Paste from the Edit menu. 

4. In the Page Name box, type a name for the page you are saving the informa­
tion to. 

5. Choose OK. A new page appears in the Local ClipBook window. 
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Before you can insert a Local ClipBook page into another document, you must copy 
the page back onto the Clipboard (unless the information is still on the Clipboard). 

~ To copy a page from the Local ClipBook back onto the Clipboard 

1. In the Main group, choose the ClipBook Viewer icon. 

2. From the Window menu, choose Local ClipBook. Or click the window to 
select it. 

3. Select the page you want to copy. 

4. On the toolbar, click the Copy button. Or choose Copy from the Edit menu. 
The contents of the page are displayed in the Clipboard window. 

Sharing Information with Other People 
You can share pages from your Local ClipBook with other people, or use pages 
they have shared. 

Sharing Local ClipBook Pages 
When information is on the Clipboard, you can save it as a page on the Local 
ClipBook and then share it with other people. Others can then connect to your Local 
ClipBook and view or change the information you have shared, depending on the 
type of access you have specified. 

When a Local ClipBook page is shared, there is an icon next to the page title 
indicating that the page is shared. 

To share a page on the Local ClipBook 

1. In the Local ClipBook window, select the page you want to share. 

2. On the toolbar, click the Share button. Or choose Share from the File menu. 

Select any of the following options in the Share ClipBook Page dialog box, and 
then choose OK. 

Select 

Start Application On Connect 

To 

Automatically start the application that was 
used to create the information in the shared 
page. If this option is not selected, other 
people cannot use the information unless the 
application used to create the information is 
already running. 



Select 

Access Type 

Passwords 
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To 

Assign the type of access others can have 
to this information. Note that full access is 
available only with some applications: With 
most applications, other people cannot 
modify shared ClipBook pages. 

Assign a password, if you specified read-only 
or full access. 

To stop sharing a page on the Local ClipBook 

1. In the Local ClipBook window, select the page you want to stop sharing. 

2. On the toolbar, click the Stop Sharing button. Or choose Stop Sharing from the 
File menu. 

Connecting to a ClipBook on Another Computer 
You might want to connect to a ClipBook on another computer in order to work on 
a document with someone else, view information, or embed or link objects from the 
other computer. For information about using ClipBook Viewer to embed or link 
objects, see the next section in this chapter. 

To connect to a ClipBook on another computer 

1. In the Main group, choose the ClipBook Viewer icon. 

2. On the toolbar, click the Connect button. Or choose Connect from the File menu. 

3. In the Select Computer dialog box, type the name of the computer that has the 
ClipBook you want to connect to, or click the arrow to the right of the Computer 
Name box to select from a list of previous connections. 

The Computers box lists the available computers by workgroup name. Expand 
(choose) a workgroup name to display a list of computers in the workgroup, 
and then select the name of the computer that has the ClipBook you want to 
connect to. 

If, typically, you know the name of the computer you want to connect to, you 
may want to clear the Always Browse check box. 

4. Choose OK. The contents of the ClipBook you connected to are displayed 
in a window. 
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You can disconnect from a ClipBook on another computer when you are done 
using it. 

To disconnect from a ClipBook on another computer 

1. In the Main group, choose the ClipBook Viewer icon. 

2. Select the ClipBook window or icon that you want to disconnect from. 

3. On the toolbar, click the Disconnect button. Or choose Disconnect from the 
File menu. 

Embedding or Linking an Object from Another Computer 
Object linking and embedding (OLE), transferring and sharing information 
between Windows-based applications, has been enhanced for Windows for 
Workgroups version 3.11. For basic information about linking and embedding 
objects, see your Windows or Windows for Workgroups user's guide. 

Using the Microsoft Windows Network, you can link or embed an object from a 
document on another computer into a document on your computer. The object must 
already be pasted as a page on the other computer's ClipBook, and it must be 
designated as shared. 

Note When you link an object from another computer by using the ClipBook, you 
cannot change the linked object by using your computer. However, changes made 
to the original document do appear in your document. 

... To embed or link an object from another computer 

1. Follow the steps for connecting to a ClipBook on another computer, described 
in the previous section. 

2. Select the shared ClipBook page that you want to embed or link into your 
document. 

3. From the Edit menu, choose Copy. A copy of the object is placed onto your 
Clipboard. 

4. Open the document in which you want to embed or link the object. 

5. From the Edit menu of this document, choose Paste to embed the object, 
or choose Paste Link to link the object. 
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Some applications have a Paste Special command. If you choose this command, 
a dialog box with a list of formats appears. Select the format you want the 
information to be displayed in, and then choose Paste to embed the object, or 
choose Paste Link to link the object. The embedded or linked object appears in 
your document. 

Note Some formats do not work with OLE. If you choose such a format and 
then choose Copy or Paste, information is copied from the Clipboard, but an 
embedded or linked object is not created. 
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CHAPTER 7 

Network Applications 

This chapter introduces the applications included in the Network group of 
Microsoft® Windows'" for Workgroups version 3.11. The Network group includes 
applications that you can use to perform many common networking tasks: 

• Use Chat, Net Watcher, WinMeter, and WinPopup to perform workgroup tasks, 
such as exchanging messages or monitoring workgroup activities and resource 
usage. If you are running a network other than the Microsoft Windows Network, 
these applications may not be set up. 

• Use Schedule+ to schedule events and communicate with co-workers who 
are using the Microsoft Windows Network. Schedule+ is always installed, 
regardless of the network you are running. 

• Use Log On/Off to log on to and off of the Microsoft Windows Network. Log 
On/Off will not be set up if you are running a network other than the Microsoft 
Windows Network. 

Online Help provides procedures for performing tasks. To view Help, choose 
the Contents command from the Help menu in each application. 
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Chat 

~ 

Use the Dial button to 
call another person. 

Log On/Off 
ft 

Using Chat, you can have an electronic conversation with up to seven other 
people by exchanging typed messages. Unlike an electronic mail message that 
you compose and send to another person, a Chat message is interactive: it is 
visible to the recipient as you type it. 

Use the Answer button to answer a call. 

Use the Hang-up button to end a conversation. 

For information about the following tasks, see Help for Chat: 

• Starting or ending a conversation 

• Answering a call 

• Calling more than one person 

• Changing the font or background color 

• Turning sound on or off 

You can log on to or off of the Microsoft Windows Network at any time by 
choosing the Log On/Off icon. If you are logged off, choosing this icon logs you 
on; if you are logged on, it logs you off. 
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When logged off, you can share your resources but cannot gain access to 
resources that are being shared by other people. To browse through and connect 
to resources that are being shared by others, you must first log on. 

You can also log on and off by using the Network option in Control Panel. For 
more information, see Chapter 8, "Customizing Network Settings and Improving 
Performance." 

Net Watcher 

~ 

A list of users 
that are connected 

to your computer 
appears here. 

You can use Net Watcher to find out which of your computer resources, such 
as files and printers, are being used by other people on the network. You can 
also see which computers are connected to your computer and, if necessary, 
disconnect them. 

Use the Properties button to display details 
about the selected connection. 
Use the Disconnect button to end 
the selected connection. 

Use the Close File button to close the selected file. 

Use the View Event Log button to see 
who is connected to your computer. 

A pencil icon -1-----ll"' A list of resources 
being used by the 
selected user 
appears here. 

indicates that users 
have full access to 

the directory or file. 

The status bar displays 
information about the 
selected item. 

An eyeglasses icon indicates that 
users have read-only access to the 
directory or file. 

If you are using the event log, you can also use Net Watcher to view your log file. 
For information about the event log, see Chapter 8, "Customizing Network Settings 
and Improving Performance." 

For more information about using Net Watcher, see Help for Net Watcher. 
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Schedule+ 
II 

Record meetings 
and events here. 

Today's date 
appears here. 

Schedule+ is a personal scheduling tool that you can use to keep track of 
appointments and tasks and to record notes. You can also use Schedule+ to 
check the schedules of other people and share your schedule with them. 

Use the calendar to view 
or make appointments. 

For information about the following tasks, see Help for Schedule+: 

• Adding an appointment 

• Adding a recurring appointment 

• Changing an appointment 

• Scheduling a meeting 

• Adding a task 



Win Meter 

ii 
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WinMeter graphically displays how much of your central processing unit (CPU) 
you and other people on the network are using. For example, if someone in your 
workgroup is printing a file from your hard disk, WinMeter displays the percentage 
of your CPU being used as the other person connects to and prints the file, 

l>,ettings fdit 
100 

80 • ,,,,,,,,,,,,, 

60 

40 

Shows the percentage 20 ,. , 

of your CPU time that ,j&if!Fiilll~_,..,....-,,....,__,.1!11111! 

you are using. 

WinPopup 

1t 

Shows the percentage of your 
CPU time being used by others 
in your workgroup. 

Note To adjust the speed at which your applications run and your resources are 
shared when others are connected to your computer, choose the Networks icon in 
Control Panel, and then choose the Startup button. For more information, see Help 
for Control Panel. 

You can use WinPopup to send and receive messages if you have Microsoft 
Windows Network, LAN Manager, or Windows NT'" or Windows NT Advanced 
Server. However, you must specify Microsoft Windows Network during Windows 
Setup in order for WinPopup to be set up. 

You can send a message to another person or computer, or you can send a message 
simultaneously to all the members of a workgroup. You also can set up WinPopup 
to notify you when a document has finished printing. 



74 Microsoft Workgroup Add-On for Windows User's Guide 

Use the Send button to send a message. 

Use the Discard button to delete the current message. 

Use the Previous button to view the previous message. 

Use the Next button to view the next message. 

No messages 

-~--...- The message 
appears here. 

WinPopup does not start automatically. You can either start WinPopup by double­
clicking the WinPopup icon in the Network group, or you can choose to have 
WinPopup start automatically each time you start Windows for Workgroups. 

~ To start WinPopup each time you start Windows for Workgroups 

1. In the Main group, choose the Control Panel icon. 

2. In the Control Panel window, choose the Network icon. 

3. Choose the Startup button. 

4. Under Startup Options, select the Enable WinPopup check box, and then 
choose OK. 

For information about the following tasks, see Help for WinPopup: 

• Sending a message 

• Deleting the current message 

• Viewing other messages 

• Deleting all messages 



CHAPTER 8 

Customizing Network Settings and 
Improving Performance 

You can customize the way your computer works with the Microsoft® Windows"' 
Network. Some of the features described in this chapter also apply to using 
Windows for Workgroups with the Microsoft Windows NT"' operating system, 
Windows NT Advanced Server, or IAN Manager. For information about other 
networks, see Chapter 9, "Using Other Networks." 

You can also select options to improve the speed of your applications. 

Customizing Microsoft Windows Network Settings 
This section provides procedures for the following tasks: 

• Logging on to and off of the Microsoft Windows Network 

• Changing workgroup settings 

• Changing startup settings 

• Changing your logon password 

• Specifying which network events to log 

• Enabling or disabling sharing 

Additional tasks, such as using other networks and setting protocols and advanced 
options for network adapters, are described in Help for Windows Setup. For 
information about how to install and configure a device driver for a network 
adapter, see Appendix D, "Configuring Network-Adapter Drivers." 
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Customizing Network Settings by Using Control Panel 
·By using the Network option in Control Panel, you can select startup options for 
logging on. For example, you can change the default logon name and you can 
choose to start Windows for Workgroups without logging on to the network. 

Use this section { 
to change basic 

workgroup settings. 

Choose this button 
to log on to or off 

of the Microsoft 

When you choose the Network icon in the Control Panel window, the Microsoft 
Windows Network dialog box appears. 

--------~----~-----~ ~ 

~ Microstlft Windows Netwmk 

J;.omputer Name: !JOHNJAll I 
:=1w=O=Rl'.G==A=OU=P======l::ll;;;.: ~orkgroup: 

C-nt: IJot..Ja11111• 
LogonS1a1uo----------~ 

Cuminti, logged an ao JOHNJAM 
Jl.elault Logon Name: ,...jJ--OH-NJA~M------. 

liiiil --
Windows Network. -l+-1!1111111111111 

Choose this button to monitor network events. 

Choose this button to change your password. 

Choose this button to change startup logon options. 

Note Several settings that you can change by using the Network option do not take 
effect until you restart your computer. Before you can restart your computer, you 
must quit any MS-D08-based applications that are running. You may want to 
save your files and quit these applications before changing network settings. 
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Logging On and Off 
You can log on to or off of the Microsoft Windows Network at any time. When 
logged off, you can share your resources, such as directories and printers, but you 
cannot gain access to resources being shared by other people. To browse through 
and connect to resources being shared by others, you must first log on. 

Logging off of the network after you are finished using Windows for Workgroups 
is useful if more than one person uses your computer, or if you don't want 
unauthorized people to have access to the resources you connect to. If others use 
your computer, they can log on by using their logon name and gain access to 
resources. 

Caution Logging off disconnects you from other computers or resources that you 
may be connected to. To prevent losing your work, make sure you save any files 
you are working on, and quit any application you are running from another person's 
computer, before you log off. 

~ To log on or off 

1. In the Control Panel window, choose the Network icon. 

2. In the Microsoft Windows Network dialog box, choose Log On or Log Off. 

For help on the Microsoft Windows Network dialog box, choose the Help button 
or press Fl while using the dialog box. 

Note You can also log on to or off of the Microsoft Windows Network by choosing 
the Log On/Off icon in the Network group. 

If you choose to log on, you need to specify your logon name and password in the 
logon dialog box. 

Changing Workgroup Settings 
You can change your computer name, the workgroup your computer belongs to, and 
the comment that follows your computer name in dialog boxes that list workgroups 
and computers. You can also create a new workgroup. 
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~ To change workgroup settings 

1. In the Control Panel window, choose the Network icon. 

2. In the Microsoft Windows Network dialog box, change the settings you want. 

The name assigned to 
your computer. You 

can type a new name. 

The comment that 
appears next to your 

computer name in 
dialog boxes. 

For help on the dialog box, choose the Help button or press Fl while using the 
dialog box. 

The workgroup your computer belongs to. Clicking the 
down arrow displays a list of workgroups to choose 
from. Typing a new name creates a workgroup. 

~omputer Name: LJ_OH_N_J_A_M__,~---~ 

:w'._orkgroup: WORKGROUP • 
Comment: LIJ_oh_n_J_am_•_•-------~ 

Logon Status-----------~ 

Currently logged on as JOHNJAM 

Jl.efault Logon Name: rlJD_H_N_J_f!M----~ 

Jlptions: 

3. Choose OK. 

After you change the settings, a dialog box appears, prompting you to restart 
your computer. If you have saved your files, you can safely restart. 

4. Choose Restart Computer to restart. 

Changing Startup Settings 
You can specify startup options to improve your computer's performance and 
to automate tasks such as logging on to a network. 

~ To specify startup options 

1. In the Control Panel window, choose the Network icon. 

2. In the Microsoft Windows Network dialog box, choose Startup. 



Select this check box 
to enable network 

applications such as 
Chat, or clear it for 

faster performance. 
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Select this check box in order 
to automatically log on when 
you start Windows. 

Select this check box to reserve a drive letter 
for each network connection. 

Startup Options------+--------~ 

181 li;"!!iiif~~!!:i\!i_~ 
181 E-.l!Je Nelwork DOE 

181 §.hosted Comeclions 

0 Enable Po- !!l.easagjng 

If you also use 1 
LAN Manager or 

Windows NT, you can 
automatically log on to 

~==:::====::'.~======~··--+Select this 
Options for Entoq>rise Ne-king check bOX to 
D l.og On lo Window8 NT or LAN Manager Domain start WinPopup 

PerformancePrioritf:-----------~ 

when you start 
Windows. 

a domain when you 
start Windows. 'ff':~if!:= IQ MW [!M, • s:a:tt::est 

3. In the Startup Settings dialog box, change the settings you want. Then 
choose OK. 

For help on the dialog boxes, choose the Help button or press Fl while using 
the dialog boxes. 

Changing Your Logon Password 
When you connect to a directory, printer, or ClipBook page that someone else 
is sharing, you may need to supply a password. Windows for Workgroups 
maintains a list of the passwords you have used and the resources they apply to. 

When you start Windows for Workgroups, the logon password you supply 
"unlocks" the password list. If you connect to a particular resource, and the 
password for that resource is in the list, you need not supply the password. 

If you log on without using a password, your connections are restored automat­
ically and anyone can gain access to them by starting your computer. It is therefore 
recommended that you use a logon password, and that you change it periodically to 
keep unauthorized people from using the passwords you save in your password list. 

You cao use the Network option in Control Panel to change your logon password. If 
you have been logging on without a password and decide to use one, you cao also 
use the Network option to set your first logon password. If you no longer want to 
use a logon password, you can delete it. 

Note If you are using Microsoft Windows NT or LAN Manager, passwords for 
servers and domains can also be stored in the password list, if your network 
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administrator allows it. If you choose to have a domain validate your password 
when you log on, Windows for Workgroups searches for the password. If Windows 
cannot find it, a dialog box appears, prompting you for it. You must supply the 
password to gain access to Windows NT and LAN Manager servers or your 
Windows for Workgroups resources. For more information about setting and 
changing network options and passwords, see Help for Control Panel. 

~ To change your logon password 

1. In the Control Panel window, choose the Network icon. 

2. In the Microsoft Windows Network dialog box, choose Password. 

3. Type your current password in the Old Password box and a new password in the 
New Password box. An asterisk (*) appears for each character you type. 

4. In the Confirm New Password box, type your new password again. Then choose 
OK. Your new password takes effect immediately. 

Recording Network Events 
There may be times when you want to track things that happen on the network. For 
example, if you are sharing your printer, you may want a record of how many times 
people use it. If you have a shared directory, you may want to know who is trying to 
connect to it. You can record these events in an event log. 

~ To record network events in the event log 

1. In the Control Panel window, choose the Network icon. 

2. In the Microsoft Windows Network dialog box, choose Event Log. 

3. Select the Enable Event Log check box. 

4. Select the events you want to log from the list on the right, and choose Add to 
move each to the Record Events list. Or choose Add All. Then choose OK. 

5. In the Microsoft Windows Network dialog box, choose OK. 

To view the event log, use the Net Watcher application. For information about Net 
Watcher, see Help for Net Watcher. 

Enabling and Disabling Sharing by Using Setup 
You can use Windows Setup to control whether you can share your directories or 
printers with other people on the network. 

Note If your network administrator has disabled file and/or print sharing for your 
network, you will not be able to share your files and/or printers. 
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~ To enable or disable sharing 

1. In the Network group, choose the Network Setup icon. The Network Setup 
dialog box appears. 

2. If sharing is enabled, the sentence "You can share your files and printers with 
others" appears. If sharing is disabled, the sentence reads, "You cannot share 
your files or printers with others." Choose the Sharing button. 

3. In the Sharing dialog box, select one or both check boxes to enable sharing. 
To disable sharing, clear these check boxes. Then choose OK. 

4. In the Network Setup dialog box, choose OK. 

A dialog box appears, notifying you that your SYSTEM.INI file has been 
modified. When you choose OK again, a dialog box appears, prompting you 
to restart Windows. If you have saved your files, you can safely restart. 

5. Choose Restart Windows to restart. 

Improving Performance 
You can make your applications run faster, using 32-bit disk access and 32-bit 
file access. 

For more information about memory management and performance, see your 
Windows or Windows for Workgroups user's guide. 

32-Bit Disk Access 
For most disk-drive controllers that Windows for Workgroups supports, you can 
speed transfer of information to and from your hard disks. 

Note Using 32-bit disk access can be unreliable on some battery-powered portable 
computers when the computer's power-saving features are enabled. 

~ To set up 32-bit disk access 

1. In the Control Panel window, choose the 386 Enhanced icon. 

2. In the Enhanced dialog box, choose Virtual Memory. 

3. In the Virtual Memory dialog box, choose Change. 

4. Select the Use 32-Bit Disk Access check box, and then choose OK. 

A dialog box appears, prompting you to restart Windows. If you have saved 
your files, you can safely restart. 

5. Choose Restart Windows. 
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After specifying 32-bit disk access and restarting Windows for Workgroups, you 
can see whether your disk-drive controllers are compatible with 32-bit disk access. 

~ To check your disk-drive controller compatibility with 32-bit disk access 

1. In the Control Panel window, choose the 386 Enhanced icon. 

2. In the Enhanced dialog box, choose Virtual Memory. 

3. In the Virtual Memory dialog box, look at the Disk Status area. If it reads Disk 
Access: Using MS-DOS or Disk Access: Using BIOS, your controllers cannot 
take advantage of 32-bit disk access. If it reads Disk Access: Using 32-Bit Disk 
Access, at least one of your controllers is able to take advantage of 32-bit disk 
access. 

32-Bit File Access 
You can use 32-bit file access to write to and read files from the hard disk more 
quickly. 

32-bit file access also provides a faster way to read from and write to the disk 
cache. Information read from your hard disk is saved in a disk cache in your 
computer's extended memory. The next time an application tries to read that 
information from the hard disk, the information is supplied directly from memory 
instead. Information to be written to disk may also be temporarily stored in the 
disk cache. 

~ To set up 32-bit file access 

1. In the Control Panel window, choose the 386 Enhanced icon. 

2. In the Enhanced dialog box, choose Virtual Memory. 

3. In the Virtual Memory dialog box, choose Change. 

4. Select the 32-Bit File Access check box. 

The default cache size is 512K. If you have 4 MB of RAM or less, leave the 
Cache Size setting at 512K. If you have more RAM, you might want to increase 
this to 1 MB to speed up file access. 

5. Choose OK. 

6. Choose Restart Windows. 
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After specifying 32-bit file access and restarting Windows for Workgroups, you 
can see which of your disk drives are using 32-bit file access. 

II> To see which disk drives are using 32-bit file access 

1. In the Control Panel window, choose the 386 Enhanced icon. 

2. In the Enhanced dialog box, choose Virtual Memory. 

3. In the Virtual Memory dialog box, look at the Disk Status area. Under File 
Access, a list of your disk drives is shown, with the type of file access being 
used on that drive. File Access: 16-Bit means the disk drive cannot take 
advantage of 32-bit file access. File Access: 32-Bit means the disk drive is 
using 32-bit file access. 

Improving Performance with 32-Bit File Access 
In Windows for Workgroups version 3.11, 16-bit file access is the default and 
16-bit SMARTDrive caches are used for disk caching. When you use 32-bit file 
access, a 32-bit cache is created for use with file management on your hard disks, 
and the SMARTDrive cache is used only with your floppy disk drives. 

If you rarely or never use your floppy disk drives, you can set your SMARTDrive 
Windows cache (WinCacheSize) to 0 to save memory. (SMARTDrive typically 
uses a cache of 512K for 4 MB RAM systems and a 2 MB cache for 8 MB RAM 
systems.) 

If you occasionally use your floppy disk drives, you can reduce the size of your 
SMARTDrive Windows cache to save memory. 

For information about how to disable or reduce the size of your SMARTDrive 
cache, see "Managing Memory and Performance" in your Windows or Windows 
for Workgroups user's guide. 





CHAPTER 9 

Using Other Networks 

This chapter describes how to set up the Microsoft® Windows'" for Workgroups 
version 3 .11 operating system for use with other networks. 

If you already have a network installed and working, it will be set up to work 
with the Microsoft Windows Network, the network included with Windows for 
Workgroups, if it is compatible. Compatible networks include Novell® Net Ware® 
and Banyan® VINES®. 

Also, you can use these networks in place of the Microsoft Windows Network. 
For information about specific versions of networks compatible with Windows 
for Workgroups, see the online document NETWORKS.WR!. To view this 
document, you can use the Write application in the Accessories group. 
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Note .You can use the Microsoft.Windows Network to gain access to shared 
resources that are on computers running the Microsoft Windows NT'" operating 
system, the Microsoft Windows NT Advanced Server, Microsoft LAN Manager, 
and any other networks compatible with LAN Manager, such as 3Com® 3+0pen®, 
DEC® Pathworks®, and IBM® LANServer. 

For an overview of networking terms and concepts, see Chapter 1, "A Brief 
Overview of Microsoft Windows Networking." 

Setting Up Windows for Workgroups to Work with 
Another Network 

If you want to use another network either in addition to or in place of the 
Microsoft Windows Network, you can set it up either when you set up 
Windows for Workgroups or later from within Windows. 
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Note Before you set up Windows for Workgroups to work with another network, 
make sure the other network is correctly set up on your computer and that you can 
use it to connect to a file or print server. For more information, see your network 
documentation and the Windows for Workgroups online document 
NETWORKS.WR!. 

11o- To set up Windows for Workgroups to use another network 

1. In the Network group, choose the Network Setup icon. 

2. In the Network Setup dialog box, choose Networks. The Networks dialog box 
appears. 

3. If you want to use your network with the Microsoft Windows Network, make 
sure Install Microsoft Windows Network is selected. Then select Other, and 
select the network you want from the list. 

If you want to use that network without the Microsoft Windows Network, select 
Install Windows Support For The Following Network Only. Then select the 
network you want from the list. 

4. Choose OK. 

5. In the Network Setup dialog box, choose OK. A dialog box appears, prompting 
you to restart your computer. If you have saved your files, it is safe to restart. 

6. Choose Restart Computer in order for your changes to take effect. 

Connecting to a Directory on a Network Server 
Connecting to a directory on a network server is similar to connecting to a shared 
directory on another computer running the Microsoft Windows Network. For more 
information about connecting to a shared directory, see Chapter 3, "New File 
Manager and Print Manager Features." 

llo- To connect to a directory on a network server 

1. In the Main group, choose the File Manager icon. 

2. On the toolbar, click the Connect Network Drive button. Or choose Connect 
Network Drive from the Disk menu. 

3. In the Connect Network Drive dialog box, type the path for the network 
directory in the Path box. In the Drive list, select the letter you want to use 
for the connection. Then choose OK. 

Or choose the button named for your network. For example, if you are using 
Novell NetWare, choose NetWare. The Network-Drive Connections dialog 
box appears. 
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4. In the Network-Drive Connections dialog box, select the letter you want to use 
for the connection, and then either type the network path in the Path box or use 
the Browse button to find and select a directory on one of the network servers 
you are connected to. By using the Browse Connections dialog box, you can 
also connect to additional servers. 

If you are running Novell Netware, you can also perform Net Ware-specific 
tasks when using the Network-Drive Connections dialog box. 

5. Choose Connect (Map) to connect to the specified directory. 

6. Choose Close. 

For help, choose the Help button or press Fl while using the dialog boxes. 

You disconnect from a directory on a network server the same way you disconnect 
from a shared directory on another computer in a workgroup. For more information, 
see Chapter 3, "New File Manager and Print Manager Features." 

Connecting to a Network Printer 
Using Windows for Workgroups, you can easily connect to network printers. 

... To connect to a network printer 

1. In the Main group, choose the Print Manager icon. 

2. On the toolbar, click the Connect Network Printer button. Or choose Connect 
Network Printer from the Printer menu. 

3. In the Connect Network Printer dialog box, type the path for the printer in the 
Path box. Select the port you want to use, and then choose OK 

Or choose the button named for your network. For example, if you are using 
Novell NetWare, choose NetWare. 

4. In the Network-Printer Connections dialog box, select the port and the path 
of the printer you want to connect to. Then choose Connect. 

You can also disconnect from printers, connect to additional servers, and set 
printer options. 

5. Choose Close. 

For help, choose the Help button or press Fl while using the dialog boxes. 

For more information, see Chapter 3, "New File Manager and Print Manager 
Features." 
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Using Microsoft Windows NT and Microsoft LAN 
Manager 

Using Windows for Workgroups, you can connect to and use files, directories, and 
printers that are shared on a Microsoft Windows NT or Microsoft LAN Manager 
server. In addition, people using LAN Manager can connect to the resources you 
have shared with the Microsoft Windows Network. For you to be able to view the 
name of a LAN Manager server, at least one computer on the network must have 
a workgroup name that matches the name of the primary domain of the LAN 
Manager server. 

You can use Control Panel to set options for Windows NT or LAN Manager. You 
can choose to log on to a LAN Manager domain when you log on to the Microsoft 
Windows Network. You can also change your passwords on various LAN Manager 
domains. 

~ To set Windows NT or LAN Manager options 

1. In the Main group, choose the Control Panel icon. 

2. In the Control Panel window, choose the Network icon. 

3. If you want to log on to a Windows NT or LAN Manager domain when you log 
on to Windows for Workgroups at startup, choose the Startup button under 
Options. The Startup Settings dialog box appears. 

4. Under Options For Enterprising Networking, select the Log On To Windows 
NT Or LAN Manager Domain check box. 

5. In the Domain Name box, type the name of the domain you want to log on to. 

6. If you want to change your password for a Windows NT or LAN Manager 
domain, choose Set Password, complete the Change Password dialog box, 
and then choose OK. Your new password takes effect immediately. 

7. In the Startup Settings dialog box, choose OK. 

8. In the Microsoft Windows Network dialog box, choose OK. 

For help, choose the Help button or press Fl while using the dialog boxes. 



APPENDIX A 

Maintaining Mail 

Before people in your workgroup can use Mail, they need to connect to a 
workgroup post office (WGPO). If your workgroup does not have a WGPO, 
someone needs to create and manage one. You should read this appendix if you 
are the person who has that responsibility. 

Mail consists of the Mail application and the WGPO. The Mail application runs 
on each workgroup member's computer. The WGPO is stored in a directory on 
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one computer running Microsoft® Windows™ for Workgroups and is shared by 
workgroup members. The Postoffice Manager command, which you use to manage 
the WGPO, is available only in the copy of Mail running on the computer where the 
WGPO is located. 

Important The WGPO can be on any computer in the workgroup, but Postoffice 
Manager is installed only on the computer of the person who sets up the WGPO. 
Only the person maintaining the Mail system can use Postoffice Manager. 

The WGPO contains information about mail accounts. To communicate by mail, 
people must be connected to the same WGPO and each person must have a mail 
account. Two people connected to different WGPOs cannot exchange messages. 
If you want people who are connected to different WGPOs to send mail to each 
other, you must purchase the Microsoft Mail: PostOffice Upgrade for Microsoft 
Windows for Workgroups. 

You can use Postoffice Manager to perform the following tasks: 

• Add or remove names from the WGPO. 

• Modify accounts. 

• Manage the disk space where the WGPO is stored. 

• Manage the Mail system files. 
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For more information about Mail, including information for advanced users, see 
the MAIL.WR! online document. To view this document, you can use the Write 
application in the Accessories group. 

If your company already has a message system that you will use instead of Mail, 
see "Using Mail with Other Message Systems" later in this chapter. 

Creating a Workgroup Post Office 
There are three steps to creating a workgroup post office: 

• Verify that there is enough disk space on the computer where the WGPO will 
be stored. 

• Create the WGPO and an administrator account. 

• Share the WGPO, so that all people in your workgroup can use it. 

Instead of creating a WGPO on a computer that is part of your workgroup, you 
can create it on an existing network, such as one used with Novell® Net Ware® or 
Microsoft LAN Manager. For information, see "Using Mail with Other Message 
Systems" later in this chapter. 

Verifying Disk Space 
There should be 360K of available disk space for an empty WGPO, in addition to 
disk space for accounts. For a small WGPO with only a few accounts, only a few 
megabytes of disk space are required. For a larger WGPO, you may need 10 to 15 
MB, or more. 

If there are many people using the WGPO or there is a high volume of messages, 
either use a computer just for the post office, or use a 486 computer with a fast disk 
drive and at least 8 MB of memory. 

On each workgroup member's computer, there should be enough available disk 
space for his or her Mail messages. The amount of disk space needed depends 
on the number and type of messages stored in Mail. A small number of messages 
requires about lOOK of disk space; a large number may require several megabytes. 

Creating the Post Office and the Administrator Account 
After you have verified disk space, you can create the WGPO and the administrator 
account. There can be only one WGPO, but it can contain many workgroups. Only 
members of the same WGPO can communicate with each other. 

The administrator account is the first account you create in the WGPO. You can 
modify this account but not remove it. 
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Important The computer where your WGPO is located must be turned on at all 
times so that people can exchange mail. 

.,. To create a WGPO and the administrator account 

1. In the Network group, choose the Mail icon. 

2. In the Welcome To Mail dialog box, select Create A New Workgroup 
Postoffice, and then choose OK. 

3. A dialog box appears, asking whether you want to create a post office. 
Choose Yes. 

4. In the Create W orkgroup Postoffice dialog box, select a location for your 
WGPO. You can create the WGPO either on your hard disk or on a shared 
directory on a network. 

To create the WGPO on your hard disk, select a drive from the Drives box and 
a directory from the Create WGPO In list. 

To create the WGPO on a network, choose Network, and then select a computer 
name and shared directory in the dialog box that appears. 

5. Choose OK. The following dialog box appears. 

Use this dialog box to create the administrator account. 

6. Supply the needed information, and then choose OK. 

The tables following this procedure explain the options. 

7. In the confirmation dialog box that appears, choose 0 K. 

Note No distinction is made between uppercase and lowercase letters; for 
example, MARIAS, MariaS, and marias are considered to be the same. Use a 
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name that is easy to remember. You should not use characters from the ASCII 
extended character set. You can use only letters and numbers in the Mailbox 
and Password boxes. 

You must provide the following information when creating an administrator 
account. 

Box 

Name 

Mailbox 

Password 

Description 

Type your full name. The maximum length is 30 characters, and 
the default is the name you used when setting up Windows for 
Workgroups. 

Type a unique name that is easy to remember, such as an abbreviation 
of your name. You will use this name to sign in. The maximum length 
is 10 characters, and the default is your Windows logon name. 

Type a password that is easy to remember. You will use this password 
and your mailbox name to sign in to Mail. The maximum length is 8 
characters, and the default is PASSWORD. 

The following is optional information you can specify. 

Box 

Phone#l 

Phone#2 

Office 

Department 

Notes 

Description 

Type your phone number. The maximum length is 32 characters. 

Type your second phone or fax number. The maximum length is 32 
characters. 

Type your office location. The maximum length is 32 characters. 

Type the name of your department. The maximum length is 32 
characters. 

Type any comments about your account. The maximum length is 
128 characters. 
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Sharing the Workgroup Post Office 
After you create the WGPO, you must share the WGPO directory with all people 
connected to the post office. 

Caution If you have put the WGPO on a Novell NetWare server, do not share the 
directory. 

~ To share the workgroup post office 

1. In the Main group, choose the File Manager icon. 

2. Select the WGPO directory. 

3. On the toolbar, click the Share As button. Or choose Share As from the Disk 
menu. 

4. In the Share Name box, type a name for your post office. The default is WGPO, 
and this name is recommended. If you use a different name, do not use spaces; 
use letters or numbers. 

5. Select the Re-share At Startup check box. 

6. Under Access Type, select Full Access. 

7. Under Passwords, you can type a full-access password for your WGPO. This is 
recommended only if you do not want some workgroup members to have access 
to your mail. 

8. Choose OK. 

Note After you create a WGPO, the Postoffice Manager command appears on 
the Mail menu when you start Mail. This command appears only on the computer 
where you created your WGPO. If you want to run Postoffice Manager from 
another computer in the workgroup, you must modify your MSMAlL.INI file. For 
information about modifying MSMAIL.INI, see the online document MAIL.WRI. 
To view this document, you can use the Write application in the Accessories group. 
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Starting Postoffice Manager 
Before you can start Postoffice Manager, Mail must be running. (For information 
about starting Mail, see Chapter 4, "Mail.") 

Ill> To start Postoffice Manager 
• From the Mail menu, choose Postoffice Manager. The following dialog box 

appears. 

Using this dialog box, you can add names to the post office, modify accounts, 
and remove names. 

Adding a Person to the WGPO 
You can add people to the WGPO, or people can add themselves. 

Note We recommend that people add themselves to the WGPO. This can minimize 
confusion about user information. 

If people start Mail on their computer and no account is set up yet, they can add 
their account information at that time. Make sure that there is only one account for 
each person. For information about adding an account when starting Mail, see 
Chapter 4, "Mail." 

If you decide to add people to the WGPO, you must provide the name, mailbox 
name, and password for each person. You can also provide phone number(s), office 
location, and department, in addition to comments about the account. 
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~ To add a person's name to the WGPO 

1. From the Mail menu, choose Postoffice Manager. 

2. In the Postoffice Manager dialog box, choose Add User. 

3. Supply the appropriate information, and then choose OK 

For more information, see "Creating a Workgroup Post Office" earlier in this 
chapter. 

Modifying an Account 
You can modify information about a person's account. This information appears 
only in the Address Book, which you can view by clicking the Address button while 
composing a message. Information on the person's computer is not updated when 
you modify the account. 

If a person has forgotten his or her password, you can change the password for 
them; otherwise, people should update their own password when it expires. 

~ To modify an account 

1. From the Mail menu, choose Postoffice Manager. 

2. In the Postoffice Manager dialog box, select the name of the person whose 
a=unt you want to modify. 

3. Choose Details. The following dialog box appears. 

The name of the person whose account 
you are changing appears here. 

4. Change information as needed, and then choose OK 
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Removing an Account 
Using Postoffice Manager, you can remove an account from your WGPO. 

Note You cannot remove the administrator's account. 

~ To remove a name 

1. From the Mail menu, choose Postoffice Manager. 

2. In the Postoffice Manager dialog box, select the name you want to remove. 

3. Choose Remove User. A confirmation message appears. 

4. Choose Yes. 

Managing Disk Space 
Managing the disk space where the WGPO is stored is one of the most important 
administrative tasks in maintaining Mail. You must check the status of shared 
folders and compress these folders to recover unused disk space. 

A shared folder is public and is stored in the WGPO, unlike a person's private 
folders, which are stored on his or her computer. All workgroup members can open 
shared folders to view messages. Anyone in the WGPO can create a shared folder 
and specify the type of access allowed (Read, Write, or Delete). 

Checking the Status of Shared Folders 
By checking the status of shared folders, you determine: 

• The number of shared folders. 

• The number of messages stored in shared folders. 

• The amount of disk space the messages use. 

• The amount of disk space you can recover by compressing shared folders. 
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~ To check the status of shared folders 

1. From the Mail menu, choose Postoffice Manager. 

2. In the Postoffice Manager dialog box, choose the Shared Folders button. 

The Shared Folders dialog box appears. 

Compressing Shared Folders 
If you run out of disk space, you need to compress shared folders (you can still gain 
access to a compressed folder). If you require even more disk space, you can delete 
old messages and unused folders or move the WGPO to a different directory. 

If your shared folders contain a large number of messages, it may take a long time 
to compress them. 

~ To compress shared folders 

1. Ask all workgroup members to close shared folders. You cannot compress 
shared folders while other people are using them. 

2. From the Mail menu, choose Postoffice Manager. 

3. In the Postoffice Manager dialog box, choose Shared Folders. 

4. In the Shared Folders dialog box, choose Compress. 

5. Choose Close. 

Managing the Mail System Files 
Each person who is using the WGPO has two Mail system files: 

• The message file (MSMAIL.MMF) 

• The Mail file (MSMAIL.INI) 

When you create a WGPO or when workgroup members connect to a post office, 
these files are automatically modified. 
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The message file, MSMAIL.MMF, stores messages, message folders, and the 
Personal Address Book. This file is updated as messages are received. The 
message file for each workgroup member is stored on his or her computer. Your 
message file is located in the directory where you set up Windows for Workgroups 
(the default is C:\W!NDOWS). 

The Mail file, MSMAIL.INI, controls the way Mail works. This file is usually 
located in the C:\WINDOWS directory. 

You need to edit the Mail system files only when you want to change functionality 
or restore these files to a particular state. For example, if you set up a WGPO and 
then delete it, you need to modify your MSMAIL.INI file to connect to a different 
post office. For information about modifying the MSMAIL.INI file, see the online 
document MAIL.WR!. To view this document, you can use the Write application in 
the Accessories group. 

Backing Up and Restoring the MSMAIL.MMF File 
In general, you don't need to modify your Mail system files; however, you might 
want to restore them to a particular state. 

It is a good practice to regularly back up your MSMAIL.MMF file. When you back 
up and restore this file, all your folders are backed up and restored. If you want to 
back up or restore only some of your folders, use the Export Folder and Import 
Folder commands. For more information about these commands, see Help for Mail. 

~ To back up your MSMAIL.MMF file 

1. From the Mail menu, choose Backup. 

2. In the File Name box, specify the name and location of your backup file­
for example, C:\WINDOWS\MARIA.MMF. 

3. Choose OK. 

~ To restore your MSMAIL.MMF file 

1. In the Main group, choose the File Manager icon. 

2. Select the backup copy of your message file. 

3. From the File menu, choose Rename. 

4. In the To box, type c:\windows\msmail.mmf 

5. Choose OK. 

The backup file becomes your message file, and the messages and folders you had 
when you backed up the file are displayed. New messages that you received after 
you backed up your message file are not displayed. 



Appendix A Maintaining Mail 99 

Using Mail with Other Message Systems 
To connect a workgroup post office to another workgroup post office, you must 
purchase Microsoft Mail Postoffice Upgrade for Windows for Workgroups for 
each post office. To connect to another message system, such as X.400 or SMTP, 
the Microsoft Mail Postoffice upgrade is required, as well as the gateway software 
which enables the two message systems to exchange information. 

Each message system can connect to the workgroup post office by using one or 
more specific gateways. For a list of message systems and gateways, see the online 
document MAIL.WR!. To view this document, you can use the Write application in 
the Accessories group. 
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Microsoft is committed to making its products and services easier for everyone to 
use. This appendix provides information about the following products and services 
that make the Microsoft® Windows'M operating system more accessible for people 
with disabilities: 

• Access Pack for Microsoft Windows, a software utility that makes using 
Windows easier for people with motion or hearing disabilities 

• J<:eyboard layouts designed for people who type with one hand or a wand 

• Microsoft software documentation on audio cassettes and floppy disks 

• Products for people who are blind or have low vision 

• Tips for customizing Windows for Workgroups 

• Other products and services for people with disabilities 
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Access Pack for Microsoft Windows 
Microsoft distributes Access Pack for Microsoft Windows, which provides people 
with motion or hearing disabilities better access to computers running Windows. 
Access Pack contains several features that do the following: 

• Enable single-finger typing of SHIFr, CTRL, and ALT key combinations. 

• Ignore accidental keystrokes. 

• Adjust the rate at which a character is repeated when you hold down a key, or 
tum off character repeating entirely. 

• Prevent extra characters if you unintentionally press a key more than once. 

• Enable you to control the mouse cursor by using the keyboard. 

• Enable you to control the computer keyboard and mouse by using an alternate 
input device. 

• Provide a visual cue when the computer beeps or makes other sounds. 

Access Pack for Microsoft Windows is included in the Windows Driver Library, 
in the file ACCP .EXE. If you have a modem, you can download Windows Driver 
Library components from network services, including CompuServe®, GEnie™, 
Microsoft OnLine, or various user-group bulletin boards (such as the bulletin-board 
services on the Association of PC User Groups network). Access Pack is also 
available from Microsoft Download Service (MSDL), which you can reach by 
calling (206) 936-MSDL (936-6735) any time except between 1:00 AM. and 2:30 
AM. Pacific time. To use MSDL, use the following communications settings: 

Baud rate 

Parity 

1200, 2400, or 9600 

None 

Data bits 

Stop bits 

Keyboard Layouts for Single-Handed Users 

8 

Microsoft distributes Dvorak keyboard layouts that make the most frequently typed 
characters on a keyboard more accessible to people who have difficulty using the 
standard "QWERTY" layout. There are three Dvorak layouts: one for 
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two-handed users, one for people who type with their left hand only, and one for 
people who type with their right hand only. The left- or right-handed keyboard 
layouts can also be useful for people who type with one finger or a wand. You do 
not need to purchase any special equipment in order to use these features. 

Windows for Workgroups already supports the two-handed Dvorak layout, which 
can be useful for coping with or avoiding repetitive-motion injuries associated with 
typing. To use this layout, choose the International icon in Control Panel. The two 
layouts for people who type with one hand are distributed as Microsoft Application 
Note GA0650. This note is also contained in file GA0650.ZIP on most network 
services or GA0650.EXE on the Microsoft Download Service (MSDL). For 
iustructions on using network services and MSDL, see the preceding section, 
"Access Pack for Microsoft Windows." 

Documentation on Audio Cassettes and Floppy Disks 
People who have difficulty reading or handling printed documentation can obtain 
most Microsoft publications from Recording for the Blind, Inc. Recording for the 
Blind distributes these documents to registered members of their distribution service 
either on audio cassettes or on floppy disks. More than 80,000 titles are available, 
including Microsoft product documentation and books from Microsoft Press. You 
can contact Recording for the Blind at the following address or phone numbers: 

Recording for the Blind, Inc. 
20 Roszel Road 
Prioceton, NJ 08540 

Phone: 
Phone outside the U.S.: 
Fax: 

(800) 221-4792 
(609) 452-0606 
(609) 987-8116 

Products for People Who Are Blind or Have Low Vision 
There are numerous products available to help people who are blind or have low 
vision use Microsoft Windows. For people with low vision there are screen­
enlargement utilities, and for people who cannot use visual information there are 
screen readers that provide synthesized voice or refreshable Braille displays. 
For more information about the various products available, see "Getting More 
Information" later in this appendix. 

In addition, people with low vision can customize the appearance of Microsoft 
Windows to suit their needs. For more information, see the following section. 
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Customizing Windows for Workgroups 
There are many ways you can adjust the appearance and performance of Windows 
for Workgroups, the mouse, and the keyboard to suit varying vision and motor 
abilities without requiring any additional software or hardware. 

For more information about the WIN.IN! and SYSTEM.IN! files in the following 
list, use Write to view the WININl.WRI and SYSINI.WRI online documents. For 
more information about using Control Panel, see your Windows or Windows for 
Workgroups user's guide. 

You can use the following methods to adjust the appearance of Windows for 
Workgroups: 

• If you have trouble differentiating the colors in Windows, or if they cause 
eyestrain, you can adjust them by using the Colors option in Control Panel or 
by modifying entries in the [colors] section of the WIN.IN! file. 

• If you have trouble reading the Windows system fonts, you can increase their 
size by using the Fixed.Fon.Fon, Fonts.Fon, and OEMFonts.Fon entries in the 
[boot] section of the SYSTEM.INI file. 

Note You should only replace the default fonts with system font files supplied 
with Windows, such as 8514FIX.FON, 8514SYS.FON, and 85140EM.FON. 
Using other fonts may cause some applications to display text incorrectly. You 
need to copy these files from your Setup disks by using the expand command. 
You cannot use TrueType fonts for these entries. 

• If you have trouble reading icon titles, you can adjust their appearance by using 
the IconTitleFaceName and IconTitleSize entries in the [desktop] section of 
WIN.IN!. 

• If you have trouble reading full-screen messages, you can adjust the colors by 
using the MessageBackColor and MessageTextColor entries in the [386Enh] 
section of SYSTEM.INI. 

• If the desktop pattern or wallpaper causes eyestrain, you can change them by 
using the Desktop option in Control Panel. 

• If you have trouble differentiating the colors in Windows Help, you can adjust 
them by using the JumpColor, PopupColor, MacroColor, IFJumpColor, 
and IFPopupColor entries in the [Windows Help] section of WIN.INI. 

• If you have trouble reading the text in Mail in Windows, you can adjust the 
fonts by using the FixedFont, NormalFont, and PrintFont entries in the 
MSMAIL.INI file. For more information, see the README.WRI online 
document. 
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• If you have trouble reading the text in Schedule+, you can adjust the font 
size and window colors by choosing Display from the Options menu or by 
using the ApptBookColor, ApptBookLinesColor, LargeFont, OtherColor, 
PageBackgroundColor, PlannerColor, PlannerLinesColor, and UserColor 
entries in the SCHDPLUS.INI file. For more information, see the 
README.WRI online document. 

• If you have trouble locating the text selection cursor (also known as the caret or 
insertion point), you can adjust the rate at which it blinks by using the Desktop 
option in Control Panel. 

You can do the following to adjust the performance of the mouse or keyboard: 

• If you have difficulty controlling the mouse pointer, you can adjust its 
speed by using the Mouse option in Control Panel or the MouseSpeed, 
MouseThresholdl, and MouseThreshold2 entries in the [Windows] section 
ofWIN.INI. 

• If you have trouble seeing the pointer when it is moving, you can select the 
Mouse Trails check box (by using the Mouse option in Control Panel), or 
change the value of the MouseTrails entry in the [Windows] section of 
WIN.IN!. 

• If you have trouble double-clicking the mouse button, you can adjust the 
sensitivity by using the Mouse option in Control Panel or by using the 
DoubleClickHeight, DoubleClickWidth, and DoubleClickSpeed entries 
in the [Windows] section of WIN.IN!. 

• If you have trouble positioning the pointer on window borders in order to adjust 
window size, you can increase the border width by using the Desktop option in 
Control Panel. 

• If you have difficulty using the keyboard because of the speed at which 
keystrokes repeat or the delay time before they begin repeating, you can make 
adjustments by using the Keyboard option in Control Panel. 

For more information relating to customizing Windows for Workgroups for people 
with disabilities, see Application Note WW0787. This note is also contained in 
file WW0787.ZIP on most network services or WW0787.EXE on the Microsoft 
Download Service (MSDL). For information about obtaining application notes 
from network services, and information about more features to help you use 
Windows, see "Access Pack for Microsoft Windows" earlier in this appendix. 
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Getting More Information 
The Trace R&D Center at the University of Wisconsin-Madison produces a book 
and a compact disc that describe products that help people with disabilities use 
computers. The book, titled Trace ResourceBook, provides descriptions and 
photographs of about 2000 products. The compact disc, titled CO-NET CD, 
provides a database of more than 17,000 products and other information for 
people with disabilities. It is issued t-.vice a year. 

You can contact the Trace R&D Center at the following address or telephone 
numbers: 

Trace R&D Center 
S-151 Waisman Center 
1500 Highland Avenue 
Madison, WI 53705-2280 

Voice telephone: 
Text telephone: 
Fax: 

(608) 263-2309 
(608) 263-5408 
(608) 262-8848 

For general information and recommendations on how computers can help specific 
people, you should consult a trained evaluator who can match your needs with the 
available solutions. An assistive technology program in your area will provide 
referrals to programs and services that are available to you. To locate the assistive 
technology program nearest you, you can contact: 

National Information System 
Center for Developmental 

Disabilities 
Benson Building 
University of South Carolina 
Columbia, SC 29208 

Voice/text telephone outside South Carolina: 
(800) 922-9234, ext. 301 
Voice/text telephone inside South Carolina: 
(800) 922-1107 
Voice/text telephone outside the U.S.: 
(803) 777-6222 
Fax: (803) 777-6058 
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APPENDIX C 

Installing Network Hardware 

This appendix describes how to install and configure (set up) a network adapter, or 
card. A network card enables your computer to connect to other computers on your 
network. You can install the card before or after setting up Microsoft® Windows'" 
for Workgroups. 

Installation Overview 
This appendix gives complete instructions for each of the following steps. 

To install and set up a network card in your computer, you need to: 

1. Verify that you have the required hardware, such as the network card, cables, 
connectors, and other items needed during installation. 

2. Configure your network card so it will work with your computer. 

3. Place the network card in your computer. 

Note In some cases, you place the card in your computer before completing step 
2, configuring the card. 

4. Connect cables to the network card, and then connect them to the other 
computer(s) on your network. 

If you have trouble installing the card, see "Setting Up a Network Card" in 
Appendix E, "Troubleshooting." 

Note In rare cases, you may need a second network card in your computer. Use 
Windows Setup to install the device driver for the additional card. For more 
information, see Appendix D, "Configuring Network-Adapter Drivers." 
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1. What You Need 
Before you start, be sure you have the following items. 

Network card 

Windows for Workgroups disk set, software disks, and 
configuration disks 

Screwdriver 
Cables, connectors, terminators, and other cabling hardware 
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• The Microsoft Windows for Workgroups disk set. 

• A network card compatible with Windows for Workgroups. 

Also, be sure your network card is compatible with the type of bus expansion 
slots used in your computer. These are the sockets inside your computer, into 
which you plug the card. The following table shows the types of slots used in 
some common computer types. 

Type of bus expansion slot Type of computer 

ISA 

EISA 

MCA 

IBM® PC/AT® and most compatibles 

Certain more powerful PC/AT compatibles 

IBM PS/2® (most models) 

Note Most computers not manufactured by IBM are either ISA or EISA ISA 
stands for Industry Standard Architecture, EISA for Extended Industry Standard 
Architecture, and MCA for Microchannel Architecture. 

If you don't know which type of slot is used in your computer, see your 
computer manual or documentation. 

• Software disks, if any, that were included with your network card. 

• Manuals or documentation included with your system hardware (computer, 
network card, cables, and any other devices you have installed). 

• Computer configuration disks, if any, that were included with your computer. 
Examples are shown in the following table. 

Type of computer 

EISA 

IBM PS/2 (most models) 

Disk you need 

Configuration disk 

Reference disk 

• Cables, connectors, terminators, and other cabling hardware compatible 
with your network card. See your network-card packaging or documentation for 
cable requirements for your specific card. For iuformation about cables, see 
"Connecting Cables" later in this appendix. 

• A screwdriver (for removing your computer cover and slot covers inside your 
computer). 
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2. Configuring Your Network Card 
Part of the installation procedure involves setting up, or configuring, your network 
card so it works correctly in your computer. To configure, you assign values to 
various settings on the card, which enable the card to communicate with your 
computer. 

For example, most cards require that you specify at least two of the following: 

• Interrupt request level (IRQ) 

• Base input/output (110) port 

• Base memory address (optional on some cards) 

These settings are described in detail in "How to Determine Which Configuration 
Settings to Use" later in this appendix. 

Use Default Settings When Possible 
In most cases, a network card comes preconfigured with common, or default, 
settings. The documentation that came with your card usually describes these 
settings. If you don't know which settings to use when configuring your card, 
begin by trying the default settings. 

If your network card does not have a default value for a setting, or these settings 
do not work, see "How to Determine Which Configuration Settings to Use" later 
in this appendix. The section contains alternative values to use. 

Commonly Used Settings 
If the default settings do not work, you may want to try the following settings for 
your card, which will work in many situations: IRQS, base 1/0 port 300, and base 
memory address DOOOO. (For some network cards, the final "O" is dropped from the 
base memory address-for example, DOOO.) 
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When to Configure the Card 
Depending on the type of network card you have, you can configure it before or 
after placing it in your computer. Some cards combine the two methods. 

Configuring Before Placing the Card in Your Computer 
Some cards require you to manually move jumpers or set switches on the card 
before placing the card in your computer. (For information, see the following 
section, "Using Jumpers and Switches to Configure a Network Card.") 

Before placing a network card in your computer, see your network-card 
documentation to find out whether you need to set jumpers or switches. 

Configuring After Placing the Card in Your Computer 
With MCA cards, most EISA cards, and some ISA cards, you configure the card by 
running a configuration program after you have placed the card in your computer. 
For instructions on configuring these cards, see "Software-Configured Cards" later 
in this appendix. 

Using Jumpers and Switches to Configure a Network Card 
If your network card is configured manually (instead of by a configuration 
program), you need to set some options by using jumper and DIP-switch settings. 

Changing Jumper Settings 
To change a jumper setting, remove the plastic hood that fits over the pins on the 
jumper block. Then place the hood on the pins as indicated in your network-card 
documentation. The following illustration shows the jumper setting being changed 
from position 2 to position 5 on a sample jumper block. 

Jumper set to position 2 Hood being removed Jumper reset to position 5 
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Changing DIP-Switch Settings 
DIP switches resemble miniature light switches, and work in much the same way. 
To reset DIP-switch settings on your network card, you move the switches to the 
alternate position (On/Off or Open/Oosed), according to the settings indicated in 
your network-card documentation. 

Tip You can use the tip of a pen to change your DIP-switch settings more easily. 

The following illustration shows two common types of DIP switches. 

How to Determine Which Configuration Settings to Use 
Different network cards require different types of settings. For most cards, you 
need to assign values for at least two of the three settings described in this section: 
interrupt request level (IRQ), base 1/0 (input/output) port, and base memory 
address. See your network-card documentation for a complete list of required 
settings. 

Recording Your Network-Card Settings 
The following table shows some common settings for certain hardware. Use it to 
record the settings you use for configuring your network card. If you know the 
settings for your other hardware, it may be useful to list that information before 
configuring your network card. This will help you avoid using the same values for 
more than one device. The documentation that came with your computer and other 
devices may list these settings. 
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Note Keep this table available for use when you set up the Windows for 
Workgroups software, after you install the network card. 

Hardware IRQ Base 1/0 port Base memory 
address 

Serial port (COMl, COM3) 4 3F8 

Second serial port (COM2, 3 2F8 
COM4) 

Floppy disk controller 6 3FO 

Hard disk controller 14 lFO 

LPTl 7 378 

LPT2 5 278 

Bus mouse 3, 4, or 12 230 

Modem 

Sound card 

Network card 

Note Some hardware does not have entries for the base memory address. 

Interrupt Request Level (IRQ) 
When your network card sends a request to your computer's central processing unit 
(CPU), it uses an electronic signal called an interrupt. Each device in your system 
must use a different interrupt request level (JRQ), which is specified when the 
device is configured. (Interrupt is often used interchangeably with IRQ.) 

In most cases, you can use IRQS, IRQlO, IRQll, or IRQlS for your network card. 
Check the documentation that came with your computer and other devices to 
determine if these interrupt levels are already being used. 

If neither IRQS, 10, 11, nor 15 is available, refer to the following table for 
alternative values you may be able to use. The interrupt levels listed as "available" 
usually can be used for your network card. If your computer does not have the 
hardware listed for a specific IRQ, that IRQ should also be available. 
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IRQ Personal computer with 386SX processor (or higher) 

2 (9) Do not use (reserved for EGANGA adapter). 

3 Usually not available (reserved for COM2 or COM4, unless only one 
serial port is installed; sometimes used for bus mouse). 

4 Do not use (reserved for COMl or COM3). 

5 Available (unless used for second parallel port [LPT2] or bus mouse). 

6 Do not use (reserved for floppy disk controller). 

7 Do not use (reserved for parallel port [LPTl ]). 

8 Do not use (reserved for real-time clock). 

10 Available. 

11 Usually available (unless used for SCSI adapter). 

12 Usually available (unless used for PS/2-style mouse). 

13 Do not use (reserved for math coprocessor). 

14 Do not use (reserved for hard disk controller). 

15 Available. 

Base 1/0 Port 
The base 1/0 (input/output) port specifies a channel through which information 
is transferred between your hardware, such as your network card, and your 
computer's CPU. The port appears to the CPU as an address. 

Each hardware device included in your system must have a different base I/0 port 
number. The port numbers (in hexadecimal format) in the following table are 
usually available for you to assign to your network card. Addresses with a device 
listed next to them are commonly used for the devices. Check the documentation 
that came with your computer and other devices to determine which addresses are 
already in use. 

Port 

200 to 20F 

210 to 21F 

220to 22F 

230 to 23F 

240 to 24F 

250 to 25F 

260 to 26F 

270to27F 

280 to 28F 

Device 

Game port 

Bus mouse 

Port 

300 to 30F 

310 to 31F 

320 to 32F 

330 to 33F 

340to34F 

350 to 35F 

360 to 36F 

LPT2 (LPT3 in MCA- 370 to 37F 
type computers) 

380 to 38F 

Device 

Some disk controllers 

Hard disk controller 
(PS/2 Model 30 only) 

SCSI controllers 

LPTl (LPT2 in MCA-type 
computers) 
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Port Device Port Device 

290 to 29F 390 to 39F 

2AOto2AF 3AOto3AF 

2BOto 2BF 3BOto3BF LPTl (MCA-type computers only) 

2COto 2CF 3COto3CF EGNVGA 

2DOto2DF 3DOto3DF CGA (also EGNVGA, in color 
video modes) 

2EOto2EF COM4 3EOto3EF COM3 

2FOto 2FF COM2 3F0to3FF Floppy disk controller; COMl 

Base Memory Address 
The base memory address defines the address of the location in your computer's 
memory (RAM) that the network card will use to exchange information between 
your computer and the other computers you are connected to. This setting is 
sometimes called the RAM start address. Often, the base memory address for 
your network card is DOOOO. (For some network cards, the final "O" is dropped 
from the address-for example, DOOO.) 

Note Some network cards do not have a setting for the base memory address, 
because they do not use any RAM. 

With some network cards, you may also need a setting that specifies the amount of 
memory to be "mapped" or set aside for this purpose. For example, for some cards 
you can specify either 16K, which leaves more memory available for other uses, or 
32K, which gives better performance but leaves less memory available. 

Note If you are using EMM386, you need to exclude the base memory address 
area by using the x= parameter on the device=emm386 line in your CONFIG.SYS 
file. For example, if your network card uses the address C800, the device=emm386 
line in your CONFIG.SYS file would look like this: 

device=emm386.exe x=c800-ceff 

For more information, see your Windows or Windows for Workgroups user's 
guide. If you use 386Max™, QEMM™, or another expanded-memory provider, see 
the documentation that comes with it to see whether you need to exclude this area. 

If you are not using an expanded-memory provider and have a network card that 
requires a base memory address, you can exclude the base memory address by 
using the EMMExclude= line in the [386Enh] section of your SYS'IEM.INI file. 
For example, if your network card uses the address C800, add the following line 
to the [386Enh] section of your SYSTEM.IN! file: 

EMMExclude=c800-ceff 
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Additional Settings 
Your network card may have other settings you need to define during configuration. 
For example, some cards have more than one connector (where you connect the 
cable), providing you with flexibility in choosing a cable. If your card has multiple 
connectors, you typically need to specify which connector to use. This can be done 
by using a jumper or a software setting. See your network-card documentation for 
details about this and other settings. 

3. Installing the Network Card 
This section describes how to place the network card in your computer. 

Before You Insert the Card 
Before placing the network card in your computer, carry out the following steps. 

Warning Always tum off and unplug your computer before you remove the cover. 

~ To get ready to place the card in your computer 

1. Quit Windows and all running applications. 

2. Tum off the power and unplug all power cords. 

3. Remove the cover from your computer's system unit. 

The screws holding the cover in place are typically located at the back and/or 
sides of the computer. Generally, there are only three or four screws to remove. 
The cover may slide forward or back, or it may lift up. 
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Tower-style computer Desktop-style computer 

4. If your network card requires you to change jumper or DIP-switch settings, 
change these settings before placing the card in your computer. (If you don't 
know whether this is required, just continue installing.) 

For information about jumper or DIP-switch settings, see "How to Determine 
Which Configuration Settings to Use" earlier in this appendix. 

Note Before touching the card, be sure to discharge static electricity from your 
hands by touching a grounded metal surface, such as the screw on an electrical 
outlet's plate cover. 
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Placing the Card in Your Computer 
After you have turned off your computer and removed the cover, you can insert the 
network card. 

Iii> To place the network card in your computer 
1. Locate an unused bus expansion slot in your computer. Be sure the slot is 

appropriate for the card (for information, see your network-card documentaiion). 
ISA cards can use either an 8-bit or 16-bit slot. A 16-bit slot, if available, gives 
better performance. EISA and MCA cards often use a 32-bit slot. 

The following illustration, looking down at a computer, shows how slots may 
look in your computer. Your computer may look different, especially if it is an 
EISA or MCA type. 

32-bit slot Front 
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2. Remove the cover from the slot, and save the screw for use in step 7. 

3: Discharge any static electricity from your hands by touching a grounded metal 
surface, such as the screw on the plate cover of an electrical outlet. 

4. Remove the network card from its protective wrapper. Be careful not to touch 
the gold contacts at the bottom of the card. 
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5. Align the bottom of the card (gold contacts) with the slot, and press the card 
firmly into the socket. When correctly installed, the card locks into place. 

6. Make sure that the top of the card is level (not slanted) and that the hole on top 
of the card's metal bracket lines up with the screw hole at the back of the slot. 
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7. Anchor the card in place using the screw you removed in step 2. 

8. Replace the computer cover and screws. 

9. Reconnect any cables and power cords you disconnected or unplugged. 

Software-Configured Cards 
If your network card is configured by using a configuration program (as are MCA, 
most EISA, and some ISA cards), follow these steps after placing the network card 
in your computer. (See your network-card packaging or documentation if you are 
unsure which type of card you have.) 

~ If you have a software-configured EISA card or an MCA card 

1. Insert your computer's configuration disk into the startup (boot) floppy disk 
drive, and then restart (reboot) your computer. 

2. When a message appears, saying your computer doesn't recognize your network 
card, replace the computer's configuration disk with the configuration disk for 
your network card, and then start the configuration program. (See your network­
card documentation for startup information.) 

3. Configure your network card. For information about settings, see "How to 
Determine Which Configuration Settings to Use" earlier in this appendix, or 
see your network-card documentation. 
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4. Remove your network card's configuration disk, and insert your computer's 
configuration disk. With some EISA cards, the card's configuration information 
is automatically copied to the computer's configuration disk. For other EISA 
cards, and MCA cards, you are given the option to copy the information. 

JI> If you have a software-configured ISA card 

1. Restart (reboot) your computer. 

2. Insert the configuration disk for the network card into a floppy disk drive, 
change to that drive, and then start the configuration program. (See your 
network-card documentation for startup information.) 

3. Configure the card. For information about settings, see "How to Determine 
Which Configuration Settings to Use" earlier in this appendix, or see your 
network -card documentation. 

4. Connecting Cables 
When you finish installing and configuring your network card, the next step is to 
connect the cables that link your computer to the other computers on your network. 
There are several types of cable/computer configurations available. The sections 
that follow describe the four most common types: thin Ethernet, thick Ethernet, 
twisted-pair, and token ring. 

To connect your computer to the network, carry out the following steps: 

1. Determine which of the four types of systems you are connecting to, and turn 
to the appropriate following section that describes that system. 

2. Using the illustrations and descriptions to identify your cable hardware, 
connect your network card to the other computers on your network. For more 
information about your system, see your network-card documentation. 

Note If you have a type of cable/computer configuration other than the four listed 
here, see your network-card documentation for more information. 

When you finish connecting, see Chapter 2, "Setting Up and Starting Windows for 
Workgroups," to finish setting up your system. If you have already set up Windows 
for Workgroups, see Appendix D, "Configuring Network-Adapter Drivers." 
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Thin Ethernet 
A thin-Ethernet system, also known as "Thinnet," has the advantages of using less 
expensive cable than a thick-Ethernet system (described in the next section) and 
using hardware that is somewhat easier to set up. 

Use the following illustrations as a guide to connecting the network card in your 
computer to a thin-Ethernet system. 

Connector jack 

T-connector 

Connector plug 

The following table describes the hardware components. 

Item 

Network card with connector jack 

BNC T-connector 

Description 

The BNC connector jack on the back of 
yonr network card connects the card to a 
T-connector. 

The T-connector connects to the network-card 
connector jack. Thin-Ethernet cables are 
connected to the jacks on either end of the "T." 
(For computers at the ends of the network, 
a terminator replaces one of the cable 
connections.) 
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Item Description 

Thin-Ethernet cable with BNC 
connector plugs 

Thin coaxial cable (RG-58), for networks that 
use the 10Base2 or 802.3 standard (as defined 
by the Institute of Electrical and Electronics 
Engineers, or IEEE). 

Terminator 

Connector plugs are located at both ends of a 
thin-Ethernet cable. 

Thin-Ethernet cable can be used in segments of 
between 0.5 and 185 meters long, and can have 
a maximum of 30 computers connected to it. A 
cable segment generally is made up of several 
smaller lengths of cable joined by connectors. 

When a computer is the last in a group of 
computers, a terminator must be connected to 
the open end of the computer's T-connector. 
Terminators used with RG-58 cable must be 
50 ohm (50 Q). 

In some cases, you may need the following for your system. 

Item 

Grounded terminator 

Barrel connector 

Description 

If there is excessive electromagnetic interference, or "noise," 
on your system, you may need to replace the terminator at 
one end of the network with a grounded terminator. The 
grounded terminator has a grounding wire connected to one 
end. You connect the wire to a ground (such as the screw 
on the plate cover of an electrical outlet). 

When necessary, a barrel connector can be used to join two 
pieces of thin-Ethernet cable. Keeping the number of barrel 
connections on a network to a minimum increases network 
reliability. Do not use T-connectors in place of barrel 
connectors. 

When you finish installing the network card and connecting the cable, your thin­
Ethernet system should be set up as illustrated. 
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Sample thin-Ethernet system 

Note Terminators must be connected to both endpoints. 

Thick Ethernet 
A thick· Ethernet (also known as "Thicknet") system is named for the standard, or 
thick, Ethernet cable used. With thick cable, you can have more computers on a 
system and the distance between computers can be greater; however, the cable is 
more expensive and more difficult to install than thin-Ethernet cable. 

Use the following illustrations as a guide to connecting the network card in your 
computer to a thick· Ethernet system. 
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DIX connector socket 

DIX connector plug 

Transceiver cable Transceiver 

Thick-Ethernet cable 

The following table describes the hardware components. 

Item 

Network card with DIX 
connector socket 

Transceiver cable with 
DIX connector plug and 
connector socket 

Transceiver 

Thick-Ethernet cable 

Terminator 

Description 

The connector socket on the back of your network card 
connects the card to the transceiver cable. 

A transceiver cable connects your computer to a transceiver 
on a thick-Ethernet system. 

A connector plug is located on one end of a transceiver 
cable. It connects to the network card. 

A connector socket is located at the other end of a transceiver 
cable. It connects the cable to a transceiver. 

Maximum length for a transceiver cable is 50 meters. 

A transceiver connects your computer to a thick-Ethernet 
network. (For systems having many computers, the 
transceivers are usually located inside office walls.) 

Also known as "standard" or simply "thick'' cable. This is 
coaxial cable. The maximum segment length is 500 meters 
and the maximum number of transceivers is 100. 

A terminator (N-series) must be connected to the thick­
Ethernet cable at each endpoint of the network. 

In some cases, you may need the following for your system. 



Thick-Ethernet cable 

Item 

Grounded terminator 
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Description 

If there is excessive electromagnetic interference, or 
"noise," on your system, you may need to replace the 
terminator at one end of the network with a grounded 
terminator (N-series). The grounded terminator has a 
grounding wire connected to one end. You connect the 
wire to a ground (such as the screw on the plate cover of 
an electrical outlet). 

When you finish installing the network card and connecting the cable, your system 
should be set up as illustrated. 

Transceiver 

Transceiver cable 

N-series terminator 

Sample thick-Ethernet system 

Note Terminators must be connected to both endpoints. 
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Twisted-Pair Ethernet 
The advantages of a twisted-pair Ethernet system are that the cable is generally less 
expensive than systems such as thick-Ethernet, and that the cable is relatively easy 
to install. 

Use the following illustrations as a guide to connecting the network card in your 
computer to a twisted-pair Ethernet system. 

The following table describes the hardware components. 

Item 

Network card with RJ-45 
connector receptacle 

RJ-45 connector 

Description 

The connector receptacle on the back of your network 
card connects the card to the network cable. 

An RJ-45 connector is located at each end of the 
twisted-pair cable. To connect the cable to the card, 
align the connector so the small plastic tab is in line 
with the slot in the receptacle, and push in the 
connector until you hear a click. (The connector is 
similar to the plastic plug used to connect a telephone 
cord to a wall outlet.) 
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Twisted-pair Ethernet cable 

Concentrator (hub) 
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Description 

Cable for a twisted-pair Ethernet system can be either 
unshielded twisted-pair (UTP) or shielded twisted­
pair (STP). (UTP is shown in the preceding 
illustration.) Both types of cable consist of two or 
more pairs of twisted copper wires; however, STP 
has a shielding layer of foil and copper braid around 
the inner cable that protects the wiring from 
electromagnetic interference, or "noise." 

Maximum cable length is 100 meters. 

The computers on a twisted-pair system are connected 
to each other by using a concentrator, 
or hub. Cable from each computer is plugged into 
a socket (connector receptacle) in the hub. 

Each hub is a full 802.3 multiport repeater, 
compatible with the IEEE 802.3 lOBaseT 
standard for connecting to UTP wiring. 

When you finish installing the network card and connecting the cable, your system 
should be set up as illustrated. 

Sample twisted-pair Ethernet system 
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Token Ring 
One advantage of a token-ring system is redundancy: One piece of the system can 
fail or the cable can be cut, and the signal will backtrack but still function. Also, 
token ring is supported by IBM mainframe software, which can be an advantage in 
some situations. 

Disadvantages are that token-ring cable is generally more expensive and more 
complex than with other systems. (If you use twisted-pair cabling, it requires four 
wires.) In addition, troubleshooting is sometimes more difficult. 

Use the following illustrations as a guide to connecting the network card in your 
computer to a token-ring system. 
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The following table describes the hardware components. 

Item 

Network card 

Cable 

Multistation access unit (MAU) 

Description 

You need a network card compatible with a 
token-ring system. 

A token-ring system generally uses either type 
1, which is heavy copper cable, or type 3, 
which is unshielded twisted-pair (UTP) cable. 

A device that is the meeting point of the wires 
in a token-ring system. Cables run from the 
MAU to link computers to the network. 

When you finish installing the network card and connecting the cable, your system 
should be set up as illustrated. 

Multistation access unit (MAU) 

Sample token-ring system 

The Next Step 
Now that you have finished installing your network card and connecting the cables 
that link you to the other computers on your system, go to Chapter 2, "Setting Up 
and Starting Windows for Workgroups," to finish setting up your system. If you 
have already set up Windows for Workgroups, see Appendix D, "Configuring 
Network-Adapter Drivers." 
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After you install a network adapter, or card, you also need to install and configure 
its driver. This appendix describes how to install, configure, and remove network­
adapter drivers and change settings for them. 

When you set up the Microsoft® Windows'" for Workgroups version 3.11 operating 
system, your network-adapter driver is installed and configured. You need to use 
the instructions in this appendix only if you have added or changed your network 
adapter after setting up Windows for Workgroups. 

For information about installing a network adapter, see Appendix C, "Installing 
Network Hardware." 

Installing a Network-Adapter Driver 
You can install and configure a network-adapter driver by using Windows Setup. 

~ To install and configure a network-adapter driver 

1. In the Network group, choose the Network Setup icon. 

2. In the Network Setup dialog box, choose Drivers. 

The Network Drivers dialog box appears, as illustrated on the following page. 
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NetworkJlriYen::--------------, 

lC:ow: Etllerl ink Plus 
T" llicrosoft NetBEUI 

J Delaul Piotocol 
lliaoooftNotBEUI 

3. In the' Network Drivers dialog box, choose Add Adapter. 

4. In the list of network adapters, select the one you want to add, and then 
choose OK. (If your adapter is not listed, select Unlisted Or Updated 
Network Adapter.) Or choose Detect to have your network adapter 
detected automatically. 

5. Insert the requested disk fu drive A. Then choose OK. If you selected Unlisted 
Or Updated Network Adapter, the disk must contain an OEMSETUP.INF file 
for the network adapter. 

Or type the drive letter and directory name (for example, d:\drivers) where 
the driver is located, and then choose OK. 

(You can also use the Browse button to locate and select the drive and directory 
where the driver is located. When you finish usfug the Browse dialog box, 
choose OK.) 

If you selected Unlisted Or Updated Network Adapter, another dialog box 
appears, listfug the drivers on the disk. Select the driver you want to install, 
and then choose OK. 

6. If the network-adapter driver requires additional settfugs, a dialog box appears, 
displayfug the default (preset) settfugs for your network adapter. 
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Please confirm the following :setting: 

r••t•rrupt 

l !lalue: ····-

liiiil --If you •e not sure that this setting is correct male a note of it 
!hon and choose OK. 

Yow netwodc. hardware or software NJ not work if this setting is 
incorrect.. You can run Windows s-... later to change it To 
detelmine the correct t:eHina. refer to JOUf netwo1k-adapter 
documentation. 

Press Fl or choose Help to get more information about network 
hardware and software settings.. 

If the settings your network adapter uses differ from the default settings, 
specify the correct interrupt (IRQ), base 1/0 port, and base memory address 
in the dialog box, and then choose OK. For a description of these settings, see 
Appendix C, "Installing Network Hardware." In most cases, the default values 
will work correctly. 

A few network adapters may require that you set advanced options. For 
example, if you are using a 3Com® adapter, you may need to specify the 
DMA channel the adapter uses. In other cases, you may also need to koow the 
transceiver type the adapter uses. In such cases, the dialog box will contain an 
Advanced button. Choose it, and then, in the Advanced dialog box, specify the 
values for each setting. When you finish, choose OK. 

For more information about the settings your adapter uses, see your network­
adapter documentation. For help on the Advanced dialog box, choose the Help 
button or press Fl while using the dialog box. 

Note Make sure that the settings for your network adapter do not conflict with 
other devices installed in your system, such as a mouse or a sound card. See the 
documentation for your devices, including your network adapter, for information 
about their settings. 

7. In the network-adapter settings dialog box, choose OK. 

8. In the Network Drivers dialog box, choose Close. 

9. In the Network Setup dialog box, choose OK. A dialog box appears, prompting 
you to restart your computer. If you have saved your files, you can safely restart. 

10. Choose the Restart Computer button to restart. 
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Removing a Network-Adapter Driver 
If you are no longer using a network adapter, you can remove its driver. 

Note To share your resources (such as printers and directories) and connect to 
resources shared by others, you must have at least one network-adapter driver 
installed. If you try to remove all network-adapter drivers, a message appears. 

~ To remove a network-adapter driver 
1. In the Network group, choose the Network Setup icon. 

2. In the Network Setup dialog box, choose Drivers. 

3. In the Network Drivers dialog box, select the network adapter you want to 
remove, and then choose Remove. 

4. Choose Qose. 

5. In the Network Setup dialog box, choose OK. A dialog box appears, prompting 
you to restart your computer. If you have saved your files, you can safely restart. 

6. Choose the Restart Computer button to restart. 

When you remove the driver, the driver file is not deleted from your hard disk. 
You can add the driver again if you decide to use your network adapter later. 

Changing Protocols and Network-Adapter Settings 
You can change settings for your network adapter. 

~ To change settings for your network adapter 
1. In the Network group, choose the Network Setup icon. 

2. In the Network Setup dialog box, choose Drivers. 

3. In the Network Drivers dialog box, choose Setup. 

Note A few network adapters require that you specify the size of certain buffers 
and the kind of cable the adapter uses, such as thin- or thick-Ethernet cable. To 
specify such advanced options, choose the Advanced button in the network-adapter 
settings dialog box. 

You may also need to change the protocols for your network adapter. A protocol 
is a set of rules and conventions for exchanging data. Because there are many types 
of protocols, computers on a network must all use the same protocol to be able to 
share information. A network adapter can use up to four protocols. 
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When you set up Windows for Workgroups, the NetBEUI protocol is installed and 
configured. This protocol and its default settings work in most cases, so you rarely 
need to change the settings or use an additional protocol. (If your computer has 
more than 6 megabytes of RAM, the IPX protocol is also installed.) If you do need 
to add other protocols, choose Add Protocol in the Network Drivers dialog box. 
You can use up to eight protocols. However, each network adapter can support only 
four. If you use more than four protocols, you must install another network adapter. 

For more information about adding protocols, changing protocol settings, or 
specifying advanced options for your network adapter, see Help for Windows 
Setup. 
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APPENDIX E 

Troubleshooting 

This appendix is designed to help if you encounter problems when using the 
Microsoft® Windows'M for Workgroups version 3.11 operating system. The 
following sections outline steps you can take to solve the most common problems: 

• Setting Up Windows for Workgroups 

• Using the Network Features of Windows for Workgroups 

• Using the Microsoft Windows Network 

• Using Novell® NetWare® 

• Setting Up a Network Card 

• Using Microsoft Network Diagnostics 

• UsingMail 

• Using Microsoft At Work™ PC Fax 

• Streamlining Your CONFIG.SYS and AUTOEXEC.BAT Files 

Setting Up Windows for Workgroups 
The following sections describe possible solutions to problems you might have 
when setting up Windows for Workgronps. 

Your system locks up during the MS-DOS part of Setup. 
The first part of the Setup program runs in MS-DOS®. (Later, Setup switches to 
Windows mode.) If Setup stops while in MS-DOS mode, it may be because your 
hardware could not be correctly detected. To solve this problem, type setup /i, 
which skips hardware detection and runs Custom Setup. In the System Information 
screen, be sure to select descriptions that match the hardware on your system. Then 
restart your computer, and type win at the command prompt to start Windows. 
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Windows won't start after a successful Setup. 
If you completed Setup but cannot start Windows for Workgroups, one of the 
following might be the cause: 

• The wrong hardware may be specified for your system. This might occur 
because you ran Express Setup and your hardware was not correctly detected, 
or because you specified the wrong hardware settings during Custom Setup. 
In your Windows directory, type setup at the command prompt. Make sure the 
hardware information is correct in the System Information screen. 

• Make sure that your computer has at least a 386SX processor. You should have 
at least 410K of free conventional memory and 3072K (3 MB) of free extended 
(XMS) memory. You should also have at least 3.5 MB of free disk space if you 
are upgrading from a previous version of Windows, and 9.5 MB if you are 
setting up Windows for Workgroups for the first time. Although you can force 
Windows to run if it has less than 3072K of free XMS memory, it is not 
recommended, because Windows may run very slowly. 

• Your system may be running memory-resident (TSR) programs that are 
incompatible with Windows and that could not be detected during setup. 

To check for this possibility, create a "clean boot'' floppy disk that contains only 
the files necessary to start your computer and Windows. Insert this disk in drive 
A, and then restart your computer. For more information about troubleshooting 
problems with memory-resident programs, see "Streamlining the CONFIG.SYS 
and AUTOEXEC.BAT Files" later in this appendix. 

• If you are using a thin-Ethernet network, make sure you have attached a BNC­
style T-connector to the back of your network card. Also, make sure you have 
attached a terminator to each end of the network. For more information, see 
Appendix C, "Installing Network Hardware." 

If Windows still won't start, try the following guidelines: 

• To see whether the problem has to do with networking, type win /n to start 
Windows without starting the network. If this command successfully starts 
Windows, then contact your network administrator. 

• Type win/b to start Windows. This creates a file, BOOTLOG.TXT, that 
records system messages generated during system startup. By using the 
MS-DOS type command, you can view this file to see where in the startup 
process Windows failed. If you have MS-DOS version 5.0 or later, you can 
also use the edit command. 

• Use the EMMExclude option when you start Windows, by typing win /d:x 
at the command prompt. This excludes the network-adapter area from areas 
that Windows searches for unused address space. Typically, this is the area 
AOOO-FFFF. The search can cause conflicts with adapters that use this area. 
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If using this command successfully starts Windows, you might want to add 
the EMMExclude command to your SYSTEM.IN! file, as described in the 
procedure following this list. 

If you are loading an expanded-memory provider such as EMM386, QEMM'M, 
or 386Max'" in the CONFIG.SYS file, any EMMExclude commands in the 
SYSTEM.IN! file are ignored. Your computer uses the settings given in the 
CONFIG.SYS file instead. 

For more information, see the documentation supplied with your memory 
provider. 

• Use the VirtualHDirq option when you start Windows, by typing win /d:v 
at the command prompt. This gives your hard disk-rather than Windows­
control over how hard-disk interrupts are processed. 

If using this command successfully starts Windows, you might want to add the 
VirtualHDirq=False command to your SYSTEM.IN! file, as described in the 
following procedure. 

.. To add an EMMExclude or VirtualHDirq command to SYSTEM.IN! 

1. Using a text editor, open the SYSTEM.IN! file, located in your Windows 
directory. 

2. In the [386Enh] section of the file, type one of the following lines: 

EMMExclude=AOOO-FFFF 

VirtualHDirq=False 

3. Save your changes to the SYSTEM.IN! file. 

4. At the command prompt, type win to start Windows. 

Note When you add the EMMExclude command to your SYSTEM.IN! file, you 
are probably excluding more address space than is necessary. To find out a more 
precise amount of address space to exclude, you can use the Microsoft Diagnostics 
(MSD) program. To start MSD, quit Windows, and then type msd at the command 
prompt. Then, in the main screen, choose Memory. You should exclude any address 
space identified as "RAM" or "ROM." You might also need to exclude address 
space identified as "Possibly Available." 

If Windows still won't start, run Setup again from the disks by using the following 
guidelines: 

• Type setup /i. In the System Information screen, be sure to select descriptions 
that match the hardware on your system. After setup, restart your computer, and 
type win at the command prompt to start Windows. 



142 Microsoft Workgroup Add·On for Windows User's Guide 

Using the Network Features of Windows for 
Workgroups 

The following sections describe possible solutions to problems you might have 
when using the network features of Windows for Workgroups. 

No network features of Windows for Workgroups are available. 
If during startup you receive a message that you will not have any of the network 
features, try the following: 

• Make sure your computer meets the processor, memory, and hard-disk 
requirements of Windows for Workgroups. For more information, see the 
"What Is Microsoft Workgroup Add-on?" chapter of this book. 

• Make sure you have properly installed the network card in your computer 
and that you have specified the correct settings. For more information about 
installing a network card, see Appendix C, "Installing Network Hardware." 
For information about specifying settings for a network card, see Appendix D, 
"Configuring Network-Adapter Drivers." 

• Make sure the cables that connect your computer to the network are connected 
properly. 

• Quit Windows, and change to the Windows directory. Type chkdsk at the 
command prompt. If chkdsk shows errors, type chkdsk /f to repair the errors. 
Or run a disk utility to repair the files on the hard disk. If there is data corruption 
in the Windows directory, you may need to reinstall Windows for Workgroups. 

• Restart your computer, and watch the screen as the CONFIG.SYS and 
AUTO EXEC.BAT files are processed. Make sure no error messages occur 
during the processing. 

• Install the network card in another slot in your computer. For more infor· 
mation about installing a network card, see Appendix C, "Installing Network 
Hardware." If it works, then the slot it was originally in does not work properly. 
Otherwise, the network card may be defective. 



Appendix E Troubleshooting 143 

Using the Microsoft Windows Network 
The following sections describe possible solutions for problems you migbt have 
when using Windows for Workgroups with the Microsoft Windows Network. 

You forget your logon password for the Microsoft Windows 
Network. 

If you forget your logon password, you can delete the file that records the pass­
word. You can create a new password list the next time you start Windows for 
Workgroups. 

II> To create a new password list 

1. Using a text editor, open the SYSTEM.INI file, located in your Windows 
directory. 

2. In the [Password Lists] section, find the line that starts with your user name. 
It specifies a file with a .PWL extension. 

3. In your Windows directory, delete the file that is specified in SYSTEM.IN!. 

4. Restart Windows. A dialog box appears, asking whether you want to create a 
new password list. If you choose Yes, it creates a new list. This list contains no 
passwords, so you will have to supply a password the next time you connect to a 
shared resource that requires one. 

Other computers on the network are not listed. 
If you open a Connect dialog box and computers on the network are not listed, make 
sure your network cables are properly connected. For more information about cable 
connections, see Appendix C, "Installing Network Hardware." 

If the names of computers on the network still don't appear, make sure your 
computer is using the same protocol as the computers you are trying to connect to. 

II> To determine which protocol you are using 

1. In the Main group, choose the Windows Setup icon. 

2. From the Options menu, choose Change Network Settings. 

3. In the Network Setup dialog box, choose Drivers. The Network Drivers dialog 
box appears, displaying your current settings. 
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If you are using the correct protocol but are still having problems, try the following: 

• Make sure that the settings in your PROTOCOL.INI file are correct for your 
network configuration. You can use a text editor, such as Notepad, to view the 
file in Windows. 

• Sometimes when a computer in your workgroup is turned off or restarted, the 
computer names don't appear. Wait a few minutes, and then try again. 

• Even though a computer name may not be visible in the Connect dialog box, you 
may still be able to connect to it by doing the following: In the Path box, type 
the name of the computer you are looking for, preceded by two backslashes 
(for example: \\computer). Then choose Connect. 

• If a computer is part of a workgroup that is not your own, the computer name 
may not be listed in the Connect dialog box. Be sure to select the workgroup 
name when you open the Connect dialog box. 

• Make sure the computer you are trying to connect to is on, running Windows 
for Workgroups, connected to the network, and set up to share files. 

• In the Main group, choose the Windows Setup icon, and then choose Change 
Network Settings from the Options menu. In the Network Setup dialog box, 
double-click the name of your network adapter. If there is an Advanced button in 
this dialog box, choose it to view the advanced settings. Make sure the advanced 
settings match your network hardware. For example, if you are using a 3Com® 
EtherLink II® or IITP (8- or 16-bit) network, make sure Transceiver Location is 
set to Onboard rather than External. 

You cannot share directories on your CD-ROM drive. 
If you are using a CD-ROM drive with Microsoft CD-ROM Extensions and you 
want to share directories on the drive, you need to use MSCDEX.EXE version 
2.22, and specify/son the MSCDEX line in your AUTOEXEC.BAT file. 

If you are running Novell NetWare, the MSCDEX line must appear before the 
MSIPX and NETX lines in your AUTOEXEC.BAT file. 

A LAN Manager server is not listed. 
You can run the Microsoft Windows Network in addition to Microsoft LAN 
Manager. If your network has a server running LAN Manager, but that server is not 
listed in the Connect dialog box, check the following: At least one of the computers 
running Windows for Workgroups in your network must have as its workgroup 
name the same name as the primary domain of the server. 
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A Windows NT or LAN Manager server is listed, but you cannot 
connect to it. 

If a Microsoft Windows NT or LAN Manager server is listed in the Connect dialog 
box, but you cannot connect to it, you might not have a valid account on the server. 
For more information about getting a valid account on the server, see your network 
administrator. 

You need to connect to or share resources before starting 
Windows. 

If you cannot use the network features of connecting to and sharing resources while 
running Windows for Workgroups, or you need to use the network features before 
starting Windows, you can start the network from MS-DOS. 

~ To start the network before starting Windows 

1. At the command prompt, type net start full. Or, if you only need limited 
network functionality, type net start basic. 

A message appears, asking whether you want to start the workstation. 

2. Press the letter Y, and then press ENfER. 

You can now run Microsoft Windows Network commands from MS-DOS. 

Note If you use the net start basic command to start the network before starting 
Windows, you will have about lOOK less memory to work with when you use 
MS-DOS Prompt within Windows. A message is displayed if you start Windows 
after starting the network. 

For more information about using Microsoft Windows Network commands from 
MS-DOS, type net help at the command prompt. 

Using Novell NetWare 
The following sections describe possible solutions for problems you might have 
when using Novell NetWare with Windows for Workgroups. 

You cannot connect to a Novell NetWare server. 
If you cannot connect to a Novell Net Ware server from within Windows for 
Workgroups, make sure you are logged on to a Net Ware server before starting 
Windows. Also make sure that you have set up Windows for Workgroups tu use 
Novell NetWare. 
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II- To see whether Windows for Workgroups is set up to use Novell Net Ware 

1. In the Network group, choose the Network Setup icon. 

2. If Windows for Workgroups is set up to use Novell NetWare, it should appear 
in the list of networks installed on your computer. If it does not, choose the 
Networks button next to the list. The Networks dialog box appears. 

If you want to use the Microsoft Windows Network and Novell NetWare, select 
Install Microsoft Windows Network, select Other, and select Novell NetWare 
from the list. 

If you want to use Novell only, select Install Windows Support For The 
Following Network Only, and then select the appropriate version of Novell 
NetWare from the list. 

3. Choose OK. 

Computers or NetWare servers are not listed. 
If you are using Novell NetWare in addition to the Microsoft Windows Network, 
and Net Ware servers are not listed in the Connect dialog box, make sure the 
Adapter Media Type setting matches your Novell Net Ware software configuration. 
For information about this configuration, see your network administrator. 

II- To check the Adapter Media Type setting 

1. In the Network group, choose the Network Setup icon. 

2. In the Network Adapters And Protocols list, double-click the name of your 
network adapter. A dialog box appears. 

3. Choose Advanced. 

4. In the advanced settings dialog box, select Adapter Media Type. 

5. When you are using Novell NetWare, the value of Adapter Media Type can be 
either Ethernet II or Ethernet_ II (DIX). For troubleshooting purposes, select the 
value that is not currently selected, and then choose OK. 

If you are using a token-ring network, you should also try removing ROUTE.COM 
from your AUTOEXEC.BAT file. 

Setting Up a Network Card 
The following section suggests possible solutions for problems you might have 
while installing and configuring your network card. 
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You're trying to install a network card. 
If you encounter problems while installing and configuring a network card, or while 
connecting to cables, you can try the following: 

• Make sure that all connections (cables and connectors) are securely attached 
and that the network card is securely in the slot, as shown in Appendix C, 
"Installing Network Hardware." 

• If a diagnostics program is included with your network card, try running the 
program. See your network-card documentation for details. 

• Check the lights (if any) on the back of the network card. See your network-card 
documentation for details on what the lights indicate. 

• Make sure that your network card has been detected correctly. Use Windows 
Setup to detect your network card, as follows. 

~ To detect a network card 

1. In the Network group, choose the Network Setup icon. 

2. In the Network Setup dialog box, choose Drivers. 

3. In the Network Drivers dialog box, choose Add Adapter. 

4. In the Add Network Adapter dialog box, choose Detect. 

• If the network card is not listed in the Add Network Adapter dialog box, you 
may need to contact the network-adapter vendor for a network-adapter driver 
that works with Windows for Workgroups. 

• If two devices are using the same interrupt request level (IRQ) or base 1/0 port, 
they will not work properly. 

See your network-card documentation for information about the settings your 
card uses. To find out which interrupt levels and base 1/0 ports on your 
computer are being used by other devices, you can run the Microsoft 
Diagnostics (MSD) program included with Windows for Workgroups. 

When you set up Windows for Workgroups, MSD is copied to your Windows 
directory. If you have not yet set up Windows for Workgroups, you can run 
MSD from the Setup disks. 

Note Also, if you already have Windows version 3.1 or Windows for 
Workgroups version 3.1 on your computer, you can run MSD before setting 
up Windows for W orkgroups version 3.11. 
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~ TorunMSD 

1. Quit Windows (if you are running it). 

2. At the command prompt, type msd and then press ENTER. 

3. Follow the instructions on the screen. 

Note MSD does not detect the IRQ and base I/0 port used by your network 
card. For more information about IRQs and base I/0 ports, see Appendix C, 
"Installing Network Hardware." 

• You may need to change the configuration settings assigned to your card. 

If you have a network card that is configured by using jumpers and switches, 
you may need to change some of these settings. If you have a software­
configured card, use the configuration program that came with your card 
to change settings. See your network-card documentation for details. 

After reconfiguring your network card, you need to specify the new settings 
by using Windows Setup. 

Note If the jumper or DIP-switch settings do not match the network settings that 
Windows for Workgroups uses, you will not be able to use the network features. 

~ To change network-card settings by using Windows Setup 

1. In the Main group, choose the Windows Setup icon. 

2. From the Options menu, choose Change Network Settings. The Network Setup 
dialog box appears. 

3. In the Network Adapters And Protocols list, double-click the name of your 
network card. The dialog box for your network card appears. (If your network 
card does not appear in the list, see the instructions for detecting a network card, 
earlier in this section.) 

4. Change the settings as needed, and then choose OK. 

5. In the Network Setup dialog box, choose OK. 

For help with the dialog boxes, choose the Help button or press Fl while 
using them. 

Note If there is an Advanced button in the dialog box for your network card, 
choose it to see more settings your network card might need. 
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• If you are using a thin-Ethernet network, make sure you have attached a BNC­
style T-connector to the back of your network card. Also, make sure you have 
attached a terminator to each end of the network. For more information, see 
Appendix C, "Installing Network Hardware." 

• If your computer cannot detect other computers in a workgroup, make sure that 
when you configured your network card you specified the correct connector 
(on the back of the card) to connect to the cable. 

Using Microsoft Network Diagnostics to Troubleshoot 
Networking Problems 

Microsoft Network Diagnostics helps a network administrator troubleshoot 
networking problems. It checks the connection between two computers on the 
network. It is useful when a computer can connect to the Microsoft Windows 
Network but cannot connect to a specific shared directory on another computer, 
or if the computer cannot find any other computers on the network. 

Network Diagnostics can perform diagnostics by using either an IPX protocol, 
such as IPXODI.COM, or a NetBIOS protocol, such as Microsoft NetBEUI. 

To run Network Diagnostics, you first need to set up a computer as a diagnostic 
server. If possible, choose a computer that can successfully connect to other 
computers on the Microsoft Windows Network. If the problem is that you cannot 
connect to a specific shared directory, the diagnostic server should be the computer 
that the shared directory is on. 

~ To set up a diagnostic server for Network Diagnostics 

1. Quit Windows. Or choose the MS-DOS Prompt icon in the Main group. 
Quitting Windows is recommended. 

2. Type net diag at the command prompt. 

3. Network Diagnostics identifies the protocols that are installed on the computer. 
If more than one protocol is found, you are prompted to select the one you want 
to use. Select a protocol that is used by all the computers you are going to use in 
the test. 

4. Network Diagnostics then checks the network for other diagnostic servers. 
If none are found, it prompts you to confirm whether there are any. If there 
are none, press N. The computer then becomes the diagnostic server. 

Now you are ready to run Network Diagnostics on the computer that cannot connect 
to the network. 
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!lo- To run Network Diagnostics 

Using Mail 

1. Quit Windows. Or choose the MS-DOS Prompt icon in the Main group. 
Quitting Windows is recommended. 

2. Type net diag at the command prompt. 

3. Network Diagnostics identifies the protocols that are installed on the computer. 
If more than one protocol is found, you are prompted to select the one you want 
to use. Select the protocol you selected when you set up t.lie diagnostic server. 

Network Diagnostics then tries to detect a diagnostic server on the network. 
If it does not detect the diagnostic server you have set up, then the network 
cable may be faulty. Press Y to quit Network Diagnostics. 

The following are options available for Network Diagnostics. 

Use 

net diag/? 

net diag /status 

net diag /names 

To 

Display a list of command-line parameters. 

Show information about your network adapter's 
network connection. (Use only for NetBIOS 
protocols, such as Microsoft NetBEUI.) 

If you enter the name of another computer on the 
network, Network Diagnostics shows information 
about that computer's network connection. 

Specify a connection name to use during the 
diagnostics. If you are using more than one computer 
as a diagnostic server, the /names option helps you 
identify the diagnostic server you are connecting to. 

Note In the event that the cable is not faulty, there might be a problem with your 
network card or configuration. 

This section contains information to help Mail administrators solve problems they 
might have when creating or managing the workgroup post office (WGPO). 

You cannot create a workgroup post office. 
There are several reasons why you may not be able to create a WGPO. Most often, 
it is because you don't have enough disk space or, if you are creating the WGPO on 
a server, because you don't have write access to that server. In these cases, find a 
new location with enough disk space to create your WGPO. 
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The post office administrator forgets his or her password. 
The administrator's password cannot be recovered; the administrator must create 
anewWGPO. 

A user forgets his or her password. 
If a user forgets his or her Mail password, you can assign a new password. 

~ To assign a user a password 

1. Sign in to Mail. 

2. From the Mail menu, choose Postoffice Manager. 

3. In the Postoffice Manager dialog box, select the name of the user, and then 
choose Details. 

4. In the Password box, type a new password, and then choose OK. 

5. In the Postoffice Manager dialog box, choose Close. 

Now the user can sign in to Mail with the new password. 

A message file is corrupted. 
If a message file is corrupted, a dialog box appears, giving you the option to repair 
the message file. You or the user can either repair the file immediately or quit Mail 
and repair it later. However, the user whose file is corrupted cannot use Mail until 
the file is repaired. 

Using Microsoft At Work PC Fax 
The following sections describe possible solutions for problems you might 
encounter when using Microsoft At Work PC Fax. 

If you receive an error message while using PC Fax, use Write to view the 
README.WRI online document for more information. 

You cannot configure or share a modem. 
If you try to configure a shared modem in another computer, the Setup button 
appears dimmed. You can configure a modem in your own computer only. 

You tried to send a fax from an application, but your system 
locked up. 

If your system locks up when you try to send a fax from an application, make sure 
that Mail is running, and then try again. 
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Mail locks up. 
If Mail locks up, it may be because you sent a fax from an application, but canceled 
the job before it "printed." From the Fax menu in Mail, choose Queue, and then 
cancel the fax in the Queue dialog box. 

You add a network modem, but you still can't send faxes. 
If you cannot send a fax from a shared network modem, check with the person who 
shared the modem to make sure the Access Type for the modem has been changed 
to Full or Depends On Password. The default setting for Access Type is Read-Only, 
which does not enable you to share the modem. 

You set up PC Fax, but could not add a fax address to the 
Personal Address Book. 

If you cannot add a fax address to the Personal Address Book, try quitting Mail 
and restarting it. PC Fax should now be one of the choices in the New Address 
dialog box. 

You attached a document to a fax, and the icon for the document 
flashes. 

If the icon for an attached document flashes, double-click it. A dialog box appears, 
describing the problem. 

You sent a fax by using a shared modem in someone else's 
computer, but the fax is waiting in the queue. 

If a fax you sent by using a shared modem in another computer is suspended in 
the queue, delete the fax from the queue and try a modem in another computer. 
A shared modem should be in a computer not regularly used by anyone. Using 
the computer holds up the processing of faxes. 

You want to use a modem speed higher than 9600 bps. 
Because many computers have trouble sending and receiving fax data at such high 
speeds, and because of conflicts with other installed software, PC Fax does not 
automatically use modem speeds higher than 9600 bps (bits per second). 
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If your modem supports higher speeds, you can add the following lines to the 
[COMx] section of your EFAXPUMP.INI file. Be aware that using higher speeds 
may result in unreliable fax operation or failures, especially on slower machines. 

Enable Vl 7Send=l 

Enable Vl 7Recv=l 

Streamlining the CONFIG.SYS and AUTOEXEC.BAT 
Files 

If you want to troubleshoot a problem yourself, it's best to start with a "minimum" 
Windows configuration. This means that as a test, you should try removing unused 
applications, memory-resident programs (TS Rs), and unnecessary device drivers 
from your CONFIG.SYS and AUTO EXEC.BAT files. You can use a text editor, 
such as Notepad (in the Accessories group), to open and edit these files in 
Windows. When just a few applications are running with Windows, it's easier to 
isolate your problem. 

Before you make any changes, create a system disk that includes a backup copy of 
your CONFIG.SYS and AUTOEXEC.BAT files. You can restore these files when 
you are finished with the troubleshooting tests. You also can use this disk to start 
your system, if necessary. 

You can make a system disk by starting File Manager and then choosing Make 
System Disk from the Disk menu. Then copy your current CONFIG.SYS and 
AUTO EXEC.BAT files to the disk. These files are usually located in the root 
directory of your first hard disk drive, which is typically drive C. If you usually 
start your system by using a floppy disk, these files are located in the root directory 
of that disk. 

When removing command lines from your CONFIG.SYS and AUTOEXEC.BAT 
files, make one change at a time. After making one change, test it. If you don't 
know what a particular command line does in the CONFIG.SYS or 
AUTOEXEC.BAT file, do not remove it. 

Note If you are using disk-compression software (such as DBLSPACE.SYS) or 
disk-partitioning software (such as DMDRVR.BIN), do not remove the command 
lines that specify it. 

You need to restart your computer in order for the change to take effect. 
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The following is an example of a CONFIG.SYS file that contains the minimum 
configuration for Windows for Workgroups. 

This command line 

files=30 

buffers=20 

device=c:\windows\himem.sys 

device=c: I windows\ifshlp.sys 

Does this 

Sets the number of files that MS-DOS can access 
atone time. 

Allocates memory for buffers when your system 
starts. These buffers help Windows read 
information faster from your hard disk. 

Sets up the HIMEM.SYS device driver. 

Installs the Windows for Workgroups drivers. 

The following is an example of an AUTOEXEC.BAT file at a minimum 
configuration. 

This command line 

c:\windows\net start 

prompt$p$g 

path c:\;c:\windows;c:\msdos 

set temp=c:\windows\temp 

Does this 

Enables and starts Microsoft Windows Network 
drivers. 

Determines the appearance of the command 
prompt. 

Specifies the search path for MS-DOS and 
Windows. (Some versions of MS-DOS might 
name this directory something other than 
\MSDOS.) 

Specifies the directory where temporary files are 
stored. You may need to create the specified 
directory if it does not exist. The directory for 
temporary swap files should be a location that 
has at least 2 MB of free disk space. For more 
information about temporary swap files, see your 
Windows or Windows for Workgroups user's 
guide. 
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Welcome 

Welcome to the Microsoft® Windows™ operating system, software that makes 
your computer easier and more fun to use. Windows is easy to learn because 
its graphical interface is consistent from one application to the next. When 
you've learned to use one application, such as Write, you've learned the 
essentials for using any other application with Windows. You can run your 
existing MS-DOS-based applications beside Windows applications and share 
information between them. And now, Windows is easier and faster to set up 
on your system. 

If you are new to Windows, you may want to go to Chapter 3 after setting up 
Windows. Chapter 3, "A Guided Tour of Microsoft Windows," offers a visual 
introduction to Windows so that you can become familiar with the graphical 
interface before you start to use it. 

If you prefer to preview Windows on the screen, you can use the Microsoft 
Windows Tutorial during the Setup program. To use the Windows Tutorial, 

xiii 

you must have a mouse and a VGA(or better) monitor. If Windows is already set 
up on your computer, you can start the Tutorial from within Windows. Choose 
the Windows Tutorial command from the Help menu in Program Manager. For 
more information, see "Running the Microsoft Windows Tutorial" at the end 
of Chapter 3, "A Guided Tour of Microsoft Windows." 

About Your Windows User's Guide 
This book is only one part of the Windows version 3.1 documentation set. Also 
included are an online Tutorial and an extensive online Help system. In addition, 
several online documents (formatted for use with Write, an application included 
with Windows) are copied to your hard disk when you set up Windows. 

The first part of the Windows User's Guide is a setup guide and introduction to 
Microsoft Windows version 3.1. The rest of the book, in conjunction with online 
Help, provides a comprehensive guide to using Windows. Procedures for the 
tasks you perform most often are provided in this book. Procedures for other 
tasks are provided in Help. For more information about using Help, see Chapter 6, 
"Online Help." 
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This book is arranged as follows: 

Part 1, "Getting Started" -Chapters in this part introduce you to Windows 
and guide you through setting up Windows. 

• "Welcome" 

An overview of this book and other documentation, and a list of system 
requirements. 

• Chapter 1, "Setting Up Windows" 

Instructions for setting up Windows, tips for previous Windows users on 
upgrading to Windows version 3.1, instructions for setting up Windows 
from a network, and options for starting Windows (for advanced users). 

• Chapter 2, "New in This Version" 

A summary of the new and enhanced features in Windows version 3.1. 

• Chapter 3, "A Guided Tour of Microsoft Windows" 

A look at Windows, introducing the basic concepts, some essential Windows 
techniques, and the main applications included with Windows. 

Part 2, "Windows Fundamentals" -Chapters in this part describe the basic 
structure of Windows and the skills you need to work with Windows. 

• Chapter 4, "Windows Basics" 

An explanation of the basic elements of Windows and instruction in the skills 
you need to work with Windows. 

• Chapter 5, "Application Basics" 

Techniques for using your applications with Windows, including how to easily 
switch from one application to another. 

• Chapter 6, "Online Help" 

Instructions on how to use online Help to find information about tasks and 
features. 

• Chapter 7, "File Manager" 

Procedures for using File Manager to organize and manage the files and 
directories on your disks. 

• Chapter 8, "Print Manager" 

Procedures for printing files and setting up your printer for use with Windows. 
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• Chapter 9, "Accessories" 

Descriptions of the accessory applications included with Windows. There are 
three full-featured accessory applications: Write, a word processor; Paintbrush, 
a color painting and drawing application; and Terminal, a communications 
application. 

There are also two new multimedia applications, Media Player and Sound 
Recorder, in addition to several applications that add convenient capabilities 
to Windows, including Calculator, Calendar, Cardfile, Character Map, Clock, 
Notepad, and Recorder. 

Part 3, "Getting the Most Out of Windows" -One chapter in this part describes 
how to run MS-DOS-based applications with Windows. The other chapters 
provide information for advanced users. 

• Chapter 10, "Object Linking and Embedding" 

Instructions for transferring and sharing information between applications. 

• Chapter 11, "MS-DOS Applications" 

Procedures for running MS-DOS-based applications (applications not 
designed for Windows). 

• Chapter 12, "Customizing Windows" 

Procedures for changing screen colors, desktop settings, and other system 
settings, such as those affecting fonts and sounds. 

• Chapter 13, "Configuring Hardware" 

Instructions for installing and changing device drivers for system hardware, 
such as your mouse, display adapter, and multimedia devices. 

• Chapter 14, "Managing Memory and Performance" 

Methods for improving system speed while keeping adequate memory for 
applications. 

Appendixes-The appendixes provide reference material on the following topics: 

• Appendix A, "Keyboard Shortcuts" 

Keyboard shortcuts for performing various Windows tasks. 

• Appendix B, "Windows and Networks" 

Instructions for using Windows with a network. 

• Appendix C, "Troubleshooting" 

Questions you might have when setting up and using Windows, and possible 
solutions. 
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What You Need to Run Windows 
The minimum software and hardware requirements your computer system needs 
to run Windows successfully are shown in the following list. 

Windows requires: 

• Microsoft MS-DOS® version 3.1 or later. (To check your version, type ver 
at the command prompt.) 

• For 386 enhanced mode, a personal computer with a 386 processor 
(or higher) and 640 kilobytes (K) of conventional memory plus 1024K 
of extended memory, 8 megabytes (MB) of free disk space (10 MB is 
recommended), and at least one floppy disk drive. 

For standard mode, a personal computer with a 286 processor (or higher) 
and 640K of conventional memory plus 256K of extended memory, 6 MB of 
free disk space (9 MB is recommended), and at least one floppy disk drive. 

Note Minimum disk-space requirements are based on your having no optional 
components, network, or printers. Recommended requirements are based on 
your having all components installed, including a network and printer. 

• A display adapter that is supported by Windows. 

• A printer that is supported by Windows, if you want to print with Windows. 

• A Hayes, Multi-Tech, Trail Blazer, or compatible modem, if you want to use 
Terminal, the Windows communications application. 

• A mouse that is supported by Windows. Though it is not required, a mouse 
is highly recommended so that you can take full advantage of the easy-to-use 
Windows graphical interface. 

Note To get the best performance from Windows, you should configure memory 
above 640K as extended memory. Memory is discussed in Chapter 14, "Managing 
Memory and Performance." 

Windows runs in one of two operating modes, standard or 386 enhanced, 
depending on your hardware configuration. For information about starting 
Windows in a specific mode, see Chapter 1, "Setting Up Windows." 



Welcome xvii 

About Your Windows Documentation 
The Windows version 3.1 documentation set consists of the Microsoft Windows 
User's Guide, an online Tutorial, an extensive online Help system, and several 
online documents (formatted for use with Write) that are copied to your hard disk 
when you set up Windows. 

The following list outlines the various pieces of the Windows documentation: 

• The Microsoft Windows User's Guide (this book) includes a guide to 
setting up Windows on your system and a brief introduction to Windows. In 
conjunction with online Help, this book also provides a comprehensive guide 
to using Windows. It includes explanations and procedures for first-time users, 
in addition to topics for advanced users. 

• The Microsoft Windows Tutorial provides online instructions for using a 
mouse and for performing some basic tasks in Windows. 

• Online Help provides a quick reference to procedures and commands you 
need when using Windows. Context-sensitive Help is now available in the 
main Windows-based applications. To obtain specific information about how 
to complete a dialog box, just press Fl or choose the Help button while using 
the dialog box. 

• Several online documents are copied to your hard disk when you set up 
Windows. You can read (and print) the files by using Write. These files 
include: 

• SE11JP.TXT-Information about software and hardware configurations 
that require special handling in order for you to successfully set up and 
start Windows. (You can view this file by using any text editor.) 

• README.WRI-Information updated after the User's Guide was printed. 

• PRINTERS.WRI-Information about configuring particular printers and 
fonts. 

• NETWORKS.WRI-Information about operating Windows with specific 
networks. 

• SYSINI.WRI-Procedures for modifying settings in the SYSTEM.IN! file 
(for advanced users only). 

• WININI.WRI~Procedures for modifying settings in the WIN.IN! file 
(for advanced users only). 
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Conventions 
To help you locate and interpret information easily, Microsoft Windows 
User's Guide uses consistent visual cues and a few standard text formats. 

Visual Cues 
You will find the following typographic conventions throughout this guide. 

This 

bold 

italic 

ALL CAPITALS 

GID 

Represents 

Characters that you must type exactly as they appear. For 
example, if you are directed to type dir \windows, you should 
type all the bold characters exactly as they are printed. 

Placeholders for information you must provide. For example, 
if you are directed to type filename, you should type the actual 
name for a file instead of the word shown in italic type. 

Italic type also signals a new term. An explanation generally 
follows the italicized term. 

Directory names, filenames, and acronyms. 

A section that is specific to running Windows in 386 enhanced 
mode. 

Keyboard Formats 
Key combinations and key sequences appear in the following formats. 

Format 

KEY1+KEY2 

KEY1,KEY2 

Meaning 

A plus sign ( +) between key names means to press and hold down 
the first key while you press the second key. For example, "press 
ALT +ESC" means to press and hold down the ALT key and press 
the ESC key, and then release both keys. 

A comma(,) between key names means to press and release the 
keys one after the other. For example, "press ALT, F" means to 
press and release the ALT key, and then press and release the 
Fkey. 
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Getting Started 





CHAPTER 1 

Setting Up Windows 

Setup Designed with Users in Mind 
Setting up the Microsoft Windows version 3.1 operating system on your computer 
is simple. You can choose between two methods: Express Setup and Custom 
Setup. 

Express Setup 
Express Setup is the method recommended for most users. 

When you use Express Setup, the Setup program identifies your hardware and 
software, configures Windows to run with your system, and updates necessary 
files. All you do is type your name, answer a few simple questions (such as what 
type of printer you have), and insert disks when requested. 

If you have applications already on your system, Express Setup sets them up so 
that you can easily use them with Windows. Setup may be unable to set up some 
less common applications. You can set these up later from within Windows. Also, 
if you want to make changes to your system after Windows has been set up, you 
can do so by running Windows Setup from within Windows. 

Note If your system does not have enough disk space to set up all of Windows, 
Express Setup proposes a partial setup, which excludes some or all of the optional 
Windows components (for example, screen savers and additional accessory 
applications). 

To set up Windows by using Express Setup, you need to know two things: 

• What type of printer you have, if any 

• Which port your printer is connected to 
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Note Most computers are equipped with one or more parallel ports, such as 
LPTl, and one or more serial ports, such as COMl. You can use these ports to 
connect your computer to external devices, such as a printer. 

A physical port is a socket located on the front or back of your computer, into 
which you plug a mouse, printer, or other hardware. A virtual port is an 
internal connection, such as a connection to a network printer. Your computer 
may have one or both types of ports. See your hardware documentation for 
information about the ports on your computer. 

Express Setup sets up Windows in the C:\WINDOWS directory. If you are 
updating from Windows version 3.0, Express Setup prompts you for a directory 
name, giving your previous Windows directory as the default choice. 

Custom Setup 
Custom Setup is for experienced computer users who want to alter the standard 
Windows configuration. For example, to control how your CONFIG.SYS and 
AUTOEXEC.BAT files are modified, you should use Custom Setup rather than 
Express Setup. 

If you have limited space on your hard disk, you can use Custom Setup to choose 
which optional Windows components or files you want to set up. 

During Custom Setup, you are prompted to verify and provide information about 
the following: 

• The directory where you want to store Windows files. 

• The type (brand and processor) of computer you are using (for example, 
COMPAQ 386). 

• Your display (monitor) type. 

• Your mouse, if you are using one. 

• Your keyboard and keyboard layout. 

• The language you will work in. 

• Any network driver you are using. 

• The printer and printer port you use, if any. 

• Applications on your hard disk that you want to run with Windows. 
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• Changes that may need to be made to your AUTOEXEC.BAT and 
CONFIG.SYS files. 

• Which optional Windows components to install (including the Microsoft 
Windows Tutorial). 

• Your virtual-memory settings (if Windows will be running in 386 enhanced 
mode). 

Running Setup 
Setup detects minimum system requirements (listed in "Welcome") and warns 
you if your system does not meet the requirements. Also, Setup notifies you if it 
detects system features that are incompatible with Setup or Windows. 

Caution Before running Setup, turn off any automatic message service, such as a 
network pop-up or a printing notification, that prints directly to your screen. 
These are incompatible with Setup . 

.,. To set up Windows 

1. Insert the Windows version 3.1 disk 1 in a floppy disk drive, and close the 
drive door. 

2. At the command prompt, type the drive letter of the drive you're using, 
followed by a colon (: ), and then press ENTER. 

3. Type setup, and then press ENTER. 

4. Follow the instructions on the screen. 

You can choose Express Setup or Custom Setup. It is recommended that you 
use Express Setup; however, you can use Custom Setup if you are an 
experienced user. Both methods are described earlier in this chapter. 

Windows Tutorial 
You can choose to go through the brief, online Microsoft Windows Tutorial as 
part of the Setup program. The first Tutorial lesson guides you through basic 
mouse techniques and gives you a chance to practice them before you start 
working with Windows. The second lesson introduces you to basic Windows 
techniques. 

If you choose not to take the Tutorial from within the Setup program, you can run 
it later from within Windows by choosing the Windows Tutorial command from 
the Help menu in Program Manager. For complete instructions, see "Running the 
Microsoft Windows Tutorial" at the end of Chapter 3, "A Guided Tour of 
Microsoft Windows." 
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Upgrading from Windows Version 3.0 
Although you can keep your existing Windows version 3.0 in a separate directory, 
it is strongly recommended that you upgrade your copy of Windows version 3.0. 
You can then take full advantage of the many new features and enhancements in 
Windows version 3.1. Before upgrading, make backup copies of any data files and 
applications you have added to your system. 

If you have Windows version 3.0, upgrading to Windows version 3.1 preserves 
existing Windows settings, such as groups you might have created or desktop 
settings you've chosen. Also, applications, fonts, and certain drivers are 
preserved. Only the Windows system files, upgraded device drivers, and 
accessories are replaced with the new versions. 

Upgrading does the following: 

• Maintains existing Program Manager groups 

If you have created new groups in Program Manager or added program-item 
icons to existing groups, Setup preserves them. 

• Preserves existing system-information settings 

Settings for your computer, display adapter (monitor), mouse, keyboard and 
keyboard layout, language, network, and the associated drivers are preserved. 

• Updates existing device drivers that were supplied with Windows 
version 3.0 

If you have a Windows version 3.0 driver installed for which there is an 
available updated version, Setup installs the updated driver. 

• Maintains all installed drivers that were not supplied with Windows 

If you have a device driver installed that was supplied by another 
manufacturer, Setup leaves the driver unchanged. In some cases, Windows 
version 3.1 has a new driver that you can use in place of your existing driver. 
For example, if you have a Super VGA (video graphics adapter), you may 
want to update to the Windows version 3.1 Super VGA driver by using 
Custom Setup or by running Setup from within Windows later. 

• Preserves settings relating to the upper memory area 

The order in which drivers are loaded is critical in optimizing the use of the 
upper memory area. Setup preserves the loadhigh= line and its placement in 
your AUTOEXEC.BAT file. Setup also preserves the devicehigh= line in your 
CONFIG.SYS file. 
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Note Although you are strongly advised against it, you can keep your existing 
Windows version 3.0 and add version 3.1 in a separate directory. When Setup 
asks whether you want to upgrade, specify a new directory for Windows 
version 3.1. Version 3.1 will not incorporate the custom settings you specified for 
version 3.0, such as new groups, colors, and desktop settings. After setting up 
Windows version 3.1, remove Windows version 3.0 from your PATH setting in 
your AUTOEXEC.BAT file. Some parts of Windows version 3.0 cause serious 
problems if Windows version 3.1 is running. 

More Information About Upgrading 
If you are upgrading, please note the following information: 

• If you are using an English version of Windows version 3.1 to upgrade a non­
English version of Windows version 3.0, Setup will upgrade all the necessary 
Windows device drivers, using the English driver names. 

However, some of your installed device drivers that were not originally 
supplied with Windows may not be upgraded. After setup, you may need to 
obtain new third-party drivers (such as those supplied by hardware 
manufacturers) and update them by running Setup from within Windows or 
from the MS-DOS prompt. For more information, see Chapter 13, 
"Configuring Hardware." 

• Microsoft also provides the Windows Driver Library (WDL), which contains 
device drivers made available after Windows version 3.1 was released. Device 
drivers are added to the WDL as they become available. If you have a modem, 
you can download WDL device drivers from network services, including 
CompuServe, GEnie, Microsoft OnLine, various user-group bulletin-board 
services (BBSs on the Association of PC User Groups, or APCUG, network), 
and the electronic downloading service maintained by Microsoft (phone 
206-936-6735). If you do not have a modem, you may purchase disks by 
calling Microsoft Customer Support Services at 1-800-426-9400. 
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Network Setup 
The Setup program has options that enable yon to put Windows files on a network 
server or set up Windows for an individual network user to run. This section 
describes both procedures. 

Setting Up Windows from a Network 
If a network system administrator has put the Microsoft Windows files on a 
network server, you can set up Windows on your system from the network. Check 
with your system administrator for any special instructions before setting up 
Windows from a network. 

Note For information about copying Windows files to a network server, see the 
next section, "Placing Windows Files on a Network Server." 

You can set up Windows from a network in three ways: 

• All Windows files are copied to your computer. 

In this situation, you create your own copy of Windows on your computer. All 
Windows files are copied to your hard disk. 

To set up Windows, you connect to the network server and type setup (do not 
use the /n network option). Follow the instructions on the screen. It is 
recommended that you use Express Setup instead of Custom Setup. Both 
methods are described earlier in this chapter. 

• Personal Windows files are copied to your computer; shared Windows 
files are located on the server. 

You can set up your system to access a shared copy of Windows. In this case, 
most Windows files are located on a network server and are shared by you and 
others. During Setup, a few Windows files are copied to your personal 
Windows directory on your hard disk. By maintaining your own copies of 
these files, you can customize Windows according to your preferences. 

To set up Windows this way, use the setup /n option, described in the 
procedure following this list. 

• No Windows files are copied to your computer. 

If your computer is a diskless workstation (that is, it does not have a hard 
disk), no files can be copied to your computer. When running Windows, you 
use shared Windows files located in a network Windows directory. During 
Setup, a few Windows files are copied to your personal Windows directory on 
the server hard disk and modified for your use. 
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To set up Windows this way, use setup /n, described in the following 
procedure. When Setup asks you where it should put your Windows files, 
specify the name of your personal Windows directory, located on the server 
hard disk. If you are not sure which network directory you should use as your 
personal Windows directory, ask your network system administrator. 

~ To set up a personal copy of Windows from a shared network directory 

1. Connect to the network. 

2. Change to the directory where Windows is located on the network (for 
example, W:\WINSHARE). 

3. At the MS-DOS prompt, type setup /n 

4. Follow the instructions on the screen. 

It is recommended that you use Express Setup instead of Custom Setup. Both 
methods are described earlier in this chapter. 

Setup will ask where it should put your Windows files. Type the path of your 
personal Windows directory-for example, c:\windows (or u:\winuser, for a 
diskless workstation). 

Note If you have a set of Windows disks, do not attempt to set up a network copy 
of Windows from the disks (by typing setup /n). You can run setup /n only if you 
are setting up Windows from a network server. 

If you are using an English version of Windows version 3.1 to upgrade a non­
English version of Windows version 3.0, you need to use Custom Setup. In the 
System Information screen, choose the English names of drivers you previously 
installed in your non-English version ofWindows. 

In addition, some of your installed device drivers that were not originally supplied 
with Windows might not be upgraded. After setup, you may need to obtain new 
third-party drivers (such as those supplied by hardware manufacturers) and update 
them by running Setup from within Windows. 

Placing Windows Files on a Network Server 
Windows has an administrative setup option you can use to place Windows files 
on a network server. The administrative option does not set up a usable copy of 
Windows that you can run, but transfers the files from the Windows Setup disks 
to a network drive. The files are expanded, renamed, and marked as read-only 
when they are copied to the network drive. After the Windows files are copied to 
a directory on the network, users may connect to this directory and run the Setup 
program to set up Windows for their own workstations. 
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~ To place Windows files on a network server 

1. Insert the Windows version 3.1disk1 in a drive. 

2. At the MS-DOS prompt, type the drive letter of the drive. 

3. Type setup /a 

4. Follow the instructions on your screen. 

Setup prompts you to specify the network drive and directory to which you 
want the Windows files copied. You're also prompted to specify group 
registration information (group name and company name), which is stored 
and used when individual workstations are set up. 

Windows requires the following disk space for network files: 

• Shared network directory-16 MB 

• Personal network directory-300K 

Setup Summary 
The Windows Setup program: 

• Determines what hardware you are using. 

• Expands files from the Windows disk set and copies them to your hard disk. 

• Configures the SYSTEM.IN! and WIN.IN! files, which are used to customize 
your copy of Windows. 

• Searches your hard disk for applications to set up for use with Windows and 
creates program-item icons for these applications. You can then start an 
application simply by choosing its icon. 

• Creates program information files (PIFs) and program-item icons for any 
known MS-DOS-based applications you currently have on your system. PIFs 
supply Windows with essential information about how to run the applications 
with Windows. 

• Modifies your AUTOEXEC.BAT and CONFIG.SYS files as described in the 
following section. (Express Setup does this automatically. During Custom 
Setup, you can choose whether or not to have Setup modify these files.) 

• Restarts your system (if you want), so that all changes that were made to your 
system during Setup take effect immediately. 
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Note If you quit Setup before Windows has been completely set up (by pressing 
F3, for example), Windows will not be properly set up on your system. You will 
need to run Setup again before you can use Windows. 

Changes to the AUTOEXEC.BAT and CONFIG.SYS Files 
Setup makes the following changes to your AUTOEXEC.BAT file: 

• Adds to your PA11I setting the directory where you are setting up Windows. 

• Adds the SMARTDRV.EXE command line, if appropriate for your system 
configuration. 

• Creates a TEMP directory in the Windows directory and sets the TEMP 
variable to it (if you have not already set the variable). 

Setup makes the following changes to your CONFIG.SYS file: 

• Adds the HIMEM.SYS line. For example: 

de vi ce-c: \wi ndows\hi mem. sys 

• Adds the SMARTDRV.EXE /double_ buffer line, if needed. For example: 

de vi ce-c: \windows \sma rtd rv. exe I doub 1 e_buff er 

• Updates RAMDRIVE.SYS, if it is in use. 

• Updates EMM386.EXE, if appropriate. 

• Updates your Microsoft or Hewlett-Packard mouse driver. 

• Deletes any commands that load incompatible device drivers. 

• Adds or updates your EGA.SYS device driver if you are using an enhanced 
graphics adapter (EGA) or a Mouse Systems mouse. 

• Adds the appropriate parameter to the 386MAX line, if it is present. 

Note If you have problems setting up Windows, see Appendix C, 
"Troubleshooting." 
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Starting Windows 
At the end of the Setup program, you can choose whether to restart Windows or 
return to the command (MS-DOS) prompt. You can start Windows from the 
MS-DOS prompt at any time. 

~ To start Windows 

• At the command prompt, type win and then press ENTER. 

Note To have Windows start whenever you turn on your computer, add the win 
command to the end of your AUTO EXEC.BAT file. For more information about 
the AUTO EXEC.BAT file, see your MS-DOS documentation. 

When you start Windows, you can specify which mode (386 enhanced or 
standard) you want Windows to run in. Windows modes are described in the next 
section. 

You can also specify the name of an application or an MS-DOS command that 
you want to run when Windows is started. 

Windows Modes 
Windows can run in two modes: 386 enhanced mode and standard mode. When 
you type win, Windows starts in the most appropriate mode for your system. You 
can find out which mode Windows is running in by choosing the About command 
from the Help menu in Program Manager. 

Windows uses the following criteria when determining which mode to use: 

• Windows runs in 386 enhanced mode if you have a 386 computer (or higher) 
with at least 640K of conventional memory plus 1024K of extended memory. 

• Windows runs in standard mode if you have a 286 computer (or higher) with 
at least 640K of conventional memory plus 256K of extended memory. 
Windows also runs in standard mode on 386 computers that have less than 
2 MB of free memory. 

Starting Windows in a Specific Mode 
At times you might want to run Windows in a specific mode, even if it is not the 
most efficient one for your system. For example, if your system is a 386 computer 
with between 2 and 3 MB of memory and you do not want to run MS-DOS-based 
applications in Windows, you may decide to run Windows version 3.1 in standard 
mode to speed up performance. For more information about improving 
performance, see Chapter 14, "Managing Memory and Performance." 
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To ensure that Windows runs in a particular mode, specify one of the following 
options after the win command. For example, type win /s to start Windows in 
standard mode. 

You can specify one of the following options. 

Use To 

Is Run Windows in standard mode. 

You might want to use this option if you have a 386 computer with 640K of 
conventional memory plus 1024K to 2096K of extended memory and do not 
use MS-DOS-based applications with Windows. On such systems, Windows 
runs faster in standard mode than in 386 enhanced mode. 

You might also want to use this option if you are having hardware 
compatibility problems when Windows is running in 386 enhanced mode. 

/3 Run Windows in 386 enhanced mode. 

You might want to use this option if you want to run Windows in 386 
enhanced mode even though your 386 (or higher) computer has less than the 2 
MB of memory that 386 enhanced mode normally requires. This option works 
only with 386 systems with at least 1 MB of memory (640K conventional, 
384K extended). If your system has less than 2 MB of memory, Windows 
probably runs slower in 386 enhanced mode than in standard mode. However, 
you may be able to run more Windows-based applications at once in 386 
enhanced mode. 

Specifying a mode is optional. If you do not specify a mode, Windows starts in 
the mode most appropriate for your system. 

Specifying an Application or an MS-DOS Command 
When you start Windows, you can also run an application or MS-DOS command. 
For example, the following commands start Windows and then Microsoft Excel: 

win c:\excel\excel .exe 

If you specify an application or MS-DOS command, it must come after an option 
that specifies a mode. For example, the following commands start Windows in 
standard mode and then run the application MYEDITOR.EXE: 

win /s myeditor.exe 

Some Samples for Starting Windows 
The following samples show how to specify modes, applications, and MS-DOS 
commands when starting Windows. 
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Sample One: Starting Windows and an Application 
The following commands start Windows and then run the application 
TEXTEDIT.COM, which is in the EDITORS directory on drive D: 

win d:\editors\textedit.com 

Sample Two: Starting Windows and Opening a Document 
The following commands start Windows in standard mode and then open the 
document AGENDA.TXT in Notepad: 

win Is agenda. txt 

Notepad starts because Windows associates all files that have the .TXT filename 
extension with Notepad. You can change such file associations in File Manager 
by choosing the Associate command from the File menu. For information, see 
Chapter 7, "File Manager." 

Sample Three: Starting Windows and an Application, and 
Opening a Document 
The following commands start Windows, run Microsoft Word, and then open the 
Word document LETTER.DOC: 

win c:\word\word.exe letter.doc 



CHAPTER 2 

New in This Version 

This chapter highlights some of the new and enhanced features and many of the 
performance improvements in Windows version 3.1. 

TrueType Fonts 
One of the most dramatic features in Windows version 3.1 is the addition of 
TrueType fonts. TrueType provides you with a full set of fonts, with enough 
variety to meet virtually all your printing needs. 

15 

TrueType font~ are scalable, so you can choose the exact font size you need for 
your documents. For example, you can use a font at 12 points for the main text of 
a report and at 16 points for topic heads. If you use a dot-matrix or laser printer, 
the page you print will appear exactly as you see it on the screen, without your 
having to obtain special screen, cartridge, or soft fonts. 

Windows version 3.1 supplies several families of TrueType fonts, including Arial, 
Courier New, Symbol, and Times New Roman. You can easily add other 
TrueType fonts from a font manufacturer to enhance your Windows-based 
applications. 

For more information about using TrueType fonts, see Chapter 12, "Customizing 
Windows." 

Object Linking and Embedding 
Object linking and embedding is now available in Paintbrush, Write, Cardfile, and 
Sound Recorder (included with Windows version 3.1) and in applications such as 
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Microsoft Excel, Ami Professional, and WordPerfect. Object linking and 
embedding enables you to transfer and share information in a powerful new way. 

• Object embedding 

With object embedding, you can create a drawing, sound file, or other object 
by using an application such as Paintbrush or Sound Recorder and then insert 
(embed) it in another document. You can edit the embedded information from 
within your document. 

For example, suppose you are working on a report in which you have 
embedded a drawing. To make changes to the drawing, you choose it, 
and Paintbrush opens. You can then make changes to the drawing, save it, 
and return to your report. You don't have to remember where the drawing is: 
Windows finds it for you. 

• Object linking 

With object linking, you can use the same information (the object) in several 
documents. An object can be any kind of information, including text, a 
drawing, or a sound file. You create the object and then connect (link) it to as 
many documents as you want. 

When you edit the information in any of the documents, your changes are 
reflected in all the other documents that contain the same linked information. 
You save time and effort because you don't have to perform a cut-and-paste 
operation for each document every time you change the information. You save 
disk space because only one copy of the information exists-the documents 
contain only the links. 

For more information about object linking and embedding, see Chapter 10, 
"Object Linking and Embedding." 

A New File Manager 
File Manager has a new look: a split window with a directory list on the left and 
the contents of the "open" directory on the right. You can browse through the file 
system easily without having to open separate windows. 

File Manager has several other enhancements, including: 

• The ability to display the contents of more than one drive or directory at once. 
This makes it easy to copy and move files and subdirectories from one 
directory or drive to another. 

• More clearly labeled windows, disk drives, and network connections, making 
it easier to use File Manager. 
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• A variety of fonts that you can use to display information in the File Manager 
window. This enables you to control how much file information is displayed in 
the File Manager window at a time. 

• Enhanced network support that makes it easy to connect to and disconnect 
from network drives. (The specific commands that appear on menus depend on 
the network you are using.) 

• A Quick Format option so that you can format a floppy disk and then copy 
files to it without having to start MS-DOS Prompt or quit Windows. 

• A status bar that displays information about disk-space usage and availability. 

For more information about using File Manager, see Chapter 7, "File Manager." 

Drag and Drop 
The new "drag and drop" feature makes it easy to print, copy, or move a file in 
File Manager. You simply drag a file icon from one location to another by using 
the mouse. For example, you can print a file by dragging its file icon from File 
Manager and dropping it onto the minimized Print Manager window. 

If you want to create a new program item to use to start an application,.you can 
drag the application's file icon from File Manager and drop it onto a group icon or 
window in Program Manager. 

For more information about dragging and dropping files, see Chapter 7, "File 
Manager." 

A New Print Manager 
Installing printers and connecting to network printers are now easier and smoother 
-you can perform these tasks by using either Print Manager or Control Panel. 

In addition, several of the Windows printer drivers have been improved, making it 
quicker and easier to print files. For example, support has been added for printing 
at a baud rate of 19200 on a Hewlett-Packard LaserJet Series II or III printer. If 
you are using this type of printer, you can take full advantage of this feature and 
increase printing speed dramatically. For more information, see your HP LaserJet 
documentation. 

Print Manager now is faster and more efficient, returning control to your 
applications sooner. This enables you to quickly return to working on your 
documents while other documents or files are being printed. And remember-you 
can print most files just by dragging their file icons from File Manager onto the 
minimized Print Manager window. 

For more information about printing, see Chapter 8, "Print Manager." 
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Online Tutorial 
Windows version 3.1 offers an online Tutorial in which you can practice working 
with a mouse and performing basic Windows tasks. To run the Microsoft 
Windows Tutorial, you need a mouse and a VGA (or better) monitor. 

You can run the Tutorial when you run Windows Setup or at any time afterward. 
To run the Tutorial after you have set up Windows, choose the Windows Tutorial 
command from the Help menu in Program Manager. 

New Multimedia Features 
Windows version 3.1 has several new multimedia features, including sound, 
graphics, animation, and video capabilities. Many popular sound devices are 
supported, such as sound cards and devices with Musical Instrument Digital 
Interface (MIDI) capabilities. 

The following are among the new multimedia features: 

• Media Player 

You can use Media Player to control the playing of media files on hardware 
such as sound cards, CD-ROM drives, and videodisc players. Media Player 
can play animation, sound, and MIDI sequencer files. For more information 
about using Media Player, see Chapter 9, "Accessories," and Media Player 
online Help. 

• Sound Recorder 

You can use Sound Recorder to play, record, and edit sound files that have the 
WA VE format. You can assign the sounds that you record to system or 
application events, or use the sounds in applications that support object linking 
and embedding. 

The Sound Recorder window displays the sound wave as if it were being 
shown on an oscilloscope. For more information about using Sound Recorder, 
see Chapter 9, "Accessories," and Sound Recorder online Help. 

• Enhancements to Control Panel 

Control Panel has a new Drivers option, so you can set up drivers for almost 
any device you want to use. Although most devices include the appropriate 
driver, Windows also supplies sound drivers for common sound devices. 

Also, you can now assign unique sounds to different system and application 
events by using the enhanced Sound option. For example, you can select a 
sound to play every time you start or quit Windows, when an application 
displays a message, or in place of your computer's warning beep. 
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Control Panel has a new MIDI Mapper option, which you can use with sound 
devices that have MIDI capabilities, such as a synthesizer. MIDI Mapper is 
available only if you have a driver installed that supports a MIDI device. 

For more information about the new sound support in Control Panel, see 
Chapter 12, "Customizing Windows." 

Additional Features and Enhancements 
There are additional features and enhancements in Windows version 3.1: 

• Setup enhancements 

Setup has been greatly simplified. If you choose Express Setup, Windows is 
set up for you. You just type your name and answer a few simple questions, 
such as what type of printer you have. 

If you are an advanced user and need more control over how Windows is set 
up-for example, if you want to set any special printer options or choose not 
to set up some Windows components-you can use Custom Setup. Chapter 1, 
"Setting Up Windows," provides detailed instructions on how to set up 
Windows on your computer, using both methods. 

• Improved support for MS-DOS-based applications 

Windows now includes program information files (PIFs) for even more 
MS-DOS-based applications. PIFs are set upwhen you create program items 
for your MS-DOS-based applications in Program Manager, making it easier to 
run these applications from within Windows. 

Note An MS-DOS-based application is designed to run with MS-DOS but not 
specifically with Windows. 

When you run Windows in 386 enhanced mode, improved virtual-memory 
functions make it smoother to run several MS-DOS-based applications in the 
background and to switch between them. 

Full mouse support has been added to MS-DOS-based applications running in 
a window. You can now use your mouse to move around in and select items in 
these applications. 

Different font sizes are available for your MS-DOS-based applications, so you 
can pick the font size that best suits your needs. 

Also included is a collection of icons (in the MORICONS.DLL file) that 
represent many of the most popular MS-DOS-based applications. You can 
now use these icons when adding MS-DOS-based applications to Program 
Manager. 

For more information about running MS-DOS-based applications in 
Windows, see Chapter 11, "MS-DOS Applications." 
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• Network enhancements 

When you restart Windows, your system is reconnected to all the printers and 
network drives you were previously connected to. 

• Character Map 

Character Map is a new accessory application that you can use to insert special 
characters not found on your keyboard into your application. These characters 
include accented characters and characters in the Symbol fonts. For more 
information about using Character Map, see Chapter 9, "Accessories," and 
Character Map online Help. 

• Object Packager 

Windows Object Packager is a new accessory application you can use when 
linking and embedding information. For more information about Object 
Packager, see Chapter 10, "Object Linking and Embedding." 

• Online Help enhancements 

In addition to a complete, indexed Help system for all of Windows, you can 
now get context-sensitive Help for the task you are performing. Context­
sensitive Help is available in all dialog boxes in the following Windows 
applications: Windows Setup, Program Manager, File Manager, Print 
Manager, PIP Editor, and Control Panel. Now, you can get Help on a dialog 
box by simply choosing the Help button or pressing Fl. For more information 
about using Help, see Chapter 6, "Online Help." 

• Improved startup configuration 

When Windows starts, it runs (or loads) any applications whose program-item 
icons you placed in the new StartUp group in Program Manager. 

In Program Manager and File Manager, you can preserve the contents and 
positions of windows and icons, and any menu settings you change, from one 
Windows session to the next. For more information about using the StartUp 
group, see Chapter 5, "Application Basics." 

• More ways to customize your desktop 

Windows version 3.1 now has more desktop color schemes to choose from, 
including three designed for use with liquid crystal display (LCD) monitors. 

Also included are screen savers, which display moving graphics or text on 
your screen while you are not actively working with Windows. Screen savers 
reduce the wear on your screen and can be password-protected so that your 
work remains private. For more information about the new desktop features, 
see Chapter 12, "Customizing Windows." 
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• Serial-port enhancements 

Windows now includes additional communications settings for your serial 
ports. You can use serial ports that were not previously recognized by 
Windows and set separate interrupts for ports 1 and 3, in addition to ports 2 
and 4, so that you can use these ports simultaneously. For more information 
about this feature, see Chapter 13, "Configuring Hardware." 

• Standardized dialog boxes 

Many of the common dialog boxes, such as those that appear when you choose 
the Open, Save As, Browse, or Print Setup command, now look the same 
throughout Windows. 

• New collection of application icons 

Program Manager now offers a collection of icons that you can choose from to 
represent your applications. Whether you are adding an application to a group 
or changing application information, you can choose the most suitable icon. 
Also included is a file (MORICONS.DLL) that contains icons used to 
represent MS-DOS-based applications. 

Performance Improvements 
Windows version 3.1 includes many significant improvements to overall 
performance. For example: 

• Program Manager now requires less system memory, so you can create more 
groups without using up memory. 

• File Manager is much faster: Your screen updates faster when you move and 
copy files and when you search through drives and directories. 

• Running an MS-DOS-based application in a window is now much faster in 
386 enhanced mode. Also, switching between Windows and an MS­
DOS-based application is smoother and faster. 

• Printing is faster and more efficient: Your documents print faster, and control 
is returned to your applications sooner. 

• Disk-caching is improved with SMARTDrive. Opening, saving, and managing 
files when using MS-DOS-based applications is now smoother and faster. 





CHAPTER 3 

A Guided Tour of Microsoft 
Windows 

Introduction 
This chapter introduces you to the Microsoft Windows operating system version 
3.1-what it is, what it looks like, and how it works. You may want to try out 
some of the Windows features as you read this chapter. 

This tour is designed for mouse users. If you don't have a mouse, the tour can 
still provide a good overview of Windows. To learn about specific keyboard 
procedures, see Chapter 4, "Windows Basics," Chapter 5, "Application Basics," 
and Appendix A, "Keyboard Shortcuts." 
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If you are new to using a mouse, you can use the online Microsoft Windows 
Tutorial either during the Setup program or later from within Windows. The first 
Tutorial lesson introduces you to basic mouse procedures. For more information, 
see "Running the Microsoft Windows Tutorial" at the end of this chapter. 

If Windows is not yet set up on your system, read Chapter 1, "Setting Up 
Windows," before continuing. 

Starting Windows 
After Windows is set up on your computer, it is easy to start: 

• At the command prompt (for example, C>), type win and then press ENTER. 

Windows Basics 
As you work with Windows, there are a few basic terms you need to become 
familiar with. 

You do your work in rectangular areas of the screen called windows. These 
windows appear on a background called the desktop. The applications you work 
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with (such as your word-processing or spreadsheet applications) are represented 
in Windows by small graphical symbols called icons. 

You often carry out an action in Windows by choosing an item: For example, 
choosing an icon can start an application. You choose an icon by double-clicking 
it with the mouse. 

• Windows 
Setup 

Program Manager 

r Program-item icons represent applications you can run. 

Print Manager Clipboard 
Viewer 

~ ~ 
PIF Editor Read Me 

m m m . - -
Games StartUp Applications 

The screen background 
is known as the desktop. 

When you start Windows, the first thing you see is Program Manager, which 
continues to run as long as you are using Windows. Initially, the Program 
Manager window displays the contents of the Main group. A group is a collection 
of applications you can run. The names and icons for the applications in the group 
are displayed in the group window. 



The Main group 
window shows the 
main applications 

included with 
Windows . 

Chapter 3 A Guided Tour of Microsoft Windows 25 

Program Manager also displays icons for other groups of applications: 
Accessories, Games, and StartUp. 

Note Your Program Manager window may contain another group icon ca!Ied 
Applications. During Windows Setup, applications already installed on your 
computer can be set up for you to use with Windows. The Applications group 
window contains icons for those applications. 

You can perform many important tasks by using Program Manager. For example, 
you can: 

• Start applications. 

• Organize your applications into groups for easy access. 

• Quit Windows. 

The following illustration points out sorne of the Windows features displayed 
when you first start Windows. 

• Windows 
Setup 

Acces:::ories 

PIFEditm 

~ 
lilfil 
Games 

~ 
Read Me 

~ 
lilfil 

~ 
lilfil 

StartUp Applications 

Group icons represent other 
groups of applications. 

The title bar identifies the 
application (or group) in the window. 

The mouse pointer is used to select 
and move objects on the screen. 
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Starting an Application 
From Program Manager, you can easily start an application by using the mouse to 
double-click (or "choose") its icon, called a program-item icon. You may need to 
open another group window to find the icon representing the application you want 
to use. For example, you need to open the Accessories group to start Notepad. 

• Windows 
Setup 

Accessories 

PIF Editor 

'"'"' @jjj 
Games 

!:!elp 

Print Manager Clipboard 

~ 
Read Me 

StartUp 

Viewer 

'"'"' ~ Applications 

You can open a group window by 
double-clicking the group icon. 

MS·DOS 
Prompt 

The Accessories group window displays icons for additional applications you 
can run. 

ile ~ ~ . • Write Paintbru:s:h Terminal 

i.B !fill • Ill • Cardfile Calendar Calculator Clock Object 
Packager 

• A 
Character Map Media Player Sound 

Recorder 



~ 
Write 

§ 
Cardf~e 

0 
Character Map 

'*' 
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When you double-click ("choose") the icon, in this case Notepad, the application 
appears in an application window, ready for you to use. 

The Notepad window is now the active window. The active window is generally 
the window in the foreground. To make another window active, you click 
anywhere in the window. 

Main 

• 

You can start an application by 
double-clicking its program-item icon. 

Paintbrush Terminal 

lfill • • " Calendar Calciktor Clock Object 
Packager 

• A 
Media Player Sound 

Recorder 

file .Edit J;;earch Help 
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Using a Menu 
Each application window, and other windows as well, has menu names located on 
a menu bar (beneath the title bar). A menu contains a list of commands, which are 
actions you can carry out in Windows. To choose a menu nanie or command, you 
click it once. 

Clicking a menu name displays 
the menu commands. 

Elle J;dil ]iearch J:lelp 

I 
_______ _J 

Clicking a command 
carries out an action. 

About Notepad ... 

Eile J;dil Bookmark J:lelp 

Contents for Notepad Help 

Notepad is a text editor that you can use to edit small ~~xt_W_e_~, 
such as your CONFIG.SYS or AUTOEXEC.BATfile. 

To learn how to use Help, press Fl 

How To ... 
Add the Time a.rid Date to Oocumenls 
Change Printers and Prin;er Opt:ons 
Copv Cut and Paste Text 
Create Nsw Documents 
Crea.ts Time-Log Documents 
~ 
Find Text 
FormatText 
Open Existing Text Files 
Print Dgcuments 
Print Headers and Footers 
QuttNotepad 
Save Documents 
Select A!! the Text in a Document 

In this case, the command 
opens a Help window. 
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Reducing an Application Window to an Icon 
As you work with Windows, you may want to temporarily put aside an 
application but keep it running and easily available to use later. You can avoid 
clutter on your screen if you reduce the application window to an icon by clicking 
its Minimize button; the icon stays on the Windows desktop until you need to use 
the application again. 

Eile f_dit S.earch .tlelp 

You can reduce an application window\ 
to an icon by clicking the Minimize button.-----""'-

The application is running, but it takes up less space as an application icon. 

~ ti) 4J\ 
Write Paintbrush Terminal 

LB !ill.I Ill {B 
Cardfile Calendar Calculator Object 

Packager .. 
Application icon 
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Quitting an Application 
When you finish using an application, you may want to quit it to free memory for 
other tasks. Using a mouse, you can quit an application as easily as starting it. The 
quickest way to quit is to double-click the application's Control-menu box. (You 
can also press ALT+F4. Or you can click the Control-menu box once to display the 
Control menu, and then click the Close command.) 

L You can quit an application by 
double-clicking its Control-menu box. 

Eile J;;dit S.earch l:!elp 

If you have any unsaved work, Windows prompts you to save it before the 
application window closes. 

More Ways to Use Program Manager 
You can also use Program Manager to: 

• Create and delete groups. 

• Add applications to a group and delete applications from a group. 

• Add applications to the StartUp group so that they start when Windows starts. 

For information about these and other Program Manager tasks, see Chapter 5, 
"Application Basics." 
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File Manager 

This isa 
directory icon. 

The status bar 
shows information 
about disk space 

and availability. 

File Manager provides a graphical representation of files and directories to help 
you organize them and simplify file maintenance. You can start File Manager by 
double-clicking its icon in the Main group window. 

You can perform many tasks by using File Manager. For example, you can: 

• View the contents of your directories. 

• Move, copy, and delete files and directories. 

• Change to other disk drives, including network drives. 

Files and Directories 
A file is an electronic document or an application or program that has been named 
and is stored on your computer. A file could be a memo you have written or the 
word-processing application you used to create the memo. Files have unique 
names, such as LETIERTXT and APPLICTN.EXE, and they can be organized 
into directories. 
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A directory is a collection of files and/or other directories (sometimes called 
subdirectories). Two directories that are likely to be on your computer are 
WINDOWS and SYSTEM. 

C:\ I Drive 

Cl REPORTS I I} 
~1 -~1 Directories 

. WINDOWS . 

SYSTEM Subdirectory 

1-----calc.exe 

1-----calc.hlp 

~---cardfile.exe 

The WINDOWS directory contains the SYSTEM subdirectory, in addition to 
many of the Windows files. The SYSTEM directory contains additional files. 

A directory window appears in the main File Manager window. It graphically 
displays the relationship of the directories and files stored on a disk drive. 

The left side of the window displays the directory tree, and the right side displays 
the contents of the current directory. 



The directory tree 
displays directories on 

the drive you are using. 
The selected directory 

(WINDOWS) is "open." 
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can.yon.mid 
L::Js.vstem L:lcardfile.eJ.:e 
D accessor.grp ~ cardfile.hlp 
D app1icat.grp E'2lcharmap.exe 
l!EJ bell:s.wav @II charmap.hlp 
~ boxes.bmp [ill chemical.wri 
~calc.exe rm chess.bmp 
um calc.hlp ~ clap.wav 
Li.]calendar.exe faclipbrd.exe 
~calendar.hip IB'] clipbrd.hlp 

The files and subdirectories in the 
open directory are displayed. 

Viewing Directory Contents 
By using File Manager, you can easily scan the contents of a directory. Just 
open the directory by clicking (selecting) its name or icon on the left side of the 
window. 

In the following illustration, the REPORTS directory is open, with its contents 
displayed at the right. 

;;;; logo.bmp 
Q] mar.wri 
~mkrepott.exe 

CJtables ~ notes.txt 
D accounts.bak D sales.dat 
D accounts. dat tlli'.:'lshowart.bat 
~apr.wri 
[b:l leb.wri 
!:illian.wri 
[j letters.log 
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Scrolling to View Information 
When a file has more text or graphics than can fit inside a window, you can use 
scroll bars to bring the rest of the information into view. 

These scrolling techniques will be useful in much of your work with Windows. 

Moving and Copying Files 

:_.ci--r.;r.=:::r.;rl- Placement 
of the scroll 
box shows 
your position 
in the list. 

With the "drag and drop" feature available in File Manager, you can use your 
mouse to move or copy files quickly. 

For example, to copy a file from your hard disk to a disk in drive A, first position 
the mouse pointer on the file icon. Then press and hold down the left mouse 
button and move (drag) the file icon to the drive icon labeled "a." Finally, 
release the mouse button, dropping the file icon onto the drive icon. 

You can move a file to a different drive by pressing and holding down the SHIFI' 
or ALT key while you drag the file icon to the drive icon. 
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When you move or copy files in File Manager, your mouse pointer appears as in 
the following illustration. 

You can also move and copy files from one directory to another by dragging file 
icons. 

• You can move a file to another directory on the same drive by dragging the 
file icon to the destination directory icon or window. 

• You can copy a file to another directory on the same drive by pressing and 
holding down the CTRL key while you drag the file icon to the destination 
directory icon or window. 

For more information about moving and copying files, see Chapter 7, 
"File Manager." 

Changing Disk Drives 
In File Manager, all of your disk drives are readily available, even any network 
drives you are connected to. 

Each File Manager directory window displays icons for all drives on your 
system-floppy disk drives, hard disk drives, and network drives-in the space 
beneath the window title. The icon of the current drive is outlined. The files and 
directories on the current drive are those displayed in the directory window. 
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The drive you are currently using is outlined. 

s. logo.bmp 
@llmar.wri 
~mkreport.ei-:e 

CJtables @) notes.lxt 
D accounts.bak [J sales.dat 
Cl accounts.dat Ll!showartbat 
~apr.wri 
~feb.wri 

When you click another drive icon, the directory window changes to display the 
contents of that drive. Double-click the drive icon to open an additional directory 
window rather than replace the contents of the current directory window. 

More Ways to Use File Manager 
You can also use File Manager to: 

• Connect to network drives. 

• Format and maintain disks. 

• Print documents. 

• Start applications. 

• Rename and delete files. 

• Change the kind and amount of information displayed about each file. 

• Create directories and subdirectories. 

For information about these and other File Manager tasks, see Chapter 7, 
"File Manager," and Help for File Manager. 

Control Panel 
You can use Control Panel to adjust settings on your system, such as changing the 
look of your desktop and configuring hardware. 

You can start Control Panel by double-clicking its icon in the Main group 
window. 



Settings l:!elp 

Ill 
Colm 
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You can perform many tasks by using Control Panel. For example, you can: 

Change screen colors and desktop settings. 

Set options for your printer. 

• Add, configure, and remove device drivers. 

By using the dialog box that appears when you choose a Control Panel icon, you 
can make changes, such as adding and removing fonts. 

Double-click the icon for the 
settings you want to change. 

aBbCcXxYyZz 123 

This is a scalable True Type font which can be 
displayed on the screen and printed on your printer. 

Size of Font on Disk: 66 KB 

Note Your fonts may be different from those shown here. 
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Using Dialog Boxes 
Sometimes Windows requires additional information from you in order to 
complete a task. You provide this information in a dialog box. Depending on the 
task you are performing, you might need to select certain options, type some text, 
or specify settings. 

r Clicking this arrow displays 
a list of options to select from. 

Clicking this command button 
displays another dialog box. 

----+11- Clicking this check box 
~==;:;:~==c='. ~------~ turns the option on or off. 

You can select only one of 
these option buttons at a time. 

More Ways to Use Control Panel 
You can also use Control Panel to: 

• Change options for your mouse or other pointing device, such as the double-
click rate. 

• Change settings for network connections. 

• Specify international settings for applications that use them. 

• Assign unique sounds to system events. For example, you can have Windows 
play musical notes each time it starts, if you have a sound card. 

• Add, configure, or remove sound and Musical Instrument Digital Interface 
(MIDI) device drivers, if you have a sound card or MIDI device. 

• Set printer options. 
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For information about these and other Control Panel tasks, see Chapter 12, 
"Customizing Windows," Chapter 13, "Configuring Hardware," and Help for 
Control Panel. 

Print Manager 
Print Manager controls printing for Windows-based applications and helps you 
keep track of documents sent to your printer. The Print Manager window displays 
the status of your printer(s) and the documents that are printing or waiting to be 
printed. 

You can view the Print Manager window by double-clicking its icon in the Main 
group window. 

You can use Print Manager to: 

• Check the print status of a document. 

• Pause and restart a printer or the printing of a document. 

• Cancel the printing of a document. 

• Set up a printer. 

In Windows, you often need to select (highlight) an item before you carry ont an 
action on it. For example, in Print Manager you click a print job to select it; then 
you can pause, restart, or cancel printing by clicking the appropriate button. 

~--~ You use the Pause and Resume buttons 

1 Calendar-SCHEDULECAL 

to temporarily stop and restart printing. 

You can cancel a print job by selecting 
it and then choosing the Delete button. 

This area displays the current 
status for the selected printer. 

b 1 (Paintbrush - ART\l/ORK.BMP) is printing on 
\PRINTROOM\PRINTER 

4% of 458K 1 :43 PM 1 0/19/1991 

PRINTER Active 

l 3K 1 :12 PM 10/19/1991 



40 Microsoft Windows User's Guide 

Checking Printer Status 

This line shows the 
queue status for a 

printer that is directly 
connected to your 

computer. 

This line shows the 
queue status for a 

printer that you are 
connected to 

through a network. 

By using Print Manager, you can monitor the status of your printer and the 
documents being printed. This can be particularly useful when you are printing 
more than one document or printing on a network printer that is located where 
you can't see it. 

1 Calendar-SCHEDULE.CAL 

b 1 (Paintbrush - ART\l/ORK.BMP) is prinling on 
\PRINTROOM\PRINTER 

4% of 458K 1 :43 PM 1 0/19/1991 

RINTER Active 

13K 112PM10/19/1991 1 
These lines display the status of files 

that are printing or waiting to be printed. 

More Ways to Use Print Manager 
You can also use Print Manager to: 

• Set up a printer. 

• Change the order of documents waiting to be printed. 

• Specify how print messages are displayed. 

• Connect to and disconnect from network printers. 

• Use separator pages between documents. 

• Specify your default printer. 

For information about these and other Print Manager tasks, see Chapter 8, "Print 
Manager," and Help for Print Manager. 

Switching Between Applications 
Using Windows to run more than one application at a time can make your job 
much easier. But when several windows are open, it may become difficult to find 
applications beneath overlapping windows. 



Task List 

The list shows your 
running applications. 
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An easy way to keep track of your applications is to use the Windows fast 
application-switching feature. You can switch quickly to another application by 
pressing and holding down the ALT key and then pressing the TAB key repeatedly. 
As you continue to press TAB, the title of each application currently running in 
Windows appears in the center of your screen. 

When you see the application you want to use, release ALT+ TAB. The application 
window appears in the foreground. 

Another method of managing your applications is to use Task List. 

Using Task List, you can: 

• Display a list of all the applications you are currently running. 

• Switch quickly to any running application. 

• Rearrange windows and icons on your desktop. 

• Quit an application. 

You can display Task List by double-clicking anywhere on the desktop. Another 
method is to press CTRL+ESC. (If a menu is displayed, you need to press ESC first.) 
Or you can choose the Switch To command from any application's Control menu. 

You can switch to an application 
by double-clicking its name. 
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The Task List buttons can be used to perform several functions: 

1111111111 

Switches you to the selected application. 

Quits the selected application. 

Closes Task List. Or you can close it by pressing ESC. 

Layers windows on your screen so that you can see the title of each 
window. 

Resizes windows and arranges them side by side. 

Rearranges application icons along the bottom of your desktop. 

For more information about switching between applications, see Chapter 5, 
"Application Basics." 

Online Help 
Windows provides online Help to assist you in working with Windows. Following 
are some of the ways you can obtain Help: 

• Press the Fl key to view a list of Help topics for the application you are 
working with. 

• When you are using a dialog box that has a Help button, click the Help button 
(or press Fl) to display information about working with the dialog box. 

• Choose the Help menu in any application to display a list of Help commands. 

The buttons near the top of the Help window can help you find the information 
you need. 
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Windows Control Panel provides you with a graphical way of 
configuring hardware and customizing Windows. 

To learn how to use Help, press Fl 

Change Keyboard Options 

Change Network Settings 

Change Point1r1g-Dev1ce Options 
Change Serial-Port Settings 

Chemge Swe9-File Settings 
Change the Look ofVv'jndows 
~oge the Svstern Date anc;[f'irne 
Conned to a Remote Printer 

Displays a list of Help topics for an application. 

Displays a dialog box where you specify a topic to search for. 

Displays the previously viewed topic. 

Displays a chronological list of all Help topics viewed during your 
current Windows session. 

Displays a list of Windows terms and their definitions. 

If you need to learn how to use Help, press Fl while the Help window is open. 
Or choose How To Use Help from your application's Help menu. For more 
information about using Help, see Chapter 6, "Online Help." 
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Quitting Windows 
Before turning off your computer, it is recommended that you quit Windows. You 
can quit Windows by double-clicking the Control-menu box in Program Manager. 

This is the Control-menu 
box in Program Manager. 

!:!elp 

i • I 
F"•e Manager ControlPonellllllllll'Jlll CT1>board MS·DOS 

Viewer Prcxnpl 

• .El!) peJ 
Windows PIF Edior Read Me 

Setup 

rn rn lml ·rn . - ~ :!!!:!. 

Accessories G"1lOS StartUp App~cation:s: 

The Next Step 
This chapter has provided a brief introduction to Windows. The rest of this book, 
along with online Help, provides details on the features presented in this chapter. 
Also, you may want to use the Windows Tutorial that is available on your system. 
Instructions for running the Tutorial follow. 

Running the Microsoft Windows Tutorial 
The Windows Tutorial is an interactive, online application that teaches you the 
basics of using a mouse and Windows. To use the Tutorial, you need a mouse and 
a VGA (or better) monitor. 
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~ To run the Tutorial from within Windows 

Mouse 

1. Switch to the Program Manager window by clicking it or by using Task List. 

2. Click the Help menu, and then click the Windows Tutorial command. 

File Manager 

• Windows 
Setup 

~ 
~ 

Accessories 

Keyboard 

~ 
PIF Editor 

~ 
~ 
Games 

!:!ow to Use Help 

Pri'l;!i;l)l)!;l;llll!!I 
About Program Manager ... 

Read Me 

r.ttl 
~ 

StartUp Applications 

1. Switch to the Program Manager window: Press and hold down ALT, and then 
press TAB repeatedly until "Program Manager" appears in the small window in 
the middle of your screen. Then release both keys. The Program Manager 
window appears. 

2. Press ALT and then H to display the Help menu. 

3. Press w. Or press the DOWN ARROW key to select the Windows Tutorial 
command, and then press ENTER. 





PART 2 

Windows Fundamentals 
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CHAPTER 4 

Windows Basics 

If you are new to Windows, this chapter may be the most important one to read. It 
explains the basic skills you need to work with Windows. You may want to return 
to this chapter often as a reference. 

Another way to become familiar with Windows is to read Chapter 3, "A Guided 
Tour of Microsoft Windows." The tour introduces you to all the parts of Windows 
and gives you a brief overview of the main applications included with Windows. 

Basic Elements of Windows 
Windows provides everything you need to manage your applications and files 
easily and efficiently. The following illustration shows the graphical environment 
of Windows . 

• ~ ~ Windows PIF Edito1 Read Me 
Setup 

[ffil . [ffil . [ffil . tn] . 
Accessories Games StartUp Applications 
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When working in Windows, your main work area is the desktop. You can move 
items around on the desktop, add new ones to it, and remove those you do not 
need. 

The first time you start Windows, the Program Manager window appears on your 
screen. You can use Program Manager to organize your applications and start 
them. 

After you start an application, it runs in an application window on the desktop. 
You can reduce any open application window to an application icon. An 
application icon is a small picture representing an application. By reducing 
application windows to icons, you can free space on your desktop without quitting 
the applications. For more information about icons, see "Types of Icons" later in 
this chapter. 

The following illustration shows applications running in windows and 
applications running as icons on the desktop. 

,.------------.- Applications running in windows 

Elle J;.dit .S.earch !!elp 

TO DO TH IS llEEK 

- Do charts for Thursday 
status 11eeting. 

- Schedule ...,eting with Jan 
re next rnonth' s se-.inar. 

- Finish writing report by 
Friday. 

- Clean out email mailbox. 
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For more information about how to start, run, switch between, and quit 
applications, see Chapter 5, "Application Basics." 

Parts of a Window 
Most windows have certain elements in common, such as a title bar and a menu 
bar. Not all windows, however, have every element. 

Insertion point 

Control-menu box Title bar 

Eile Edit Search !::!elp 

I 

Window corner Mouse pointer Horizontal scroll bar 

Minimize button 

Maximize button 

Menu bar 

Window border 

Vertical 
scroll bar 

Scroll arrows 

You'll learn more about how to use window elements throughout this chapter. 

• The Control-menu box is in the upper-left corner of each window. Click the 
Control-menu box to open the Control menu. The Control menu is most useful 
if you use your keyboard (rather than a mouse) to move, size, and close a 
window. 

• The title bar shows the name of the application, document, group, directory, or 
file. If more than one window is open, the title bar for the active window (the 
one in which you are working) has a color or intensity different from other title 
bars. 
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• The menu bar contains the available menus from which you can choose 
commands. 

• The scroll bars enable you to move through a document or a list when the 
entire document or list does not fit in the window or the allotted space. Click 
the scroll arrows with the mouse to move through the document or list one 
line at a time. 

• Clicking the Maximize button with the mouse enlarges the active window so 
that it fills the entire desktop; clicking the Minimize button reduces the 
window to an icon. You can also use the Maximize and Minimize commands 
on the Control menu. 

• The Restore button replaces the Maximize button after you enlarge a window. 
Clicking the Restore button returns the window to its previous size. You can 
also use the Restore command on the Control menu. 

• The window border is the outside edge of a window. You can change the 
window size by lengthening or shortening the border on each side of a 
window. 

• Moving the window corner shortens or lengthens two adjoining sides of a 
window border at the same time. 

• The insertion point shows where you are in a document. It marks the place 
where text and graphics appear when you begin typing or drawing. (The shape 
of the insertion point may vary among applications.) 

• The mouse pointer appears if you have a mouse installed. When you move the 
mouse, the position of the pointer changes on the screen. (The shape of the 
mouse pointer may vary among applications and even among documents 
within the same application.) 
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Types of Windows 
As you work with applications, two kinds of windows appear on your desktop: 
application windows and windows inside the application window. 

An application window contains a running application. The following is an 
example of an application window. 

An application (••••••••a11111111m•••••••• window has a title\_ file .Edit .Search !::!elp 

bar and menu bar. 

Another window, sometimes called a document window, may appear inside an 
application window. This type of window may contain documents, data files, 
groups (in Program Manager), or directories (in File Manager). In certain 
applications, more than one of these windows can be open at a time. For example, 
with File Manager (one of the main applications included with Windows), you 
can view several directories at a time. Each directory appears inside its own 
window. 
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As the following illustration shows, document windows share the application­
window menu bar but not the title bar. When a document window is open, 
commands that you choose from the application's menus affect the document 
window and the information contained in it. 

,.--------------,-Document windows do not 
have their own menu bars. 

Main 

I • Control Panel Print Manager 

a!J Ill ' • ~ ~ Card file Calculator Clock Windows PIF Editor Read Me 
Setup 

Games StartUp Applications 

If you use a mouse, you move and size application windows and document 
windows in the same way. If you use the keyboard, however, you use different 
keystrokes to manipulate each type of window. For more information, see 
"Working with a Window" later in this chapter. 

Types of Icons 
Icons are small pictures that represent various types of applications and files. 



Group icons 

SJ !ill) 
Cardfile Calendar 

rm! . 
Games 

• Calculator 

rm! . 
StartUp 
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Program-item icons appear only in Program Manager 
groups and can be moved from one group to another. 

~ 
~ 

Reco1der 

II . 9 
Clock Obiect 

Packager 

rm! . 
Maiti 

\ Application icons ap~ear at !he 
lower edge of the Windows desktop. 

The following table describes the three types of icons found on the desktop. 

Icon type 

Program-item icon 

Application icon 

Group or document.icon 

Description 

Represents an application you can start from Windows. 

Most program-item icons look unique. However, icons 
for many MS-DOS-based applications are identical. A 
group might contain several MS-DOS-based 
applications. The icon label is the only way to 
distinguish which application the icon represents. 

Represents a program-item icon (an application) that was 
started and then reduced to an icon. 

Generally appears along the lower edge of the 
application window and represents a group or document 
window that was reduced to an icon. This icon can be 
moved anywhere within the application window. 
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Minimized document 
windows have identical 
icons distinguished only 

by their labels. 

Basic Mouse Techniques 
The following table describes some of the terms referred to throughout this guide. 
Other terms are explained as they are introduced in the text. 

Term 

Oick 

Double-click 

Drag 

Point 

Meaning 

To quickly press and release the mouse button. 

To click the mouse button twice in rapid succession. 

To press and hold down the mouse button while you move the 
mouse. 

To move the mouse until the mouse pointer on the screen points to 
the item of choice. 

Note The mouse has more than one button. In Windows, use the left mouse 
button, which is the default. You can change the default by using Control Panel. 
For more information, see Help for Control Panel. 

Basic Keyboard Techniques 
Using a mouse is usually easier and faster than using the keyboard. Therefore, in 
most cases the procedures in this guide show you mouse techniques for 
completing tasks. If you prefer using the keyboard, see Appendix A, "Keyboard 
Shortcuts." 
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Choosing and Selecting 
In Windows, the terms choose and select have different meanings. Selecting an 
item usually means marking it with the selection cursor, which can appear as a 
highlight, a dotted rectangle, or both. Selecting alone does not start an action. 

You choose an item to carry out an action. For example, choosing an icon might 
start an application, open a window, or carry out a command. You choose an item 
from a menu and choose a command button in a dialog box. (Menus and dialog 
boxes are discussed later in this chapter.) 

You select an item by clicking it once with the mouse or by using the TAB key or 
the arrow keys to move the cursor to the item. You choose an item by double­
clicking it or by pressing a key (such as ENTER) after the item is selected. 

You can use a combination of mouse and keyboard techniques. For example, you 
can click an item to select it and then press ENTER to choose it. When a procedure 
in this guide directs you to choose an item, generally you can use either a mouse 
or the keyboard, whichever method you prefer. 

Selecting Items 
While. using Windows, you often need to select an item or multiple items from a 
list; for example, when using a dialog box. 

... To select a single item by using a mouse 

1. If necessary, click the scroll arrows until the item you want appears. 

2. Click the item. 

... To select a single item by using the keyboard 

1. If necessary, use the arrow keys until the item you want appears. 

2. Press ENTER. 

Sometimes you may want to select multiple items that may or may not be in 
sequential order. In these cases, you can select or cancel items. 

II> To select or cancel multiple sequential items by using a mouse 

• To select items, click the first item you want to select, and then drag the cursor 
to the last item you want. To cancel the selection, click any iiem in the list. 

Or click the first item you want to select, press and hold down SHIFT, and then 
click the last item you want. Both items and all items in between ·are selected. 
To cancel the selection, release SHIFT, and then click any item. 
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... To select or cancel multiple sequential items by using the keyboard 

1. To select items, use the arrow keys to highlight the first item you want. 

2. Press and hold down SHIFT, and press the arrow key to continue to select 
items. To cancel the selection, press the appropriate arrow key . 

.,. To select or cancel multiple nonsequential items 

• To select, press and hold down CTRL, and then click each item you want. To 
cancel, press and hold down CTRL, and then click the item to cancel the 
selection. 

For more information about using the keyboard to select items, see "Selecting 
Items" in Appendix A, "Keyboard Shortcuts." 

Using a Menu 
Commands are listed on menus. Most applications have their own menus, which 
are listed on the menu bar along the top of the application window. 

Note Some applications, such as Clock, can hide their menu bar. To display a 
hidden menu, double-click anywhere in the application window. 

The following are typical Windows menus. 

Q.pen Enter 
Move... F7 
J;opy... F8 
Q.elete Del 
f!roperties... Alt+Enter 

Bun ... 

E~it Windows ... 

Choosing Commands from Menus 

Select All 
Time/Qate F5 

'6'ord Wrap 

To open a menu, you select it. When a menu is open, you can choose an item 
from it. Menu items are most often commands. However, they can also be 
characteristics (such as bold or centered) that you assign to graphics or text, a list 
of open windows or files, or the names of other menus (cascading menus) that list 
additional commands. 
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~ To open a menu and choose an item 

1. Move the mouse pointer so that it points to the name of the menu on the menu 
bar, and then click the left mouse button. 

2. Click the menu item you want. Or drag the selection cursor down the menu 
until the menu item is highlighted, and then release the mouse button. 

Tip To move directly to a command on a menu, type the letter that is 
underlined in the item name. 

The following menu conventions are used in Windows. 

Menu convention 

Dimmed (or not visible) command 

An ellipsis( ... ) following a command 

A check mark (VJ to the left of a command 

A key combination to the right of a command 

A triangle ( ~ ) to the right of a command 

~ To close a menu without choosing an item 

Meaning 

You cannot use the command with your 
application at the current time. (For 
example, you may need to select another 
item before you can use this command.) 

A dialog box appears when you choose 
the command. The dialog box contains 
options you need to select before the 
command can be carried out. 

The command is in effect. When you 
remove the check mark (by choosing the 
command again), the command is no 
longer in effect. 

The key combination is a shortcut for 
choosing the command. You can press 
the keys listed to choose the command 
without first opening the menu. 

When you choose this command, a 
cascading menu appears. 

• Click the menu name, or click anywhere outside the menu. 

Using the Control Menu 
Application windows and their icons, document windows and their icons, and 
some dialog boxes have a Control menu. 

You open the Control menu for windows and dialog boxes by selecting the 
Control-menu box in the upper-left corner of the window or dialog box. You open 
the Control menu for an icon by selecting the icon. 
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The commands on the Control menu and the way you open this menu vary. The 
following section describes how to use the Control menu in different 
environments. 

Opening the Control Menu in a Windows Application 
How you open the Control menu depends on whether you are working with an 
application window, a document window, a dialog box, or an icon. 

Note In an application window that contains document windows, there may be 
more than one Control-menu box. The Control-menu box to the left of the 
application title bar controls the application. The others control the document 
windows inside the application window. 

~ To open the Control menu 

• Click the Control-menu box in the upper-left corner of the dialog box, 
application window, or document window. Or, if the application or document 
window has been reduced to an icon, click the icon. 

Do not double-click; if you do, you close the window or application or restore 
the icon to a window. 

You can also use the keyboard to open the Control menu. Use one of the 
following key combinations after the window or icon is selected. 

To open the Control menu 

In an application window 

In a document window 

In a dialog box 

Press 

ALT+SPACEBAR 

ALT+HYPHEN (-) 

ALT+SPACEBAR 

Tip When you are using the keyboard, you must first cycle through the windows 
and icons to select the one whose Control menu you want to open. Press ALT+ESC 

(to cycle through application windrows and icons) or CTRL+TAB (to cycle through 
document windows and icons). 

Opening the Control Menu in an MS-DOS Application 
An MS-DOS-based application is designed to run with Microsoft MS-DOS 
rather than with Windows. You can use most MS-DOS-based applications with 
Windows. 

Windows can run in one of two modes: standard or 386 enhanced. An 
MS-DOS-based application running in standard mode does not have an 
application window; it occupies the entire screen. Before you can open its 
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Control menu, you must switch back to Windows so that the application is 
reduced to an icon. 

To find out which mode Windows is running in, choose the About command on 
the Help menu in Program Manager. 

II> To open the Control menu for an MS-DOS-based application running in a 
full screen 

1. Press ALT+ESC to switch from the application to Windows. 

The application is reduced to an icon at the bottom of the screen. 

2. Click the icon. Or press ALT+ESC to select the icon you want, and then press 
ALT+SPACEBAR to open the Control menu. 

II> To open the Control menu for an MS-DOS-based application running in a 
window in 386 enhanced mode 

• Click the Control-menu box in the upper-left comer of the application 
window. Or, if the application window has been reduced to an icon, click the 
icon. 

Do not double-click; if you do, you close the window or restore the icon to a 
window. 

Control-Menu Commands 
The following table describes the commands on the Control menu. Some 
applications do not have all these commands. 

Use 

Restore 

Move 

Size 

Minimize 

Maximize 

Close 

Switch To 

Next 

Edit 

To 

Restore the wiodow to its former size after you have enlarged 
(maximized) it or reduced (minimized) it to an icon. 

Move the wiodow to another position by using the keyboard. 

Change the size of the window by using the keyboard. 

Reduce the wiodow to an icon. 

Enlarge the window to its maximum size. 

Close the window or dialog box. (From an application wiodow, 
you can use this command to quit the application.) 

Open Task Llst, which enables you to switch between running 
applications and to rearrange windows and icons on your desktop. 

Switch between open document windows and icons (available for 
document windows only). 

Display a cascading menu with additional commands (available 
for MS-DOS-based applications running in 386 enhanced mode 
only). 
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Use 

Settings 

Fonts 

Always On Top 

To 

Display a dialog box that requests information about multitasking 
options (available for MS-DOS-based applications running in 
386 enhanced mode only). 

Display a dialog box that you can use to specify font information 
(available for MS-DOS-based applications running in 386 
enhanced mode only). 

Ensure that a particular window is not covered by any other 
window. 

Choosing the Edit command opens a menu with four additional commands, as 
follows. 

Use 

Mark 

Copy 

Paste 

Scroll 

Working with a Window 

To 

Select text and move it onto the Clipboard by using the keyboard. 

Copy the selected text onto the Clipboard. 

Copy text from the Clipboard to the active window. 

View information not currently visible in the window. 

When you work with applications and documents, you often have a number of 
windows open. This section explains how to move and resize windows, scroll 
through their contents, and arrange them on the desktop. 

Moving a Window 
You can move any window to a different location on your desktop . 

.,. To move a window 

1. Drag the title bar of the window to the new location. 

As you move the mouse pointer, an outline of the window moves with it. 

2. Release the mouse button. 

Tip To cancel the move, press ESC before you release the mouse button. 
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Changing the Size of a Window 
You can change the size and shape of a window so you can view the contents of 
two or more windows simultaneously. 

Note Some application windows cannot be resized. 

~ To change the size of a window 

1. Select the window you want to resize. 

2. Point to a border or corner of the window. 

The pointer changes to a two-headed arrow. 

3. Drag the corner or border until the window is the size you want. 

If you drag a corner, the two sides that form the corner are sized at the same 
time. 

4. Release the mouse button. 

Tip To cancel the resizing, press ESC before you release the mouse button. 

Reducing a Window to an Icon 
You may want to reduce an application window to an icon if you want the 
application available for later use. When reduced to icons, Windows-based 
applications continue to run but their windows do not take up space on the 
desktop. You may also be able to reduce a document window to an icon. These 
icons appear in the application window, not at the bottom of the desktop. 

After a window is reduced to an icon, you can select and move the icon in the 
same way you select and move a window. 
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~ To reduce a window to an icon 

1. Select the window you want to reduce. 

2. Click the Minimize button in the upper-right corner of the window. 

Eile J;dit Fi!!d .!;horacter f!oragraph Qocument t!elp 

Minimize 
button 

Tip When a document window is maximized, the Minimize and Maximize 
buttons are replaced by the Restore button. If you want to minimize the document 
window, you can either choose Minimize from the window's Control menu, or 
you can first use the Restore button to restore the window and then click the 
Minimize button. 

Enlarging a Window 
In most cases, you can enlarge an application window to fill a larger portion of the 
desktop or even the entire desktop. A document window can be enlarged to fill 
the application window. 

~ To enlarge a window to its maximum size 

• Click the Maximize button in the upper-right corner of the window. 

The Maximize button is replaced by the Restore button. 

Eile J;dit Fi!!d .!;haracter Earagraph Qocument t!elp 

Maximize 
button 

Tip You can also maximize a window by double-clicking its title bar. To restore 
an application window to its previous size, double-click the title bar again. To 
restore a document window, click the Restore button in the upper-right corner of 
the window. 
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A maximized docwnent window shares the application window's title bar. The 
Minimize and Maximize buttons affect the application window, not any windows 
inside it. Only the Restore button affects the docwnent window alone. 

Tip When two or more windows are open inside an application window and you 
enlarge one of them, all the others are covered up by the enlarged window. If you 
want the other windows displayed, choose the Restore button to return the 
enlarged window to its previous size, or choose Minimize from the document 
window's Control menu to reduce the window to an icon. 

Restoring an Icon or Window 
You can restore an icon or window to its original size. 

II> To restore an icon to a window 

• Double-click the icon. 

II> To restore an enlarged window to its previous size 

• Click the Restore button in the upper-right comer of the window. 

Elle J;:dit Find, !;haracter e&ragroph Qocument Help 

Moving an Icon 

Restore 
button 

You can move an application icon anywhere on your desktop except into another 
application window. (An application icon may appear to be in another application 
window, but if you close the window, the icon remains on the desktop.) You can 
move a document icon to a different location in its application window but not 
outside the application window. 

II> To move an icon 

1. Drag the icon to a new location. The mouse pointer changes to an outline of 
the icon, which moves as you move the mouse. 

2. Release the mouse button. 

Tip To cancel the move, press ESC before you release the mouse button. 
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Using Scroll Bars 
Some windows and dialog boxes have scroll bars you can use to view information 
that does not fit inside the window. When you can view all the contents of a 
window or dialog box without scrolling, scroll bars may be absent or dimmed to 
indicate they cannot be used. 

~ 8li • 'I ... t-- Scroll arrow 
~ t-- Scroll box 

Paintbrush Terminal Notepad Recorder 

J!P Ifill II • • t-- Scroll bar 
Cardfile Calendar Calci .• dator Clock Object 

Packager 

~ To scroll through information displayed in a window or dialog box 

• Drag the scroll box to scroll through all the information in a list or document. 

You can also use the following techniques to scroll. 

To scroll 

One line up or down 

One screen 

Continuously 

To any position 

Do this 

Click the up or down scroll arrow. 

Click the scroll bar above or below the scroll box on 
vertical scroll bars to scroll vertically. Click to the left 
or right of the scroll box on the horizontal scroll bar to 
scroll horizontally. 

Point to one of the scroll arrows, and press and hold 
down the mouse button until the information comes into 
view. 

Drag the scroll box in the scroll bar to the position you 
want. The section of the document or list that moves into 
view depends on where you position the scroll box. For 
example, if you position the scroll box halfway down the 
vertical scroll bar, the text halfway through the document 
or list appears. 

For information about using the keyboard to scroll, see Appendix A, "Keyboard 
Shortcuts." 
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Closing a Window 
One way to quit an application is to close the application window. Similarly, you 
can close a document by closing the document window. If you made changes to 
your document since you last saved it, a message prompts you to save the 
document before closing the window. 

Ill> To close a window, use one of the following methods 

• From the File menu, choose Exit. 

• From the Control menu, choose Close. 

• Double-click the Control-menu box. 

• Press ALT+F4. 

Using a Dialog Box 
A dialog box appears when you need to supply additional information to complete 
a task. 

An ellipsis ( ... ) after a menu command indicates that a dialog box will appear 
when you choose that command. For example, if you choose the Open command 
on the File menu in Notepad, the Open dialog box appears. In this dialog box, you 
specify the name of the file you want to open. 

File !lame: D.irectoriea: 
c:\memos 

'-----·t .. _.txl _111 EJ review.txt 
statrepUat 

list Fies of ,hipe: Drixe:r. 

._lr_eat_File_•_,[·_. TX__,TJ'--_..11,. I • c: ctuio I 

Most dialog boxes contain options you can select. After you specify options, you 
can choose a command button to carry out the command. Some dialog boxes may 
display information, warnings, or messages indicating why a requested task 
cannot be accomplished. 

If a dialog box has a title bar, you can move the dialog box to another location on 
your desktop. Moving a dialog box is just like moving a window-you drag the 
title bar or use the Move command on the Control menu. For more information, 
see "Moving a Window" earlier in this chapter. 
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Moving Within a Dialog Box 
Often you need to move within a dialog box to select one or more options. The 
currently selected option is marked by the selection cursor, which appears as a 
dotted rectangle, a highlight, or both. 

~ To move within a dialog box 

• Click the option or area you want to move to. Or press TAB to move clockwise 
or SHIFT+ TAB to move counterclockwise through the options or areas. 

Tip If the option, box, or button has an underlined letter in its name, you can 
choose that item by pressing and holding down ALT while typing the underlined 
letter. 

Types of Options 
Several types of dialog box options are described in the following sections. 

Command Buttons 
You choose a command button to initiate an action, such as carrying out or 
canceling a command. The OK, Cancel, and Help buttons are common command 
buttons. They are often located along the bottom or on the right side of the dialog 
box. 

The selection cursor indicates 
the currently selected option. 

B.esolution: 

Paper Si~e: 

Paper .S.,ource: ,,lu=PP="=' =T'="9========== 
M.emor9: ~l1_.6_M_B ________ ~ 

Orientation 

~. . .. 
@ f.orlrait C · r,--i _op1es: t.!___J 
0 landscape 

Car!ridges (maic: 2) 

HP: \l/ordPerfect 
HP: Global Text 
HP: Great Start 

This button carries 
out the command. 

This button closes 
the dialog box 
without carrying 
out the command. 

A button containing an 
ellipsis ( ... ) opens 
another dialog box. 
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Some dialog boxes contain a command button marked with greater-than signs 
(>> ). This button expands the active dialog box. 

Unavailable buttons appear dimmed. The currently selected button has a border 
that is darker than that of other buttons. You can choose the selected button 
simply by pressing ENTER. 

... To choose a command button 

• Click the command button. Or press TAB until the button you want is selected, 
and then press ENTER. 

Text Boxes 
You type information into a text box. When you move to an empty text box, an 
insertion point (a flashing vertical bar) appears. The text you type starts at the 
insertion point. 

Insertion point 

.5,.earchfor: ~ 

StartErom: :'=lc=:\w=i=ndo=w=.==========:l flllli1 
[ill S§.arch All Subdirectorie$ 

If the box you move to contains text, and the text is highlighted, any text you 
type will replace it. You can also delete the existing text by pressing DEL or 
BACKSPACE. For information about editing text, see "Working with Text" in 
Chapter 5, "Application Basics." 

... To select text in a text box 

• Drag the pointer across the text, or double-click a word to select one word at a 
time. Or press and hold down ALT while pressing an arrow key. 

For more information about selection methods, see "Selecting Text" in Chapter 5, 
"Application Basics." 
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List boxes present 
available choices. 

List Boxes 
A list box displays a list of choices. If there are more choices than can fit in the 
box, scroll bars are provided so you can move quickly through the list. For 
information about scrolling, see "Using Scroll Bars" earlier in this chapter. 

I Delault Printer 
_Epson MX~100 on LPT1: I 

Installed .e_rinters: 

~I 
QMS-PS 810 on LPT2: 
r·iJ.l.U@immmH!lii 

~ 
_, 1--!ZI !!se Print Manager 

/ : 1.ist of Printers: 

~ l':'"!'"~~j_T.e•t Only 
Agfa 9000 Series PS , ... 

'I 

Agfa Compugraphic 400PS 
Agfa Compugraphic Genies 
Apple Laser\l/riter 
Apple Laser\llriter II NT 
~e Laser\llriter II NTX 

Usually, you can select only one item in a list box. In some cases, you can select 
more than one item, as in the Disconnect Drive dialog box in File Manager. 

For more information about selecting items in a list box, see "Selecting Items" 
earlier in this chapter. 

Drop-Down List Boxes 
A drop-down list box appears initially as a rectangular box containing the current 
selection. When you select the down arrow in the square box at the right, a list of 
available choices appears. If there are more items than can fit in the box, scroll 
bars are provided. 
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A drop-down list box opens 
to show available choices. 

,kountry: 

1anguage: 

Keyboard layout: 

.Measurement: 

List .[eparator: D 
!!.ate Format Cyrrency Format 

[ I.ime Format 
1:24:23AM 

$1.22 

($1.22) 

N_umber Format---,• 

1,234.22 

~ To open a drop-down list box and select an item by using a mouse 

1. Click the arrow at the right of the box to open the box. 

2. Click the up or down scroll arrow. Or drag the scroll box until the item you 
want to select is displayed. 

3. Click the item. 

~ To select an item from a drop-down list by using the keyboard 

Option buttons 
present mutually 

exclusive options. 

• Press the UP ARROW or DOWN ARROW key to move through the available 
options until you reach the one you want. 

Option Buttons 
Option buttons represent a group of mutually exclusive options. You can select 
only one option at a time. If you already have one option selected, your current 
selection replaces it. The selected option button contains a black dot. Nam es of 
unavailable options appear dimmed. 

New-------
0 Program §.roup 

@r~~~-9.~~-~If~.~J 

This option is selected. 
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... To select an option button 

• Click the option button, or press the SPACEBAR. 

Tip If the option name has an underlined letter, you can select the option button 
by pressing and holding down ALT while typing the underlined letter. 

Check Boxes 
A check box presents nonexclusive options; you can select as many check-box 
options as needed. When a check box is selected, it contains an X. Names of 
unavailable options appear dimmed. 

Check boxes present { 
nonexclusive options. 

a.hese options are selected. 

~~~i!•~ liiiiiil 
[g]l~::~;M.odificationDate -
D Last Modification !.ime 
D [ileAttributes ~ 
'----------' -

... To select or clear a check box 

• Click the check box, or press the SPACEBAR. 

Tip If the option name has an underlined letter, you can select or clear the check 
box by pressing and holding down ALT while typing the underlined letter. 

Closing a Dialog Box 
When you choose a command button, the dialog box closes and the command is 
carried out. You can also close the dialog box to cancel a command. 

... To close a dialog box without carrying out a command 

• Choose the Cancel button, double-click the Control-menu box, or press ESC. 

Note You can also choose the Close command on the Control menu (or press 
ALT+F4) to close a dialog box. If a dialog box does not have a Control menu, 
choose the appropriate button. 
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CHAPTER 5 

Application Basics 

A major advantage of using Windows is that you can run two or more 
applications at the same time. For example, you can have a spreadsheet 
calculating complex formulas while you are using a word-processing application 
to prepare an annual report. At the same time, your computer can be receiving the 
latest information about industry sales trends that you can use in the introduction 
of your report. 

Types of Applications 
Various types of applications run with Windows. Some are specifically designed 
to run with Windows. Others are designed to run with Microsoft MS-DOS rather 
than Windows. The following table lists the types of applications you can run. 

Type of application 

Windows-based 

Older Windows-based 

MS-DOS-based 

Description 

Windows-based applications require Windows version 
3.0 or later in order to run. These programs are 
generally highly graphical and designed to share your 
computer's memory among applications as efficiently 
as possible. 

Some Windows-based applications were designed for 
previous versions of Windows and do not work 
correctly with Windows version 3.0 and later. If you 
have an older Windows-based application, it is best to 
obtain an updated version of it. 

MS-DOS-based applications are designed to run with 
the MS-DOS operating system but not specifically 
with Windows. They do not take advantage of the 
Windows graphical interface, they may not have 
menus or dialog boxes, and they may not make use of 
the mouse. However, you can still use most of these 
applications with Windows. For more information, see 
Chapter 11, "MS-DOS Applications." 
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Type of application 

Memory-resident program 

Description 

Memory-resident programs are MS-DOS-based 
applications; however, they run differently than other 
applications. When started from MS-DOS, a memory­
resident program is loaded into memory and is 
available even when another application is running. A 
common type of memory-resident program is a pop-up 
program, which is loaded into memory but is not 
visible until you type a certain key combination. 
Memory-resident programs are sometimes referred to 
as terminate-and-stay-resident programs, or TSRs. For 
more information, see Chapter 11, "MS-DOS 
Applications." 

Organizing Your Applications into Groups 
Windows has several predefined groups of applications, described in the 
following table. You can control how the groups are arranged on your desktop, 
and you can define and add new groups. 

Group 

Main 

Applications 

Accessories 

Games 

StartUp 

Creating and Deleting a Group 

Contains 

Windows system applications: File Manager, Control 
Panel, Print Manager, Clipboard Viewer, MS-DOS 
Prompt, Windows Setup, and PIF Editor. This group 
also contains an item named Read Me that includes 
information you should have before you start working 
with Windows. 

Applications found on your hard disk during Setup. If, 
during Setup, you chose the Custom Setup option and 
chose not to have Windows set up applications from 
your hard disk, your Program Manager window will 
not contain an Applications group. 

Windows-based applications for word processing, 
drawing, and communications. 

Games included with Windows. You can use these 
games to practice basic Windows skills. 

Applications that start when you start Windows. You 
can add any application to this group. The group is 
empty until you add applications to it. 

You can add any number of groups to Program Manager to organize your 
applications and documents. If you no longer need a group, you can delete it. You 
do not have to delete the contents of the group before you delete it. 
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~ To create a new group 

1. From the File menu in Program Manager, choose New. 

2. Select the Program Group option button, and then choose the OK button. 

3. In the Program Group Properties dialog box, type a description for the group 
you want to create, and then choose the OK button. 

The Group File box contains information about the contents of the group. You 
can leave this box blank, because Program Manager automatically assigns a 
name to this file. 

D_escription: 

§.roup File: 

After creating a group, you can add program items (icons that represent 
applications) to it. 

~ To delete a group 

1. Select the group icon for the group you want to delete. 

2. From the File menu, choose Delete. Or press DEL. 

Creating a Program Item 
When you create a program item for an application, you specify the program 
item's properties, such as a description (label) for the item, a working directory 
where any files the application creates are stored, and the icon that represents the 
application. You can change these properties at any time. For information about 
changing properties, see Help for Program Manager. 

A group can contain a maximum of 40 program items. 

You can create a program item by using any of the following methods: 

• Choose the New command from the File menu in Program Manager to create a 
program item for an application or document. 

• Drag files from File Manager to a Program Manager group. 

• Run Windows Setup to create program items for one or more applications. 

The following sections describe these methods in detail. 
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Using the New Command to Create a Program Item 
You can create a program item for an application or document. When you choose 
a program item for a document, the application opens, displaying the document. 

.,. To create a program item for an application 

1. Open the group that you want to add an item to, and then choose New from the 
File menu in Program Manager. 

2. Select the Program Item option button, and then choose the OK button. 

Tip You can quickly open the Program Item Properties dialog box by pressing 
and holding down ALT while double-clicking in a blank area of the group 
window . 

.Q.escription: 

kommand Line: 

:w'..orking Directory: 

.5,hortcul Key: j~"-""-"------~ 
D .Run Minimized 

3. In the Program Item Properties dialog box, type a description for the 
application. The description becomes the label that appears under the icon in 
the group window. If you leave this box blank, Program Manager labels the 
icon for you. 

4. In the Command Line box, type the name of the program file, including the 
path (if there is one) and extension. 

For example, to add Microsoft Excel, located in a directory named C:\EXCEL, 
type c:\excel\excel.exe. 

If you don't know the name of the program file, choose the Browse button in 
the Program Item Properties dialog box to display a list of files and directories. 
Select the appropriate filename from the list, and then choose the OK button. 
(You can use the directory listing to change to a different directory.) 



File .tfame: 
lpb1u:s:h.exe 

rnelwatch. exe 
notepad.e:11e 

loaedit.e•e 
p1intman.exe 
progman.e11:e 
recmder.exe 

-

!tirectories: 

c:\,,.indows 

~c:\ 
It windows 
Qsystem 

List Files ol !J,ipe: Driyes: 

~IP_•o_o_••_m_• _____ JI_ Is c: chris 
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II 

5. In the Working Directory box, type the name of the directory where the 
program files for this application are located and where new files will be 
stored. 

6. To reserve a shortcut key for use with the application, type the key 
combination in the Shortcut Key box. You use a shortcut key to switch to the 
application when it is running or to start an application when the Program 
Manager window is active. 

Valid shortcut-key sequences are: 

• CTRL+ALT+character 

• CTRL+SHIFT +character 

• SHIFT +ALT +character 

• CTRL+SHIFT +ALT +character 

Character can be any letter, number, or special character. When you type only 
a character in the. Shortcut Key box, Program Manager adds CTRL+ALT in front 
of it. To specify a different control-key sequence, you must type the sequence. 

Note You can reserve shortcut keys for an MS-DOS-based application by 
using Program Manager or PIF Editor. Shortcut-key settings made in Program 
Manager override settings made in PIF Editor. 

7. If you want this application to be reduced to an icon when it starts, select the 
Run Minimized check box. 

8. Choose the Change Icon button to see the default icon for this program item. 
Scroll through the list, select the icon you want to use, and then choose 
the OK button. 

9. Choose the OK button in the Program Item Properties dialog box. The new 
program item appears in the group. 
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~ To create a program item for a document 

1. Follow the first four steps in the procedure describing how to create a program 
item for an application, in the preceding section. 

2. After the program filename in the Command Line box, press the SPACEBAR, 

and type the filename of the document. Include the path required to locate the 
document. 

For example, to specify a spreadsheet named 93BUDGET.XLS, located in the 
C:\ADMIN\FY93 directory, as the document to be opened when you start 
Microsoft Excel, you would type the following: 

c:\excel\excel.exe c:\admin\fy93\93budget.xls 

Note If the document is in the same directory as the application, you do not 
have to repeat the path when you type the filename of the document. If you 
have specified a working directory that is different from the application 
directory, you must specify a path with the document filename. 

3. Complete the other areas in the dialog box, and then choose the OK button. 

Dragging Files from File Manager to Create a Program Item 
You can also use File Manager to create program items by moving applications 
and associated documents from File Manager directories to Program Manager 
group windows. You can do this even if a group window is minimized. The 
following procedure requires a mouse. 

~ To create a program item by using File Manager 

1. Locate the Program Manager group where you want to create a new program 
item. The destination group can be either a window or an icon. 

2. Open File Manager and select the program or document file that you want to 
add as a program item. (You can also select multiple items and add them to a 
group at the same time.) 

3. If necessary, reposition the File Manager window so that you can see both File 
Manager and the Program Manager group icon or window where you want to 
place the new program item. 

Tip If no other application windows are open except for File Manager and 
Program Manager, you can press CTRL+ESC to open Task List, and then choose 
the Tile button to arrange the File Manager and Program Manager windows. 

4. Drag the file icon from File Manager to Program Manager, and drop it in the 
group window or onto the group icon. 

As you drag the file icon, the mouse pointer turns into a replica of a file icon. 
If you select multiple items, you can drag them all at the same time. 
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Running Setup to Create Program Items 
By using the Windows Setup icon, you can create a program item for one or more 
applications already on your hard disk. Instead of adding each application to a 
group separately, you can have Windows Setup search your computer's drive(s) 
and set up multiple applications at the same time. Windows Setup creates an 
Applications group, and each application found appears as an icon in that group. 

Caution Before running a setup program for any other Microsoft application that 
is not yet on your hard disk, you must quit Windows Setup. Otherwise, the 
application's setup program may fail. 

Note If Setup finds an MS-DOS-based application on your hard disk, it uses a 
program information file (PIF) to set up the application. Setup will set up only 
those MS-DOS-based applications that have a PIF. If Setup detects a naming 
conflict or multiple PIFs for one application, it displays a dialog box prompting 
you to specify the name of the application or PIF you want to use. For more 
information, see Chapter 11, "MS-DOS Applications." 

II> To have Setup search for and set up applications 

1. In the Main group, choose the Windows Setup icon. 

2. From the Options menu, choose Set Up Applications. 

3. Select the Search For Applications option button, and then choose the 
OK button. Setup displays a dialog box where you specify that Setup search 
for applications on one or more specific drives, and/or the current path. 

4. Click the search options you want, and then choose the Search Now button. 
When the search is completed, Setup displays a list of the applications found. 

Applications found on hard disk(s): 

earning Windows 1 _o 

~Mlllic!l1ro11sotlJftlH~e!lllp~Jl.5•····-
Quick Troubleshooter J i.iliiil 
~INCBT -, ... 
Micmsoft Word 
C:\llllNWORD\WINWORD.EXE 

,iet up for use with Windows: 

In the Applications Found On Hard Disk( s) box, Setup lists the names of all 
the applications it found. (If you cancel the search, Setup lists the names of 
applications found before you canceled.) 
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5. Click each application you want. (You can cancel the selection by clicking it 
again.) 

6. After you select all the applications you want, choose the Add button to move 
them to the Set Up For Use With Windows box. To add all the listed 
applications, choose the Add All button. 

To delete an application after you add it, select the application name, and then 
choose the Remove button. 

7. After you have selected the applications you want to set up, choose the 
OK button. 

Changing a Program-Item Icon 
If you don't like the icon assigned to a program item, you can choose one of the 
many icons provided with Program Manager. 

~ To change the program-item icon 

1. Select the program-item icon that you want to change. 

2. Choose Properties from the File menu, and then choose Change Icon in the 
Program Item Properties dialog box. 

3. In the File Name box, type the path for either the PROGMAN.EXE file or the 
MORICONS.DLL file (in your Windows directory). 

You can now select from these icons by scrolling through the Current 
Icon box. 

4. After you select the new icon, choose the OK button. 

5. Choose the OK button in the Program Item Properties dialog box. The icon 
you selected appears. 

Starting an Application 
With Windows, you can start an application in a number of ways: 

• Choose a program-item icon from a group in Program Manager. 

• Choose a program file or a program information file (PIF) from a directory 
window in File Manager. (For information about starting an application from 
its PIF, see Help for PIF Editor.) 

• Choose the Run command from the File menu in Program Manager or File 
Manager. 

• Use MS-DOS Prompt to start MS-DOS-based applications. 
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Note In the following procedures, remember that when using a mouse, you click 
to choose menu commands and command buttons, and you double-click to choose 
icons. 

Starting an Application from Program Manager 
The easiest way to start an application in a group is to choose the program-item 
icon for the application from the group window. If a document is associated with 
this program-item icon, the application opens, displaying the document. 

Ii> To start an application from a group 

1. If necessary, double-click the group icon to open the group window that 
contains the application you want to run. 

2. Double-click the icon for the application. 

Tip You can choose the Minimize On Use command from the Options menu in 
Program Manager to reduce Program Manager to an icon whenever you start an 
application. 

Starting an Application When You Start Windows 
When you install Windows by using the Setup program, Windows creates a 
StartUp group. Each application in this group starts when you start Windows. 

For example, if you want File Manager to start whenever you start Windows, 
copy the File Manager icon from the Main group to the Start Up group. (For more 
information, see Chapter 4, "Windows Basics.") 

You can also have Windows automatically reduce an application to an icon in the 
Start Up group. To do this, select the Run Minimized check box when you create 
the program item, or choose the Properties command on the File menu. 

Returning to Program Manager from an Application 
When you are working with an application or document and you want to start a 
different application, you can do so by returning to Program Manager. 

Ii> To return to Program Manager 

• Click the Program Manager window. Or double-click anywhere on the 
Windows desktop or press CTRL+ESC to display Task List, and then choose 
Program Manager from the list of running applications. 
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Tip Press and hold down ALT, and then press TAB repeatedly. As you continue to 
press TAB, the title of each running application is displayed. When "Program 
Manager" appears in the center of your screen, release ALT. The Program 
Manager window appears in the foreground. 

Starting an Application by Using File Manager 
You can start an application from File Manager by choosing the application 
program file from a directory window. A program file has a .COM, .EXE, .PIP, or 
.BAT filename extension. If you start an application that can run in a window, the 
window appears in front of the File Manager window. If the application is a full­
screen application, such as MS-DOS Prompt, it replaces the Windows desktop on 
your screen. 

~ To start an application by using File Manager 

1. In the Main group, double-click the File Manager icon. 

2. Click the drive icon for the drive you want. 

3. Click the directory icon for the directory you want. 

4. Double-click the name of the application's program file. 

Tip You can choose the Minimize On Use command from the Options menu in 
File Manager to reduce File Manager to an icon whenever you start an 
application. 

Starting an Application by Using the Run Command 
You can use the Run command to start an application that you run only 
occasionally or have not yet added to a group. You can also specify that a 
particular document open when you start the application. 

~ To start an application by using the Run command 

1. From the File menu in Program Manager or File Manager, choose Run. 
The Run dialog box appears. 

Cwrent Directory: C:\WINDOWS 

J;,ommand Line: 

D Run Minimized 
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2. In the Command Line box, type the path and the name of the program file, 
including the extension, if there is one. (In File Manager, you do not need to 
type the path if the program file is in the current directory. In Program 
Manager, you can choose the Browse button to display a list of program files 
to select from.) 

For example, if you want to start Aldus PageMaker and it is in the directory 
C:\P AGEMKR, you would type the following in the Command Line box: 

c:\pagemkr\pm.exe 

In most cases, you can open a document at the same time you start an 
application by typing a space and the document filename (including the path 
where the document is located) after the program filename. 

For example, to open a document named NEWSLTR.PM3 in the AUGUST 
subdirectory of C:\PAGEMKR, you would type the following: 

c:\pagemkr\pm.exe c:\pagemkr\angust\newsltr.pm3 

3. If you want the application to be reduced to an icon as soon as it starts, select 
the Run Minimized check box. 

4. Choose the OK button or press ENTER. 

Starting an Application by Using the MS-DOS Command Prompt 
Generally, you can set up your MS-DOS-based applications to run from Program 
Manager. (For more information, see Chapter 11, "MS-DOS Applications.") For 
MS-DOS-based applications that aren't set up, such as memory-resident 
programs, you can start them by using MS-DOS commands. 

MS-DOS Prompt appears as a program item in the Main group in Program 
Manager. You can use it to gain access to the MS-DOS command prompt without 
leaving Windows. 

~ To start an application by using MS-DOS Prompt 

1. In Program Manager, choose the Main group icon. 

2. In the Main group, choose the MS-DOS Prompt icon. 

3. When the command prompt appears, type the necessary MS-DOS commands 
to start your MS-DOS-based application. 

~ To run MS-DOS Prompt in a window (in 386 enhanced mode only) 

• After MS-DOS Prompt is running (follow steps 1 and 2 from the previous 
procedure), press ALT+ENTER. MS-DOS Prompt appears in a window so you 
can use the commands on the Control menu. 

• To return to a full screen, press ALT+ENTER again. 



84 Microsoft Windows User's Guide 

Tip If you want MS-DOS Prompt to always start in a window, you can change 
the DOSPRMPT.PIF file located in the Windows directory. Using PIF Editor, 
open the file and select the Windowed option under Display Usage. Then save the 
file. Running MS-DOS Prompt in a window uses more memory. 

II> To quit MS-DOS Prompt 

1. At the command prompt, type the following: 

exit 

2. Press ENTER. 

You can also leave MS-DOS running and switch to Windows to work with 
applications. For more information, see "Switching Between Applications and 
Documents" later in this chapter. 

Caution Some MS-DOS commands do not work properly when Windows is 
running. For example, when you use the chkdsk command with the /f option, 
chkdsk tries to modify part of the operating system that cannot be modified while 
Windows is running. You should also avoid using the undelete command; the 
chcp (change codepage) command; and disk-compaction or optimization 
programs, such as the Norton SD.EXE program, when Windows is running. If you 
need to run such programs or such commands, quit Windows first. 

Running Two or More Applications 
With Windows, you can start an application and then keep it running while you 
start one or more additional applications. 

When applications run at the same time, they share computer resources. The way 
they share resources depends on the type of computer you have, the type and 
amount of available memory, whether the applications are Windows-based or 
MS-DOS-based, and which mode Windows is running in. 

Note When Windows is running in 386 enhanced mode rather than in standard 
mode, more applications can run simultaneously. To find out which mode 
Windows is running in, choose the Aboui command from the Help menu in 
Program Manager. 
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Switching Between Applications and Documents 
When you have more than one application window open at once, the window you 
are currently working with is the active window. The active window always 
appears in the foreground, so it might overlap or completely obscure other 
windows. To work with another application, you must select its window to make 
it active. 

~ To switch to an application, use one of the following methods 

• If the application is visible, click anywhere in the application window. If the 
application is running as an icon, double-click the icon. 

• To return to the application you last used, press ALT+TAB. 

• To switch quickly to another application, press and hold down ALT, and then 
press TAB repeatedly. As you continue to press TAB, the title of each running 
application appears. 

When the title of the application you want appears, release ALT. The 
application the_n appears in the foreground. 

• Press ALT+ESC repeatedly to cycle through open application windows and 
application icons until you reach the application-you want. 

• Display Task List, and use it to switch to the application you want. For more 
information, see the following section, "Using Task List to Switch Between 
Applications." 

Tip If you use an application frequently, you may want to create a shortcut key to 
use when switching to it. You can define a shortcut key in the Program Item 
Properties dialog box in Program Manager. For more information, see "Using the 
New Command to Create a Program Item" earlier in this chapter. 

Using Task List to Switch Between Applications 
Task List is a window that displays a list of all the applications you are currently 
running. You can use Task List to switch to another application. 
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~ To switch to an application by using Task List 

1. Double-click anywhere on the desktop (that is, not inside an open window) to 
display Task List, or choose Switch To from the Control menu in Program 
Manager, or press CTRL+ESC. 

Control Panel 
Sound Recorder - (Untitled) 
Notepad - REllDME. TXT 
Calculator 
Object Package. - Package 

2. In Task List, double-click the name of the application to switch to. Or select 
the name of the application you want, and then choose the Switch To button. 

~ To close Task List 

• Press ESC, or choose the Cancel button. 

For more information about displaying and using Task List, see "Arranging 
Application Windows and Icons" later in this chapter. 

Switching Between Documents 
With some applications, you can open more than one document at a time, each in 
its own window. If you have more than one document window open, you can 
easily switch between them. 

For example, you can switch between directory windows in File Manager. 

~ To switch to another document window in an application 

• Click anywhere in the document window you want to switch to. Or open the 
application's Window menu, and then choose the document you want. 

Tip You can also press CTRL+F6 or CTRL+ TAB repeatedly until the document 
window you want is selected. (This is a shortcut for using the Next command on 
the Control menu.) 
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Arranging Application Windows and Icons 
You can use the Cascade and Tile buttons in Task List to rearrange application 
windows so that all running applications are visible on your desktop. The Cascade 
command causes the windows to overlap so that each title bar is visible. The Tile 
command arranges the open windows in smaller sizes to fit next to each other on 
the desktop. 

~ To arrange application windows on your desktop 

1. Double-click anywhere on the desktop to open Task List. Or press CTRL+ESC. 

2. Choose the Cascade or Tile button. 

If you have a number of applications running as icons and they are scattered 
across your desktop, follow the next procedure to rearrange them evenly. 

~ To rearrange application icons 

1. Double-click anywhere on the desktop to open Task List. Or press CTRL+ESC. 

2. Choose the Arrange Icons button. The icons are arranged along the lower edge 
of the desktop. 

Dragging Files to Perform Tasks 
When using File Manager, Program Manager, Print Manager, and certain other 
Windows-based applications, you can perform some essential tasks by dragging 
File Manager files from one place to another with the mouse. This is known as 
dragging and dropping. 

For example, you can print a file on your default printer by dragging a File 
Manager file onto the Print Manager icon (the minimized Print Manager window) 
and then releasing the mouse button. Or you can set up an application to run with 
Windows by dragging a File Manager file onto a group window or icon in 
Program Manager. 

Note Dragging File Manager files can only be done by using a mouse. There is 
no keyboard equivalent. 

~ To drag and drop a file 

1. In the Main group, double-click the File Manager icon to start File Manager. 

2. Select the drive and directory containing the file you want to drag. 

3. Make sure the application that you want to drag the file to is running either as 
a window or an icon. 
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4. Arrange the windows on your screen so that both the File Manager file you 
want to drag and the application window or icon you want to move the file 
onto are visible. 

5. Select the file you want. 

6. Press and hold down the left mouse button, drag the file onto the application 
window or icon, and then release the mouse button. 

You can perform the following tasks by dragging File Manager files. 

To 

Create a Program Manager group item 

Open a file in an application 

Move or copy a file to a different drive 

Move or copy a file to a File Manager 
directory 

Print a file on your default printer with the 
default settings 

Drag the file onto 

A Program Manager group window or 
icon. 

The application's icon or title bar. 

A File Manager drive icon. 

A File Manager directory window or 
directory icon. 

The minimized Print Manager window 
(Print Manager running as an icon). 

Note The ability to print and open files by dragging and dropping icons depends 
on the application. Some applications may not support this feature. Check your 
application's documentation to find out whether dragging and dropping are 
supported. 

Receiving a Message from an Inactive Application 
When an inactive application issues a status or error message, the application title 
bar or icon flashes, and you may hear a beep. 

~ To receive a status or error message 

• Select the application window or icon. The message appears. 

Quitting an Application 
There are various ways to quit an application. If you are working on a document 
and you haven't saved your changes, you are prompted to save them. 

~ To quit a Windows-based application, use one of the following methods 

• From the application's File menu, choose Exit. 

• From the Control menu, choose Close. 
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• Press ALT +F4. 

• Double-click the Control-menu box. 

~ To quit an MS-DOS-based application 

• Choose the application's exit or quit command. If you are using MS-DOS 
Prompt, type exit at the command prompt. Tue application closes, and you 
return to Windows. 

When you quit an MS-DOS-based application that is running in a full screen, 
you usually return to the Windows desktop just as you left it. If you return to an 
MS-DOS prompt, type exit. 

Opening and Saving Documents 
This section explains some basic tasks, such as opening, editing, and saving files, 
that are common to many Windows-based applications. 

Note The procedures in this section apply to the applications supplied with 
Windows. Other applications may work different! y. 

Opening Files 
Choosing the Open command from an application's File menu opens a dialog box 
that is often the same regardless of which application you are using. This dialog 
box is designed to save you time because you can select the drive, directory, file, 
and file type from the ones displayed in the list boxes. 

~ To open a file 

1. From the application's File menu, choose Open. The Open dialog box appears. 

File N.ame: 

jhome.txl 

mtgnotes.txt 
review.lxt 
:datrept.br:t 

Q.itectories: 

c:\memos 

!Oc:\ 
~memos 

list Files of I.Jlpe: Driyes: 

~I T_e_••_F_ile_•~C"_. T_X_T~l -~llJ_. I liiil c: chri• Ill 
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Saving Files 

2. If the file you want to open is on a different drive, select the drive you want 
from the Drives list. 

3. In the Directories box, choose the directory you want to open. (Double-click 
the directory.) 

Windows displays the names of all files in that directory that are the type 
selected in the List Files Of Type box. To display a different type of file, 
select the type you want from the List Files Of Type box. 

4. Type the filename, and then choose the OK button. Or double-click the 
filename in the File Name box. 

In many applications, the File menu contains two commands for saving files: Save 
and Save As. You use the Save command to save changes to an existing file. You 
use the Save As command to name and save a new file or to save an existing file 
under a new name. For example, you may want to make changes to a file, yet also 
keep the original file without the changes. By using the Save As command, you 
can save a copy of the original file with a different name. 

~ To save an existing file 

• From the application's File menu, choose Save. 

~ To save a new file or an existing tile under a new name 

1. From the application's File menu, choose Save As. 

2. If you want to save the file on a different drive, select the drive you want from 
the Drives list. 

3. In the Directories box, choose the directory in which you want to save the file. 

4. In the File Name box, type a name for the file. 

If you don't specify a filename extension, the application may add one. For 
example, Notepad adds the extension .TXT to a filename. 

The default extension is shown in the Save File As Type box. To use a 
different extension, select an extension from the Save File As Type list, or 
type an extension. 

5. Choose the OK button. 
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Working with Text 
With many applications, you type text from time to time. The procedures for 
typing text, correcting errors, and editing text are the same for most Windows­
based applications. 

Typing Text 
When you start typing text, an insertion point marks the place where the text 
appears. 

~ To type text in a new document 

• Begin typing the text. Press ENTER to move the insertion point to the next line. 
Press the SPACEBAR to move the insertion point one space to the right. 

~ To type text in an existing document 

• Move the mouse pointer to where you want text to appear, click once, and then 
start typing. Or use the arrow keys to move the insertion point to where you 
want text to appear. 

Note To create a blank line and move the insertion point along that line, use 
ENTER and the SPACEBAR. For example, to type a report title 10 lines from the top 
of a new page and 20 spaces from the left margin, press ENTER 10 times, and then 
press the SPACEBAR 20 times before you type the title. 

Moving Within Text 
You can easily move the insertion point wherever you want within text. 

To move to the 

Next line 

Previous line 

End of the line 

Beginning of the line 

Next screen 

Previous screen 

Next word 

Previous word 

End of the document 

Beginning of the document 

Press 

DOWN ARROW 

UPARROW 

END 

HOME 

PAGE DOWN 

PAGE UP 

CTRL+RIGHT ARROW 

CTRL+LEFT ARROW 

CTRL+END 

CTRL+HOME 
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Correcting Typing Mistakes 
If you make a mistake while typing, you can correct it by using one of the 
methods in the following table. Or, if you need to change more than a few 
characters, you can select the text and edit it. 

To 

Delete the character (or selected text) to the 
left of the insertion point 

Delete the character (or selected text) to the 
right of the insertion point 

Insert characters at the insertion point 

Selecting Text 

Do this 

Press BACKSPACE. 

Press DEL. 

Type the characters. 

You can make changes to blocks of text by selecting (highlighting) the text you 
want to change, and then choosing one of the commands from the application's 
Edit menu. 

Ii>- To select text 

1. Point to the first character you want to select. 

2. Press and hold down the mouse button, and then drag the insertion point to the 
last character you want to select. 

3. Release the mouse button. 

Tip With some applications, you can select a singfo word by double-clicking it. 
Or you can select all the text in your file by choosing Select All from the Edit 
menu. 

Ii>- To cancel the selection 

• Click anywhere in the document. 

The following table shows ways to select text by using the keyboard. Not all 
applications offer all options. In most cases, you can select an area of text by 
pressing and holding down SHIFT while you use standard keystrokes. For 
information about valid key combinations, see your application's documentation. 



To extend the selection to the 

Next word 

Previous word 

Next line 

Previous line 

End of the line 

Beginning of the line 

Next screen 

Previous screen 

End of the document 

Beginning of the document 

Editing Selected Text 
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Press 

CfRL+SHIFI'+RIGHf ARROW 

CTRL+SHIFI'+LEFI' ARROW 

SHIFI'+DOWN ARROW 

SHIFI'+UP ARROW 

SHIFf+END 

SHIFI'+HOME 

SH!Ff+PAGEDOWN 

SHIFI'+PAGE UP 

CfRL+SHIFI'+END 

CTRL+SHIFI' +HOME 

The following table describes ways you can edit selected text. 

To 

Delete the selected text and place it 
onto the Clipboard 

Make a copy of the selected text and 
place it onto the Clipboard 

Replace the text with new text 

Delete the text (not place it onto the 
Clipboard) 

Cancel the previous editing 
operation 

Paste text from the Clipboard into 
the active window · 

Do this 

From the Edit menu, choose Cut. 

From the Edit menu, choose Copy. 

Type the new text. 

Press DEL or BACKSPACE. 

From the Edit menu, choose Undo. 

Place the insertion point where you want the text to 
appear, and then choose Paste from the .Edit menu. 

Transferring Information Between Applications by 
Using the Clipboard 

Information you cut or copy onto the Clipboard remains there until you clear it or 
cut or copy another piece of information onto it, or until you quit Windows. 
Because the information remains on the Clipboard, you can paste the information 
into a document as often as you like. 
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Cutting or Copying Information onto the Clipboard 
The method you use to transfer information onto the Clipboard depends on 
whether you are using a Windows-based or MS-DOS-based application and 
whether it is running in a window or a full screen. For more information about 
cutting or copying information onto the Clipboard from an MS-DOS-based 
application, see Chapter 11, "MS-DOS Applications." 

If you are using a Windows-based application, you can cut or copy selected 
information onto the Clipboard. You can also copy an image of the entire desktop 
or a single window. 

~ To cut or copy information onto the Clipboard 

1. Select the information you want to cut or copy. (For information about 
selecting text in Windows, see "Selecting Text" earlier in this chapter.) 

You can cut or copy text, graphics, or a combination of text and graphics. 

2. From the application's Edit menu, choose Cut or Copy. 

Use the Cut command to remove information from a file and place it onto the 
Clipboard. 

Use the Copy command to place a copy of the information onto the Clipboard, 
leaving the information in its original location as well. 

Copying the Desktop 
Whether Windows is running in 386 enhanced mode or in standard mode, you can 
copy the contents of the desktop onto the Clipboard. When Windows is running in 
standard mode, however, graphics from an MS-DOS-based application are not 
copied onto the Clipboard. 

~ To copy an image of the desktop onto the Clipboard 

• Press PRINT SCREEN. 

Note If pressing PRINT SCREEN does not copy the screen onto the Clipboard, you 
may not have an enhanced keyboard. Try pressing ALT +PRINT SCREEN or 
SHIFf +PRINT SCREEN to copy the screen. 
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Copying the Contents of the Active Window 
To use the following procedure, Windows must be running in 386 enhanced 
mode. 

~ To copy the contents of the active window onto the Clipboard 

• Press ALT +PRINT SCREEN. If you are copying from a Windows-based 
application, a bitmap of the window is placed onto the Clipboard. If you are 
copying from an MS-DOS-based application, the information is placed onto 
the Clipboard as text. The application you want to transfer the information to 
must be able to read bitmap (.BMP) files. See the documentation supplied with 
your application to determine this. 

~ To copy from an MS-DOS-based application running in a window 

Mouse 

1. Drag the mouse pointer across the information you want to copy. 

2. Click the Control-menu box, and the choose Edit from the Control menu. 
The Edit drop-down menu appears. 

3. Choose Copy to transfer the selected information onto the Clipboard. 

Keyboard 

1. Press ALT+SPACEBAR to open the Control menu for the application, and then 
choose Edit from the Control menu. The Edit cascading menu appears. 

2. Choose Mark. A rectangular cursor appears at the upper-left comer of the 
window. 

3. Move the cursor to the first character you want to select. 

4. Press SH!Ff and an arrow key to mark the information you want to copy. 

5. From the Control menu, choose Edit. The Edit menu appears 

6. Choose Copy to transfer the selected information onto the Clipboard. 
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Viewing the Contents of the Clipboard 
When you copy or cut information, it is placed on the Clipboard. You can view 
the contents of the Clipboard by starting Clipboard Viewer. 

II> To view the contents of the Clipboard 

1. Switch to Program Manager. 

2. In the Main group, choose the Clipboard Viewer icon. 

Note Sometimes Windows changes the line length of the information you copy or 
cut so that all of it can be seen in the Clipboard window. When you paste the 
information from the Clipboard into the destination application, however, the 
information is intact. 

The Clipboard accepts a number of text and graphics formats. When you transfer 
information from one application to another, the original application places the 
information onto the Clipboard in all the formats the Clipboard recognizes. The 
application you paste the information into then selects the format that is most 
compatible. To view a list of all the available formats on the Clipboard and to 
view the information in a different format, use the Display menu in Clipboard 
Viewer. 

Pasting Information from the Clipboard 
You can paste information from the Clipboard into an application at any time. 
Make sure the application you want to paste the information into accepts the 
bitmap format if you copied the desktop or a window onto the Clipboard. 
Information you cut or copy onto the Clipboard remains there until you cut or 
copy something else, clear it, or quit Windows. The method you use to paste 
information depends on whether you are pasting into a Windows-based or 
MS-DOS-based application. For information about MS-DOS-based applications, 
see Chapter 11, "MS-DOS Applications." 

II> To paste information into a Windows-based application 

1. Make sure the information you want to paste is on the Clipboard. (For 
information about viewing the CTipboard contents, see the preceding section, 
"Viewing the Contents of the Clipboard.") 

2. Start the application. 

3. Place the insertion point where you want to paste the information. 

4. From the application's Edit menu, choose Paste. 
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Saving the Contents of the Clipboard 
You can save the contents of the Clipboard in a file. You can later retrieve the file 
and paste its contents into an application. You can view the file you save by using 
Clipboard Viewer. 

~ To save the contents of the Clipboard to a file 

1. Switch to Program Manager. 

2. In the Main group, choose the Clipboard Viewer icon, and then choose Save 
As from the File menu. The Save As dialog box appears. 

3. Type a filename for the contents of the Clipboard. The default extension for a 
Clipboard file is .CLP. 

You can also type a path if you want to store the Clipboard file in a different 
directory. 

4. Choose the OK button. 

You can open a Clipboard file and then paste it into any application. Only files 
with a .CLP extension can be opened in Clipboard Viewer. 

~ To retrieve a Clipboard file 

1. Switch to Program Manager. 

2. In the Main group, choose the Clipboard Viewer icon, and then choose Open 
from the File menu. The Open dialog box appears. 

3. Select the .CLP file you want to retrieve, and then choose the OK button. 

Note If the Clipboard already contains information, you are prompted to clear it. 
If you choose the OK button, the current contents of the Clipboard are replaced by 
the contents of the file you specified. 

If you need more memory to run an application, you can clear the Clipboard. 
Since the Clipboard stores information in multiple formats, clearing it might free 
some memory. 

~ To clear the Clipboard 

1. Switch to Program Manager. 

2. In the Main group, choose the Clipboard Viewer icon, and then choose Delete 
from the Edit menu or press DEL. 

3. Choose the OK button. 
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CHAPTER 6 

Online Help 

Online Help in Windows is a convenient, quick way to look up information about 
a task you are performing or a feature or dialog box you would like to know more 
about. 

Help is available whenever you see a Help command button in a dialog box or 
Help as an item on a menu bar. 

The applications and accessories (except Clock) you received with Windows 
include Help, as described in this section. Other Windows-based applications 
and MS-DOS-based applications might also have Help. For information, see the 
documentation for your application. 

Starting Help 
Because Help may be displayed differently, depending on which application you 
are using and what kind of information you need, you can request Help in several 
ways. Not all methods can be used with every application. 
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~ To request Help, use one of the following methods 

• From the Help menu, choose a Help command. 

• Press Fl. Then choose a topic from the Help Contents for the application you 
are using, or search for a topic by using the Search button. 

• Choose the Help button available in many dialog boxes. This method gives 
you quick access to specific information about the dialog box. 

• Use the keyboard to select an item on a menu, and then press Fl to see a 
description of the item (available in certain applications). 

• Select a dialog box option or command, and then press Fl or choose the 
Help button to move directly to an explanation of the option (available in 
PIF Editor, an application included with Windows). 

Tip You can keep Help readily available by resizing the Help window and 
moving it next to the running application. For information about moving and 
sizing windows, see "Working with a Window" in Chapter 4, "Windows Basics." 

Using the Help Menu 
When you choose Help from the menu bar, a list of Help menu commands 
appears. 

~ To get Help by using the Help menu 

1. Choose the Help menu from the menu bar. 

About Paintbrush ... 

2. Choose the menu command you want to use. 

You can find the following standard commands on most Help menus in Windows. 
If this is the first time you've used Help, you may want to choose How To Use 
Help to get started. 



Menu item 

Contents 

Search For Help On 

How To Use Help 

Always On Top 

About application 
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Description 

An alphabetic list of all Help topics available for the active 
application. 

A dialog box for locating information about a specific topic. 

Information about how to use Help. 

When selected, ensures that no other open window on the 
desktop overlaps the Help window. (This command appears 
only on the Help menu in a Help window.) 

Information about the active application, such as copyright, 
version, and application name. Generally, this also includes a 
user name and company name, the mode Windows is running 
in, and the amount of memory available on your computer. 

Note The Help menu in Program Manager also contains a command named 
Windows Tutorial. Choose this command to start an online Tutorial that teaches 
basic mouse and Windows techniques. To use the Windows Tutorial, you need a 
mouse and a VGA (or better) monitor. For information about how to use the 
Tutorial, see "Running the Microsoft Windows Tutorial" in Chapter 3, "A Guided 
Tour of Microsoft Windows." 

Finding Information in Help 
You can find information in Help by using Help Contents or Search For Help On, 
two commands on the Help menu. 

Finding Information by Using Help Contents 
If you are using an application that has Help on the menu bar, you can view all the 
available Help topics. Each application has a unique Help file, so the Help topics 
displayed are for the application you are currently using. 

~ To display Help Contents and choose a topic 

1. From the Help menu, choose Contents or press Fl. 

2. Scroll to the topic you want information about. 

3. Click the topic. Or press TAB until you reach the topic you want, and then 
press ENTER. 
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Finding Information by Using Search 
The Search feature is an efficient way to find the information you need. When you 
have a topic that you want help with, you can use Search to find the information. 

~ To search for a Help topic 

1. From the Help menu in your application, choose Search For Help On. Or press 
Fl to open Help, and then choose the Search button. 

The Search dialog box appears. 

2. Select the word or phrase you want to search for. Or type a word in the text 
box. You do not have to type an entire word; Help matches the characters you 
type as closely as possible with the available keywords. 

3. Double-click the word or phrase, or choose the Show Topics button. A list of 
topics is displayed at the bottom of the dialog box. 

4. Double-click the topic. Or select the topic you want to view, and then choose 
the Go To button. 

Information about the topic you selected appears on your screen. 

Getting Help for a Dialog Box 
Many dialog boxes contain a Help button. 

~ To request Help on a dialog box 

1. While using the dialog box, choose the Help button or press Fl. 

A new window opens that contains a description of the dialog box. If the 
dialog box contains only a few areas, procedural information for the entire 
dialog box is included. More complex dialog boxes have a list of areas to 
select from. 

2. Select the area you want information about. 

A pop-up window displaying procedural information appears. (If the window 
has no Control menu, you can close it by pressing any key or clicking 
anywhere on your screen.) 

Tip It may be helpful to resize and arrange the Help window so that it does not 
overlap the dialog box. In some cases, the smaller the Help window is, the smaller 
the pop-up window is. If you cannot read all the information in a pop-up window, 
enlarge the Help window. For more information, see "Working with a Window" 
in Chapter 4, "Windows Basics." 



Chapter 6 Online Help 103 

Additional Methods 
When you finish reading about a topic, you have several choices. If a list of 
related topics follows the information, you can choose from the list. Or you can 
choose one of the buttons along the top of the Help window. 

Use this button 1-IE"W 
I ... 
1=e I-

To 

View the Help Contents for your application. 

Locate information about a topic (keyword or phrase) you select 
from a list or that you type in the Search For box. 

Retrace your path through the Help topics you've already viewed. 

View a complete, sequential list of every Help topic you have 
viewed during the current Windows session. 

View an alphabetic listing of terms used in Help. 

The following buttons may appear in Help for some applications. 

Use this button To 

View the previous topic in a series of related topics. When you 
reach the first topic in the series, the button appears dimmed. 

View the next topic in a series of related topics. When you reach 
the last topic in the series, the button appears dimmed. 

View an alphabetic list of all Help topics. 

Displaying Glossary Definitions 
In Help, glossary terms have a dotted underline. If you choose a glossary term, a 
definition of that term appears. 

II> To display a glossary definition 

• Choose the term. 

A definition appears. 



104 Microsoft Windows User's Guide 

~ To remove the definition from your screen 

• Click anywhere on your screen. Or press ESC. 

You can also view the entire list of available glossary terms. This list is organized 
alphabetically. 

~ To view the list of glossary terms 

1. From the Help window, choose the Glossary button. 

2. Scroll through the list until you find the term you want to learn about. 

3. Choose the term. 

Quitting Help 
You can quit Help at any time. 

~ To quit Help 

• From the File menu, choose Exit. 
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CHAPTER 7 

File Manager 

File Manager is an application included with Windows that can help you organize 
files and directories on your disk drives. 

This chapter describes how you can use File Manager to perform some common 
tasks, including managing drives, directories, and files and connecting to network 
directories. For a more complete list, see Help for File Manager. 

The File Manager Window 
When you start File Manager from the Main group, the window shown on the 
following page appears. 
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Drive bar 
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Status bar ---11111111111111 
Directory window 

• The directory window is divided by the split bar. The left side of the window 
displays the structure of the current drive, or the directory tree. The right side 
of the window displays a list of files in the selected directory. 

The following table describes the various icons used in the directory window. 

Icon Description 

Displays the contents of the directory one level up in the directory tree. 

Represents a directory. 

Represents an application file. These files start applications or· run 
programs. 

Represents a document file associated with an application. When you 
open this file, the application associated with it starts. 

Represents a system or hidden file. These files have system or hidden 
attributes. 

Represents other document files. 
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• You can use the drive icons on the drive bar to choose what drive is displayed 
in a directory window. You can choose to hide the drive bar. 

• The status bar displays information about the current drive and directory and 
other information that helps explain the task you are performing with File 
Manager. You can choose to hide the status bar. 

• The menu bar contains menus listing File Manager commands. 

Viewing Information in a Directory Window 
File Manager provides many ways to display files. Often, if you are looking for a 
particular file or group of files, it helps to change the way the files are listed or to 
display only the files that fit particular criteria. Also, when you are preparing to 
copy or move a file, it may be useful to display both the file and the directory that 
you will move or copy the file to. 

Opening a New Directory Window 
You can open more than one directory window to display more than one drive or 
directory at a time. Among other things, opening more than one directory window 
enables you to move and copy files by dragging them from one directory window 
to another. For more information about moving and copying files, see "Moving 
and Copying Files and Directories" later in this chapter. 

~ To open a new directory window 

• From the Window menu, choose New Window. 

If you want to open a new window displaying the contents of a different drive, 
you can double-click the drive icon. 

The new window initially has the same display characteristics as the original 
window, but you can change its characteristics independently of other windows. 

Changing the Information Displayed for Each File 
You can change the way files are displayed in the directory window. For example, 
if you want to know when each file was created, you can display all the details 
about each file (including the date) and then sort the files by creation date. Or, if 
you want to see as many files as will fit in the window, you can display only the 
name of each file. The following table describes how you can use the many 
display options. 
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Use the following commands on the View menu to determine what information is 
displayed for each file. 

Use this command 

Name 

All File Details 

Partial Details 

Sort By Name 

Sort By Type 

Sort By Size 

Sort By Date 

By File Type 

To 

Display only the names of files. 

Display the names, sizes, dates and times of creation, and 
attributes of files. 

Display specific information about each file. 

Display files in alphabetic order, based on the filename. 

Display files in alphabetic order, based on the filename 
extension. 

Display files in order of size, from largest to smallest. 

Display files in chronological order. 

Specify which types of files are displayed in a directory 
window. 

To save the new settings when you quit File Manager, choose the Save Settings 
On Exit command from the Options menu. A check mark next to the command 
means it is in effect. 

Note These commands affect only the list of files in the active directory window. 
If the directory window is displaying only the directory tree, the commands do not 
affect the window. 

Updating a Directory Window 
In most cases, File Manager updates open directory windows automatically. 
Sometimes, however, File Manager cannot do this, especially if you are using 
network drives or if you change floppy disks. 

~ To update a directory window 

• Click the icon for the current drive, or choose Refresh from the Window menu. 
You can also press F5. 
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More Ways to View Information in a Directory Window 
For information about the following additional tasks, see "Changing the Look of 
File Manager" in Help for File Manager: 

• Arranging windows and icons 

• Changing views in a directory window 

Looking at Drives, Directories, and Files 
In order to perform tasks with File Manager, you must be able to locate the file or 
directory you want to work with. This section describes how to locate and select 
files and directories. 

Selecting Files and Directories 
You can select one or more files or directories in the list of files when you want to 
copy, move, or delete files or perform other related tasks. You use the same 
methods for selecting files and directories as you do for selecting items in a list 
box. For more information about selecting items in a list box, see Chapter 4, 
"Windows Basics." 

~ To select a file or directory 

• Click the icon. Or press TAB. to move to the list of files, and then use the arrow 
keys. 

~ To selectconsecutive items 

• Click the first item, press and hold down SHIFT, and then click the last item in 
the group. Or select the first item by using the arrow keys, press and hold 
down SHIFT, and then use the arrow keys to extend the selection to the last 
item in the group. 

~ To select or cancel selection of nonconsecutive items 

• Press and hold down CTRL, and click each item. Or press SHIFT +F8, use the 
arrow keys to move to each item, press the SPACEBAR to select it or to cancel 
selection, and then press SHIFT +F8 again. 
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~ To select files with similar filenames 

1. From the File menu, choose Select Files. 

2. In the Files box, specify the type of files you want to select. For example, type 
* .txt to select all files that have a . TXT extension. 

3. Choose the Select button. 

You can repeat steps 2 and 3 to select more groups of files, if you want. 

You can choose the Deselect button at any time to remove from a selection the 
file type currently specified in the Files box. 

Tip You can select all files in a directory by pressing CTRL+SLASH (/). You can 
cancel all selections by clicking any item (without pressing CTRL), or by pressing 
CTRL+BACKSLASH (\). 

Changing Drives and Directories 
The files you want to work with may be on a different drive or in a different 
directory. File Manager enables you to easily view and work with them. 

~ To change the current drive 

• In the drive bar, click the drive icon for the drive you want, or double-click it 
to create a new directory window displaying information for the new drive. 
You can also press and hold down CTRL while typing the letter of the drive 
you want to select. The last method works even if the drive bar is not 
displayed. 

Note When you change drives, File Manager searches the drive to display its 
contents. You can press ESC at any time to stop the search. If you stop the search, 
only a partial directory tree may be displayed, as indicated in the status bar. 

~ To change to another directory 

• Select the directory in the directory tree (or select the directory in the list of 
files) by using the mouse or the arrow keys. 

In the list of files, you can move up one level in the directory structure by 
clicking the Up icon. 
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Viewing Different Directory Levels 
In the directory tree, you can view the subdirectories in a directory by expanding 
the directory. You can also choose not to view subdirectories by collapsing the 
directory. 

When you expand a directory, the names of its subdirectories are displayed in the 
directory tree, as shown in the following example. 

E:ll planning 
/t;Jprograms 
(;;J project1 
E:J project2 

You can expand an entire branch (all levels of subdirectories in a directory), a 
single level of the branch, or all branches on the drive. 

You can collapse a directory so that subdirectories are not shown in the directory 
tree. All directories except the root directory are collapsed the first time you start 
File Manager. 

~ To expand one level of a directory 

• In the directory tree, double-click the icon of the directory you want to expand. 
Or select it by using the arrow keys, and then press ENTER. 

You can also use the following commands on the Tree menu to expand 
directories. 

Use 

Expand One Level 

Expand Branch 

Expand All 

To 

Display the immediate subdirectories of the selected directory. 
Or you can press the PLUS ( +) key. 

Display all the subdirectory levels below the selected directory. 
Or you can press the ASTERISK (*) key. 

Display all the directories and subdirectories on the drive. Or 
you can press CTRL+ASTERISK (*)on the numeric keypad. 
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~ To collapse a directory 

• In the directory tree, double-click the icon of the directory you want to 
collapse. Or select the icon by using the arrow keys, and then press ENTER. 

You can also use the Collapse Branch command on the Tree menu. 

Using Network Directories 
If you are using a network, you can use File Manager to connect to a network 
directory if you know its location (and password, if there is one). With some 
networks, you can browse through all the network directories to find the one you 
want to connect to. You can also disconnect from network directories that you are 
no longer using. If you are not using a network, the network commands are not 
available. 

You should always start the network before you start Windows. If you made 
network connections before you started Windows, the network drive icons for 
these connections appear on the File Manager drive bar. Windows saves any new 
network connections you make and, if you do not disconnect from them, sets up 
the same network connections the next time you start Windows. 

With some networks, you can change settings so that your connections are not 
reestablished each time you start Windows. To change network settings, choose 
the Network icon in Control Panel. For more information, see Help for Control 
Panel. 

Connecting to and Disconnecting from Network Directories 
When you connect to a network directory, File Manager assigns the directory the 
next available drive letter (or you can assign a letter of your choice). This creates 
a network drive, which appears as a drive icon on the File Manager drive bar. 
After you are connected to a network directory, you can use the resulting network 
drive as you would any other drive. 

Note Depending on your network, you may have different commands and dialog 
boxes available to connect to and disconnect from network directories. The 
following procedures are based on your having the Network Connections 
command available. If you have different network commands, such as Connect 
Network Drive and Disconnect Network Drive, substitute those commands for 
Network Connections in the following procedures. If the dialog box for 
connecting to a network directory is different from the one shown in this 
procedure, choose the Help button in the dialog box for more information. 
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~ To connect to a network directory 

1. From the Disk menu, choose Network Connections. 

2. In the Network Connections dialog box, specify the network path, drive 
letter, and password, if any, for the connection. For help with the Network 
Connections dialog box, choose the Help button or press Fl while using the 
dialog box. 

LYou can assign a different drive letter to the network 
directory by opening the Drive list and selecting the letter 
you want. Or you can type the drive letter in the Drive box. 

L You specify the location of the network 
directory by typing its path in this box. 

I New Connection .f 
N_elw01k Palh: L _L 

l Drive: ~:D""=:===Jl1!~-=----=------=--~~ 
Password: [ 

Cunent D1iye Conne~$: 

You choose the Previous 
button to connect to a 
network directory you 
have used before. 

~ ~. ~ t 

"-:If the network directory requires 
a password, type it in this box. 

3. Choose the Connect button. 

With some networks, you 
can use the Browse button 
to find the directory you 
want. 

4. Repeat steps 1 through 3 for each connection you want to make. When you are 
finished, choose the Close button. 

Note The Browse button may appear dimmed if your network does not support 
browsing. 
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~ To disconnect from a network directory 

1. In the Network Connections dialog box, select the directory you want to 
disconnect from in the Current Drive Connections box. 

2. Choose the Disconnect button, and then choose the Close button. 

Note If Windows is running in 386 enhanced mode, you may not be able to 
disconnect from network drives that were active before you started Windows. 

Working with Files and Directories 
You can use File Manager to move, copy, create, delete, rename, and search for 
files or directories. You can also print files from File Manager. 

Moving and Copying Files and Directories 
You can move and copy files and directories from one location (called the source) 
to another (called the destination) either by the drag-and-drop method or by using 
the Copy or Move command. The destination can be a directory window, 
directory icon, or drive icon. 

~ To move or copy a file or directory 

• To move a file or directory to a destination on a different drive, press and hold 
down SHIFT while you drag the item. To move a file or directory to a 
destination on the same drive, drag the item. 

• To copy to a different drive, drag the item to the appropriate drive icon. To 
copy to the same drive, press and hold down CTRL while you drag the item. 

• You can also select the file or directory and then choose Move or Copy from 
the File menu. Then complete the appropriate dialog box. 

Creating Directories 
You can create a directory by using the Create Directory command. 

~ To create a directory 

• From the File menu, choose Create Directory. Then type the new directory's 
path in the Name box. 

Tip To quickly create a subdirectory of an existing directory, select the existing 
directory before you choose the Create Directory command. Then type only the 
new directory's name instead of its path in the Name box. 
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Deleting Files and Directories 
You can delete a file or an entire directory, including all the files and 
subdirectories contained in it. 

~ To delete a file or directory 

• Select the file or directory you want to delete (you can extend the selection to 
include more than one file or directory). Then choose Delete from the File 
menu, or press DEL. 

Renaming Files and Directories 
You can change the names of files, but you must be careful when working with 
system or hidden files. A system file contains information required for running the 
Microsoft MS-DOS operating system. A hidden file is a file not intended to be 
viewed in a directory listing. For example, your Windows swap file is a hidden 
file. If you change the name of a system file, your Windows directory, or any 
initialization (.INI) file used by Windows, your system may not run correctly. 

~ To rename a file or directory 

1. Select the file( s) or directory you want to rename, and then choose Rename 
from the File menu. 

2. The From box contains the name(s) you selected. In the To box, type a 
filename to rename a single file, or use wildcards (* or ?) to rename a group of 
files. For example, type * .bak to affect all files that have the .BAK extension. 
For more information about wildcards, see your MS-DOS documentation. 

Searching for Files and Directories 
If you know a particular file is on your disk, but you don't remember where, you 
can use the Search command to find it. 

~ To search for a file or directory 

1. Select the directory that you want to start the search from, and then choose 
Search from the File menu. 

2. Type a filename, or use wildcards (* or ?) in the Search For box to search for 
a group of files or directories that have related filenames or extensions. The 
Search Results window displays a list of all the files that meet the criteria. 

You can work with the files that appear in the Search Results window in the same 
way you work with files in the directory window. 

To cancel the search, press ESC. To close the Search Results window, choose 
Close from the Control menu. 
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Printing Files 

If you modify information on the drive on which the search was performed, and 
the Search Results window is active (or is made active), a dialog box appears, 
asking whether you want to update the Search Results window. If you choose 
the Yes button, the search is repeated. 

You can print files by dragging the file icons onto the Print Manager application 
icon or window. Some applications do not support printing through File Manager. 
If this is the case, or if a file is not associated with an application, you must open 
the appropriate application and then print the file from there. 

~ To print a file by using File Manager 

• Make sure Print Manager is activated, and then drag the document-file icon 
onto the Print Manager application icon or window. 

Or, in the directory window, select the file you want to print, and then choose 
Print from the File menu. 

For information about activating Print Manager, see Help for Print Manager. 

Note Printing by using File Manager prints the file on the default printer. 

Working with Floppy Disks 
You can use commands on the Disk menu to format floppy disks and copy the 
contents of one disk to another. 

~ To format a floppy disk 

1. Insert a disk in a drive. 

2. From the Disk menu, choose Format Disk. 

3. In the Disk In list, select the letter for the drive you want to format. The other 
parameters are adjusted to match that drive. 

4. Complete the other areas of the dialog box, and then choose the OK button. 

In the Format Disk dialog box, you can use the following options. 

Use 

Label 

Make System Disk 

Quick Format 

To 

Specify the disk label. 

Make the disk a startup disk. 

Format the disk quickly (the disk is not scanned for bad 
sectors). This works only for disks that have been 
previously formatted. 



Chapter 7 File Manager 117 

For more information about formatting a disk, choose the Help button or press Fl 

while using the Format Disk dialog box. 

Caution Be sure you format the correct disk. Unless you are running MS-DOS 
version 5.0 or later, or you have a disk-recovery program, you cannot recover 
information on a disk that is accidentally formatted. 

~ To copy a floppy disk to another floppy disk 

• Insert the source disk in the drive you want to copy from. If you have two 
floppy disk drives of the same size, insert the destination disk in the drive you 
want to copy to. Then choose Copy Disk from the Disk menu. 

Both disks must have the same storage capacity, but you do not need two drives 
of the same storage capacity. If you have only one floppy disk drive of the right 
capacity, Windows prompts you to switch source and destination disks as needed. 

For information about the following additional tasks, see "Managing Floppy 
Disks" in Help for File Manager: 

• Labeling a disk 

• Making a system disk 

More Ways to Use File Manager 
There are many other features that you can use to customize File Manager to fit 
your needs and to perform various tasks. For example, you can start applications 
from File Manager (for more information, see Chapter 5, "Application Basics"). 

For information about the following tasks, see Help for File Manager: 

• Associating files with applications 

• Changing the look of File Manager 

• Managing floppy disks 

• Moving around in File Manager 

• Starting applications 

• Turning off confirmation messages 

• Working with files and directories 





CHAPTER 8 

Print Manager 

Print Manager is an application included with Windows that you can use to 
manage documents sent to a printer. You can also use Print Manager to install 
and configure printers and to connect to network printers. 
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If you print from a Windows-based application, the application creates a print file 
and sends it to Print Manager. Print Manager works in the background, sending 
your documents to the printer while you continue working. You can check the 
status of the document at any time and change its status until it starts printing. 

This chapter describes some of the common tasks you can perform by using Print 
Manager. For a more complete list, see Help for Print Manager. 

Before You Print 
You must do the following before you can print: 

1. Make sure the appropriate printer driver is installed. This is a program that 
enables your printer to communicate with Windows. For each type of printer 
you plan to use, whether it is your own or a printer on the network, you must 
install the appropriate printer driver. 

Generally, you specify a printer when you set up Windows, and the Setup 
program installs the printer driver for that printer. However, if you skipped this 
step during Setup, or if you want to use an additional or different printer, you 
need to perform this step again. For information about how to set up a printer, 
see "Setting Up a Printer" later in this chapter. 

2. If you plan to use a printer on the network, you must connect to that printer. 
For information about how to connect to a network printer, see "Connecting to 
a Network Printer" later in this chapter. 
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Managing Documents 
Most Windows-based applications include a Print command on the File menu 
that you can use to print documents. You can also print a document from File 
Manager by dragging the file's icon onto the Print Manager application icon or 
window. For information about this procedure, see Chapter 7, "File Manager." 

When you print a document from a Windows-based application on your own 
printer (a printer physically connected by a printer cable to your computer), Print 
Manager starts and appears on the desktop as an icon, if it is not already running. 
The icon does not appear when you print on a network printer (a central printer 
that anyone who is using a network can use). 

MS-DOS-based applications that run in Windows print the same way they would 
from MS-DOS. They do not use Windows printer drivers and do not route print 
files through Print Manager, but they can still print on network printers. 

Looking at the Print Queue 

Information for 
your printer 

Information for a 

As you send documents to Print Manager, a print queue forms. Print queues list 
information about the printers that are installed on your system and about the 
documents that are printing or waiting to print. You can view this information by 
enlarging the Print Manager icon to a window or by choosing Print Manager from 
the Main group. 

Message box 

4% of 458K 1 :43 PM 10/19/1991 

network printer OMS-PS 810 on \\PRINTROOM\PRINTER ctive 

Information for {1!11~1 ~co.mJleillnldlo.rl_,s,c•HE'-o-u•L~E-.CA·Lllliililiillll1~3!1K~1 :~12!1P~M~10~/1~9/IJ11§1991Jl1••11 
documents 
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The print queue displays the following printer information: 

• The name of the printer. 

• The port your printer is connected to and, if it is a network printer, the 
network path. 

• The current status of the printer (such as active or idle). 

Beneath the printer information, the print queue displays the following document 
information: 

• The title of the document (some network software may not support this 
feature). 

• The document's position in the queue, or a printer icon if the document is 
printing. 

• The size of the document in kilobytes (if the Print File Size command has a 
check mark next to it). 

• The time and date you sent the document to Print Manager (if the Time/Date 
Sent command has a check mark next to it). If you are connected to a network 
printer, the network time and date are shown, which may differ from your 
computer's time and date. 

• If a document is currently printing, the amount (as a percentage) of the 
document printed so far. 

If you are printing on a network printer from a Windows-based application, Print 
Manager only reports the status of your documents in the network queue. For 
information about viewing every document in a network queue, see "Viewing 
Network Print Queues" in Help for Print Manager. 

Pausing and Resuming Printing 
You can pause your printer or your individual documents on a network printer. 
Pausing your printer stops every document in its queue from printing. Pausing 
a single document stops only that document from printing-other documents in 
the queue will print. After a document has actually started to print, you cannot 
pause it. 
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Use these buttons to 
pause, resume, and 

cancel printing. 

Most networks allow you to pause only the documents you send to a network 
printer. However, your ability to pause the entire network queue depends on the 
features your network supports. 

Q i:s Paused 

~ To pause printing 

1. In the Print Manager window, select the document or the name of the printer 
you want to pause. 

2. Choose the Pause button. Or press ALT+P. 

~ To resume printing 

1. In the Print Manager window, select the document or the name of the printer 
you want to resume printing. 

2. Choose the Resume button. Or press ALT+R. 

Canceling the Printing of a Document 
You can cancel the printing of your document on your own printer or on a 
network printer by deleting it from the print queue. Whether you can cancel the 
printing of other documents on a network printer depends on the capabilities of 
the network. 

~ To cancel the printing of a document 

1. In the Print Manager window, select the document you want to cancel. 

2. Choose the Delete button. Or press ALT +D. A dialog box appears, prompting 
you to confirm the deletion. 

~ To cancel the printing of all documents on your printer 

• From the File menu, choose Exit to quit Print Manager. A dialog box appears, 
prompting you to confirm the deletion. 

Note If you quit Print Manager while a document is printing in graphics mode, 
you might need to turn your printer off and on or use the reset option on your 
printer. 
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Choosing the Default Printer 
Many Windows-based applications use the default printer when you choose the 
Print command . 

..,. To choose a default printer 

1. From the Options menu, choose Printer Setup. 

2. In the Installed Printers list, select the printer you want. 

3. Choose the Set As Default Printer button, and then choose the Close button. 

Tip You can also double-click the printer in the Installed Printers list. 

Note Some Windows-based applications may have a Print Setup command that 
you can use to print to any installed printer. In most cases, selecting a different 
printer does not make it the default printer for all Windows-based applications. 
However, with some applications, the setting for the default printer does change. 
For more information, see the documentation that comes with your application. 

Printing to a File 
If you are planning to merge two files or to print a document at a later time or 
different location, you may want to print a document to a file rather than directly 
to a printer. 

Some applications have an area in their Print dialog box in which you can specify 
printing to a file. If your application does not support this feature, you can print 
your document to a file by specifying FILE as the port in Print Manager. For more 
information, see "Setting Up a Printer" later in this chapter. 

Printing Through MS-DOS 
When you print in Windows, documents are sent directly to the port your printer 
is connected to, bypassing MS-DOS printing interrupts. This speeds up printing 
and is the recommended method to use. 

However, in the following situations you may want to print by using MS-DOS 
interrupts: 

• You are using additional printer software that relies on MS-DOS interrupts 
(such as software that accompanies switch boxes). 

• You are trying to print on a network not supported by Windows. 

• You are trying to print to a serial printer and are using a terminate-and-stay­
resident (TSR) program that takes direct control of the COM port. 
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Printing through MS-DOS may slow down printing, but it ensures that in these 
cases your files print correctly. 

~ To print through MS-DOS 

1. From the Options menu, choose Printer Setup. 

2. In the Printers dialog box, choose the Connect button. 

3. In the Connect dialog box, clear the Fast Printing Direct To Port check box, 
and then choose the OK button to return to the Printers dialog box. 

4. Choose the Close button. 

Connecting to a Network Printer 
If you are using a network and want to print to a network printer, you can use 
Print Manager to connect to the printer. 

When you connect to a network printer, you specify the location of the printer, a 
password, if one is required, and a port name, such as LPT2 or LPT3. Before 
connecting to a network printer, make sure that you have installed the printer 
driver for the network printer and that the printer is assigned to the port that you 
want to use for the network connection. For more information about installing a 
printer driver, see "Setting Up a Printer" later in this chapter. 

Note Depending on your network, you may use different commands and dialog 
boxes to connect to and disconnect from network printers. The following 
procedures are based on your having the Network Connections command and 
dialog box available. If your network provides different commands, such as 
Connect Network Printer and Disconnect Network Printer, substitute those 
commands for Network Connections in the following procedures. If the dialog 
box for connecting to or disconnecting from a network printer is different from 
the one shown in this procedure, choose the Help button in the dialog box for 
more information. 
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... To connect to a network printer 

1. From the Options menu, choose Network Connections. 

2. In the Network Connections dialog box, specify the network path, port, and 
password, if any, for the connection. For help with the Network Connections 
dialog box, choose the Help button or press Fl while using the dialog box. 

You specify the location of the network 
printer by typing its path in this box. 

You can assign a different port to the 
network printer by opening the Port 
list and selecting the port you want. 
Or you can type the port in the box. 

New Connection--+---+----~ 
You choose the Previous 
button to connect to a 
network printer you have 
used before. 

J!etwork Path: 

Po1l: 

Pas:a:!!ord: 

3. Choose the Connect button. 

If the network printer requires 
a password, type it in this box. 

With some networks, you 
can use the Browse 
button to find the printer 
you want. 

4. Repeat steps 1 through 3 for each connection you want to make. When you are 
finished, choose the Close button. 

Note The Browse button may appear dimmed if your network does not support 
browsing. 

... To disconnect from a network printer 

1. In the Network Connections dialog box, select the printer you want to 
disconnect from in the Current Printer Connections box. 

2. Choose the Disconnect button, and then choose the Close button. 
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Setting Up a Printer 
If you did not set up a printer when you set up Windows, the Print Manager 
window is empty and you cannot print. You can set up printers by using Control 
Panel or Print Manager. 

It is recommended that you read the PRINTERS.WRI online document, which 
contains information about specific printers, before you set up a printer. 

Note The Printers option in Control Panel provides the same method for setting 
up a printer as the Print Manager method described in the following sections. 

~ To set up a printer 

1. From the Options menu, choose Printer Setup. 

2. Choose the Add button to display the List Of Printers box if it is not already 
displayed. 

3. In the List Of Printers box, do the following. 

Double-click If 

The model name of your printer 

The PostScript version of your printer 

The printer that your printer emulates 

The printer that your Postscript cartridge 
emulates 

Postscript Printer 

Install Unlisted or Updated Printer 

Generic/Text Only 

Your printer is listed and does not 
emulate another printer. 

Your printer uses a Postscript 
cartridge that does not emulate another 
printer. 

Your printer is not listed but emulates 
a listed printer. 

Your printer uses a PostScript 
cartridge that emulates a listed printer. 

Your printer is not listed, does not 
emulate a listed printer, but is 
PostScript-compatible. 

You have a disk from your printer 
manufacturer that contains a Windows 
printer driver for your printer. 

Your printer is not listed and is a 
daisy-wheel printer or a text-only 
printer. 

Depending on the choice you make, you may be required to insert one of the 
installation disks contained in the Windows package, a disk provided by your 
printer manufacturer, or, if you are not a United States customer, the additional 
Non-USA Printer Drivers disk that comes with your Windows package. 
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Note If you choose the name of a printer that your printer emulates, your 
printer must be set to operate in the appropriate emulation mode. Make sure 
that you set the proper DIP-switch settings or menu settings on your printer. 
For more information, see your printer documentation. 

4. If you want to change the port that is assigned to your printer, select the printer 
in the Installed Printers list, and then choose the Connect button. In the dialog 
box that appears, select the port that you want to assign to your printer. 

Following is a description of the types of ports available. 

Port Description 

LPT A parallel port. 

COM A serial port. 

EPT Used for the IBM Personal Pageprinter. This port requires that a special 
card be installed in your computer. 

FILE Prints to a file instead ofto a printer. If the application you are working 
with supports this feature, you can print to a file even if you don't select 
this option. 

If you select a COM port, you might want to make sure that the 
communications settings for the port match those required by your 
printer. You can choose the Settings button to determine this. For help 
with the Settings dialog box, choose the Help button or press Fl while using 
the dialog box. 

If the printer is a network printer, choose the Network button to connect 
to it. For more information about connecting to network printers, see 
"Connecting to a Network Printer" earlier in this chapter. 

Choose the OK button to close the Connect dialog box. 

5. If you want to make this printer the default printer, double-click the printer in 
the Installed Printers list. Or select the printer, and then choose the Set As 
Default Printer button. 

6. Choose the Close button. 

If none of the printers listed in the Printers dialog box is appropriate for your 
printer, you have two choices: 

• Contact your printer manufacturer for a printer driver that works with 
Windows. 

• Request information about additional drivers included on the Windows Driver 
Library (WDL) disk. Microsoft adds drivers as they become available. For 
more information, see "The Windows Driver Library" in Chapter 13, 
"Configuring Hardware." 
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If you are using MS-DOS-based applications in 386 enhanced mode, you can use 
the 386 Enhanced option in Control Panel to control what happens when several 
applications compete for access to a printer port. For more information, see Help 

. for Control Panel. 

There are more procedures to help you set up printers. For information about the 
following additional tasks, see "Setting Up a Printer" in Help for Print Manager: 

• Selecting timeout options 

• Selecting printer settings 

Removing an Installed Printer 
If you are no longer using a printer, you can remove it from the Installed Printers 
list in the Printers dialog box. 

~ To remove an installed printer 

1. From the Options menu, choose Printer Setup. 

2. From the Installed Printers list, select the printer you want to remove. 

3. Choose the Remove button. A dialog box appears, prompting you to confirm 
the removal. 

4. Choose the Close button. 

Removing a printer from the Installed Printers list does not remove the printer 
driver from your hard disk. This is because another printer may use the same 
driver. Similarly, removing the printer does not remove any associated fonts 
from memory. For information about removing fonts, see Chapter 12, 
"Customizing Windows." 

More Ways to Use Print Manager 
There are many other features that you can use to customize Print Manager to fit 
your needs and to perform various tasks. For information about the following 
tasks, see Help for Print Manager: 

• Changing the print order 

• Deactivating Print Manager 

• Displaying Print Manager messages 

• Giving Print Manager priority 

• Printing on a network 
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CHAPTER 9 

Accessories 

Calculator 

• 

Windows includes accessories that you can use to perform many everyday tasks. 
The following list briefly describes how to use the accessories: 

• Use Media Player and Sound Recorder to play or record sound files and work 
with other multimedia devices. 

• Use Calculator, Calendar, Cardfile, and Clock to manage personal information. 

• Use Write, Notepad, Paintbrush, and Character Map for publishing or writing 
tasks. 

• Use Terminal to communicate with another computer through a modem. 

• Use Recorder to record keystrokes or mouse actions to play back later. 

This chapter introduces the accessories (in alphabetic order). Procedures for 
performing tasks are provided in online Help. To view Help, choose the Contents 
command from the Help menu. 

To start an accessory, choose an icon in the Accessories group. For information 
about starting accessories, see Chapter 4, "Windows Basics." 

Calculator includes both a standard and scientific calculator. You can use the 
standard calculator to do simple calculations and then store them in memory. You 
use the scientific calculator to do advanced scientific and statistical calculations. 
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Use these buttons 
to edit the numbers 

in the display. 

Use these 
buttons to use 

memory features. 

When you start Calculator for the first time, the standard calculator appears. 

Th' ·s where Calculator 
ays numbers . displ L ISi 

. ' 
fdit ~iew l:!elp _j_ 

I o.J 
--1 [D0( Back] D 
§) 000 GJ ~ 
~00000 --1 

§JCD0CDDG.8 
~ 

~CDGJDGJCJ = 
f- These are the basic 

mathematical operators. 

For information about the following tasks, see Help for Calculator: 

• Performing calculations 

• Using Calculator memory 

• Using Calculator with the Clipboard 

• Using the scientific calculator 

• Working with different number systems 

• Using advanced functions (operators, number-base functions, advanced 
statistical functions) 
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SJ 
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Calendar combines a month-at-a-glance calendar and a daily appointment book. 

s .fZ__ cro arrows 
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8:00 
9:00 
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11:00 
12:00 PM 
1:00 
2:00 
3:00 
4:00 
5:00 I Insertion point 
6:00 
7:00 
8:00 

- t- Scratch pad 

For information about the following tasks, see Help for Calendar: 

• Entering appointments 

• Moving to appointments 

• Printing appointments 

• Setting and removing appointments 

Cardfile is similar to a set of index cards. You can use it to keep track of names, 
addresses, phone numbers, directions, or anything else you want quick access to. 
If you have a modem, you can dial a telephone number that is typed on a Cardfile 
card. 
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Use the index line 
to label each card. -I 

You can also copy, link, or embed information into Cardfile. For example, on a 
card that shows a client's name, address, and telephone number, you could add a 
picture (a bitmap image) of the client. Or you could add an icon that, when 
chosen, opens and displays the picture. For more information about linking and 
embedding objects, see Chapter 10, "Object Linking and Embedding." 

file ~it l,liew J;.ard Search ~Ip 
Card View - 1 Card 

\ 
t--

~lixt ar t h in rti n e appe sate se o 
point when you type. 

Use the scroll 
arrows to move 
forward or backward 
through the cards. 

For information about the following tasks, see Help for Cardfile: 

• Filling in and adding cards 

• Viewing cards as a list 

• Moving through your cards 

• Editing text on cards 

• Embedding or linking an object 

• Restoring or deleting a card 

• Duplicating a card 

• Printing a Cardfile file 

• Using automatic dialing 
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Character Map 

• Character Map displays all the characters, including extended and special 
characters, that you can use with the selected font in your Windows-based 
application. Character Map also displays the keystrokes you can use to create a 
selected character within your application. 

You can use Character Map only with Windows-based applications. If you are 
running an MS-DOS-based application, check its documentation to find out how 
to insert special characters. 

Choose the Copy button 
Ava 
are 

ilable fonts~ 
listed here. 

to copy these characte~ ~ 
onto the Clipboard. Copy button~ 

These are the { 
available characters 
in the selected font. 
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7 This box shows what keys to press 
to create the selected character. 

For information about the following tasks, see Help for Character Map: 

• Selecting a font 

• Inserting a character into a document 

• Using keystrokes to create selected characters 

Clock helps you keep track of time. You can display an analog or digital clock. 
You might find it useful to add Clock to your StartUp group, so that Clock is 
running every time you start Windows. 
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Media Player 

• Using Media Player, you can play multimedia files and control hardware devices. 
For example, you can use Media Player to play sound files through a sound card. 
If you have an audio compact-disc player or videodisc player connected to your 
computer, you can use Media Player to start and stop them. 

Media Player can play digitized sounds created by Sound Recorder or Musical 
Instrument Digital Interface (MIDI) devices. 

Before Media Player can play a file, you must have the sound hardware and its 
driver installed and configured. For information about installing hardware drivers, 
choose the Drivers icon from Control Panel, and then choose the Help button. 

To play a multimedia file (sound or animation) or device (such as a videodisc 
player), you must first choose the type of device you want to use. For information 
about setting up your device, see Chapter 13, "Configuring Hardware." If the 
device requires a file to play, you must also open the file. Some devices, such as 
audio compact-disc players, do not require a file. 

Use the scroll bar to start 
playing at another part of the file. 

Elle 

Eject 

For information about the following tasks, see Help for Media Player: 

• Specifying a media device 

• Playing a media file 

• Changing and positioning the scale 



Notepad 

Paintbrush 

The Toolbox contains 
the tools you use to 

create or change 
a drawing. 
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Notepad is a text editor. You can use Notepad to create notes, write short memos, 
and create and edit batch files. Notepad creates files by using the ASCII format 
and has none of the features used for formatting a document. 

For information about the following tasks, see Help for Notepad: 

• Setting word wrap 

• Searching for text in Notepad 

• Managing Notepad files 

• Printing a Notepad document 

Using Paintbrush, you can create simple or elaborate, black-and-white or color 
drawings. After you've created a drawing, you can print it or use it in another 
document. For information about using Paintbrush drawings in other documents, 
see Chapter 10, "Object Linking and Embedding." 

The Linesize box contains 
the available drawing widths. 

The drawing area is where 
you create or change a drawing. 

\ The Palette contains colors and 
patterns you can use in a drawing. 
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You use the tools in the Paintbrush Toolbox to create and change drawings. The 
following list provides a brief description of each tool's function. 

Color Eraser -

Paint Rol!er- -Brush 

Curve- c;? /-Line 

Box - D Ill -Filled Box 

Rounded Box- 0 •-Filled Rounded Box 

Circle/Ellipse- Q 8 -Filled Circle/Ellipse 

Polygon - "l '\. -Filled Polygon 

This tool 

Scissors 

Pick tool 

Airbrush 

Text tool 

Color Eraser 

Eraser 

Paint Roller 

Brush 

Curve 

Line 

Box 

Filled Box 

Rounded Box 

Filled Rounded Box 

Circle/Ellipse 

Filled Circle/Ellipse 

Polygon 

Filled Polygon 

Does this 

Defines an area to cut, copy, or change. 

Defines a rectangular area to cut, copy, or change. 

Creates a circular spray of dots. 

Adds text to your drawing. 

Changes colors in all or part of a drawing. 

Changes foreground colors to the selected background color. 

Fills any closed shape or area with color. 

Draws freehand shapes and lines. 

Draws curved lines. 

Draws straight lines. 

Draws hollow squares and rectangles. 

Draws squares and rectangles filled with color. 

Draws hollow round-cornered squares and rectangles. 

Draws round-cornered squares and rectangles filled with 
color. 

Draws hollow circles and ellipses. 

Draws circles and ellipses filled with color. 

Draws polygons from connected straight lines. 

Draws polygons filled with color. 

Unlike the other accessories, Paintbrush makes use of both mouse buttons. Help 
for Paintbrush specifies when to use the right mouse button. If no button is 



Recorder ... 
~ 
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specified, use the left mouse button. For information about performing tasks with 
Paintbrush, see Help for Paintbrush. 

Using Recorder, you can record a sequence of keystrokes and mouse actions­
called a macro-to play back at a later time. You can use macros to automatically 
type a special phrase or code that you use frequently or to automate the steps of a 
task you routinely perform. For example, you could record the steps you go 
through to switch to the Main group in Program Manager, choose the MS-DOS 
Prompt icon, change to the MS-DOS directory, and start a text editor. When you 
run this macro, it performs these steps for you. 

For information about the following tasks, see Help for Recorder: 

• Recording a simple macro 

• Playing back a macro 

• Setting permanent preferences 

• Creating macros to use as demos 

Sound Recorder 
A You can use Sound Recorder to play, record, and edit digitized sound files. 

To play sound files, you must have a sound card and its driver installed and 
configured. To record sound files, you must also have a microphone installed. 
For information about hardware drivers, see Chapter 13, "Configuring Hardware." 

The Wave box displays the sound 
as if it were being shown on an oscilloscope. 

Use the scroll bar to move 
to any point in a sound file. 

Record 
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Terminal 

• 
Write 
~ 

For information about the following tasks, see Help for Sound Recorder: 

• Creating and editing a sound file 

• Playing a sound file 

• Linking and embedding sound files 

Using Terminal, you can connect your computer to other computers and 
exchange information through a modem. For example, you can connect to online 
information services, such as Dow Jones News/Retrieval, and to online bulletin 
boards, such as CompuServe. 

To run Terminal, you must have a Hayes or Hayes-compatible modem installed 
on your computer. For information about performing tasks with Terminal, see 
Help for Terminal. 

Write is a word-processing application that you can use to create and print 
documents for business and personal use. When you create Write documents, 
you can type, edit, and format text in the Write window; insert graphics; save the 
text and graphics as a file; and print your documents. 

Write also supports object linking and embedding (OLE). For more information, 
see Chapter 10, "Object Linking and Embedding." 

L_ The end mark indicates the end of the document. 

Text appears at •.•• 1.•1. •••l!!l!llllllllDl••••••••lll the insertion point E•IOZ fd1t Find J;.haracter f'aragraph Qocument Help 

when you type. -11-1'/ 

The page-status area ~ 
indicates which page --llllllll•••llll••··············· of text is displayed. • ' · 

~The mouse pointer indicates where the insertion point 
will move to if you click a location in the document. 

For information about performing tasks with Write, see Help for Write. 
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Getting the Most Out of 
Windows 





CHAPTER 10 

Object Linking and Embedding 

In Windows, you can use a feature called object linking and embedding (OLE) 
to transfer and share information between Windows-based applications and 
accessories. When you use OLE, you can view and use different forms of 
information in a single document. For example, rather than switching between 
applications, you can view and even work on a Microsoft Excel spreadsheet or 
a Paintbrush bitmap right from a Microsoft Word for Windows document. 

Paintbrush, Sound Recorder, Write, Cardfile, and Object Packager all support 
OLE and are included with Windows. Many other Windows-based applications 
support OLE. Check the documentation supplied with your applications to 
determine whether they support OLE and how to use their OLE features. 
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This chapter provides an introduction to OLE. Some procedures are provided as 
examples, using the Paintbrush and Write applications. For more comprehensive 
information about using the OLE features of Paintbrush and Write, see Help for 
each of these applications. 
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What Is Object Linking and Embedding? 
To understand object linking and embedding, you need to be familiar with the 
following terms and concepts: 

• An object is a piece of information such as a chart, a spreadsheet, a drawing, 
or text that can be linked or embedded. 

• A source document is the document in which the object originates. For 
example, if you use Microsoft Excel to create a spreadsheet and then use 
that spreadsheet or part of it in another document, the original spreadsheet 
is the source document. 

• A destination document is the document into which you place an object. For 
example, if you use part of a Microsoft Excel spreadsheet (as in the previous 
example) in a Word document, the Word document is the destination 
document. 

• An embedded object is an object in a destination document that is a copy of 
information that was created in another application. By choosing an embedded 
object-for example, by double-clicking it-you start the application that 
was used to create it, without switching away from the document you're 
working in. 

For example, suppose you are creating a memo by using Write and you want 
to use a drawing of your company logo at the top of the memo. The drawing 
has been created by using Paintbrush, so you can embed the drawing in your 
Write document. After it is embedded, making changes to it is easy-you 
choose the embedded object, and Paintbrush starts, displaying the object. 

After it is embedded, an object is no longer connected to the source document. 
Changes you make to the object do not affect the source document. 

• When you create a linked object, you establish a link between the 
destination and source documents. Although the linked object is displayed 
in the destination document and you can print the object, the data that makes 
up the object resides only in the source document. When you make changes 
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to a linked object, you are actually changing the information in the source 
document. When you make changes in the source document, the changes 
appear in the destination document (updating the linked object). 

Note You can control whether a linked object is updated manually or 
automatically. For more information, see "Maintaining Links" later in this 
chapter. 

By choosing a linked object-for example, by double-clicking it-you start 
the application that was used to create it, without switching away from the 
document you're working in. 

For example, suppose you are writing a chapter of a book by using Word for 
Windows. Someone else is creating the artwork for your chapter by using 
Paintbrush. You can create a link between the Paintbrush artwork and your 
Word document so that any changes to the artwork are automatically reflected 
in your document. 

The procedures you use for embedding and linking objects are generally similar to 
the procedures you use for copying and pasting information. The end result 
depends on the application that was used to create the information you are using. 
If the application supports OLE, then following the procedures in this chapter will 
result in an embedded or linked object. If the application does not support OLE, 
then following these procedures will result in static copies of the information. 

Embedding an Object 
The way you embed an object depends on the type of object it is and whether the 
object has already been created. 

Note Different applications may use different menu commands for object linking 
and embedding. For information about embedding an object by using a specific 
application, see the documentation supplied with the application. 
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You can embed an object by starting from either the source or destination 
document. The following illustration shows an example of both methods of 
embedding. 

Use the Insert Object command to 
embed the Paintbrush object into 
the Write document. 

The Write file, SAMPLE.WR!, 
is the destination document. 

~·•'---11- After you choose the Update 
command in Paintbrush, the 
embedded object appears. 

The Paintbrush file, 
WINDOWS.BMP, is 
the source document. 

fdH lliew !ext Pick J!.ptions !!elp 

Use the Update command --fll2Pllm•nl!li.!ll .......... ----- ------ -----
to embed the object. save As .. . 

This isa 
Paintbrush 

Page Sejup ... 
frlnt ... 
Print Setup ..• 

object. ---lll:rl=-it-------;-
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The following procedure describes one way of embedding a Paintbrush object in a 
Write document. 

.,. To embed a Paintbrush object, starting from Write 

1. Open the Write document in which you want to embed the object. 

2. Place the insertion point where you want the object to appear. 

3. From the Edit menu, choose Insert Object. A dialog box appears, listing all 
the applications on your computer that support OLE. 

Note Some applications have a Paste From command on the Edit menu that 
you can use to open the document containing the drawing you want to embed 
as an object. 

4. Select Paintbrush Picture, and then choose the OK button. 

5. In the Paintbrush window, create a drawing. Or open the document that 
contains the drawing you want to embed. 

6. From the File menu in Paintbrush, choose Update. This embeds the 
Paintbrush object into the Write document. 

7. From the File menu in Paintbrush, choose Exit & Return To (name of 
document). Paintbrush closes and you return to the Write document. 

Editing an Embedded Object 
You can edit an embedded object from within its destination document. The 
following procedure describes how to edit a Paintbrush object that has been 
embedded in a Write document. 

.,. To edit an embedded Paintbrush object from within a Write document 

1. In the Write document, choose the embedded object. Paintbrush opens, 
with the object displayed. 

2. Edit the object as needed. 

3. From the File menu in Paintbrush, choose Update. 

The embedded object is updated in the Write document. 

4. From the File menu in Paintbrush, choose Exit & Return To (name of 
document). Paintbrush closes and you return to the Write document. 
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Linking an Object 
The way you link an object depends on the type of object it is. 

Note Different applications may use different command names for object linking 
and embedding. For more information about linking an object by using a specific 
application, see the documentation supplied with the application. 

From a single source document, you can create links to more than one destination 
document. Any changes you make to a linked object in a destination document 
appear in the source document and in every destination document that contains a 
link to that object. 

Note You can control whether a linked object is updated manually or 
automatically. For more information, see "Maintaining Links" later in this 
chapter. 

You can link objects only from saved documents. For example, if you open 
Paintbrush and create a drawing, you must save it as a file before you can link the 
drawing to another document. 
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The following illustration shows how to link a Paintbrush object to a Write 
document. 

Copy the saved object onto the 
Clipboard by using the Copy 
command in the source document. 

This is the source document. 

This is the destination document, 
which now contains the linked object. 

•.1-

After an object has been 
copied onto the Clipboard, 
you link it to your destination 
document by choosing 
the Paste Link command. 
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The following procedure describes how to link a Paintbrush object to a Write 
document. 

~ To link a Paintbrush object to a Write document 

1. In Paintbrush, open the document that contains the drawing you want to link. 
Or create a drawing. 

2. If you've created a drawing or made any changes to an existing drawing, save 
the drawing. 

3. Use the Pick tool to select the drawing. 

4. From the Edit menu, choose Copy. A copy of the drawing is placed onto the 
Clipboard. 

5. Start Write and open the document to which you want to link the drawing. 

6. Place the insertion point where you want the object to appear. 

7. From the Edit menu in Write, choose Paste Link. 

Some applications have a Paste Special command that, when chosen, displays 
a list of formats. You can choose which format you want the information 
displayed in. 

The linked object appears in your Write document. 

Editing a Linked Object 
Any changes you make to a linked object in a destination document appear in the 
source document and in every destination document that contains a link to that 
object. 

The following procedure describes how to edit a Paintbrush object that is linked 
to a Write document. 

~ To edit a linked Paintbrush object from within a Write document 

1. In the Write document, choose the linked object. Paintbrush opens, with the 
source document displayed. 

2. Edit the object as needed. The linked object in the Write document is updated 
as you make your changes. 

3. In Paintbrush, choose Save from the File menu. 

4. From the File menu, choose Exit. Paintbrush closes and you return to the Write 
document. 
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Maintaining Links 
After you create a linked object in a destination document, you can do the 
following: 

• Control whether the linked object is updated manually or automatically. 

• Create multiple links to the same object. 

• Cancel or delete a link. 

• Restore a broken link. 

• Change the format of an object. 

The following sections generally describe these tasks. For more information about 
performing these tasks by using a specific application, see the documentation 
supplied with the application. 

Controlling How Linked Objects Are Updated 
You can update a linked ob.iect either automatically or manually. A linked object 
in a destination document that is updated automatically is updated whenever the 
object in the source document changes. By default, linked objects are updated 
automatically. If you specify that a linked object is to be updated manually, the 
object in the destination document does not change when the object in the source 
document changes, but only when you choose to update it. 

Some applications have a Links command that, when chosen, displays a dialog 
box containing a list of existing links; you can then specify how a linked object is 
updated. Sound and animation objects are always updated automatically when 
you save changes to the source document. 

Creating Multiple Links 
There are two ways to create multiple links to an object. You can create each link 
by using the procedure described earlier in this chapter, or you can copy an 
existing linked object from a destination document. The result is the same­
multiple destination documents will contain links to the object in the source 
document. You can edit the object from any document that contains a link to the 
source document, or you can change the source document without opening a 
destination document. Either way, the changes are reflected in every document 
that contains a link to the source document. 

To copy a linked object, select the object in one destination document, and then 
copy it onto the Clipboard. Then paste the object from the Clipboard into the 
document in which you want it to appear. 
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Canceling or Deleting a Link 
Many applications have a Links command that opens a dialog box from which 
you can cancel or delete existing links. 

You can cancel a link so that an object in a destination document no longer retains 
a link to the object in the source document but exists as a static copy. After you 
cancel a link, changes made in the source document no longer appear in the 
destination document, and you can no longer make changes to the source 
document from the destination document. The object still exists in both the 
source and other destination documents. 

To edit an object in a destination document after you cancel a link, you must 
cut and paste it into the application that was used to create it, make your changes, 
and then copy and paste the object back into the destination document. 

Deleting a link is different from canceling a link because both the link and the 
object itself are removed from the destination document. To delete a link, select 
the linked object in the destination document, and then cut it from the document. 

Restoring a Broken Link 
If you change the name of a source document that contains linked objects, the 
links between the destination document and those objects break because they 
refer to a filename that no longer exists. From the destination document, you must 
change the name of the document that the object is linked to so that the link will 
work properly again. 

Some applications have a Links command that, when chosen, displays a dialog 
box containing a list of existing links; you can then specify the name of the source 
document that the selected object is linked to. 

Note If for any other reason a link no longer works, try choosing the object again 
to open the source document. If the link still does not work, you may need to 
delete the linked object from the destination document and try linking it again. 

Changing the Format of an Object 
Because information is stored on the Clipboard in a variety of formats, you can 
transfer and share information between applications that use different formats. 
For example, on the Clipboard you can store a Paintbrush picture, unformatted 
text, or a document in Word for Windows format. 
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When you use the Copy command to place information onto the Clipboard, the 
source application sends the information in more than one format. When you 
paste the information from the Clipboard, the destination application selects a 
format that it can use. 

You can change the format that the destination application selects from the 
Clipboard by using the Paste Special command. For example, you might select a 
particular format if you know that people using the destination document have 
an application that can read only one format. When you choose the Paste Special 
command, a dialog box appears, listing other available formats for the 
information currently on the Clipboard, with the default format for the Paste 
command selected. You can select a different format and then choose the Paste 
button to paste or embed the object, or the Paste Link button to link it. (With some 
formats, choosing the Paste button may paste the object rather than embed it.) 

Choosing the Paste button from the Paste Special dialog box without selecting a 
different format is the same as choosing the Paste command directly from the Edit 
menu. 

Note Not all applications provide the Paste Special command. Write and 
Cardfile, both applications that support object linking and embedding, provide 
this command as described. Check your application's documentation to see how 
the Paste Special command is used. 

Using Object Packager 
There is another way to embed or link objects. Instead of embedding or linking 
the object in the form in which it was created, you can use Object Packager, an 
application in the Accessories group, to embed an icon that represents the object. 
This icon is called a package. A package can contain either an embedded object 
or a link to a document, but a package itself is always embedded. 

A package has the same properties as any embedded object. When you choose a 
package, the object it contains is displayed (as in the case of text or a Paintbrush 
object) or played (as in the case of a sound object). 

For example, suppose you are writing a report that refers to survey results on your 
topic. You want the survey results to be available to those who are interested, but 
easy to skip over for those who are not. Placing the results as a package in the 
context of your report makes the information easily accessible but not actually 
part of the text. To view the survey results, you simply open the package by 
choosing it. 
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Object Packager is also useful if you've embedded or linked a range of 
spreadsheet cells into a text document. You can package the cells so that 
they appear as an icon instead of as a range of cells within your text. 

You can use Object Packager to: 

• Package information into an object so that you can embed it in a destination 
document. 

• Package an MS-DOS command line into an object so that it can be embedded 
and run from within a destination document. 

• Customize the icon and label of the packaged object. 

For more information about Object Packager, see Help for Object Packager. 
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MS-DOS Applications 

MS-DOS-based applications are designed to run with MS-DOS but not 
specifically with Windows. Most MS-DOS-based applications can run with 
Windows nonetheless. These applications are also sometimes referred to as 
non-Windows applications. 
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To run an MS-DOS-based application in the most efficient way, you may need to 
supply Windows with more information about the application. You do this by 
using a program information file (PIF). A PIF contains information about an 
MS-DOS-based application, such as how much memory it needs and how it uses 
various system components. 

Windows provides PIFs for many common MS-DOS-based applications, in 
addition to a default PIF with settings that work for most applications. If 
Windows does not provide a PIF and the settings in the default file do not 
work with your application, you need to create a PIF. You do this by using PIF 
Editor, an application in the Main group. 

This chapter explains what you need to know about setting up and running 
MS-DOS-based applications, describes how to use PIFs, and introduces PIF 
Editor. For more information about PIF Editor and all its options, see Help for PIF 
Editor. 

Setting Up an MS-DOS Application 
You set up an MS-DOS-based application to run with Windows just as you would 
other applications, by using Program Manager, File Manager, or Windows Setup. 
Regardless of which method you use, Windows sets up a PIF for the application. 
This section describes using the Setup program. For information about using 
Program Manager or File Manager to set up an application, see "Creating a 
Program Item" in Chapter 5, "Application Basics." 
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When you run the Setup program to install Windows, you can choose to have 
Setup search your hard disk for applications you have installed and create a PIP 
and an icon for each application. Setup gets the information it needs for each 
PIP by using information provided by Windows. 

When you set up an MS-DOS-based application after Windows is set up, the 
Windows Setup program searches your hard disk for a PIP to use with the 
application. If it finds one, it sets up the application and the PIP to work together. 
If Setup doesn't find a PIP and there is no information available to create one, 
Windows uses the default PIP, named _DEFAULT.PIP, when you start the 
application. 

... To set up an MS-DOS-based application after Windows is set up 

1. In the Main group, choose the Windows Setup icon. 

2. From the Options menu, choose Set Up Applications. 

3. Select one of the two option buttons, depending on whether you want the 
Setup program to search your hard disk for applications or whether you want 
to specify an application. Then choose the OK button. 

4. If you selected Search For Applications, a dialog box appears, prompting you 
to select the MS-DOS path or individual drives that Setup should search. 
Select Path to search the directories specified by the path command in your 
AUTOEXEC.BAT file. Select a drive letter to search the entire contents of a 
hard disk. After making your selection, choose the Search Now button. 

At the completion of the search, Setup displays a dialog box listing the 
applications found. From the list of applications, select those you want to set 
up, and then select the Add button, or select Add All to set up all applications 
listed. Then choose the OK button. 

5. If you selected to specify an application, a dialog box appears. Type the 
application's path (the drive letter and directory where the program file is 
located) and filename, or choose the Browse button to select from a list of 
applications. Then choose the OK button in the Setup Applications dialog box. 

For each application you select, Setup adds a program-item icon to the 
Applications group. If there is no Applications group, Setup creates one. 

6. If Setup detects a naming conflict or multiple PIFs for one application, it 
displays a dialog box prompting you to specify the name of the application 
or PIP you want to use. 

If Setup doesn't find a PIP, it searches for the information it needs to create 
one. If it finds the information, a dialog box appears, asking whether you want 
Windows to use the information. When you choose the Yes button, a PIP is 
created. 
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Using Program Information Files 
After you set up your application, you can start using it with Windows. If 
the application doesn't perform properly, you probably need to modify the 
application's PIF. The following procedure describes how to do this. (You can 
also use this procedure to create a PIF.) 

Make sure you are modifying the PIF that Windows is using with your 
application. Sometimes you can determine this by using the Properties 
command on the File menu in Program Manager. The PIF is specified in 
the Command Line box in the Program Item Properties dialog box. 

Caution Changing PIF settings can affect how, and even whether, the 
application runs. 

11-- To modify a PIF 

1. In the Main group, choose the PIF Editor icon. Depending on which mode 
Windows is running in, PIF Editor displays an untitled PIF that contains either 
standard-mode or enhanced-mode settings. (To create a PIF, you can change 
these options and then name the new file by using the Save As command on 
the File menu.) 

2. From the File menu, choose Open. In the File Name box, type the name of the 
PIF you want to open, or select a PIF from the list. Then choose the OK 
button. 

3. Change any options that are appropriate for your application. To receive Help 
for a selected option, press Fl while using PIF Editor. 

4. From the File menu, choose Save. Use the same base filename as the 
application. For example, if the application filename (program file) is 
WP.EXE, use WP.PIP as the name of the PIF. 

5. From the File menu, choose Exit. 

Using a Manufacturer-Supplied PIF 
Some software manufacturers provide a PIF for an application so that you can run 
the application with Windows. To determine whether a PIF has been supplied, 
contact the software manufacturer or search the application disks for a file that 
uses the same base filename as the application and has a .PIF extension. If you 
have PIFs from both Windows and the software manufacturer, use the PIF 
supplied by the manufacturer. 
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To use a PIF supplied with an application, copy the file to the directory where the 
application's files are located or the directory where you set up Windows. Then 
create a program item in Program Manager so that you can run the application 
from its PIF. For more information, see "Creating a Program Item" in Chapter 5, 
"Application Basics." 

Using the Default PIF 
The _DEFAULT.PIP file is located in your Windows directory. This PIF contains 
settings that work with most MS-DOS-based applications. Windows uses the 
_DEFAULT.PIP file when there is no other PIF available for your application. 

Because Windows might use the default PIF with more than one application, do 
not modify it; however, you can use the default PIF as a starting point for creating 
a PIF. Use the procedure for modifying a PIF described earlier in this chapter to 
open the _DEFAULT.PIP file and modify it. Then save it by using the Save As 
command and specifying a new filename. Your default PIF remains unchanged. 

Using Multiple PIFs for an Application 
You can create more than one PIF for an application if you run an application 
under different circumstances. For example, you can specify in a PIF how much 
expanded (EMS) memory an application has access to. By using two PIFs, you 
could give an application access to a large amount of EMS memory when you are 
using large data files but limit its use of memory when you are working with 
smaller files. 

To start the application, you choose the program-item icon for the PIF that 
contains the settings you want. 

~ To set up two PIFs for an application 

1. Create two PIFs. For more information, see the procedure for modifying a PIF 
earlier in this chapter. 

2. For each PIF, indicate the appropriate settings. In the example just cited, for 
one PIF you would set the EMS Memory: KB Limit setting to -1, which 
allocates as much expanded memory to the application as it requests. For 
the other PIF, you would set the EMS Memory: KB Limit setting to 1024K. 
(These options are available only in 386 enhanced mode.) 

3. Save each PIF with a unique filename. 

4. Create program-item icons for both PIFs in Program Manager, giving each 
a unique label. For more information, see "Creating a Program Item" in 
Chapter 5, "Application Basics." 
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Note Because you want to start the application from its PIP in this case, 
be sure to specify the PIP filename, not the program file, in the Command 
Line box. 

You then can choose either program-item icon to start the application. 

Starting an MS-DOS Application 
You start an MS-DOS-based application from Program Manager by choosing the 
application's program-item icon, or from File Manager by choosing its program 
file, a document associated with a program file, or the application's program 
information file (PIP). For detailed information about ways to start an application, 
see Chapter 5, "Application Basics." 

When you start an application from Program Manager or File Manager, Windows 
searches for a PIP with the same base filename. It searches directories in the 
following order: the directory where the application's files are located, the current 
working directory, the Windows directory, the SYSTEM subdirectory of the 
Windows directory, and then the directories specified by the path command in 
the AUTOEXEC.BAT file. 

You can also run MS-DOS-based applications, such as memory-resident 
programs (TSRs), by using MS-DOS Prompt. However, when you start an 
MS-DOS-based application from the command prompt, the DOSPRMPT.PIF file 
is used instead of the application's PIP. If your application requires unique PIP 
settings and has its own PIP, start the application from Program Manager or File 
Manager. 

Working with MS-DOS Applications in 386 Enhanced 
Mode 

This section describes features that you use only when you are running 
MS-DOS-based applications in 386 enhanced mode. To determine which mode 
Windows is running in, choose the About command from the Help menu in 
Program Manager. The mode is displayed near the bottom of the dialog box. 

Running an MS-DOS Application in a Window 
You can run most MS-DOS-based applications in a window when Windows is 
running in 386 enhanced mode. You cannot run an MS-DOS-based application 
in a window if Windows is running in standard mode. When the application is 
running in a window, you can move and size the window, and you can share 
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information with other applications by using the Clipboard. For more information 
about using the Clipboard with MS-DOS-based applications, see "Copying 
and Pasting Information by Using the Clipboard" later in this chapter. 

~ To switch an MS-DOS-based application between a window and a full screen 

• While working with the MS-DOS-based application, press ALT+ENTER. 

If the application was running in a full screen, it now appears in a window. If 
the application was running in a window, it now appears in a full screen. 

Tip You can specify that you want an application to run in a window every 
time you start it. To do this, select the Windowed option button in the 
application's PIP. 

Changing Settings for a Running Application 
You can make temporary changes to the way an MS-DOS-based application runs. 
Your changes stay in effect until you quit the application. 

~ To change settings for a running application 

1. If your MS-DOS-based application is running in a full screen, press CTRL+ESC 

to reduce it to an icon, or press ALT+ENTER to run it in a window. 

2. From the Control menu, choose Settings. A dialog box appears, displaying the 
settings you can modify. 

Tip To both run the application in a window and open the Control menu in 
one step, press ALT+SPACEBAR. (If your application uses ALT+SPACEBAR 

for another function, you cannot open the Control menu by pressing 
ALT +SPACEBAR.) 

3. Change the appropriate setting(s), and then choose the OK button. The options 
(Display, Tasking, Priority, and Terminate) are described in the following 
sections. 

For information about using the Control menu, see Chapter 4, "Windows Basics." 
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Display Options 
Use the Display options to specify whether an application appears in a window or 
in a full screen. 

Use 

Window 

Full Screen 

To 

Run the application in a window. 

Run the application in a full screen. 

Tasking Options 
Use the Tasking options to control how an application shares system resources 
with other applications. You can select one or both of the following check boxes. 

Use 

Exclusive 

Background 

To 

Suspend other applications while the application is the active one. 
(If the application is running in a window, Windows-based 
applications continue to run, but other MS-DOS-based 
applications are suspended.) 

Run the application in the background while you work with other 
applications. (This application is suspended when an application 
that has the Exclusive option set is the active application.) 

You can also set these options in the application's PIF by using PIF Editor. For 
more information about these and other PIF Editor options, see Help for PIF 
Editor. 

Priority Options 
Use the Priority options to specify how much processor time the application 
should receive, relative to other applications. Giving the application a high 
priority makes it run faster than applications with lower priorities; conversely, 
giving it a lower priority slows it down. 

Use 

Foreground 

Background 

To 

Control how fast the application runs, relative to other applications, 
when it is the active application. You can type a value from 0 to 
10000; the default foreground priority is 100. 

Control how fast the application runs, relative to other applications, 
when it is not the active application. For this option to take effect, 
you must also select the Background check box under Tasking 
Options. You can type a value from 0 to 10000; the default 
Background priority is 50. 

You can also set these options in the application's PIF by using PIF Editor. For 
more information about these and other PIF Editor options, see Help for PIF 
Editor. 
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Terminate Option 
Use the Terminate button to quit an MS-DOS-based application when you 
cannot use the usual methods from within the application-for example, when 
the application does not respond to the commands you type. 

Caution Use the Terminate button only as a last resort, because it can result 
in lost data. If you cannot open the Control menu in your MS-DOS-based 
application, you can press CTRL+ALT +DEL to quit the application. Windows 
displays a message confirming the action. Press ENTER to quit the application. 

Changing the Size of the Font 
When you are running an MS-DOS-based application in a window, you can 
change the size of the font displayed in the window by using the Fonts command 
on the Control menu. 

JI> To change the size of the font 

1. If your MS-DOS-based application is running in a full screen, press CTRL+ESC 

to reduce it to an icon, or press ALT +ENTER to run it in a window. 

2. From the Control menu, choose Fonts. 

3. Select a font size. The Selected Font box displays the font size. 

4. If you want to use this font size whenever you run this MS-DOS-based 
application in a window, select the Save Settings On Exit check box. 

5. Choose the OK button. 

Copying and Pasting Information by Using the Clipboard 
The methods you use to copy and paste information between MS-DOS-based 
applications are different from those you use with Windows-based applications. 
With MS-DOS-based applications, you use commands on the Control menu. 

JI> To copy selected information from an MS-DOS-based application 

1. If the MS-DOS-based application you want to copy from is running in a full 
screen, press ALT+ENTER to run it in a window. 

2. From the Control menu, choose Edit. 

3. From the Edit cascading menu, choose Mark. 

4. Select the information you want to copy. 

5. Click using the right mouse button, or press ENTER, to copy the selected 
information onto the Clipboard. You can also choose the Copy command from 
the Edit menu. 
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The method you use to paste information into an MS-DOS-based application 
depends on whether the application is running in a window or in a full screen. 

II> To paste information into an MS-DOS application running in a window 

1. Make sure the information you want to paste is on the Clipboard. To view the 
contents of the Clipboard, choose the Clipboard Viewer icon in the Main 
group. 

2. Switch to the destination application. 

3. Place the insertion point where you want the information from the Clipboard 
to appear. 

4. Open the application's Control menu. 

5. From the Control menu, choose Edit. 

6. From the Edit cascading menu, choose Paste. 

The following procedure can be used in either standard or 386 enhanced mode. 

II> To paste information into an MS-DOS application running in a full screen 
1. Make sure the information you want to paste is on the Clipboard. ,To view the 

contents of the Clipboard, choose the Clipboard Viewer icon in the Main 
group. 

2. Switch to the destination application. 

3. Place the insertion point where you want the information from the Clipboard 
to appear. 

4. Press ALT+SPACEBAR to open the application's Control menu. 

Note If Windows is running in standard mode, or if your application uses 
ALT+SPACEBAR for another function, you cannot open the Contro1menu by 
pressing ALT+SPACEBAR. Press CfRL+ESC. The application will then appear as 
an icon near the bottom of the Windows desktop. (Task List will also appear.) 
Qick the icon to open the application's Control menu. 

5. From the Control menu, choose Edit. 

6. From the Edit cascading menu, choose Paste. 

Giving an Application Exclusive Use of Resources 
You can specify that an application has exclusive use of system resources when 
it is the active application. For example, you might want to do this to ensure that 
an application runs as quickly as possible, without being slowed down by 
applications running in the background. Also, some applications use hardware 
in such a way that they cannot run at the same time as other applications. 
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There are two ways to give an application exclusive use of resources: 

• Use PIF Editor to open the application's PIF, and then select the Exclusive 
check box. When you use this setting, no other applications can run when 
that application is active. This setting takes effect every time you start the 
application. 

• If the application is running in a window or as an icon, use the Settings 
command on the application's Control menu. Select the Exclusive check box 
(under Tasking Options). The application gets exclusive use of resources only 
until you quit the application. The next time you start the application, the 
setting is not in effect. 

Running an Application in the Background 
You can run an application in the background (calculating numbers or reading a 
large file, for example) while another application is in the foreground. 

There are two ways to run an application in the background: 

• Use PIF Editor to open the application's PIF, and then select the Background 
check box. This setting takes effect every time you run the application. 

• If the application is running in a window or as an icon, use the Settings 
command on the application's Control menu. Select the Background check 
box (under Tasking Options). The application runs in the background only 
until you quit the application. 

Note If an MS-DOS-based application is running in the foreground and the 
Exclusive check box is selected in its PIF, other applications cannot run in the 
background (even if the Background check box is selected in their PIFs ). 

Using Memory-Resident Programs 
If you want a memory-resident program (TSR) to be available to all Windows­
based and MS-DOS-based applications, start it before you run Windows. The 
program is then available to all applications you run with Windows; however, the 
memory it uses is not available to other applications. In general, most memory­
resident programs are started from your CONFIG.SYS or AUTOEXEC.BAT file. 
(These files are located in the root directory of your startup drive.) The files 
indicate to MS-DOS which commands and programs to run when you start your 
computer. 

If only one application requires a memory-resident program, you might not want 
to start the program from the CONFIG.SYS or AUTOEXEC.BAT file. Instead, 
you can create an MS-DOS batch program that starts the memory-resident 
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program and then the application. You can run that batch program from Windows. 
For more information about using batch programs with Windows, see your 
MS-DOS documentation. 

Running Pop-up Programs 
A pop-up program is a memory-resident program that is loaded into memory but 
isn't visible until you press a certain key combination. You should start pop-up 
programs, such as Borland SideKick, only after starting Windows. By doing so, 
you can switch to and from that program as you would any MS-DOS-based 
application (rather than by using its "pop-up" shortcut key), and the pop-up 
program can share memory with Windows and other applications. 

JI> To use a pop-up program with Windows 

1. If necessary, create a PIP for the pop-up program. 

2. Start the pop-up program as you would any application-for example, by 
setting it up as a program item in Program Manager and then double-clicking 
its icon. When you start the pop-up program, Windows displays a message 
confirming that the program is loaded. 

For information about setting up and starting applications, see Chapter 5, 
"Application Basics." 

3. Press the appropriate key combination to make the program appear on your 
screen. 

A few pop-up programs require a key combination that is usually reserved for 
Windows (for example, ALT +ESC). In this case, you can edit the PIP for the. 
pop-up program, selecting the appropriate key-combination check box in the 
Reserve Shortcut Keys area in the Advanced Options window. When you 
press the key combination, the pop-up program appears instead of the usual 
Windows function being performed. 

Note You can switch to and from a pop-up program by using Task List (press 
CTRL+ESC) rather than by pressing the key combination that usually displays the 
program. 





165 

CHAPTER 12 

Customizing Windows 

After setting up Windows, you may want to change some of your system settings. 
For example, you may want to use a different color scheme or add some fonts. 
This chapter describes the following tasks that you can perform to customize 
Windows: 

• Changing your desktop colors, pattern, or wallpaper 

• Using a screen saver 

• Adding and removing fonts 

• Changing your network settings 

• Using sounds and setting MIDI options 

• Changing your code page 

For information about other customization tasks, see "More Ways to Customize 
Windows" at the end of this chapter. 

Customizing Desktop Colors 
By using the Colors option in Control Panel, you can customize the colors used 
for your desktop, the area of the screen in which windows, icons, and dialog 
boxes appear. You can change the color of an individual screen element or 
several elements at once. You can also create your own colors. 

Choosing a Color Scheme 
Windows provides several predefined color schemes. A color scheme is a 
collection of complementary colors. Some color schemes include only solid 
colors; others also include nonsolid colors. 
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A solid color is directly supported by your display adapter. Video graphics 
adapters (VGAs) support 16 solid colors, and 256-color adapters support 20 
solid colors. Both types of adapters support hundreds of nonsolid colors. 
A nonsolid color is produced by a pattern of colored dots. 

~ To choose a color scheme 

• In the Control Panel window, choose the Color icon. In the Color dialog box, 
select the color scheme you want to use, and then choose the OK button. 

For help with the Color dialog box, choose the Help button or press Fl while 
using the dialog box. 

This box displays the current color 
scheme. Clicking the down arrow opens 
a list of color schemes to select from. 

Choosing this button deletes 
the current color scheme. 

The sample screen shows 
the current color selections. 

When choosing a color scheme, note the following: 

• Using a color scheme that has only solid colors (such as Windows Default) 
may increase the speed at which Windows redraws your screen. 

• If you are using a plasma display adapter, you might want to use the Plasma 
Power Saver color scheme, which uses darker colors that require less power. 

• If you are using a liquid crystal display adapter (LCD), colors may appear in 
reverse video. In this case, you might want to use one of the color schemes 
whose names start with LCD. 

• Control Panel uses the solid color closest to the selected nonsolid color for 
several screen elements. This will be reflected in the sample screen. 
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Note Some LCD monitors have switches you can use to set the screen display so 
that it does not appear in reverse video. For other computers with LCD monitors, 
you need to press a key to change the screen display. In this case, you may need 
to quit Windows before you can change the display. 

If you use only a few color schemes, you can shorten the list of selections by 
removing schemes. The only color scheme you cannot remove is Windows 
Default. 

Changing the Color of Screen Elements 
You can change the color of one or more screen elements (parts of a window) and 
then save the changes you make. 

~ To change the color of a screen element 

Clicking an element 
in the sample screen 
selects it so that you 
can change its color. 

• In the Color dialog box, choose the Color Palette button. The dialog box 
expands as shown. Select the colors you want for particular screen elements, 
and then choose the OK button. 

Choosing this button saves the current color selections to 
the current color scheme or to a new scheme that you specify. 

This box displays the selected screen 
element name. Clicking the down arrow 

opens a list of elements you can select from. 

J!asic Colors: 

Selecting a color in the Basic Colors palette 
changes the color of the selected screen element. 
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Creating Your Own Colors 
You can create up to 16 additional colors at a time and use them in your color 
schemes . 

.,. To create your own color 

Dragging the cursor 
in the color refiner 

box creates a color. 

Double-clicking this 
square or pressing 
ALT +O selects the 

solid color that 
is closest to the 

new color. 

• In the expanded Color dialog box, choose the Define Custom Colors button. In 
the Custom Color Selector dialog box, create colors, and then choose the Add 
Color button to add them to the Custom Colors palette. Then choose the Close 
button. 

For help with the Custom Color Selector dialog box, choose the Help button or 
press Fl while using the dialog box. 

ColorlSglid 

f!.ed:@II 

Dragging the cursor in this 
bar adjusts the color brightness. 
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Screen .E_lement: 
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~ Custom Colors: 
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I.um:~ !llue:~ 00000000 
,, .. 

Typing values or clicking the arrows 
in these boxes can also create a color. 

Choosing this button adds the new color to 
the selected box in the Custom Colors palette. 

Changing Desktop Settings 
By using the Desktop option in Control Panel, you can change the screen 
background and customize the way that windows and icons appear on your 
screen. When you choose the Desktop icon, the Desktop dialog box appears. 



Select this check 
box to enable fast 
switching among 

applications. 

Use this area to 
select a wallpaper 

(bitmap) for the 
desktop. 
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Use this area to select or 
create a pattern for the desktop. 

Icons------, 

~--~I II liPacing: ~ Pixels 

'--"'---0--"L'-ile _ __, 0 l![rap Title 

Use this area to set an invisible grid 
for aligning windows and icons and 
to change the window-border width. 

Use this area to select a 
screen saver to display 
when Windows is running 
but not being used. 

Use this area to adjust 
spacing between icons 
and to break long icon 
titles to a second line. 

Use this area to specify 
how fast you want the 
cursor to blink. 

This section describes procedures for using patterns, wallpaper, and screen savers. 
For information about the other desktop options, choose the Help button or press 
Fl while using the Desktop dialog box. 

Displaying Desktop Patterns 
When you first start Windows, the desktop is a solid color. You can replace the 
color with a predesigned desktop pattern or, if you are using a mouse, you can 
create a pattern of your own. 

The background color for the pattern is the same as the Desktop color. The 
foreground color (the dots that make up the pattern) is the same as the color of 
the Window Text screen element. For information about setting these colors, see 
"Customizing Desktop Colors" earlier in this chapter. 

Note If the Desktop and Window Text colors are the same, you will not see a 
pattern on your desktop. 
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Iii- To choose a pattern 

• Under Pattern in the Desktop dialog box, open the Name list, select a pattern, 
and then choose the OK button. 

If you are using a mouse, you can change an existing desktop pattern or create one 
and save it with a new name. You cannot change a pattern by using the keyboard. 

Iii- To change or create a pattern 

The results of your 
changes appear here. 

• In the Desktop dialog box, choose the Edit Pattern button. In the Desktop-Edit 
Pattern dialog box, create or edit a pattern, and then choose the OK button. 

For help with the Desktop-Edit Pattern dialog box, choose the Help button or 
press Fl while using the dialog box. 

This box displays the current pattern. Clicking 
the down arrow opens a list of patterns. You 
can type a new name for a pattern you create. 

Clicking in this cell changes 
the selected pattern 

----ii-or creates a new one. 

Choosing these buttons adds 
a new pattern, or changes or 
removes the selected pattern. 

The pattern you define is repeated as many times as necessary to completely fill 
the background. 

If you use only one or two patterns, you can shorten the list of selections by 
removing unneeded patterns. 

Displaying Custom Wallpaper 
Instead of a desktop color or pattern, you can display a wallpaper. You can use 
any bitmap file that has a .BMP extension, even an elaborate one such as a 
scanned color photograph. If you select both a wallpaper and a pattern, the 
wallpaper appears as your desktop background. The pattern appears as the 
background used to highlight icon titles on your desktop. 

You can also use Paintbrush or another drawing application to produce .BMP 
files. 



Chapter 12 Customizing Windows 171 

~ To choose a bitmap to display as wallpaper 

1. Under Wallpaper in the Desktop dialog box, open the File list, and then select 
a bitmap. Or, in the File box, type the full path for the bitmap if it is not in 
your Windows directory. 

2. Select the Center or Tile option button, and then choose the OK button. 

The Center option positions the bitmap at the center of the desktop. The Tile 
option repeats the bitmap as many times as necessary to cover the desktop. 
This is useful if you are using small bitmaps. 

If the original bitmap is too large to fit on the screen or takes up too much 
memory, Windows does not display it. 

Note Windows uses more memory when displaying wallpaper than when 
displaying a solid color or a pattern on the desktop. If you receive a memory 
error when running an application, you can try changing to a color or pattern, 
or you can select None in the Pattern or Wallpaper box. 

~ To remove a wallpaper from the list 

• Delete the bitmap file from your Windows directory. 

Using a Screen Saver 
If you want, you can select a screen saver, a moving pattern or bitmap, to appear 
on your screen after your computer has not been used for a specified amount of 
time. Screen savers can reduce the wear on your screen and provide some security 
for your system. Windows provides several screen savers. 

~ To choose a screen saver 

1. Under Screen Saver in the Desktop dialog box, open the Name list, and then 
select a screen saver. 

2. To see how the screen saver looks, choose the Test button. To end the test, 
move the mouse or press any key. 

3. In the Delay box, click the up or down arrow to increase or decrease the 
number of minutes of inactivity you want to elapse before the screen saver 
appears. Or type a number larger than zero. 

4. If you want to customize the screen saver, choose the Setup button. (If the . 
screen saver cannot be customized, a message notifies you that there are no 
options to set.) 
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5. In the setup dialog box for the screen saver, change any settings you want. 

If you want to specify a password, select the Password Protected check box, 
and then choose the Set Password button. Complete the Change Password 
dialog box, and then choose the OK button twice to return to the Desktop 
dialog box. 

For information about the setup or Change Password dialog box, choose the 
Help button or press Fl while using the dialog box. 

6. Choose the OK button. 

~ To return to Windows when the screen saver is active 

• Move the mouse or press any key. If you have specified a password, a dialog 
box appears, in which you must type the password before you can return to 
Windows. This ensures that unauthorized users do not have access to your 
work. 

Note If an MS-DOS-based application is the active application, the screen saver 
does not appear, even after the specified number of minutes have elapsed. 
Windows screen savers will not appear if Windows is not running. 

Using Fonts 
A font, or typeface, is a collection of characters-letters, numerals, symbols, 
and punctuation marks-that have common characteristics. Fonts have various 
sizes and styles. Font sizes indicate the height of a character and are measured in 
points, a point equaling 1/72 of an inch. Font styles include bold and italic. 

Choosing the right font, font size, and font style can help you create whatever 
look you want for a document-professional, highly graphical, or draft quality. 
The font size and style also determine how much text can fit on a page. 

Using Windows Fonts and Printer Fonts 
When you set up Windows on your computer, several kinds of fonts are installed. 
These fonts include: 

• Screen fonts, which are used by Windows to display information such as 
the text that appears in application windows and dialog boxes. Screen fonts 
come in predefined point sizes. Screen fonts also print on some printers (for 
example, dot-matrix printers). 
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• Plotter fonts, which are scalable to any point size and are most often used 
for displaying information on the screen and for plotting graphics with pen 
plotters. Plotter fonts can also be used with some dot-matrix printers; however, 
the print quality may not be as good. 

• True Type fonts, which are scalable to any point size and look the same on the 
screen as they do printed. For information about TrueType fonts, see "Using 
TrueType Fonts" later in this chapter. 

Printers include built-in fonts for printing. These fonts are known as printer 
fonts. The number of printer fonts that a printer supports varies according to the 
capabilities of the printer. Dot-matrix and some laser printers include one or two 
printer fonts; PostScript-compatible printers include several printer fonts. When 
you install a printer, the printer fonts appear in the Font list of the Fonts dialog 
box in applications such as Write. 

Using Cartridge Fonts and Soft Fonts 
You can also use soft fonts and cartridge fonts with your printer. To use soft fonts, 
you need to install them by using the installation program that comes with yonr 
fonts package. If an installation program was not provided with your fonts 
package and you are using a Hewlett-Packard LaserJet or DeskJet (PCL) printer, 
you can use the Font Installer program provided with Windows. 

To use cartridge fonts, you need to insert one or more font cartridges into the 
cartridge slots on yonr printer. You might also need to install them, if support 
for the fonts is not built into the printer driver for your printer. If you need to use 
Font Installer, you can do so while setting printing options. For more information 
about setting printing options and using Font Installer, choose the Help button 
or press Fl while using the Printer Setup or Font Installer dialog box. For more 
information about printer drivers, see Chapter 8, "Print Manager." 

Viewing Printer, Soft, and Cartridge Fonts on the Screen 
Because various printers and screens display information at different resolutions, 
many printer drivers and cartridge- and soft-font packages include matching 
screen fonts so that the fonts look the same on your screen as they do printed. 
If matching screen fonts are not included with your font cartridge or soft-font 
package, check with your printer or font manufacturer to determine whether they 
are available. 

If you use a cartridge, soft, or printer font to format text, and no matching screen 
font is available, one of the screen, plotter, or TrueType fonts supplied with 
Windows is used to display text on the screen. Though the font on the screen 
may not look exactly like the printed font, the substitute font creates line lengths 
and page breaks on the screen similar to those in the printed document. 
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Using TrueType Fonts 
If you use TrueType fonts in your documents, Windows and all Windows-based 
applications display the fonts on the screen exactly as they appear when printed­
there is no need to install matching screen fonts. In addition, when you use 
TrueType fonts, your documents become more portable: The fonts look the 
same printed on different printers, as long as you use the same application and 
print at the same resolution. 

Note If you print at a different resolution or print a document from an older 
application, line and page breaks might change. 

Several TrueType fonts are installed automatically when you set up Windows. 
They are immediately available to your printer and to the applications (such as 
Write and Paintbrush) included with Windows. In these applications, TrueType 
fonts appear with a TT symbol next to them in the Font list in the Fonts dialog 
box. If you purchase additional TrueType fonts, you can add them to Windows 
and your Windows-based applications by using the Fonts option in Control Panel. 

Adding and Removing Fonts 
When you install a printer driver, any screen fonts matching the printer fonts that 
your printer supports are also installed. If you are using cartridge or soft fonts, 
your font manufacturer usually supplies a program for installing screen fonts. 
(The program that installs the cartridge or soft fonts may install the screen fonts 
automatically.) If no program is provided for installing screen fonts, you can use 
the Fonts option in Control Panel to install them. You can also use the Fonts 
option in Control Panel to set True Type font options. 

If you find that you use only TrueType fonts in your documents, you can use the 
Fonts option to prevent all other fonts-screen, plotter, and printer fonts-from 
appearing in the font lists of your Windows-based applications. 
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~ To add a font and set TrueType options 

1. In the Control Panel window, choose the Fonts icon. The Fonts dialog box 
appears. 

The kind of font (for example, True Type 
or plotter) is displayed in parentheses. 

Screen fonts are designated by the 
screen resolution (for example, VGA res). 

This box displays a list of installed fonts. 

aBbCcXxYyZz 123 

This is a scalable TrueT9pe fonl which can be 
displayed on the screen and printed on your printer. 

Size of Font on Disk: 69 KB 

2. Choose the Add button. 

1-------1r- This box shows 
a sample of the 
selected font. 

3. Open the Drives list, and then select the drive that contains the fonts you want 
to add. Then select the directory where the fonts are located. 

4. From the List Of Fonts box, select the fonts you want to add. You can extend 
the selection to add several fonts at once. Or, to add every font in the list, 
choose the Select All button. 

5. If you have limited disk space, you can clear the Copy Fonts To Windows 
Directory check box. You can then use the fonts directly from the directory in 
which they are located, without copying them to your Windows directory. For 
example, this is useful if you are using a CD-ROM that contains hundreds of 
TrueType fonts. 
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If the fonts are located on a network or on a removable disk drive, it is 
recommended that you select the Copy Fonts To Windows Directory check 
box. This ensures that the fonts will always be available, even if the source 
drive is removed or the fonts are removed from the network. 

6. Choose the OK button. Then choose the Close button, unless you want to set 
TrueType options. 

7. To set TrueType options, choose the TrueType button in the Fonts dialog box. 

8. To turn offTrueType fonts, clear the Enable TrueType Fonts check box. Or, to 
use TrueType fonts exclusively, select the Show Only TrueType Fonts In 
Applications check box. Then choose the OK button. 

9. Any change you make to the Enable TrueType Fonts option does not take 
effect until you restart Windows. To restart, choose the Restart Now button. 

Note Selecting the Show Only TrueType Fonts In Applications check box does 
not tum off non-TrueType fonts. It only prevents them from appearing in the fonts 
lists of your Windows-based applications. You can still use these applications to 
view and print documents that contain other fonts. Some applications do not 
support the listing of TrueType fonts exclusively. If you select the Show Only 
TrueType Fonts In Applications check box and no TrueType fonts appear in your 
application, do not use this option. 

If you are no longer using a font, you can remove it. Removing fonts frees 
memory for use by your applications. 

Caution The MS® Sans Serif font set is used for most Windows dialog boxes. Do 
not remove this font; if you do, the text in dialog boxes will be difficult to read. 

II> To remove a font 

1. From the Installed Fonts list, select the font you want to remove, and then 
choose the Remove button. 

2. If you want to delete the font files from your disk in addition to removing the 
fonts from memory, select the Delete Font File From Disk check box. Then 
choose the Yes button. Or, if you are removing several fonts at once, choose 
the Yes To All button. 
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Caution If you chose not to copy the fonts to your Windows directory (if you 
cleared the Copy Fonts To Windows Directory check box in the Add Fonts dialog 
box), do not select the Delete Font File From Disk check box. If you do, you may 
delete the fonts from their source disk, making them unavailable to anyone else. 

Using Sound 
Control Panel provides several options to control how sound works in Windows. 
By using these options, you can perform tasks such as assigning different sounds 
to system and application events. If you are using a sound device that has Musical 
Instrument Digital Interface (MIDI) capabilities, you can specify MIDI settings 
for your device. If you are not using such a device, the MIDI Mapper icon does 
not appear in the Control Panel window. 

To use sound in Windows, you should have a sound card installed that conforms 
to the Multimedia Personal Computer (MPC) specifications. To use MIDI sound 
capabilities, your sound card should include a built-in MIDI synthesizer, or you 
should have a synthesizer connected to the MIDI output port of your sound card. 
You also need to install the sound drivers that control your sound card and your 
MIDI devices. For information about installing and configuring drivers for your 
sound devices, see Chapter 13, "Configuring Hardware." 

Assigning Sounds to Events 
By using the Sound option in Control Panel, you can assign waveform sounds 
(stored in files that have the .WAY extension) to different application and system 
events. For example, you can select a sound to play whenever you start Windows. 
Other sounds play as specified by the application you are using. For example, 
some applications play the sound assigned to the Exclamation or Asterisk event 
whenever a warning message is displayed. 

If you do not have a sound card that supports the waveform sound format, or if the 
sound driver is not configured properly, Windows uses only a warning beep when 
it encounters an error or when you attempt to do something your computer does 
not recognize. 
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~ To assign sounds to events 

Clicking this check 
box turns all sounds 
on or off, except for 

Windows Exit and 
Windows Start. 

• In the Control Panel window, choose the Sound icon. In the Sound dialog box, 
select which sounds you want to use for which events, and then choose the OK 
button. 

For help with the Sound dialog box, choose the Help button or press Fl while 
using the dialog box. 

,[vents: 

Critical Stop 
Default Beep 
Exclamation 
Question 
Windows Exit 
Windows Start 

Enable System Sounds 

You select an event that you want to assign a sound to. 

c:\windows 

You select a sound file in this list. 
If you don't want to assign a sound 
to the selected event, select None. 

Choosing this 
button or 
double-clicking 
the filename 
plays the sound. 

Changing MIDI Settings 
If you are using a sound device, such as a synthesizer, that has Musical Instrument 
Digital Interface (MIDI) capabilities, you can specify MIDI settings for your 
device. 

Wfodows supports two standards for playing MIDI information that is generated 
by an application or stored in a MIDI file. These standards, the General MIDI 
guidelines and the Microsoft authoring guidelines for MIDI files, both include 
certain instrument patch settings and key assignments, as defined by the General 
MIDI specifications. However, they differ in the channel settings they require. 

When you set up Windows, the Setup program installs MIDI setups that support 
both standards for playing MIDI information on common combinations of sound 
cards and synthesizers. These setups include key maps, patch maps, and channel 
settings that ensure that MIDI information plays accurately on your synthesizer. 
You can use the MIDI Mapper option in Control Panel to select a different MIDI 
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setup, create a new setup, or edit key assignments, patch maps, or channel 
mappings for an existing setup. This section describes how to select a MIDI setup. 
For information about how to edit or create a MIDI setup, see Help for Control 
Panel. 

Caution To use MIDI Mapper, you should have a basic understanding of MIDI 
concepts and terminology. It is recommended that you not use MIDI Mapper to 
edit or create MIDI setups unless you are experienced with MIDI and understand 
the results of the changes you make. 

Selecting a MIDI Setup 
If you are using an application, such as Media Player, that uses MIDI setups to 
play MIDI files, you need to select the MIDI setup for the synthesizer that will be 
playing the file. 

~ To select a MIDI setup 

• In the Control Panel window, choose the MIDI Mapper icon. In the MIDI 
Mapper dialog box, select the name of the setup you want to use, and then 
choose the Close button. 

For help with the MIDI Mapper dialog box, choose the Help button or press F1 

while using the dialog box. 

Make sure the Setups option button is selected. 

o e•im 11..,, o E.e1 M8ps 

D eacription: Base-level :setup 

This box displays the current MIDI 
setup. Clicking the down arrow 
opens a list of setups to choose from. 
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The following table lists the MIDI setups provided with Windows and describes 
the setups you should use with your synthesizer and MIDI output port. 

Use 

AdLlb 

Ad Lib General 

LAP Cl 

MT32 

Proteus/1 

Proteus General 

Extended MIDI 

General MIDI 

For 

The Ad Lib or Ad Lib-compatible synthesizer included on your 
sound card. This setup uses channels 12-16 (base-level channels). 

Same as for Ad Lib; however, this setup uses all 16 channels. 

The Roland synthesizer included on your LAPCl sound card. 
This setup uses all available LAPCl channels. 

Same as for LAPCl; however, this setup uses all available MT32 
channels. 

The E-mu Systems Proteus/1 synthesizer connected to the 
Sound Blaster MIDI output port. This setup uses channels 
1-10 (extended-level channels). 

Same as for Proteus/1; however, this setup uses all 16 channels. 

Any General MIDI synthesizer, such as the Roland Sound Canvas 
(SC-55), connected to the Sound Blaster MIDI output port. This 
setup uses channels 1-10 (extended-level channels). Use this 
setup to play MIDI files authored according to Microsoft 
guidelines. 

Same as for Extended MIDI; however, this setup uses all 16 
channels. Use this setup to play MIDI files authored according 
to General MIDI guidelines. 

If you plan to play MIDI files authored according to General MIDI guidelines, use 
a "general" setup for your synthesizer. If you plan to play MIDI files authored 
according to Microsoft guidelines, use the other setup. 

If you are using a synthesizer that is connected to a MIDI output port other than 
Sound Blaster or a Sound Blaster-compatible port, you need to edit the setup to 
change the port assignments. If you are using a synthesizer that is not included in 
the list, you may need to create a MIDI setup for it. For information about editing 
or creating MIDI setups, see Help for Control Panel. 

Setting Network Options 
If you installed a network when setting up Windows, the Control Panel window 
includes a Network icon. You can choose this icon to view information about 
your network or to specify settings available for your particular network. 
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When you choose the Network icon, a dialog box specific to your network 
appears. The following are some of the tasks you might be able to perform by 
using this dialog box: 

• Signing on and off the network 

• Changing user ID and password 

• Sending messages to other network users 

• Restoring network connections when you start Windows 

For information about the tasks you can perform by using your network, see your 
network documentation and Help (if available) in the dialog box. 

Changing the Code Page 
In Windows, the Codepage setting determines the character set (the characters for 
the language you are using on your system) to use for your keyboard layout, for 
filenames that include extended characters, and for MS-DOS-based applications 
running in a window. When Windows is first set up on your system, Setup detects 
the code page used by MS-DOS and sets up Windows to use the same one. If you 
subsequently change your MS-DOS code page, you need to update the Codepage 
setting in Windows to match it. 

You update the Codepage setting by using the Windows Setup program. 

~ To change to another code page 

1. Quit Windows. 

2. Change to your Windows directory, type setup at the command prompt, and 
then press ENTER. 

3. In the System Information screen, select the Codepage setting (use the UP 

ARROW or DOWN ARROW key), and then press ENTER. A list of the available 
code pages appears. 

4. Select the code page you want to use, and then press ENTER. 

5. When the System Information screen appears, press ENTER again. Setup asks 
you to confirm that you want to change code pages. Press F3 to verify the 
change. 

6. Setup prompts you for the disk containing the new code-page file. 

If you are changing to a code page that you have used before, Setup asks you 
whether you want to use a new code-page driver or the one that is currently on 
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your computer. If you have an updated driver, press ESC; otherwise, press 
ENTER. Insert the disk or type the drive and directory where the driver file is 
located, and then press ENTER. 

After Setup copies the file, you return to the command prompt. The new code 
page takes effect the next time you start Windows. 

More Ways to Customize Windows 
You can also use Control Panel and Windows Setup when you need to perform 
the following tasks: 

• Setting up a network for use with Windows 

• Customizing the mouse and other pointing devices 

• Adjusting the keyboard speed 

• Setting the system date and time 

• Specifying international settings 

• Creating and editing MIDI setups 

• Adding and removing Windows components 

Help for Windows Setup provides information about adding and removing 
Windows components and setting up a network for use with Windows. Help for 
Control Panel describes all other tasks in detail. Choose the Help button or press 
Fl while working in the dialog box for each Control Panel or Setup option. 
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CHAPTER 13 

Configuring Hardware 

When you set up Windows, the Setup program installs the appropriate drivers for 
your hardware, based on your system configuration. A driver is a program that 
enables a specific piece of hardware (or device) to communicate with Windows. If 
you change your system configuration by adding a new device, you need to add a 
driver for it. 

Generally, your device or hardware package includes a disk containing the 
appropriate Windows device driver. Or Windows may include the driver you 
need. 

Although the device may be installed in or connected to your computer, Windows 
does not recognize a device until you install and configure the device driver. 

This chapter describes how to install and change device drivers for your 
multimedia devices, display adapter, keyboard, and mouse. It also describes 
how to configure communications ports. 

The Windows Driver Library 
If you do not have a driver or if you want an updated driver for your device, 
contact your device manufacturer or check the Windows Driver Library (WDL), 
which contains device drivers made available after Windows was released. 
Device drivers are added to the WDL as they become available. If you have 
a modem, you can download WDL device drivers from network services, 
including CompuServe, GEnie, Microsoft OnLine, various user-group bulletin­
board services (BBSs on the Association of PC User Groups, or APCUG, 
network), and the electronic downloading service maintained by Microsoft 
(206-936-6735). If you do not have a modem and are located in the United 
States, you can obtain disks by calling Microsoft Customer Support Services 
at 1-800-426-9400. 
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Methods for Installing Device Drivers 
You can install device drivers after you have set up Windows, either by 
running the Setup program or by using Control Panel options. The method you 
use depends on the type of hardware you are adding or changing. For example, 
you can add a sound driver to your system by using Control Panel. If you want 
to change the resolution of your screen, you run Setup. 

To install and configure a printer, you can use either the Printers option in Control 
Panel or the Printer Setup command in Print Manager. For instructions on how to 
install and configure a printer, see Chapter 8, "Print Manager." 

Note Depending on the type of driver that you install or the settings that you 
change, you need to restart Windows or your computer in order for the new 
driver or changed settings to take effect. 

Installing a Third-Party Device Driver 
Windows provides drivers for common display adapters, mice, keyboards, and 
sound cards. If Windows does not supply a driver for your device, or if you are 
updating to a newer version of the driver, you may need to install a driver 
provided by your device manufacturer (third-party driver). 

The driver disks that you receive from your device manufacturer should include 
an OEMSETUP.INF file. This file supplies Windows with setup information that 
specifies the driver files on the disk and any additional files (such as font files) the 
driver requires. 

If your driver disks include an OEMSETUP.INF file, you can use Setup or 
Control Panel to install the driver. If the driver disks do not include this file, you 
need to follow the instructions supplied by your device manufacturer to install the 
driver. 
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Installing and Configuring Multimedia Drivers 
You can use the Drivers option in Control Panel to install, configure, and remove 
device drivers that support multimedia devices, such as sound cards, synthesizers, 
audio compact-disc players, and videodisc players. 

Note To install an updated version of a multimedia driver, you must first remove 
the old driver from your system. 

~ To install a multimedia device driver 

This box displays a list 
of multimedia drivers 

already installed in 
your computer. 

1. In the Main group, choose the Control Panel icon. 

2. In the Control Panel window, choose the Drivers icon. The Drivers dialog box 
appears. 

• 
!-dDriven !iiiil 
Timer !iiiil (MO) MIDI Sequencer 
IMO) Sound !iiiil 

!iiiil 
!iiiil 

3. Choose the Add button. 

4. In the list, select the driver you want to install, and then choose the OK button. 
(If your device is not listed, select Unlisted Or Updated Driver.) 

5. Insert the requested disk in drive A, and then choose the OK button. 

Or type the drive letter and directory name (for example, d:\drivers) where the 
driver is located, and then choose the OK button. 

(You can also use the Browse button to locate and select the drive and 
directory where the driver is located. When you are finished using the Browse 
dialog box, choose the OK button.) 

If you selected Unlisted Or Updated Driver, another dialog box appears, listing 
the drivers on the disk. Select the driver you want to install, and then choose 
the OK button. 
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6. When you install a multimedia driver, Windows installs other related 
multimedia drivers at the same time. If the drivers require additional settings, 
a setup dialog box appears for each driver. Select the settings required by the 
driver, and then choose the OK button. 

Note Make sure that the settings you specify do not conflict with the settings 
used by other devices installed in your system, such as a mouse or network 
adapter. See the documentation for your devices, including your multimedia 
device, for information about their settings. 

7. New or changed multimedia-driver settings do not take effect until you restart 
Windows. To restart, choose the Restart Now button. 

If you are no longer using a device, you can remove its driver. 

Caution The multimedia device drivers that are automatically installed during 
Setup are required by your system (these are the drivers displayed when you first 
open the Drivers dialog box). If you remove one of these drivers, your system 
may not work properly. 

~ To remove a multimedia driver 

1. In the Installed Drivers list, select the driver, and then choose the Remove 
button. 

2. To completely remove the driver from memory, you need to restart Windows. 
To restart, choose the Restart Now button. 

Removing a multimedia driver from the Installed Drivers list does not delete the 
driver file from your hard disk. If you need to use the same multimedia device 
later, you can add its driver again. 

Changing Your Mouse, Keyboard, or Display Driver 
You might want to add a mouse to your system, upgrade your display adapter 
to use a higher resolution, or install a new keyboard driver. You can do so by 
running Setup from within Windows. 

Note If a driver is in use (for example, your display driver), and you want to 
update it to a newer version of the same driver, you need to quit Windows and 
then run Setup from MS-DOS. For more information, see the following section, 
"Updating a Driver Currently in Use." 
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II> To change your mouse, keyboard, or display driver from within Windows 

1. Be sure your hardware is set up to match the setting to which you are 
changing. Check the documentation for your device. 

2. In the Main group, choose the Windows Setup icon. The Windows Setup 
window appears, listing your current hardware settings. 

Qptions !:!elp 

Displa]r: 
l(eyboard: 
Mouse: 
Network: 

VGA 
Enhanced 101 or 102 key US and Non US 
Microsoft. or IBM PS/2 
No Network lnllaled 

3. From the Options menu, choose Change System Settings. 

4. Open the list for the device that you want to change, select the driver you 
want, and then choose the OK button. 

If your hardware is not listed or if you are updating a driVer that appears on the 
list (rather than installing a new one), scroll to the bottom of the list, and then 
select Other. Remember that a driver you are updating must not currently be in 
use by Windows. 

If you are installing a new driver or updating to a newer version, Setup 
requests that you insert in drive A a Windows disk or the disk that comes 
with your new mouse, display adapter, or keyboard. Insert the disk, or type the 
drive letter and directory where the device driver is located, and then choose 
the OK button. 

If you sele~ted Other, Setup displays a list of drivers on the disk. Select the 
appropriate. device driver, and then choose the OK button. You may be 
prompted for addition;tl. disks if more than one disk was provided by the 
hardware manufacturer. You might also be prompted for specific Windows 
disks. Setup then copies the appropriate files to your Windows SYSTEM 
subdirectory and displays the updated list of your hardware. 

5. Choose the OK button. A dialog box appears that contains a Restart Windows 
button and may contain a Reboot button. 

6. If no Reboot button appears, choose the Restart Windows button. 

If the Reboot button appears, make sure there are no disks in any drive, and 
then choose the Reboot button. Your system restarts. Then restart Windows. 

Note If the driver you install for your keyboard, display adapter, or mouse 
prevents Windows from running correctly, you need to run Setup from MS-DOS 
to install the correct driver. For more information, see the following section, 
"Updating a Driver Currently in Use." 
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Updating a Driver Currently in Use 
To update a driver that is being used by Windows, you must quit Windows and 
then run Setup from MS-DOS. 

Note Setup will not run from MS-DOS Prompt within Windows. 

~ To install an updated mouse, keyboard, or display driver 

1. Quit Windows. 

2. Change to your Windows directory, type setup at the command prompt, and 
then press ENTER. The System Information screen appears. 

3. Select the setting for the driver you want to update (use the UP ARROW or 
DOWN ARROW key), and then press ENTER. A screen listing the available 
drivers appears. 

4. Scroll to the bottom of the list (use the UP ARROW or DOWN ARROW key), 
select Other, and then press ENTER. 

5. Insert the disk containing the updated driver, or type the path of the driver file, 
and then press ENTER. You return to the command prompt. The new driver is 
used the next time you start Windows. 

Configuring Communications Ports 
You can specify the communications settings for each serial port on your system 
by using the Ports option in Control Panel. You use serial ports to connect serial 
pointing devices, modems, scanners, or other serial devices to your computer. 
Most computers include at least two serial ports: COMl and COM2. Some 
devices, such as serial-port adapters, modems, and fax cards, can use COM3 
and COM4. The settings you specify determine how information is transferred 
between your computer and the device. 

The communications settings you can specify include standard settings (such as 
those for baud rate, parity, and flow control) and advanced settings (such as those 
for the base port address and interrupt request line). If you plan to use serial ports 
COMl and COM2 only, you may only need to change the standard settings. If 
you want to use COM3 and COM4, you may also need to change the advanced 
settings. 
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Note Most communications applications that you use to exchange information 
between computers (such as Terminal, which is included with Windows) require 
that you specify standard port settings within the application. These settings 
override the settings you specify by using the Ports option in Control Panel. 

~ To specify standard communications settings 

1. In the Main group, choose the Control Panel icon. 

2. In the Control Panel window, choose the Ports icon. 

3. In the Ports dialog box, double-click the icon for the port whose 
communications settings you want to specify. Or press TAB to select it, 
and then press ALT +s to choose the Settings button. The Settings dialog 
box appears. 

.B_aud Rate: Im 1m 
D..ata Bil:s: lo II 
f,arity: I Nono II 
.5,.lop Bits: 11 II 
flow Control: lxon /Xoff II 

4. Open the list for each option, set the option to match the device connected to 
the port, and then choose the OK button. 

For a description of the options, choose the Help button or press Fl while using 
the Settings dialog box. For information about the correct settings to use, see 
the documentation supplied with the device. 

5. In the Ports dialog box, choose the Close button. 

Setting Advanced Options 
The Ports option in Control Panel provides advanced options for specifying 
the base port address and the interrupt request line (IRQ) for each serial port. 
Windows often can detect the addresses and IRQs the ports are using. However, 
if you install additional serial ports, or if a device connected to a serial port does 
not use the values that Windows detects, you can change the settings so that 
they match those required by your device. 

The table on the following page lists common port-address and IRQ settings. See 
the documentation that came with your device for information about the IRQ and 
base port address that your device uses. If you are not sure which settings to use, 
select Default. 
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~ To specify advanced port settings for a serial port 

1. In the Settings dialog box, choose the Advanced button. 

2. Open the Base I/0 Port Address and the Interrupt Request Line (IRQ) 
lists, and then select an address and IRQ value. Or type values in the boxes. 
(The IRQ value must be between 2 and 15.) Then choose the OK button. 

3. Any changes you make do not take effect until you restart Windows. To 
restart, choose the Restart Now button. 

The following table lists common port-address and IRQ settings you can use if 
Windows does not provide settings. 

Port 

CO Ml 

COM2 

COM3 

COM4 

Address 

03F8 

02F8 

03E8 

02E8 

IRQ 

4 

3 

4 

3 

Note If you want to use serial ports 1 and 3 or 2 and 4 simultaneously and your 
computer cannot simultaneously access ports that use the same interrupt, you 
need to specify a unique IRQ number for each serial port. First, identify which 
interrupts are not being used by other cards or boards installed in your computer. 
After you have determined this, you may need to adjust your communications 
card in order to use the interrupts. For more information, see the documentation 
supplied with your communications card. 



CHAPTER 14 

Managing Memory 
and Performance 

This chapter describes ways you can manage memory and configure settings to 
improve system speed while leaving enough memory for your applications. 

191 

When you assess the performance of Windows, take into account how much 
memory your system has and how much disk space is available. Also consider 
how many applications you run at one time and whether you use any memory­
resident programs (also called terminate-and-stay-resident, or TSRs). Typically, 
optimizing your system in.valves improving one or more aspects of system 
performance but sacrificing something else. For example, you might optimize 
your system so that more applications can run faster at one time, but you may 
have less disk space available as a result. 

Identifying Your System Memory Configuration 
Memory is found on your computer's main system board or on add-in memory 
boards. Before information on a disk is processed by your computer or displayed 
on the screen, it is first placed in memory. The following table describes memory 
types and terminology used throughout this chapter. 

Type of memory 

Conventional memory 

Extended memory 

Description 

Up to the first 640K of memory on a computer. All 
personal computers have conventional memory. 
MS-DOS uses this memory to run applications. 

Memory beyond 1 MB on 80286, 80386, and 80486 
computers. Extended memory requires an extended­
memory manager, such as IDMEM.SYS, to prevent 
applications from using the same area of extended 
memory at the same time. Extended memory is 
required for Windows. 
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Type of memory 

Expanded memory 

Virtual memory 

Upper memory area 

High memory area 

Description 

Memory in addition to conventional memory that some 
MS-DOS-based applications can use. Expanded memory is 
installed on an expanded-memory board and comes with an 
expanded-memory manager. Because an expanded-memory 
manager gives access to only a limited amount of expanded 
memory at a time, using expanded memory is slower than 
using extended memory. Windows and Windows-based 
applications do not use expanded memory; however, 
Windows running in 386 enhanced mode can simulate 
expanded memory for MS-DOS-based applications that 
require it. For more information, see "Using Memory 
Managers" later in this chapter. 

Space on your hard disk that Windows running in 386 
enhanced mode uses as if it were memory, by temporarily 
moving information from memory to a file (called a swap 
file). This makes the memory available for other 
applications. The benefit of using virtual memory is that 
you can run more applications at one time than your 
system's physical memory (found on your system boards 
and any add-in boards) would usually allow. The 
drawbacks are the disk space required for the virtual­
memory swap file, and the slower performance when 
swapping is required. 

The 384K of memory above the 640K of conventional 
memory in your system, usually reserved for system 
hardware, such as your display adapter. Unused parts of 
the upper memory area are called upper memory blocks 
(UMBs) and can be used by Windows running in 386 
enhanced mode. 

The first 64K of extended memory. This area is used 
by some applications and by Windows. If you are using 
MS-DOS version 5.0 or later, you can run MS-DOS in the 
high memory area, leaving more conventional memory 
available for applications. For more information, see your 
MS-DOS documentation. 

It's important to know how much and what type of memory your computer has. 
On most computers, when you tum on the power, the screen displays a count of 
how much memory there is. However, this won't show you what type of memory 
it is. If you have MS-DOS version 4.0 or later, you can find out about your 
memory configuration by using the MS-DOS mem command . 

.,. To find out about your system's memory configuration 

1. Quit Windows. 

2. At the command prompt, type mem and then press ENTER. 
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Managing Memory 
Properly configuring your system memory is one of the most important things you 
can do to improve performance. The following sections describe ways you can 
free memory for your applications and configure memory so that it is used 
efficiently. 

Streamlining Your CONFIG.SYS and AUTOEXEC.BAT Files 
Your CONFIG.SYS and AUTOEXEC.BAT files, located in the root directory of 
your startup drive, may contain commands that load device drivers and other 
programs when you start your computer. You can make more memory available 
by removing unnecessary commands from these files. Be sure to leave intact any 
command lines that start or enable a network. 

Note During Express Setup, the Setup program adds the appropriate memory 
managers to your AUTOEXEC.BAT and CONFIG.SYS files. For information 
about these memory managers and how to change command-line options, see 
"Command Reference" later in this chapter. 

When you modify the CONFIG.SYS or AUTOEXEC.BAT file, use the following 
guidelines: 

• First, always make a system disk that you can use to start your computer. 
Include a backup copy of both your CONFIG.SYS and AUTOEXEC.BAT 
files and any other startup files your system requires, such as disk-partitioning 
software. For more information about system disks, see Help for File Manager. 

• Use a text editor that can save files in ASCII (text-only) format, such as 
Notepad, to open and edit the CONFIG.SYS and AUTOEXEC.BAT files. 

• If you want to remove a command line, add the rem command (for "remark") 
at the beginning of the line to disable it. This makes it easy to add the 
command again if you decide you want to put it back in the file. 

For example, to disable the following CONFIG.SYS command line: 

device=c:\device\mouse.sys 

type rem in front of it, as follows: 

rem device=c:\device\mouse.sys 
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Note If you use the rem command to disable command lines in your 
CONFIG.SYS file, and you are using a version of MS-DOS earlier than 5.0, 
you'll see a message, such as "Unrecognized command in CONFIG.SYS," 
when you start your computer. Once you are sure that your computer works 
properly with the command lines disabled, you might want to delete those 
lines to avoid the message. 

• If you are not sure about whether you need a particular command line, do not 
remove it. 

The changes you make do not take effect until you restart your computer. If your 
system does not start properly after you've modified your CONFIG.SYS or 
AUTOEXEC.BAT file, insert in drive A the system disk you created, and start 
your computer again. If you know which command line(s) are causing the 
problem, edit the appropriate file (CONFIG.SYS or AUTOEXEC.BAT) on your 
hard disk, and then restart your computer. Or, to start over, copy the backup 
version of the file(s) from the system disk to the root directory of your hard disk. 

~ To streamline the CONFIG.SYS file 

• Disable command lines for any unnecessary device drivers. Your 
CONFIG.SYS file should define only device drivers that you absolutely 
need. (Device drivers are defined by using the device command.) 

Note Do not disable the HIMEM.SYS command line. When you install 
Windows, the Setup program adds this command line to your CONFIG.SYS 
file if your system needs this device driver. 

• Make sure the buffers setting is from 10 to 20. 

The buffers command line sets the number of disk buffers that MS-DOS 
allocates in memory when your computer starts. These buffers enable 
MS-DOS to improve disk-access time in certain cases. The larger the 
number you specify for buffers, the more conventional memory is used. 

Note Setting buffers to a value higher than 20 might improve disk-access 
time in some cases. However, doing so might also require more memory. If 
you are using MS-DOS version 5.0 or later, you can set buffers=30 without 
using more memory. 

• If your CONFIG.SYS file contains a shell command line that specifies your 
environment space, try specifying a smaller environment. The smaller the 
environment, the fewer environment variables you can define with the set 
command in MS-DOS; however, a large environment could take up more 
memory. Environment space should always be at least 1024 bytes. 
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... To streamline the AUTOEXEC.BAT file 

• Disable command lines that start pop-up programs or other memory-resident 
software. Instead of starting memory-resident programs (TSRs) from the 
AUTOEXEC.BAT file, you can start them from within Windows. For more 
information about running memory-resident programs, see the following 
section. 

• If you have a RAM drive, you might want to set your TEMP environment 
variable to the RAM drive. This can speed up applications that store temporary 
files in the directory specified by the TEMP variable. For example, if your 
RAM drive has the drive letter E, you could place the following lines in the 
AUTOEXEC.BAT file: 

mkdir e:\temp 
set temp=e:\temp 

The first command creates the directory TEMP on the RAM drive. The second 
command sets the TEMP variable to that directory. 

Conserving Memory When Starting Memory-Resident Programs 
If you want a memory-resident program (TSR) to be available to all applications 
that you run with Windows, you must start it before starting Windows. However, 
this takes memory away from other MS-DOS..:.based applications. 

There are two ways to conserve memory when starting memory-resident 
programs: 

• Ifa particular MS-DOS-based application needs a memory-resident program, 
you can start both the program and the application from the same batch file in 
Windows. This gives the application access to the program and does not take 
memory away from other applications. For more information about creating 
and using batch files, see your MS-DOS documentation. 

• If only Windows-based applications use the memory-resident program, you 
can create a batch file called WINSTART.BAT in the Windows directory 
and then run the memory-resident program from there. Each time you start 
Windows in 386 enhanced mode, WINSTART.BAT runs. 

When you start a program from WINSTART.BAT, that program is only 
available to Windows-based applications. This prevents the program from 
taking memory away from MS-DOS-based applications. 

Some memory-resident programs do not work when started from 
WINSTART.BAT. For information, see the documentation that came with 
the program. 
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Changing Virtual Memory Settings 
When Windows is running in 386 enhanced mode, it frees memory and speeds up 
performance by swapping information from memory to a swap file on your hard 
disk (virtual memory). 

The Setup program creates a swap file based on the type and amount of available 
space on your hard disk. The Setup program creates a permanent swap file if it 
can-a permanent swap file is contiguous and thus improves the speed of 
Windows. Otherwise, Windows creates a temporary swap file (named 
WIN386.SWP) whenever you start Windows in 386 enhanced mode. This 
file can grow and shrink in size and is deleted when you quit Windows. 

A permanent swap file consists of two files-SPART.PAR is a read-only file 
in your Windows directory, and 386SP ART.PAR is a hidden file in the root 
directory of the drive specified for the swap file. 

You can determine whether you are using virtual memory, and see the size and 
type of the swap file, by using Control Panel. (The Windows version 3.1 swap-file 
functionality replaces the Windows version 3.0 Swapfile application.) 

Generally, you should keep the default swap-file settings. However, there may be 
times when you want to change the settings. For example, if you work with an 
application that requires a large amount of memory, you might want to create a 
larger swap file. 

Note If you are connected to a network, storing your swap file on your local disk, 
as opposed to on a network disk, provides better performance and reliability. 

~ To display or change information about your system's virtual memory 

1. In the Main group, choose the Control Panel icon. 

2. In the Control Panel window, choose the 386 Enhanced icon. 

3. Choose the Virtual Memory button. The Virtual Memory dialog box appears, 
which displays the current swap-file settings. 

Current Settings---------~ 
Drftre: C: 
Size: 7 .792 KB 
Type: Temporary (using MS·DOS) 
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4. To change the drive location, size, and type of the swap file, choose the 
Change button. The dialog box expands, enabling you to change the settings. 

If your hard-disk controller is compatible with the 32-bit disk-access 
feature, the Use 32-Bit Disk Access check box appears in the dialog box. 
This feature provides increased performance on all disk activities and 
increased performance when you are using MS-DOS Prompt and running 
MS-DOS-based applications. Using 32-bit disk access may be unreliable on 
some battery-powered portable computers when the computer's power-saving 
features are enabled. To turn this feature on, select the check box. 

For help with the Virtual Memory dialog box, choose the Help button or press 
Fl while using the dialog box. 

Note If Windows is running in 386 enhanced mode, you can conserve disk space 
by preventing Windows from swapping any information to the disk. Do not 
prevent swapping unless disk space is at a premium, because swapping increases 
the number of applications you can run at one time. To prevent swapping, select 
None in the Type box in the expanded Virtual Memory dialog box. 

Working with Application Swap Files (Standard Mode) 
When you start an MS-DOS-based application in standard mode, Windows 
creates a temporary application swap file for that application. (It does not use 
application swap files in 386 enhanced mode.) When you switch from the 
application, Windows moves some or all of the application from memory to the 
application swap file. This makes the memory available to other applications. 
When you quit the application, the application swap file is deleted. 

The location Windows uses to store application swap files can affect the time it 
takes to switch to and from MS-DOS-based applications. 

Application swap files are hidden files with names that start with the characters 
-WOA. These files are placed in the directory specified by the swapdisk setting 
in the [Non WindowsApp] section of your SYSTEM.INI file. If the swapdisk 
setting is not specified, the files are placed in the directory specified by the 
TEMP environment variable in your AUTOEXEC.BAT file. If there is no TEMP 
environment variable specified, swap files are placed in the root directory of the 
first hard disk (or first floppy disk drive, if you start your system from a floppy 
disk). 
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Basic Recommendations 
• Usually, it is not a good idea to set swapdisk to a RAM drive. If the swapdisk 

setting or the TEMP environment variable specifies a RAM drive, when 
Windows tries to swap application information from memory to disk, it swaps 
it to another area of memory instead. This is useful only if you have much 
more memory than you require for running applications. 

• Set the swapdisk setting to a hard disk with at least 512K of free disk space. If 
you have more than one hard disk, set swapdisk to the disk with the most free 
space. 

The more disk space Windows can use for application swap files, the more 
MS-DOS-based applications you can run at one time. 

• If you have more than one hard disk and the disks differ in speed, set the 
swapdisk setting to the fastest disk (provided it has enough free space). 

~ To change the location that Windows uses for application swap files 

1. Open your SYSTEM.IN! file (located in your Windows directory) by using a 
text editor such as Notepad. Be sure not to use an application such as Write to 
edit this file. Such applications can add characters that prevent MS-DOS from 
correctly processing the file. 

2. Find or add the [NonWindowsApp] section of the file. If you're using 
Notepad, you can find this section quickly by choosing Find from the Search 
menu, typing [NonWindowsApp], and then choosing the Find Next button. 

3. Add or change the swapdisk setting. Set swapdisk to the directory and drive 
you want. 

For example, if you want application swap files to be created in the 
TEMPFILE directory on drive D, type the following: 

swapdisk=d:\tempfile 

4. Save your SYSTEM.IN! file. 

5. Quit and restart Windows to have the change take effect. 

For more information about SYSTEM.IN! settings, use Write to open the 
SYSINl.WRI online document located in the Windows directory. 
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Other Methods for Improving Performance 
There are factors other than memory to consider when optimizing your system. 
This section describes the following ways to speed up your system: 

• Improving the efficiency of your hard disk 

• Using the SMARTDrive disk-caching program 

• Changing multitasking settings for Windows 

This section also describes ways you can find out how your system resources are 
being used and ways you can free those resources to improve the performance of 
your system. 

Improving the Efficiency of Your Hard Disk 
Your system's speed can be greatly affected by the amount of free disk space and 
how efficiently the information on your disk is structured .. You can perform the 
following tasks to improve the efficiency of your hard disk: 

• Delete files you don't need. (This section describes how you can find out how 
much free disk space you have and which files you can delete.) 

• Use the MS-DOS chkdsk command to recover lost disk space. For 
information about chkdsk, see your MS-DOS documentation. 

• Run a disk-compaction program. Over time, the information on your disk can 
become fragmented (instead of being stored in a single location, files are split 
into fragments and stored in different locations on the disk). This makes it 
time-consuming to read the files from the disk. Running a disk-compaction 
program regroups fragmented files and can significantly reduce the time it 
takes for Windows and applications to start. · 

Before running a disk-compaction program, you should quit Windows, delete 
any unnecessary files, run the chkdsk command; and make sure you are not 
running any programs that use the hard disk. 

Generally, it's a good idea to keep at least 1 MB of free space on your hard disk. 
Windows and applications use free disk space to temporarily store information 
and to save documents and other files. Use the procedure on the following page to 
determine how much disk space is available on your system. 



200 Microsoft Windows User's Gulde 

1111- To check the amount of free disk space when Windows is running 

1. In the Main group, choose the File Manager icon. 

2. Choose the drive icon for the drive you want to check. 

The status bar at the bottom of the File Manager window indicates how much 
disk space is currently available on that disk drive. (If the status bar does not 
appear, you can display it by choosing Status Bar from the Options menu.) 

Often, there is less free disk space when you are running Windows than when you 
are not. This is because Windows uses swap files that take up some disk space. To 
determine how much disk space Windows is using, compare the amount of free 
disk space when it is running to the amount of free disk space when it is not 
running. 

1111- To check the amount of free disk space when Windows is not running 

1. Quit Windows. 

2. At the command prompt, type dir and then press ENTER. 

MS-DOS displays information about the files in the current directory. The last 
line of information shows how many bytes of disk space are free on that drive. 

If you need more disk space, you may be able to delete some unnecessary files 
from your hard disk. 

Deleting Unnecessary Files 
If your disk is becoming full, you can delete files you don't need or don't use. 
Depending on how you use Windows, you might also be able to delete certain 
Windows files. It is particularly important to delete unnecessary files before you 
run a disk-compaction program. There are three categories of files you may want 
to delete: 

• Windows files (installed by the Setup program) that you do not need or plan to 
use. For details, see the following procedure. 

• Application files, documents, or programs that you no longer need or use. 

• Temporary files (files that have a .TMP extension) that are left on your hard 
disk when your computer fails unexpectedly. 

1111- To delete unnecessary Windows files 

1. If you plan to delete Windows wallpaper or screen-saver files, first use the 
Desktop option in Control Panel to change these settings to "None." 

2. While running Windows, quit all applications except Program Manager. 
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3. In the Main group, choose the Windows Setup icon. 

4. From the Options menu, choose Add/Remove Windows Components. 

5. Choose the Files button for the Windows component that contains the files you 
want to delete. 

6. Follow the instructions on the screen to remove files from your hard disk. 

Note If you use this method (choosing the Windows Setup icon), Setup will not 
delete files that are necessary to run Windows. Therefore, it is recommended that 
you use this method rather than File Manager or MS-DOS Prompt to delete 
Windows files. 

II- To delete other unnecessary files 

1. Quit Windows. 

2. Delete any files that remain in your TEMP directory, the directory that 
applications use to store temporary files. If you don't know which directory is 
set as your TEMP directory, look in your AUTOEXEC.BAT file for the set 
temp= command. 

3. Delete any files that start with the characters -WOA. These files are 
application swap files that were created in standard mode. Usually, Windows 
deletes application swap files when you quit the associated applications; 
however, these files might remain on your hard disk if Windows stops running 
unexpectedly. You can safely delete application swap files if Windows is not 
running. 

4. Delete any file named WIN386.SWP. This file is a temporary swap file created 
in 386 enhanced mode. Usually, Windows deletes it when you quit Windows. 
However, a temporary swap file might be left on your hard disk if your 
computer stops running unexpectedly. You can safely delete WIN386.SWP 
if Windows is not running. (Do not delete swap files named 386SPART.PAR 
or SPART.PAR.) 

5. If you want, delete any other unwanted files or documents. 

Using SMARTDrive 
SMARTDrive is a disk-caching program provided with Windows. SMARTDrive 
saves information read from your hard disk in a disk cache in your computer's 
extended memory. When an application tries to read that information from the 
hard disk, SMARTDrive supplies the information directly from memory instead. 
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SMARTDrive also temporarily stores information to be written to disk in the disk 
cache. SMARTDrive later writes this information to the hard disk, when system 
resources are in less demand. 

Caution If you turn off your computer before the information in the disk cache 
is written to your hard disk, the information could be lost. To prevent this, type 
smartdrv /cat the command prompt to write any cached information to the hard 
disk. For more information, see "Command Reference" later in this chapter. 

Windows runs much faster when using a disk cache. The Setup program adds the 
smartdrv command to your AUTOEXEC.BAT file. It is recommended that you 
use SMARTDrive if your system has a hard disk and at least 2 MB of memory. 
The way you set up SMARTDrive depends on the applications you run and 
your system memory configuration, so there is no single "best setting" for 
SMARTDrive. By default, the size of the SMARTDrive disk cache is based on 
how much memory your system has. In most cases, this provides the best system 
performance; however, you can change the cache size and other SMARTDrive 
settings if needed. For more information, see "Command Reference" later in this 
chapter. 

Setting Multitasking Options 
When Windows is running in 386 enhanced mode, you may need to specify how 
applications share resources. You can do this by using Control Panel. 

You use the Scheduling options in the 386 Enhanced dialog box to determine 
how Windows performs when running more than one application. These options 
are described in the Help for the 386 Enhanced dialog box. For information 
about running more than one MS-DOS-based application, see Chapter 11, 
"MS-DOS Applications." 
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Command Reference 
This section describes the command-line options for the memory managers and 
disk-caching program provided with Windows. 

Using Memory Managers 
Windows provides the following memory managers that provide access to a 
particular type of memory. 

Memory manager 

HIMEM 

RAMDrive 

EMM386 

Description 

A program that coordinates the use of your system's extended 
memory so that no two applications use the same memory at 
the same time. 

A memory-resident program that enables you to use part of 
your system memory as if it were a hard disk drive. This 
memory area is called a RAM drive becanse it exists in 
random access memory (RAM). 

A program Windows uses to emulate expanded memory when 
Windows is running in standard mode. If you use applications 
that require expanded memory and you don't have any 
expanded memory installed on your computer, you can use 
EMM386 to emulate expanded memory. (Windows running in 
386 enhanced mode can emulate expanded memory and does 
not require EMM386.) 

When used with MS-DOS version 5.0 or later, EMM386 can 
also provide access to upper memory blocks (UMBs) between 
640K and lMB. For more information, see your MS-DOS 
documentation. 

You install these memory managers by adding a command line to your 
CONFIG.SYS file. The following sections describe the command-line options 
you can set for each of the memory managers provided with Windows. 

Using the HIMEM Command line 
The HIMEM command line has the following form: 

device=[ drive: }[path }himem.sys [/hmamin=m} [/numhandles=n] [/intlS==l 
[/shadowram:onlof:l] [/machine:name] [/a20control:onlof:l] [/cpuclock:onloff] 
[/eisa] 

An explanation of each part of the command line follows. In most cases you 
won't need to specify command-line options-the default values are designed 
to work with most hardware. 
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Use 

device= 

[drive:] [path ]himem.sys 

/hmamin=m 

/numhandles=n 

/int15= 

To 

Install a device driver-in this case, HIMEM. You must 
include this part of the command line. 

Specify the location of the HIMEM program file. For 
example, if HIMEM.SYS is in the WINDOWS directory 
on drive C, type c:\windows\himem.sys. If the file is in 
the root directory of your startup drive, you don't need 
to include a path. However, you must always include the 
filename (HIMEM.SYS). 

Specify how many kilobytes of memory an application 
requires for HIMEM to give that application use of the 
high memory area (HMA). Only one application can use 
the HMA at a time. HIMEM allocates the HMA to the 
first application that meets the memory-use requirements 
set by this option. You can specify a value from 0 to 63. 

The /hmamin option is not required; the default value is 
zero. Omitting this option (or setting it to zero) specifies 
that HIMEM allocate the HMA to the first application 
that requests it, regardless of how much of the HMA the 
application is going to use. 

Set /hmamin to the amount of memory required by the 
application that uses the most HMA memory. 

The /hmamin option has no effect when Windows is 
running in 386 enhanced mode. 

Specify the maximum number of extended-memory 
block (EMB) handles that can be used simultaneously. 
You can specify a value from 1 to 128; the default value 
is 32. Each additional handle requires an additional 6 
bytes of memory. 

The /numhandles option has no effect when Windows 
is running in 386 enhanced mode. 

Allocate the amount of extended memory (in kilobytes) 
to be reserved for the Interrupt 15h interface. Some older 
applications use this interface to allocate extended 
memory rather than using the XMS (extended-memory 
specification) method provided by HIMEM. If you use 
these applications, you can ensure enough memory is 
available to them by setting xxxx to 64K larger than the 
amount required by the application. 

You can specify a value from 64 to 65535; however, you 
cannot specify more memory than your system has 
available. If you specify a value less than 64, the value 
becomes 0. The default value is 0. 
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To 

Specify whether to disable shadow RAM. Some 
computers make ROM (read-only memory) code run 
faster by "shadowing" it in RAM-that is, by copying 
the ROM code into faster RAM memory at startup. 
However, this uses some extended memory. Usually, on 
computers that use shadow RAM and have less than 2 
MB of RAM, HIMEM attempts to disable shadow RAM 
to recover additional extended memory for Windows to 
use (the default value of this setting is oft). HIMEM can 
disable shadow RAM only on certain types of systems. 
When HIMEM disables shadow RAM, the ROM code 
runs in the slower ROM instead of RAM; therefore, your 
computer might run slightly slower. 

To leave the ROM code running from RAM, even on 
systems with Jess than 2 MB of memory, include the 
value /shadowram:on. To have HIMEM disable 
shadow RAM, include the value /shadowram:otT. 

Specify what type of computer you are using. Usually, 
HIMEM can detect your system type successfully; 
however, there are a few computers that HIMEM cannot 
detect. On such systems, HIMEM uses the default 
system type (IBM AT or compatible). You might need 
to include the /machine option if your computer is a 
type that HIMEM cannot detect and if HIMEM does 
not work properly on your system by using the default 
system type. 

Currently, systems that require this option include Acer 
1100, Wyse, and IBM 7552. 

The value for name can be any of the codes or their 
equivalent numbers listed in the following table. 

Code Number Computer type 

at IBM AT or 100% 
compatible 

ps2 2 IBMPS/2 

ptlcascade 3 Phoenix Cascade 
BIOS 

hpvectra 4 HP Vectra (A& A+) 

att6300plus 5 AT&T 6300 Plus 

acerl100 6 Acer 1100 

toshiba 7 Toshiba 1600 & 
1200XE 

wyse 8 Wyse 12.5 Mhz 286 
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Use 

/a20coutrol:ou/off 

/cpuclock:on/off 

/eisa 

To 

Code Number Computer type 

tulip 9 Tulip SX 

zenith 10 Zenith ZBIOS 

atl 11 IBM PC/AT 

at2 12 IBM PC/AT 
(alternative delay) 

css 12 CSS Labs 

at3 13 IBM PC/AT 
(alternative delay) 

philips 13 Philips 

fasthp 14 HPVectra 

ibm7552 15 IBM 7552 Industrial 
Computer 

bullmicral 16 Bull Micral 60 

Specify whether HIMEM is to take control of the A20 
line even if A20 was on when HIMEM was loaded. The 
A20 handler gives your computer access to the HMA. If 
you specify /a20control:off, HIMEM takes control of 
the A20 line only if A20 was off when HIMEM was 
loaded. The default setting is /a20control:on. 

Specify whether HIMEM is to affect the clock speed of 
your computer. If your computer's clock speed changes 
when you install HIMEM, specifying /cpuclock:on may 
correct the problem; however, enabling this option slows 
down HIMEM. The default setting is /cpuclock:off. 

Enable HIMEM to use all the Extended Industry 
Standard Architecture (EISA) memory installed in the 
computer. This option has no effect on non-EISA 
computers. 

Using the RAMDrive Command Line 
The RAMDrive command line has the following form: 

device=[ drive: ][path ]ramdrive.sys [DiskSize [SectorSize [NumEntries]]] [/e//a] 

An explanation of each part of the command line follows. When you set up a 
RAM drive, it is assigned the next available drive letter. 
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device= 

[drive:] [path] ramdrive.sys 

DiskSize 

SectorSize 

NumEntries 

/e 
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To 

Install a device driver-in this case, RAMDrive. You 
must include this part of the command line. 

Specify the path of the RAMDrive program file. For 
example, if RAMO RIVE.SYS is in the WINDOWS 
directory on drive C, type c:\windows\ramdrive.sys. 
If the file is in the root directory of your startup drive, 
you don't need to include a path. However, you must 
always include the filename (RAMDRIVE.SYS). 

Specify how many kilobytes of memory you want to 
use for the RAM drive. For example, to create a 640K 
RAM drive, specify 640. If you don't specify an 
amount, RAMDrive will create a 64K RAM drive. 
You can specify a value from 4 to 32767. However, 
you cannot specify more memory than your system 
has available. 

Specify the sector size in bytes. The size can be 128, 
256, or 512 bytes. (If you include a SectorSize value, 
you must also include a value for DiskSize.) 

Generally, you should use the default sector size of 
512 bytes. 

Limit the number of files and directories you can 
create in the RAM drive root directory. The limit can 
be from 2 to 1024 entries; the limit you specify is 
rounded up to the nearest sector size boundary. If you 
do not specify a limit, you can create up to 64 entries 
in the RAM drive root directory. (If you include a 
value for NumEntries, you must also include values 
for DiskSize and Sector Size.) 

If there is not enough memory to create the RAM 
drive as specified, RAMDrive will try to create it with 
a limit of 16 directory entries. This may result in a 
RAM drive with a limit different from the one you 
specified. 

Create the RAM drive in extended memory. 

For RAMDrive to use extended memory, your system 
must be configured so that it provides extended 
memory. Also, the command line for the extended­
memory manager (such as HIMEM.SYS) must appear 
in your CONFIG.SYS file before the RAMDrive 
command line. In general, it is best to create a RAM 
drive in extended memory if your system has 
extended memory. 



208 Microsoft Windows User's Gulde 

Use 

/a 

To 

Create the RAM drive in expanded memory. 

For RAMDrive to use expanded memory, your 
system must be configured so that it provides 
expanded memory. Also, the command line for the 
expanded-memory manager (such as EMM386, 
386MAX, CEMM, or QEMM) must appear in your 
CONFIG.SYS file before the RAMDrive command 
line. 

Although specifying a memory type is optional, it is highly recommended. If you 
omit both the /a and the /e options, RAMDrive uses your system's conventional 
memory. It is not a good idea to use conventional memory for a RAM drive, 
because doing so affects the performance of Windows. 

Using the EMM386 Command Line 
The EMM386 command line has the following form in the CONFIG.SYS file: 

device=[drive: ][path ]emm386.exe [ onlofflauto] [/nohigh] [memory] 
[MemoryOptions] 

An explanation of each part of the command line follows. 

Use 

device= 

[drive: ][path]emm386.exe 

[onlofflauto] 

/no high 

To 

Install a device driver-in this case, EMM386. You 
must include this part of the command line. 

Specify the location of the EMM386 program file. 
For example, if EMM386.EXE is in the WINDOWS 
directory on drive C, type c:\windows\emm386.exe. If 
the file is in the root directory of your startup drive, 
you don't need to include a path. However, you must 
always include the filename (EMM386.EXE). 

Activate EMM386 if set to on, suspend EMM386 if 
set to off, or place EMM386 in auto mode if set to 
auto. Auto mode enables expanded-memory support 
only when a program calls for it. The default value is 
on. Use the emm386 command at the command 
prompt to change this value after EMM386 has 
started. 

Specify that no part of EMM386 is loaded into upper 
memory blocks (UMBs). By default, a portion of 
EMM386 is loaded into UMBs. If UMB space is at a 
premium, use this option to save approximately 3K of 
UMBspace. 
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Use 

memory 

MemoryOptions 

To 

Specify how many kilobytes of memory you want 
EMM386 to use. For example, to give EMM386 640K 
of memory, specify 640. You can specify a value from 
64 to 32768. (EMM386 rounds the value down to the 
nearest multiple of 16.) However, you cannot specify 
more extended memory than your system has 
available. 

This value is optional; if you don't specify an amount, 
EMM386 uses 256K of memory. 

Fine-tune the way EMM386 uses memory. 

You can use the EMM386 memory options to control 
the location of the EMS page frame, determine how 
EMM386 uses certain addresses, and so on. For more 
information, see the following table. 

Under most circumstances, you don't need to specify memory options on the 
EMM386 command line, because EMM386 usually runs properly by using the 
default values. 

However, in some cases, you may want to control how EMM386 uses memory­
for example, where EMM386 puts the EMS page frame, or which addresses it can 
use for EMS pages. EMM386 provides several command-line options that you 
can use to fine-tune the way it uses memory. You can use as many of these 
options as you want, in any order, but they should follow the EMM386 path 
and memory amount (if any). 

An explanation of each EMM386 memory option follows. 

Use 

w=onlw=off 

frame=address 

To 

Enable or disable support for the Weitek Coprocessor. 
To enable support, include the value w=on in the 
EMM386 command line. To disable support, include 
the value w=off instead. By default, Weitek 
Coprocessor support is disabled. 

Specify the base address of the 64K EMS page frame. 
You can specify values in the ranges 8000h through 
9000h and COOOh through EOOOh, in increments of 
400h. 

Usually, you do not need to specify a base address; by 
default, EMM386 uses a contiguous 64 K region of 
memory, and it does not place the page frame below 
COOO:OOOO. However, sometimes it is not possible to 
identify adapter memory absolutely. If a conflict 
occurs, you may need to ensure that EMM386 places 
the page frame at a particular location. 
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Use 

mx 

/pmmmm 

pn=address 

To 

You can also use the frame option to specify a more specific base 
address. For example, to place the page frame at C800:0000, type 
frame=C800 on the EMM386 command line. 

If you use the frame option, you cannot use the m option or the /p 
option. 

Specify the address of the page frame. You can specify a value 
from 1 through 14. The following list shows each value and its 
associated base address in hexadecimal: 

1 => COOOh 8=>DC00h 

2=>C400h 9 =>EOOOh 

3 => C800h 10=> 8000h 

4=>CCOOh 11=>8400h 

5=>D000h 12=> 8800h 

6=>D400h 13 => 8COOh 

7=>D800h 14 => 9000h 

Values ranging from 10 through 14 should be used only on 
computers with 512K of memory. If you use the m option, you 
cannot use the frame option or the /p option. 

Specify tl!e address of the page frame. Valid values for mmmm are 
in the ranges 8000h through 9000h and COOOh through EOOOh, in 
increments of 400h. 

If you use the /p option, you cannot use the frame option or the m 
option. 

Define the segment address of a specific page. 

The p option has the form pn=address, in which n is the number 
of the page you are specifying and address is the segment address. 
For example, to place page 4 at the address CCOO, type p4=CCOO 
on the EMM386 command line. 

Valid values for n are in the range 0 through 255. Valid values 
for address are in the ranges 8000h through 9COOh and COOOh 
through ECOOh, in increments of 400h. The addresses for pages 0 
through 3 must be contiguous to maintain compatibility with 
version 3.2 of the LIM EMS. 

If you use the frame, m, or /p option, you cannot use the p option 
to specify addresses for pages 0 through 3. 



Use 

x=mmmm-nnnn 

i=mmmm-nnnn 

b=address 

L=minXMS 

a=altregs 

h=handles 

d=nnn 
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To 

Prevent EMM386 from using a particular range of addresses for 
an EMS page. To specify the range, inclnde this option on the 
command line, followed by the range of addresses you want to 
exclude. Valid values for mmmm and nnnn are in the range AOOOh 
through FFFFh, and are rounded down to the nearest 4 K 
boundary. For example, to prevent EMM386 from using segments 
AOOO:OOOO through BOOO:OOOO, type the value x=AOOO-BOOO on 
the EMM386 command line. 

The x option takes precedence over the i option if the two ranges 
overlap. 

Specify a range of segment addresses to be used (included) for an 
EMS page or for RAM. Valid values for mmmm and nnnn range 
from AOOOh through FFFFh, and are rounded down to the nearest 
4K boundary. 

The x option takes precedence over the i option if the two ranges 
overlap. 

Specify the lowest address available for EMS "banking" 
(swapping of 16K pages). Valid values are in the range lOOOh 
through 4000h. By defanlt, 4000:0000 is the lowest address. 
To specify a different low address, include this option on the 
EMM386 command line, followed by the address you want. For 
example, to make 3000:0000 the lowest address, include the value 
b=3000. 

Ensure that the specified amount of extended memory will still 
be available after EMM386 is loaded. Specify the amount of 
memory in kilobytes. For example, to ensure that 640K. of 
extended memory will be available after loading EMM386, 
type the value L=640 on the EMM386 command line. 

Specify how many fast alternate register sets you want to allocate 
to EMM38.6. For example, to allocate 16 register sets to EMM386, 
type the value a=16 on the command line. You can specify a 
number from 0 to 254; the default setting is 7 sets. Every alternate 
register set adds about 200 bytes to the size in memory of 
EMM386.EXE. 

Specify how many handles EMM386 can use. For example, to let 
EMM386 use 127 handles, type the value h=127 on the EMM386 
command line. You can specify from 1 to 255 handles; the default 
setting is 64. 

Specify how many kilobytes of memory should be reserved for 
buffered direct memory access (OMA). This value should 
reflect the largest OMA iransfer that will occur while you use 
EMM386.EXE, not counting floppy disk DMA. You can specify 
from 16 to 256 kilobytes; the default setting is 16. 
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Use 

ram 

noems 

To 

Provide access to both expanded memory and the 
upper memory area. This option is valid only if you 
are running MS-DOS version 5.0 or later. 

Provide access to the upper memory area, but prevent 
access to expanded memory that conforms to the LIM 
specification version 3.2. This option is valid only if 
you are running MS-DOS version 5.0 or later. 

Excluding Shared Memory Used by a Network Adapter 
If you use EMM386.EXE and you have a network adapter installed that uses 
RAM, you should exclude the memory addresses that the network adapter uses, 
so that Windows won't use the same area of memory. 

For example, if your network adapter uses memory in the address range D800h to 
D8FFh, you would exclude this range from Windows by specifying the following: 

device=c:\windows\emm386.exe x=d800-d8ff 

For information about which address space your network adapter uses, see the 
documentation for the adapter. 

Using the SMARTDrive Command Line 
If for some reason Setup did not install SMARIDrive on your system, or if you 
removed SMARIDrive, you can install it by adding the smartd" command to 
your AUTOEXEC.BAT file. For information about how to modify this file, see 
"Streamlining Your CONFIG.SYS and AUTOEXEC.BAT Files" earlier in this 
chapter. 

The SMARIDrive command line has the following form: 

[drive:][path]sma~.exe [[drive[+J-]] ... ] [!e:ElementSize] [InitCacheSize 
[WinCacheSize]] [/b:BufferSize] [le] [/r] [/I] [/q] [Is] [/?] 

An explanation of each part of the command line follows. 

Use 

[drive: ](path] smartdrv .exe 

To 

Specify the location of the SMARTDrive program 
file. For example, if SMARTDRV.EXE is in the 
WINDOWS directory on drive C, type 
c:\windows\smartdrv.exe. If the file is in the 
root directory of your startup drive, you don't need 
to include a path. However, you must always include 
the filename (SMARTDRV.EXE). 



Use 

drive 

+I-

/e:ElementSize 

lnitCacheSize 

WinCacheSize 
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To 

Specify the letter of the disk drive for which you 
want to control caching. If you don't specify a drive 
letter, floppy disk drives are read-cached but not 
write-cached, hard disk drives are read- and write­
cached, and CD-ROM and network drives are 
ignored. 

Enable(+) or disable(-) caching. Use the plus(+) 
and minus (-) signs to override the default settings. If 
you specify a drive letter without a plus or minus 
sign, read-caching is enabled and write-caching is 
disabled. If you specify a drive letter followed by a 
plus sign ( + ), read- and write-caching are enabled. If 
you specify a drive letter followed by a minus sign 
(-),read- and write-caching are disabled. 

You can specify multiple disk drives. 

Specify in bytes the amount of the cache that 
SMARIDrive moves at a time. Valid values are 
1024, 2048, 4096, and 8192. The default value is 
8192. 

Specify in kilobytes the size of the cache when 
SMARIDrive starts (before Windows is running). 
The size of the disk cache affects how efficiently 
SMARIDrive runs. In general, the larger the 
cache, the less often SMARTDrive needs to read 
information from the disk, which speeds up system 
performance. If you do not specify an InitCacheSize 
value, SMARIDrive sets the value according to 
how much memory your system has (see the table 
following this list). 

Limit to what amount (in kilobytes) Windows can 
reduce the cache size. Windows reduces the size 
of the cache to recover memory for its own use. 
Windows and SMARIDrive then cooperate to 
provide optimum use of your system memory. When 
you quit Windows, it restores the cache to its normal 
size. The default value depends on how much 
available memory your system has (see the table 
following this list). If you specify a value for 
InitCacheSize that is smaller than the value specified 
for WinCacheSize, InitCacheSize is set to the same 
size as WinCacheSize. 



214 Microsoft Windows User's Guide 

Use 

fb:BufferSize 

/c 

/r 

II 

/q 

/s 

/? 

To 

Specify the size of the read-ahead buffer. A read­
ahead buffer contains additional information that 
SMARTDrive reads when an application reads 
information from the hard disk. For example, if an 
application reads 512K of information from a file, 
SMARTDrive then reads the amount of information 
specified by BufferSize and saves it in memory. The 
next time the application needs to read information 
from that file, it can read it from memory instead. 
The default size of the read-ahead buffer is 16K Its 
value can be any multiple of the ElementSize value. 

Write all cached information from memory to the 
hard disk. SMARTDrive writes information from 
memory to the hard disk at times when other disk 
activity has slowed. You might use this option if you 
are going to tum off your computer and want to make 
sure all cached information has been written to the 
hard disk. 

Clear the contents of the existing cache and restart 
SMARTDrive. 

Prevent SMARTDrive from loading into upper 
memory blocks (UMBs), even if there are UMBs 
available. You can use this option if you are using 
MS-DOS version 5.0 or later and UMBs are enabled. 

Prevent the display of SMARTDrive information on 
your screen. 

Display additional information about the status of 
SMARTDrive. 

Display Help about the SMARTDrive command and 
options. 

The following table shows the default values for InitCacheSize and 
WinCacheSize, depending on the amount of available extended memory 
your computer has. 

Extended memory InitCacheSize WinCacheSize 

UptolMB All extended memory Zero (no caching) 

Upto2MB lMB 256K 

Upto4MB lMB 512K 

Upto6MB 2MB lMB 

6MBormore 2MB 2MB 
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Caution Check that SMARTDrive has completed all write-caching before you 
turn off your computer. To make sure this has happened, type smartdrv /c at the 
command prompt. After all disk activity has stopped, you can safely turn off your 
computer. 

Using Double Buffering 
If you have a SCSI (Small Computer System Interface) hard disk, you may need 
to use the double-buffering feature of SMARTDrive. Double buffering provides 
compatibility for hard-disk controllers that cannot work with virtual memory. If 
necessary, Setup places a smartdrv command line in the CONFIG.SYS file in 
addition to the one in the AUTOEXEC.BAT file. The command line in the 
CONFIG.SYS file is required for you to use the double-buffering feature of 
SMARTDrive. The command line in the CONFIG.SYS file has the following 
form: 

device=c:\windows\smartdrv .exe /double_ buffer 

Most hard-disk controllers do not need to use double buffering. Therefore, Setup 
does not add the command to the CONFIG.SYS file in most cases. When Setup is 
unable to determine whether double buffering is required, it adds the command 
line to the CONFIG.SYS file. 

If your computer does not require double buffering, you can remove the command 
line from the CONFIG.SYS file. 

~ To determine whether you can remove the SMARTDrive command line from 
CONFIG.SYS 

1. Make sure that the SMARTDrive driver has been loaded using the 
CONFIG.SYS command line and that double buffering is enabled. 

2. In the Main group, choose the MS-DOS Prompt icon. 

3. At the command prompt, type smartdrv and then press ENTER. SMARTDrive 
displays information about your system. 

4. Look at the column labeled "Buffering." If every line in this column reads 
"no," you can remove the device=c:\windows\smartdrv.exe /double_ buffer 
command line from your CONFIG.SYS file. 
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APPENDIX A 

Keyboard Shortcuts 

This appendix lists keyboard techniques you can use in Windows. 

Use the keyboard shortcuts described in "Basic Windows Tasks" to do common 
Windows tasks, such as choosing commands on menus and moving around in 
dialog boxes and lists. You can use these basic techniques throughout Windows 
and in Windows-based applications. 

To work with specific applications and accessories included with Windows, use 
the keyboard shortcuts described in the other sections of this appendix. 

Basic Windows Tasks 
Using Help 

To 

Start Help 

Move among the jumps in a topic 

Display all the jumps in a topic or 
cancel the selection of a jump 

Copy a Help screen or annotation onto 
the Clipboard 

Quit Help 

Press 

Fl 

TABorSHIFT+TAB 

CTRL+TAB 

ALT +PRINT SCREEN 

ALT+F4 
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Switching Between Applications 

Using Menus 

To switch 

Between applications 

To the next application 

To the previous application 

To Task List 

An MS-DOS-based application 
from a full screen to a window 
and back 

To 

Activate the menu bar 

Select a menu 

Choose a menu command 

Do this 

Press and hold down ALT or SHIFI+ALT, and 
repeatedly press TAB. 

Press ALT +ESC. 

Press SHIFT +ALT +ESC. 

Press CTRL+ESC. 

Press ALT+ENTER. 

Press 

ALT or FlO 

ALT+ the underlined character in the menu name 

An arrow key, ENTER 

Or the underlined character in a command name 

Note Although you can choose any menu command by using this method, many 
commands have faster keyboard equivalents, which are usually shown next to the 
command on the menu. 

Open the Control menu for an 
application window 

Open the Control menu for a 
document window or a group 
window 

ALT+SPACEBAR 

ALT+HYPHEN 



Using Dialog Boxes 
To 

Move between items 

Carry out a command 

Choose a selected item 

Open or close a selected list 

Move around and select items in a 
list 

Cancel the dialog box 

Moving Around 
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Do this 

See "Moving Around" later in this appendix. 

Press ENTER. 

Press SPACEBAR. 

Press ALT+DOWN ARROW. 

See "Moving Around" and "Selecting Items" later in 
this appendix. 

Press ESC or ALT +F4. (Confirmation dialog boxes 
carmot be canceled by using these keys.) 

To move Press 

Between menu commands, An arrow key 
characters in a text box, or items 
in a list 

To the next or previous dialog TAB or SHIFT+TAB 

box item 

To a dialog box item ALT+ the character underlined in the item name 

Right or left one word in a text CTRL + an arrow key 
box 

To the beginning or end of a line, HOME or END 

list, or screen 

Up or down one screen PAGE UP or PAGE DOWN 

Selecting Items 
In a Document Window 
To select 

One line of text up or down 

Text to the beginning or end of a 
document 

Press 

SHIFT+UP ARROW or SHIFT+DOWN ARROW 

SHIFT +CTRL+HOME or SHIFT +CTRL+END 
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Editing Text 

In a Document Window, Text Box, or List 
To select Press 

Text to the beginning or end of a line SHIFT+HOME or SHIFT+END 

The next or previous word SHIFT+CTRL+RIGHf ARROW or SHIFT+CTRL+LEFT 

ARROW 

One letter at a time to left or right 

In a Dialog Box 
To 

Select nonconsecutive items in a list 

Select a list item or check box 

Select all items in a list (where 
applicable) 

Cancel all selections in a list except 
the current one 

In a Text Box or Window 

SHIFT+LEFT ARROW or SHIFT +RIGHT ARROW 

Press 

SHIFT+F8, use the arrow keys to move to each item 
you want to select, press SPACEBAR to select each 
item, and press SHIFT +FS again 
when done. 

SPACEBAR 

CTRL+SLASH (f) 

CTRL+BACKSLASH (\) 

To Press 

Delete the character to the left or BACKSPACE or DEL 

right or delete selected text 

Copy selected text onto the Clipboard CTRL+C or CTRL+INS 

Move selected text onto the CTRL+X or SHIFT +DEL 

Clipboard 

Paste text from the Clipboard CTRL+ v or SHIFT+ INS 

Undo the last editing action CTRL+Zor ALT+BACKSPACE 



Copying onto the Clipboard 
To 

Copy an image of the entire screen onto 
the Clipboard. (This also works for an 
MS-DOS-based application running in 
text mode.) 

Copy an image of the active window onto the 
Clipboard 

Copy or move selected text onto and from the 
Clipboard 
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Do this 

Press PRINT SCREEN. 

Press ALT+PRINT SCREEN. 

See "Editing Text" earlier in this 
appendix. 

Quitting an Application and Closing a Window 
To 

Quit an application (or, in Program Manager, 
quit Windows) 

Close the active document window or group 
window 

Program Manager 
To 

Move between groups 

Move between items in a group window 

Start the selected application or restore the 
selected group icon 

Tile the group windows 

Cascade the group windows 

Close an active group window 

Press 

ALT+F4 

CTRL+F4 

Press 

CTRL+F6 or CTRL+TAB 

An arrow key 

ENTER 

SHIFT+F4 

SffiFT+F5 

CTRL+F4 
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File Manager 
To 

Move among the left and right sides of 
the directory window and the drive bar 

Change the drive displayed in the 
directory window 

Move among and select directories or 
files 

Display or hide a selected directory's 
subdirectories, start a selected 
application, or open a selected file 

Open a new window displaying only 
the contents of the selected directory 

Select the next file or directory whose 
name begins with a certain character 

Move the selected file or directory 

Copy the selected file or directory 

Update the information displayed 

Display the properties of the selected 
file or directory 

Print Manager 

Do this 

Press TAB or F6. 

Press CTRL + the letter representing the drive. 

See "Moving Around" and "Selecting Items" 
earlier in this appendix. 

Press ENTER. 

Press SHIFT +ENTER. 

Press the first character of the file or 
directory name. 

Press F7. 

Press FB. 

Press FS. 

Press ALT +ENTER. 

To Press 

Move between queues and between UP ARROW or DOWN ARROW 

documents in each queue 

Move the selected document up or down CTRL+UP ARROW or CTRL+DOWN ARROW 

in a queue 

Update the information displayed F5 
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Control Panel 
You can use the keyboard shortcuts described in "Basic Windows Tasks" earlier 
in this appendix to move among icons in Control Panel, select icons, and work 
with the dialog boxes displayed when you choose an icon. 

Clipboard Viewer 

PIF Editor 

To 

Clear the Clipboard contents 

Copy or move items onto and from 
the Clipboard 

Do this 

Press DEL. 

See "Copying onto the Clipboard" and 
"Editing Text" earlier in this appendix. 

You can use the keyboard shortcuts described in "Basic Windows Tasks" earlier 
in this appendix to work with the PIF Editor dialog boxes. 

Accessories 

Calculator 

Calendar 

In addition to the keyboard shortcuts described in "Basic Windows Tasks" 
earlier in this appendix, you can use techniques unique to Calculator. For more 
information, see Help for Calculator. 

Use the following keys in Calendar. 

Month View Keys 
Use the following keys in the Month view. 

To 

Move to the previous week 

Move to the next week 

Move to the previous month 

Move to the next month 

Move between a date and the scratch pad 

Change to the Day view 

Press 

UPARROW 

DOWN ARROW 

PAGE UP 

PAGE DOWN 

TAB 

ENTER 
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Cardfile 

Notepad 

Day View Keys 
Use the following keys in the Day view. 

To 

Move to the previous time 

Move to the next time 

Move to the previous screen 

Move to the next screen 

Move to the starting time 

Move to 12 entries after the starting time 

Move between the appointment area and the 
scratch pad 

Move the selection onto the Clipboard 

Copy the selection onto the Clipboard 

Paste the Clipboard contents into the 
appointment area or scratch pad 

Move to the previous day 

Move to the next day 

To 

Scroll forward or backward one card (or one 
page of index lines in List view) 

Scroll forward or backward one card in List 
view 

Display the first or last card 

Display the first card whose name begins with 
a particular character 

Press 

UPARROW 

DOWN ARROW or EN'IER 

PAGE UP 

PAGE DOWN 

CTRL+HOME 

CTRL+END 

TAB 

SHIFT+DEL 

CTRL+INS 

SHIFT+INS 

CTRL+PAGE UP 

CTRL+PAGEDOWN 

Press 

PAGE DOWN or PAGE UP 

DOWN ARROW or UP ARROW 

CTRL+HOME or CTRL+END 

SHIFT +CTRL + the character 

You can use the keyboard shortcuts described in "Basic Windows Tasks" earlier 
in this appendix to work with Notepad. 



Object Packager 

Paintbrush 

To 

Move between the Content and 
Appearance windows 

To move 

The cursor 

Among the Toolbox, Linesize box, 
Palette, and drawing area 

To scroll 

To the left or right side of the 
drawing area 

To the top or bottom of the 
drawing area 

Left or right one screen 

Up or down one screen 

Left or right one space 

Up or down one line 

To simulate 

Clicking the left mouse button 

Clicking the right mouse button 

Double-clicking the left mouse button 

Dragging the cursor 

To undo 

Part of what you have drawn since 
selecting a tool 

Everything you have drawn since 
selecting a tool 
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Press 

TAB 

Press 

An arrow key 

TAB or SHIFI'+TAB 

Press 

SHIFI' +HOME or SHIFI' +END 

HOME Or END 

SHIFI'+PAGE UP or SH!Ff+PAGE DOWN 

PAGEUPorPAGEDOWN 

SHIFI' +LEFT ARROW 
or SHIFI'+RIGHT ARROW 

SHIFI'+UP ARROW or SHIFI'+DOWN ARROW 

Press 

INS 

DEL 

F9+INS 

INS + an arrow key 

Do this 

Press BACKSPACE, and then use 
INS + the arrow keys. 

Press CTRL+Z. 
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Sound Recorder and Media Player 

Write 

You can use the same keyboard shortcuts for both Sound Recorder and Media 
Player. 

To 

Move around and select items in 
the window 

Move backward or forward when 
the scroll bar is selected 

Move backward or forward 1 
second when the scroll bar is 
selected 

Move to the beginning or end of 
the sound when the scroll bar is 
selected 

Do this 

See "Moving Around" and "Selecting Items" earlier 
in this appendix. 

Press LEFf ARROW or RIGHT ARROW. 

Press PAGE UP or PAGE DOWN. 

Press HOME or END. 

In the following table, 5 refers to the 5 key on the numeric keypad only, and will 
only work as described with the NUM WCK key turned off. 

To move to the 

Next or previous sentence 

Next or previous paragraph 

Next or previous page (if the 
document has been paginated) 

To 

Select text 

Copy or move text onto and from 
the Clipboard 

Undo the last typing or editing 
action 

Insert a manual page break 

Select a picture or object when 
the cursor is above the upper-left 
corner of the picture or object 

Press 

5+LEFf ARROW or 5+RIGHT ARROW 

5+DOWN ARROW or 5+UP ARROW 

5+PAGE DOWN or 5+PAGE UP 

Do this 

See "Selecting Items" earlier in this appendix. 

See "Copying outo the Clipboard" and "Editing Text" 
earlier in this appendix. 

Press Cl'RL+Z or ALT+BACKSPACE. 

Press Cl'RL+ENTER. 

Press DOWN ARROW. 
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To Do this 

Move the Size Picture cursor or Press an arrow key. 
move a selected picture after 
choosing Move Picture from the 
Edit menu 

Insert an invisible hyphen Press CTRL+SHIFr+HYPHEN. 

{only to be used when a word 
is wrapped) 

Switch between the document and Press ALT +F6. 

the Find or Replace dialog box, or 
between the Header and Footer 
window and the Page Header or 
Page Footer dialog box 
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Windows and Networks 

Using Windows with Networks 
The Microsoft Windows operating system provides many features that make it 
easier to work with a network's resources. Before you use these features, you 
should be aware of some basic guidelines for using networks. This appendix 
outlines Windows network features and lists guidelines for using networks. 

For information about setting up Windows from a network, see Chapter 1, 
"Setting Up Windows." 

Windows Network Features 
The following list describes what you can do with Windows and networks and 
where to find information about the Windows network features. 

You can do the following: 

• Connect your system to a particular network directory. On some networks, 
you can browse through a list of directories to find the one you want. For 
information, see Chapter 7, "File Manager." 

• Set up a network for use with Windows and set options that are specific to 
your network. For information, see Help for Windows Setup. 

• Set up network printer connections. On some networks, you can browse 
through a list of printers to find the one you want. For information, see 
Chapter 8, "Print Manager." 

231 

• Take advantage of special features offered by Print Manager when you use a 
network printer. For information, see Chapter 8, "Print Manager." 
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Guidelines for Using Networks 
You can avoid many problems when using Windows with a network by following 
these guidelines: 

• Read the NETWORKS.WR! online document that is included with this 
version of Windows to make sure your network software is compatible with 
Windows. This document contains information about running Windows with 
your specific network. 

• Always start the network before you start Windows. 

You can connect to network directories and printers after you start Windows, 
but the network software must be running on your computer before you start 
Windows. If you try to start your network after you have started Windows, 
your system may not run correctly. 

• Some networks fail if you log in or log out at the MS-DOS prompt while 
running Windows. Some networks support logging in or out by using the 
Network option in Control Panel. If your network does not support this 
feature, log in before you start Windows. 

• If you are using a shared copy of Windows or a shared copy of another 
application, use the same letter to designate the network directory on your 
system every time you connect to that directory. 

For example, if you use the drive letter W when you connect to the network 
directory to set up a shared copy of Windows, Windows records W as the path 
it should use in the future to look for the shared Windows files. If the next time 
you connect to the same network directory you use a letter other than W, you 
will not be able to start Windows correctly. 

If you do need to specify a different drive letter when you connect to a 
network directory in order to use a shared application, be sure to change 
the path that Windows uses to find the application. 

• Every time you connect to a network printer, use the same port for that 
particular printer. 

Control Panel retains the printer settings for a particular port. If you change the 
port you are using for a printer, the settings for the new port may not be correct 
for that printer. 

If you do need to change the port your printer is connected to, be sure to use 
Control Panel to change the printer settings. 



APPENDIX C 

Troubleshooting 

This appendix is designed to help if you encounter problems when using the 
Microsoft Windows operating system. Each section suggests steps you can take 
to solve the most common problems. 

This appendix has the following sections: 

• Setting Up Windows 

• Using a Mouse 

• Running Applications 

• Linking and Embedding Objects 

• Printing 

• Managing Memory 

• Using Serial Communications 

• Using Terminal 

• Using Windows with a Network 

• Using Two Versions of Windows 

• Additional Troubleshooting Techniques 

Setting Up Windows 
The following sections describe solutions to problems you might have when 
setting up Windows. 

Your system locks up during the MS-DOS part of Setup. 

233 

The first part of the Setup program runs with MS-DOS. (Later, Setup switches to 
Windows mode.) If the Setup program stops while still using MS-DOS, it may be 
because Setup was unable to correctly detect your hardware. To solve this 
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problem, type setup /i to run Setup again. This causes Setup to skip hardware 
detection and run Custom Setup, in which you specify your system settings. In the 
System Information screen, select descriptions that match the hardware on your 
system. 

Setup stops when switching from MS-DOS to Windows. 
The first part of the Setup program runs with MS-DOS. If Setup stops when 
switching from MS-DOS to Windows, it may be due to one of the following 
reasons: 

• When you started Setup, your system had an application in memory sending 
output directly to your screen. An example is a network message service that 
notifies you when printing is complete. Be sure to close any such applications 
before starting Setup. 

• Setup was unable to correctly detect your hardware or software. You need to 
quit Setup and run it again, choosing the Custom Setup option. If possible, 
Setup indicates which hardware or software is causing the problem. Make sure 
the descriptions of hardware and software in the System Information screen 
match what you have on your system. If not, correct the settings. 

• You are running the wrong version of MS-DOS. Windows version 3.1 requires 
MS-DOS version 3.1 or later. To find out which version you are running, type 
ver at the command prompt. If necessary, install a newer version of MS-DOS, 
restart your computer, and then run Windows Setup again. 

• Your system has a memory-resident program (also known as a terminate-and­
stay-resident program, or TSR) that is incompatible with Setup. Setup detects 
and notifies you about using certain programs. Read the online document 
SETUP.TXT for information about using specific programs with Setup or 
Windows. 

SETUP.TXT is a text-only file located on a Windows Setup disk. Programs are 
listed alphabetically in the file. To look at the file, use a text editor you have 
on your system, or use the following procedure. 

~ To view the SETUP.TXT file 

1. Type the following at the command prompt: 

more < setup.txt 

The file is displayed, one screen at a time. 

2. To see the next screen, press the SPACEBAR. 

3. To quit viewing the file, press CTRL+C. 
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You might need to remove from your CONFIG.SYS and AUTOEXEC.BAT files 
any command lines that specify memory-resident programs and then restart your 
computer. For more information, see "Additional Troubleshooting Techniques" 
later in this appendix. 

The Setup program keeps prompting you for the same disk. 
When you run the Setup program, you are prompted to insert disks one by one. If 
Setup doesn't recognize that you have inserted the disk you are being prompted 
for, it might be for one of the following reasons: 

• A disk-caching program (such as SMARTDrive) is caching the floppy disk. 
To correct the problem, use a text editor to open the CONFIG.SYS or 
AUTOEXEC.BAT file, and then disable or remove the command line that 
specifies the disk-caching program. 

For this change to take effect, you must restart your computer (remove the 
Setup disk from the floppy disk drive first). Then run Setup again. 

• The system did not recognize that you changed the floppy disk. To correct 
the problem, add a drivparm command to your CONFIG.SYS file, and then 
restart your computer. For example, if you are setting up Windows from a 
5.25-inch, 1.2-MB floppy disk drive labeled A, you would add the following 
line to the CONFIG.SYS file: 

drivparm = /d:O /f:l 

For this change to take effect, you must restart your computer (remove the 
Setup disk from the disk drive first). See your MS-DOS documentation for 
more information about the drivparm command. 

You have special hardware to set up with Windows. 
To use your hardware with Windows, you install a device driver. A device driver 
is a program that instructs Windows how to communicate with your hardware. 
Windows includes drivers for most popular types of display adapters, printers, 
and other devices. 

Windows drivers for your hardware may be available from the following sources: 

• Microsoft provides the Windows Driver Library (WDL), which contains 
device drivers made available after this version of Windows was released. 
If you have a modem, you can download the WDL from network services, 
including CompuServe, GEnie, Microsoft OnLine, various user-group 
bulletin-board services (BBSs on the Association of PC User Groups, or 
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APCUG, network), and the electronic downloading service maintained by 
Microsoft (phone 206-93~735). Users who do not have a modem and are 
located in the United States may obtain disks by contacting Microsoft 
Customer Support Services at 1-800-426-9400. 

• If the WDL does not include a driver for your hardware, contact your hardware 
manufacturer to find out whether a device driver is available that is compatible 
with Windows version 3.1. 

Note Color graphics adapter (CGA) display drivers are no longer included with 
Windows. You can, however, obtain a CGA display driver from the WDL, as 
previously described in this section. CGA monitors are not fully supported in 
Windows 3.1 and higher. An enhanced graphics adapter (EGA) or better is 
recommended. 

You receive a message about memory-resident programs. 
The Windows Setup program detects and warns you about some memory­
resident (TSR) programs that might not be compatible with Windows. For 
information about setting up and using specific memory-resident programs, see 
the SETUP.TXT online document. SETUP.TXT is a text-only file located on a 
Windows Setup disk. The programs are listed alphabetically in the file. To look at 
the file, use a text editor you have on your system, or use the procedure described 
in the section "Setup Stops When Switching from MS-DOS to Windows" earlier 
in this appendix. 

Windows won't start after a successful Setup. 
If you completed Setup but cannot start Windows, one of the following might be 
the cause: 

• The wrong hardware is specified for your system. This might occur because 
you ran Express Setup and Setup was unable to correctly detect your 
hardware; or because during Custom Setup, you specified the wrong hardware 
settings. In the Windows directory, type setup at the command prompt. Make 
sure the hardware information is correct in the System Information Screen. 
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• Your system may be running memory-resident (TSR) programs that are 
incompatible with Windows. Setup detects and warns you about most of these 
programs; however, your system may have a program that Setup cannot detect. 

For more information about troubleshooting problems with memory-resident 
programs, see "Streamline the CONFIG.SYS and AUTOEXEC.BAT Files" 
later in this appendix. 

If Windows still won't start, run Setup again from the Windows disks, using the 
following guidelines: 

• Type setup /i, which causes Setup to skip hardware detection. This also runs 
Custom Setup, in which you specify your system settings. In the System 
Information screen, be sure to choose descriptions that match the hardware 
on your system. Then restart your system, and type win to start Windows. 

• Type win /s (for standard mode) or win /3 (for 386 enhanced mode). If you 
can start Windows in standard mode, see the next section. 

Windows runs in standard mode but not in 386 enhanced mode. 
If you have an 80386 or 80486 computer and Windows can run only in standard 
mode, you may be able to correct the problem in one of the following ways: 

• Make sure that your computer has at least an 80386 processor and enough 
memory to run in 386 enhanced mode. You should have at least ZOOK of free 
conventional memory, 1024K (1 MB) of free extended memory, and at least 2 
MB of free disk space. 

If your system meets these requirements, try to start Windows in 386 enhanced 
mode by typing win /3 at the command prompt. Although you can force 
Windows into 386 enhanced mode if it has less than 1024K of extended 
memory, it is not recommended, because Windows may run very slowly. 

• Use the EMMExclude option when you start Windows, by typing win /d:x at 
the command prompt. This excludes the adapter area from areas that Windows 
searches for unused address space. Typically, this is the area AOOO-FFFF. The 
search can cause conflicts with adapters that use this area. 

If using this command successfully starts Windows in 386 enhanced mode, 
you might want to add the EMMExclude command to your SYSTEM.IN! file, 
as described in the procedure following this list. 

• Use the VirtualHDirq option when you start Windows, by typing win /d:v at 
the command prompt. This gives your hard disk-rather than Windows 386 
enhanced mode-control over how hard-disk interrupts are processed. 
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If using this command successfully starts Windows in 386 enhanced mode, 
you might want to add the VirtualHDirq=False command to your 
SYSTEM.IN! file, as described in the following procedure. 

.. To add an EMMExclude or VirtualHDirq command to SYSTEM.IN! 

1. Using a text editor, open the SYSTEM.IN! file, which is located in your 
Windows directory. 

2. Find the [386Enh] section of the file, and type one of the following lines: 

EMMExclude=AOOO-FFFF 

VirtualHDirq=F ALSE 

3. Save your changes to the SYSTEM.IN! file. 

4. At the command prompt, type win to start Windows. 

Note When you add the EMMExclude command to your SYSTEM.IN! file, you 
are probably excluding more address space than is necessary. To find out a more 
precise amount of address space to exclude, you can use the Microsoft 
Diagnostics (MSD) program. To start MSD, type msd at the command prompt. 
From the first screen, choose Memory. You should exclude any address space 
identified as "RAM" or "ROM." You might also be able to exclude address space 
identified as "Possibly Available." 

You need to copy Windows files directly to your computer. 
The files on the Windows Setup disks are compressed and are not usable until 
expanded. Usually, Setup and Control Panel expand the compressed files as they 
are copied to your hard disk. In some cases, you may need to copy files directly 
from a Windows Setup disk without using Setup or Control Panel. 

The EXP AND.EXE file is copied to your Windows directory during the setup 
process. 

.. To copy Windows files to your system and expand them 

1. Insert in drive A (or another floppy disk drive) the disk containing the file you 
want to expand. 

2. Type the following command at the command prompt, and then press ENTER: 

expand x:lfilenamel y:\windirectorylfilename2 

where x is the floppy disk you are copying from, filename] is the name of 
the compressed file you want to copy, y is the hard disk you are copying to, 
windirectory is the name of your Windows directory, and filename2 is the file 
you want to appear on your hard disk. The compressed file is expanded as it is 
copied to your hard disk. 
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When files are compressed, their extensions are renamed to end with an 
underscore. System files (.SYS) have the extension .SY_ as compressed files. 
For example, MOUSE.SYS is named MOUSE.SY_, and HIMEM.SYS is named 
HIMEM.SY _. When you use the Setup program to install these files, they are 
expanded and renamed with .SYS extensions. 

If you use the expand command to copy .SY_ files to your hard disk, you must 
change their filename extensions to .SYS. You can use the MS-DOS rename 
command, or you can rename each file as you copy it from the Windows Setup 
disk by using the expand command. For more information about the expand 
command, see your MS-DOS documentation. 

Using a Mouse 
The following sections describe solutions to problems you might have when 
using a mouse with Windows. If you cannot use your mouse and need to use 
your keyboard with Windows, see Chapter 4, "Windows Basics." 

The mouse won't work with Windows. 
If your mouse is not working with Windows, it could be for one of the following 
reasons: 

• If you are using a serial mouse, make sure you are using either the CO Ml or 
COM2 serial port. You cannot use serial port COM3 or COM4 with a mouse 
in Windows. Examine your hardware to see which port the mouse cable is 
attached to. Then make sure Windows is set up correctly by using the Ports 
option in Control Panel. 

• Determine which hardware interrupt (IRQ) the mouse port is set to use and 
whether there is another device set to use the same IRQ. If there is an IRQ 
conflict with the serial or bus port that the mouse is connected to, the mouse 
won't work. For information about changing IRQ settings and determining 
which IRQs the mouse port and other hardware are using, see your mouse 
and hardware documentation. 

The mouse pointer won't move. 
If your mouse pointer won't move, it could be for one of the following reasons: 

• If the mouse pointer appears on your screen but won't move, choose the 
Windows Setup icon in the Main group to display a list of settings. Make 
sure the mouse you are using is listed here. For information about keyboard 
techniques you can use in Windows, see Appendix A, "Keyboard Shortcuts." 



240 Microsoft Windows User's Guide 

• If you are certain you are using the appropriate mouse driver and the mouse 
pointer still won't move, see whether there is an interrupt (IRQ) conflict 
between the mouse port and another device. For information about 
determining which IRQ your mouse or other hardware is using, see the 
documentation supplied with your hardware. 

The mouse pointer jumps around on the Windows screen. 
If the mouse pointer jumps around rather than moving smoothly, you might have 
one of the following problems: 

• There might be a system-hardware interrupt (IRQ) conflict. You need to set up 
the mouse so that it isn't using an IRQ that is being used by another device. 
For information about changing mouse IRQ settings, see the documentation 
supplied with your mouse. 

• Your mouse needs to be cleaned. For instructions, see the documentation 
supplied with your mouse. 

The mouse won't work with an MS-DOS application running in a 
window. 

If your mouse works with an MS-DOS-based application running in a full screen 
but not with an MS-DOS-based application running in a window, you could have 
one of the following problems: 

• To use a mouse with an MS-DOS-based application running in a window, you 
must set up the mouse driver before starting Windows. For a Microsoft mouse, 
you need to use either the MOUSE.SYS or MOUSE.COM driver. You set up 
MOUSE.SYS in the CONFIG.SYS file, or you set up MOUSE.COM in the 
AUTOEXEC.BAT file. For example, to specify the MOUSE.SYS device 
driver located in the WINDOWS directory on drive C, add the following 
command line to your CONFIG.SYS file: 

device= c:\windows\mouse.sys 

The MS-DOS mouse driver you are using might not support the use of a 
mouse pointer for an MS-DOS-based application running in a window. The 
MS-DOS mouse drivers MOUSE.SYS and MOUSE.COM do support this. 

If you are copying these files from the Windows disks, you need to use the 
expand command. For more information, see "You Need to Copy Windows 
Files Directly to Your Computer" earlier in this appendix. 

• You might be using a display driver that does not support the use of a mouse 
pointer for an MS-DOS-based application running in a window. 
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If you are using a 16-color, 800x600-resolution display adapter with a display 
driver that was provided with a Windows version earlier than 3.1, you need to 
update the driver. Display drivers provided with the Windows version 3.0 
Supplemental Driver Library should be updated as well. You need to use the 
standard Super VGA display driver provided with Windows version 3.1. You 
can install this driver, even after Windows is installed, by using the Setup 
program. 

If you are using a display driver that was provided with your display 
adapter, you might need to update the driver to one designed to work with 
MS-DOS-based applications running in a window. Contact your display­
adapter manufacturer for an updated display driver. For more information 
about using specific display adapters, view the README.WRI online 
document by using Write (in the Accessories group). 

• If you are using an IBM mouse with the IBM mouse driver version 1.0, you 
need to replace this driver. Version 1.0 of this driver was not designed to 
support MS-DOS-based applications rum:iing in a window. Contact your 
dealer for an updated version. of the mouse driver. 

Running Applications 
Applications usually run without problems. However, you might occasionally 
receive an error message when starting or running an application, or a key or 
function might not work properly. The following recommendations cover the 
most common problems. 

You press a key, and the unexpected happens~ 
If a key combination doesn't work, it is usually because Windows or another 
running application is using the key combination for another purpose. 

The following are some common problems and solutions: 

• You use a key combination that should perform a function in an application, 
but it instead performs a Windows function (for example, you unexpectedly 
switch to another application). 

You are probably using a Windows shortcut key. You assign a Windows 
shortcut key to an application by using the Properties command on the 
File menu in Program Manager or by specifying a key combination in the 
application's program information file (PIF). Use the Properties command 
or check the application's PIF to find out whether you have assigned a 
Windows shortcut key to your application. For more information, see 
Chapter 5, "Application Basics," and Help for PIF Editor. 
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• You press a Windows shortcut-key combination, such as ALT+ TAB, but the 
Windows function is not performed. 

The key combination probably is reserved for an MS-DOS-based application 
and no longer performs the Windows function. Check the PIF of the 
foreground application to determine whether a Windows key combination 
is reserved for that application. 

• If Windows is running in 386 enhanced mode and you hear a beep whenever 
you press a key while using a particular application, Windows might have 
suspended that application. This might happen, for example, if you try to run 
the application in a window but it cannot run in a window. If that is the case, 
press ALT +ENTER to return the application to a full screen. If the application 
does not respond to ALT+ENTER, you might be able to press CTRL+ALT+DEL 

to quit the application without having to restart Windows or your computer. 

• If Windows is running in 386 enhanced mode and you have chosen the 
Select or Mark command from the Control menu (the application's title bar 
will contain the word "Select" or "Mark"), Windows is waiting for you to 
select information to copy onto the Clipboard. To cancel the command, press 
the ESC key. To copy selected information onto the Clipboard, choose the 
Copy command from the application's Edit menu, or click using the right 
mouse button. 

• If Windows is running in 386 enhanced mode and you have chosen the Scroll 
command from the Control menu (the application's title bar will contain the 
word "Scroll"), Windows is waiting for you to use the arrow keys to scroll 
through the information in the application's window. To cancel the Scroll 
command, press the ESC key. 

• If you are using a language that has accented characters, you might not be 
able to use those characters when naming files. Before MS-DOS reads a 
filename, it shifts all the letters in the filename to uppercase. Some accented 
characters do not have valid uppercase characters. 

Your application stops responding to the system. 
If an application stops responding to the system, use the following checklist: 

• You can press CTRL+ALT+DEL to quit an application that has stopped 
responding to the system. Windows displays a message confirming your 
action. To continue, follow the instructions in the message. 

When you are using MS-DOS (not MS-DOS Prompt within Windows) 
and you press CTRL+ALT+DEL, your computer restarts. When you press 
CTRL+ALT+DEL while using Windows, you can quit the application that has 
stopped responding without having to restart your computer or Windows. 

• You are running an earlier version of a Windows application that is 
incompatible with Windows version 3.0 or later. Contact the manufacturer 
for an updated version of the application. 
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Your application runs too slowly. 
If your application runs too slowly, try one of the following solutions: 

• Your system might be low on memory. If your hard-disk light blinks 
frequently, Windows is swapping information to disk to make room in 
memory for other information or is rereading information from the disk 
into memory. For information about making more memory available, see 
Chapter 14, "Managing Memory and Performance." 

• You might need to set up a permanent swap file. If Windows is running 
in 386 enhanced mode and you run more than one application at a time or 
applications that use very large files, you should set up a permanent swap 
file. Do this by choosing the 386 Enhanced icon in Control Panel and then 
choosing the Virtual Memory button. For more information, press the Fl key 
while using the dialog box, or see Chapter 14, "Managing Memory and 
Performance." 

Your Super VGA screen contents are not restored correctly. 
If you use a Super VGA and the screen contents aren't restored correctly when 
you switch between Windows and an MS-DOS-based application, you probably 
need to update your display driver. The Super VGA display driver provided with 
Windows version 3.1 supports most 16-color, 800x600-resolution display 
adapters. If it doesn't work correctly, contact the display-adapter manufacturer to 
find out whether there is a Windows version 3.1 display driver available for your 
display adapter. 

You cannot take a snapshot of the screen. 
If you cannot take a "snapshot" of an application screen, one of the following 
might be the cause: 

• If Windows is running in standard mode and you are trying to take a snapshot 
of an MS-DOS-based application, open the application's program information 
file (PIF) by using PIF Editor, and see whether the No Screen Exchange check 
box is selected in the application's PIF. This option prevents you from copying 
information onto the Clipboard by using PRINT SCREEN or the ALT +PRINT 

SCREEN key combination. This option might be set to give the application 
enough memory to run. Try clearing this check box. 

• If you are trying to take a snapshot of an MS-DOS-based application by 
using the PRINT SCREEN or ALT+PRINT SCREEN key combination (usually 
Windows shortcut keys), these combinations might be reserved for the active 
application. Try clearing the corresponding Reserve Shortcut Key check boxes 
in the active application's PIF. 
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• If Windows is running in standard mode, the wrong Video Mode option button 
might be selected in the application's PIF. Try selecting a higher-resolution 
video mode. 

• If Windows is running in 386 enhanced mode, more memory might be 
required. Quit some applications to free memory. For more information, 
see "Managing Memory" later in this appendix. 

You cannot paste information into an MS-DOS-based application. 
If you cannot paste information from the Clipboard into an MS-DOS-based 
application, one of the following could be the cause: 

• The information might not be in text format. Windows cannot paste graphics 
into an MS-DOS-based application. Try saving the information you want to 
paste as a separate file and then opening the file by using the application. 

• An MS-DOS-based application might not be able to accommodate the fastest 
pasting method. If Windows is running in 386 enhanced mode, the Allow Fast 
Paste check box in the application's PIF is usually selected because most 
applications can accommodate the fastest pasting method. However, if the 
application cannot use the fastest method, it might not respond when you try to 
paste into it. Try clearing the Allow Fast Paste check box in the application's 
PIF. You must restart the application for the changes to a PIF to take effect. 

You cannot change the font size for an MS-DOS-based 
application. 

If you cannot change the font size for an MS-DOS-based application running 
in a window, one of the following could be the cause: 

• The application is probably running in graphics mode. You can change 
font sizes only when the application is running in text mode. With some 
MS-DOS-based applications, you can choose which mode the application 
runs in. To find out whether your application can run in text mode, see the 
documentation included with the application. 

• You might be using a display driver that doesn't provide the capability of 
changing fonts for an MS-DOS-based application running in a window. 
If you are using a 16-color, 800x600-resolution video graphics adapter (Super 
VGA), make sure you are using the Super VGA display driver provided with 
Windows version 3.1. This driver supports most Super VGA display adapters. 
If this driver doesn't work, contact the display-adapter manufacturer to find 
out whether a Windows version 3.1 display driver is available. 
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• If you are using a display driver that doesn't provide the capability of 
changing fonts for an MS-DOS-based application running in a window, 
try including the following line in the [Non WindowsApp] section of the 
SYSTEM.IN! file: 

FontChangeEnable=l 

For more information about modifying the SYSTEM.IN! file, view the 
SYSINI.WRI online document by using Write (in the Accessories group). 

Nole This setting does not work for all display drivers. In some cases, specifying 
this setting causes the mouse pointer to be displayed incorrectly. 

Your system stops responding or quits unexpectedly. 
If Windows or your computer stops responding, an application or Windows closes 
unexpectedly, or your computer restarts unexpectedly, one of the following might 
be the cause: 

• You are running an earlier version of a Windows-based application that is 
incompatible with Windows version 3.0 or later. Contact the manufacturer for 
an updated version of the application. 

• You are using hardware that is incompatible with Windows. Sometimes 
you can resolve hardware incompatibility by adjusting settings in your 
SYSTEM.IN! file. For more information about SYSTEM.IN!, use Write to 
view the SYSINI.WRI online document. 

You receive a message that the registration database is 
corrupted. 

If you have problems such as the following, your registration database may be 
corrupted: 

• You try to open or print a file that is associated with an application and you 
receive a message that the association information is incomplete. 

• While working with linked or embedded objects, you receive a message that 
the server is not registering properly. 

• In File Manager, you choose the Associate command and there are no entries 
in the list of files in the Associate dialog box. 

If your registration database is corrupted, you must delete the registration 
database and then recreate it. 
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~ To restore your registration database 

1. Quit Windows. 

2. Delete the REG.DAT file (located in your Windows directory). 

3. Restart Windows. 

4. Start Registration Info Editor by opening File Manager and then choosing the 
REGEDIT.EXE file (located in your Windows directory). 

5. From the File menu, choose Merge Registration File. The Merge Registration 
dialog box appears. 

6. In the File Name List, select the SETUP.REG file, and then choose the OK 
button. (The SETUP.REG file is located in the Windows SYSTEM 
subdirectory.) 

7. Search for *.REG files on drive C by using the Search command on the File 
menu in File Manager. 

8. Double-click each .REG file (or select it, and then press ENTER). 

9. Repeat steps 6 through 8 for each drive on your system. 

Note You may need to contact your software manufacturer if problems still 
persist when running a Windows-based application. 

Linking and Embedding Objects 
The following sections describe solutions to problems you might encounter when 
linking and embedding objects by using Windows-based applications that support 
object linking and embedding. 

You receive a message that the server is unavailable. 
The application used to create the object (sometimes referred to as a server 
application) must be available when you try to create, edit, play, or update an 
object in a destination document. A server application cannot respond if it is 
performing an action such as printing or making calculations, if the cursor is in 
a field waiting for information, or if a dialog box is open. 

Use the following guidelines to solve the problem: 

• Wait a short while to determine whether the server is going to become 
available to respond to your request. If it becomes available, the message 
closes and your request is processed. 
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If the server application does not become available, you may be able to 
choose the Cancel button in the dialog box to cancel the request. If you do 
not want to or cannot cancel the request, determine which server application is 
unavailable. Then switch to the server application, and complete or cancel the 
action that is causing the application to be unavailable. 

• Your registration database may be corrupted. For information about restoring 
your registration database, see "You Receive a Message That the Registration 
Database is Corrupted" earlier in this appendix. 

You choose an object type from the Insert Object dialog box, but 
the application doesn't open. 

If you choose an object type from the Insert Object dialog box and the application 
doesn't open, it means Windows cannot find the application. 

Use the following checklist to solve the problem: 

• Make sure the application that creates this object type has not been deleted 
from the computer. For example, Paintbrush (PBRUSH.EXE) needs to be on 
your computer before you can open a Paintbrush Picture object type,., 

• If the application has been moved from the location specified in the, 
registration database, make sure the directory containing the application 
is included in the path in your AUTOEXEC.BAT file. 

• Try reinstalling the application. 

You get different results each time you use the Paste command. 
When you use the Paste command, the contents of the Clipboard are either 
inserted or embedded into the document. The result is determined by the type 
of application you used to create the information on the Clipboard. 

If you used a server application-one that can supply objects for object linking 
and embedding-the information may be embedded when you choose the Paste 
command. When the information is embedded, you can activate the information 
or edit it from within the document. 

If the application used to create the information on the Clipboard does not 
support object linking and embedding, the information is simply inserted when 
you choose the Paste command and cannot be edited or activated from within the 
document. 
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A linked sound object updates automatically even though it is set 
to update manually. 

When you create a link, you are inserting into the destination document a 
reference to the source document that contains the linked object. When the 
object is placed in the destination document, you see either the same information 
that is in the source document or a representation of that data, such as an icon. 
When an object is represented by an icon, as it always is for a sound object, you 
always get the latest information when you choose the object. 

The Picture option in the Content window of Object Packager is 
unavailable. 

The Picture option in the Content window displays a snapshot view of the 
object. Picture View is available only when the object was created with a server 
application and when the Clipboard is used to transfer the object into Object 
Packager. 

If you use the Import command on the File menu to load a document into Object 
Packager, or you copy onto the Clipboard information created by using an 
application that is not a server, the Picture option is not available. 

A linked object is not updating. 
Under certain circumstances, a linked object must be manually updated in the 
source document before the linked object in the destination document is 
updated, regardless of whether it is an automatic or manual link. This is true for 
links to documents that contain text, spreadsheets, and pictures because these 
linked objects are represented in the destination document by images that 
reproduce the information in the source file. This is not true for links to sound 
and animation files because these types of links are represented by icons and 
not by the contents of the linked document. 

For example, suppose you have a destination document open that contains a link 
to a Paintbrush document, and you have the source document open in Paintbrush. 
When you make changes to the source document in Paintbrush, the visual 
presentation of the Paintbrush object in the destination document is not updated 
with the changes you are making. You must save the document in Paintbrush and 
then update the linked object in the destination document to see the updated 
object. 
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.. To update a link 

1. Select the linked object in the destination document. 

2. From the Edit menu, choose Links. 

3. Choose the Update Now button. 

4. Choose the OK button. 

The Paste command in Cardfile is not available, yet there is 
information on the Clipboard. 

You must first choose the Picture command from the Edit menu before you can 
use the Paste, Paste Link, and Paste Special commands in Cardfile. 

A check mark appears next to the Picture command when it is in effect. 

The Paste link command appears dimmed, yet there is 
information on the Clipboard. 

Printing 

If the Paste Link command appears dimmed in your application and you know 
there is information on the Clipboard, one of the following may be the cause: 

• You can only create a link to information in a saved file, so the Paste Link 
command is available in the destination document's application only when 
you copy information from a saved file onto the Clipboard. 

Save the file before copying information onto the Clipboard. Then you have 
the choice of using the Paste command to embed the information or the Paste 
Link command to create a link to it. 

• If you have chosen the Paste Special command in a destination document 
and are selecting from a list of file formats, the Paste Link command will be 
available only when the format you have selected is supported by the 
application used to create the destination document. 

The following sections describe common printer problems and offer suggestions 
for correcting the problems. When there are suggested steps to follow, you should 
try to print after you complete one of the steps. If you can print from Windows, 
you've solved the problem. If not, try the next step. 
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Your printer does not print. 
When a printer cannot print, the cause is often mechanical. For example, the 
printer could be offline, turned off, or disconnected. Use the following checklist: 

• Is the printer plugged in, turned on, and online? 

• Do you have the correct cable for your printer, and is it properly connected? 
For example, if you are using a Hewlett-Packard plotter, you need to use a 
Hewlett-Packard plotter cable. If you suspect the cable is the problem, you 
may want to borrow a cable that is working with another computer and printer. 

• Does the currently selected printer in the application you are printing from 
match the printer you are printing to? 

• Are the printing options set correctly, and have you chosen the correct port for 
the selected printer? For more information, see Chapter 8, "Print Manager." 

• When you are using a serial printer and you choose the Ports icon in Control 
Panel, does the information in the Settings dialog box match those required by 
your printer? For more information, see Chapter 13, "Configuring Hardware." 

• Do you need to change the ribbon, install a print wheel or cartridge, or add 
paper? Choose the Print Manager icon in the Main group. Depending on the 
printer you are using and the commands you have chosen from the Options 
menu, a message might appear that describes the problem. 

• If you are printing to a network printer, have you connected to the network 
printer? 

• Can you print from Notepad and Write? If so, the problem is likely with the 
application you are using. Consult the application's documentation or contact 
the software manufacturer. 

• If you are using a switchbox to switch between different printers, try clearing 
the Fast Printing Direct To Port check box in the Connect dialog box. (Choose 
the Printer icon in Control Panel, and then choose the Connect button.) If this 
doesn't work, try printing directly to the printer without using the switchbox. 

If you still cannot print, try copying a small text file from MS-DOS directly to the 
port your printer is connected to. For printers that accept ASCII codes (such as 
dot-matrix printers) and PCL printers (Hewlett-Packard DeskJet, LaserJet, or 
compatible printers), you could type the following at the command prompt, 
specifying the directory where your Windows files are located, and the port 
you are using: 

copy c:\windows\setup.txt lptl: 

The output from the copy command (in this example, the contents of your 
SETUP.TXT file) is sent to the printer that is using LPTl instead of to the screen. 
If the file doesn't print, the problem is not with Windows. For more information, 
see the documentation supplied with your printer. 
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For PostScript printers, try copying the file TESTPS.TXT to the port you are 
using. This file was copied to your hard disk when you installed the PostScript 
printer driver. For example, if your Windows system files are stored in a directory 
named C:\WINDOWS\SYSTEM (the default directory name), you would type the 
following: 

copy c:\windows\system\testps.txt coml 

This command line prints a list of communications settings. Make sure your 
settings match the list. 

You can print from MS-DOS but not from Windows. 
If you can print from MS-DOS hut not from Windows, there may not be enough 
space for Windows to store temporary files. (Windows creates temporary files 
when printing, even if you are not using Print Manager.) 

Jll> To see how much space exists for temporary files 

1. At the command prompt, type set to see what directory the TEMP 
environment variable is set to use. 

2. If there is a TEMP variable listed, make sure the specified directory exists. If 
it doesn't exist, you need to create it or reset the value of TEMP to specify 
an existing directory. If there is no TEMP variable listed, define one. For 
example, to set the TEMP variable to use a directory named TMP located 
on drive C, add the following line to your AUTOEXEC.BAT file: 

set temp=c:\tmp 

You need to restart your computer after making changes to the 
AUTOEXEC.BAT file. Windows uses the root directory of your 
startup drive to store temporary files if no other location is defined. 

3. Change to the directory specified by the TEMP variable. 

4. Type dir to see how much space is available. Windows needs at least 2 MB 
of free disk space in which to store temporary files. 

5. If you had to change any of these settings, try printing again. 

If you still cannot print, step through the following checklist: 

• Check the printer cable. Windows-based applications require that all pin 
connectors are functioning, whereas some MS-DOS-based applications 
do not. Try using a cable that you know is functioning. 

• If you are using a serial printer, make sure you do not have an interrupt (IRQ) 
conflict. A mouse might be on the same IRQ as the serial port being used for 
printing. 
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• Make sure you are not using a serial port to connect to a network printer. 
Windows supports network-printer connections on parallel (LP'I) ports only. 

• If you are using a printer that isn't listed during Windows Setup (or in the 
Printers dialog box in Print Manager or Control Panel) and are trying to 
emulate a standard printer, make sure you have chosen the correct printer 
to emulate. See your printer documentation. 

• Try printing without using Print Manager. To turn off (deactivate) Print 
Manager, choose the Printers icon in Control Panel, and then clear the Use 
Print Manager check box. 

• If you are printing to LPTl, try printing to the LPTl.DOS file instead. 
To specify the LPTl.DOS file, choose the Printers icon in Control Panel. 
When the Printers dialog box appears, choose the Connect button. Choose 
LPTl .DOS from the Ports list. If LPTl .DOS does not appear in the list, you 
need to add it to the list of ports in the [ports] section of the WIN.INI file. 
For more information, view the WININI.WRI online document by using Write 
(in the Accessories group). 

The page prints but is formatted incorrectly. 
If the pages of a document are formatted incorrectly, the margins are incorrect, the 
document contains extra lines, or the document is paginated incorrectly, use this 
checklist: 

• If you haven't already read the PRINTERS.WR! online document provided 
with Windows, you should determine whether it contains information specific 
to your printer. You can view this file by using Write (in the Accessories 
group). 

• Make sure your printer is capable of printing the formats you specified in your 
application. Pay special attention to your printer's capabilities when selecting 
fonts and point sizes. For more information about the font you specified in 
Windows, start Write, and then choose Fonts from the Character menu. The 
Font dialog box appears, providing information about the fonts that are 
available with Windows. 

• Make sure you specified the correct settings when you configured your 
printer. When configuring a printer, you can control settings such as margin 
size, number of lines per printed page, paper orientation, and number of dots 
per inch. Choose the Printers icon in Control Panel. In the Printers dialog box, 
select the printer you are using, and then choose the Setup button. 

• If your printer has hardware switches that set page length or line length, 
make sure you've chosen the correct settings. (For information, see your 
printer documentation.) For example, on a Hewlett-Packard LaserJet printer, 
you would set the number of lines per printed page to a maximum of 66. 
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• If your printer has a hardware switch that inserts an automatic linefeed at 
each carriage return, it should be set for carriage returns only. For more 
information, see your printer documentation. 

• Determine whether the formatting problems are consistent by printing the 
same file twice. If the two printouts look different, you may be having 
problems sending printing information through the port. 

Your printer output is garbled. 
If you can print your document, but it is unreadable or contains extra characters, 
use this checklist: 

• Make sure the correct printer is selected as the default printer. For more 
information, see Chapter 8, "Print Manager." 

• If your printer accepts font cartridges, make sure you select the correct 
cartridge when you set the printing options. If the wrong font cartridge is 
selected, the printer may insert stray characters at the beginning of lines. 
For more information, see Chapter 12, "Customizing Windows." 

• If you have a serial printer, make sure the settings for the printer port match 
those required by your printer. Choose the Ports icon in Control Panel, and 
then choose the Settings button. Lowering the baud rate might solve the 
problem. 

• You may be using a printer that isn't listed during Windows Setup (or in the 
Printers dialog box in Print Manager or Control Panel). If so, you are probably 
trying to use your printer to emulate a standard printer. Few printers are 100-
percent accurate when emulating industry-standard printers. Often, fonts are 
not printed accurately. Try emulating a different type of printer. You could 
also contact the printer manufacturer to find out whether a Windows printer 
driver is available for your printer. 

• The printer buffer may be retaining garbled information. Try turning the 
printer off, waiting a few seconds, and then turning it on again. 

• The printer cable may be faulty. Verify that you have the correct cable and 
that it is functioning. 

As a last resort, try installing the Windows Generic(fext Only printer-driver file 
to see how it works with your printer. You could also contact your printer 
manufacturer or dealer lo determine whether there is a problem with your printer. 
For information about installing printer drivers, see Chapter 8, "Print Manager." 
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The last page of a document is left in the printer. 
Some MS-DOS-based applications leave the last page of a document in the 
printer instead of ejecting it when printing is completed. When this happens, 
the next document to be printed starts printing on the last page of the previous 
document. 

If your printer has a form-feed or continue button, you can press the button to get 
the last page out of the printer. 

If you are printing multiple documents, using separator pages can also solve this 
problem. If the last page of a document is still in the printer, it is ejected when the 
separator page that precedes the next document is fed in. 

The fonts on your screen and the fonts that print are different. 
A font set is a group of letters, numbers, symbols, and punctuation marks having 
the same design. Screen fonts display information in windows and dialog boxes. 
Printer fonts are part of the printer driver or are in the form of cartridge fonts and 
soft fonts. Many printer drivers, cartridge fonts, and soft fonts have matching 
screen fonts so that the fonts on your screen look the same as those that print. 
If matching fonts are not available, Windows uses a font that looks the most like 
the printer font being used. Sometimes there isn't a font that looks the same. 

If you use TrueType fonts, Windows and Windows-based applications use the 
same fonts, and fonts appear the same on the screen as they do when printed. 
TrueType fonts are installed when you set up Windows. · 

~ To find out whether TrueType fonts are available 

1. In the Control Panel window, choose the Fonts icon. 

2. Choose the TrueType button. 

3. Note whether the Enable TrueType Fonts check box is selected. If it is, 
TrueType fonts are available and can be used in your documents. 

To view available fonts, choose the Write icon in the Accessories group, and 
then choose the Fonts command from the Character menu. The Font dialog box 
appears, displaying samples of various fonts. The TrueType fonts have a 
TrueType icon next to them, and printer fonts have a printer icon. Plotter and 
screen fonts have no icon next to them. 

You cannot print TrueType fonts on your laser printer. 
When you are using a laser printer, TrueType fonts are listed in your application 
as a selectable font only if you are using a Windows version 3.1 printer driver. 
Windows version 3.1 printer drivers provide the necessary information for 
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printing TrueType fonts. If you cannot print TrueType fonts, the printer driver 
you are using may not be the correct version. Contact your printer manufacturer 
to find out whether a Windows version 3.1 printer driver is available for your 
printer or whether one of the printer drivers supplied with Windows can work 
with your printer. 

Your laser printer does not print your cartridge or soft fonts. 
If you install a font cartridge or soft fonts for your laser printer, but the printer 
doesn't print these fonts, use this checklist: 

• Make sure the printing-option settings for your printer are correct and that you 
have selected the correct cartridge from the Cartridges list in the Setup dialog 
box. To select a cartridge, choose the Printers icon in Control Panel, and then 
choose the Setup button. 

• If you are using a font cartridge, tum off the printer and make sure the 
cartridge is all the way in its slot. You may need to press firmly on the 
cartridge until it pops into the slot. 

• If you are using soft fonts, make sure they are properly installed. (For 
information, see the installation kit provided with your soft fonts.) 

• If your soft fonts are installed as permanent, perhaps the printer was turned 
off or reset. Try sending the soft fonts to the printer again. 

• You may be using too many soft fonts. Printer drivers can support a limited 
number of soft fonts. Generally, PostScript printer drivers have a limit of about 
170 soft fonts. PCL printer drivers generally have a limit of 250 soft fonts. 

The number of soft fonts you can use is also limited by the maximum size of 
the WIN.INI file. The WIN.INI file can be no larger than 64K. If the file is 
full, you cannot specify any additional soft fonts. One way to minimize the 
size of the WIN.INI file is to move the soft-font files closer to the root of the 
directory structure and then specify these shorter paths in the WIN.INI file. 

You can also try installing fewer fonts or installing them as temporary fonts, if 
appropriate. For more information, see your printer documentation or contact 
your printer manufacturer. 

• If you have changed port connections since you installed soft fonts, you need 
to reinstall the soft fonts for the new port. If you are using the Hewlett-Packard 
LaserJet and DeskJet family of printers, choose the Printers icon in Control 
Panel, and then choose the Setup button in the Printers dialog box. Then use 
the Fouts button in the Print Setup dialog box to copy soft fonts from one port 
to another. 
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The printer loses text. 
• If you are using a parallel printer and an LPT port, and the printer loses text, 

the cable could be faulty. Try using a new cable of the same type. 

If you have a serial printer and it prints the document but loses blocks of text, you 
might have a flow-control (also called handshake) problem with your serial port. 

To check for a flow-control problem: 

• Try lowering the baud rate. 

• Make sure all communications settings (baud rate, data bits, parity, stop 
bits, and flow control) are set the same in Windows, in MS-DOS, and on the 
printer. The most common values for these settings are 9600 baud, 8 data bits, 
no parity, 1 stop bit, and Xon/Xoff flow control. 

You can change these settings in Windows by choosing the Ports icon in 
Control Panel and then choosing the Settings button. You can also change 
these settings in MS-DOS by using the mode command. For information 
about mode command-line options, see your MS-DOS documentation. For 
information about settings on the printer, see your printer documentation. 

If the printer is still losing text, make sure all the manual switches on your printer 
are set as described in your printer documentation. If you are using a network 
printer, make sure you are using network software that works with Windows. 
For more information, see the NETWORKS.WR! online document provided with 
Windows. You can view this file by using Write (in the Accessories group). 

Only part of a page prints. 
If your printer prints only part of your document, use the following checklist: 

• The most common cause of this problem is insufficient memory in the printer. 
It is recommended that you add more memory to the printer. If you are 
printing graphics, try using a lower print resolution. You can try printing a 
page of text to confirm that you are running out of memory because you are 
printing graphics. 

• Make sure the paper size you chose when configuring the printer matches 
the paper size loaded in the printer. 

• Make sure you have selected the appropriate memory setting in the printer­
driver dialog box. Make sure you haven't specified more memory than your 
printer actually has. 

To view this dialog box, choose the Printer Setup command from the Options 
menu in Print Manager. 



Appendix C Troubleshooting 257 

Paintbrush graphics are too small when printed. 
If you are using Paintbrush and the printed image is much smaller than you 
expected, use the following checklist: 

• From the File menu in Paintbrush, choose Print. Make sure the Use Printer 
Resolution check box is cleared in the Print dialog box. Also, check the 
scaling factor. If a small scaling factor is specified, the printer output is small. 

• From the View menu, choose View Picture to see how the image appears on 
the page. You may need to adjust the position. 

Your Postscript printer runs out of memory. 
Occasionally when you try to print a file, you might see a message indicating 
that the printer is out of memory. 

If you are using a Postscript printer, and the document you are trying to print 
includes soft fonts, try using TrueType or printer fonts instead. (For more 
information, see Chapter 12, "Customizing Windows.") 

You can also try changing some of the options in the Advanced Options 
dialog box . 

._ To change a Postscript printer's options 

1. In the Main group, choose the Print Manager icon. 

2. From the Options menu, choose Printer Setup. 

3. From the list of installed printers, select the printer you are using. 

4. Choose the Setup button. 

5. Choose the Options button. 

6. Choose the Advanced button. 

7. In the Send To Printer As list, make sure Adobe Type 1 is selected. This 
option causes the driver to use outline fonts for large point sizes and 
bitmaps for small point sizes. 

8. Make sure the Clear Memory Per Page check box is selected. This option 
causes the driver to clear the printer's memory after printing each page. 

9. Make sure the Use Substitution Table check box is select.ed. This option 
causes the driver to use a built-in printer font alreadyin the printer's 
memory instead of using a new font. Make sure you select a printer font 
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to use in place of the TrueType fonts in your document. To do this, choose 
the Edit Substitution Table button, and then supply the necessary information 
in the Substitution dialog box. 

If you need help working with the Advanced Options or the Substitution dialog 
box, choose the Help button or press Fl while using the dialog box. 

If a problem still exists after completing this procedure, consider adding more 
memory to your printer. If your printer still runs out of memory when printing, 
there is a problem with the driver or printer. For more information, contact your 
printer manufacturer. 

You receive a message that the printer is not responding. 
When printing files, you may receive the following message from Print Manager: 
"The printer on LPTl is not responding. Check the printer or increase the 
Transmission Retry value in the Printer Connect dialog box, and then resume 
the print queue." 

Check whether there is a problem with the printer, such as jammed paper, and 
make sure the printer is online. 

You might also receive this message if you are using PostScript printer 
cartridges; it is most common when printing graphics with these cartridges. 
When the printing process takes too long, it appears to Windows that a printer is 
not responding. If you receive this message, go through the following procedure 
to increase the value (in seconds) of the Transmission Retry setting. 

~ To change the Transmission Retry setting 

1. In the Main group, choose the Print Manager icon. 

2. From the Options menu, choose Printer Setup. 

3. Select the printer you are using. 

4. Choose the Connect button. 

5. In the Transmission Retry box, type a larger value (start by doubling the 
current value). 

Managing Memory 
The following sections describe solutions to problems you might encounter when 
managing memory in Windows. For more information about managing memory, 
see Chapter 14, "Managing Memory and Performance." 
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You receive an out-of-memory message. 
If you receive an out-of-memory message when you try to start an application, 
you can free memory in a number of ways, including the following: 

• Free some memory before starting Windows. You may be able to do this 
by modifying your CONFIG.SYS and AUTOEXEC.BAT files to eliminate 
any memory-resident software that isn't needed by all applications. For 
information about how to do this, see Chapter 14, "Managing Memory 
and Performance." 

• ·Close any applications you aren't using. 

• Run MS-DOS-based applications in a full screen instead of a window 
(possible in 386 enhanced mode only). If an MS-DOS-based application is 
running in a window, you can switch it to a full screen by pressing ALT+ENI'ER 

while it is the active application. 

• Reduce Windows-based applications to icons. Many applications use less 
memory when minimized than when running in a window. To reduce an 
application to an icon, click the Minimize button in the upper-right comer of 
the window. Or bring the application to the foreground, press ALT+SPACEBAR 

to open the Control menu, and then choose Minimize. 

• Qear or save the Clipboard contents. For information about using the 
Clipboard, see Chapter 5, "Application Basics." 

• If you are using a desktop wallpaper, set the wallpaper to None or use a pattern 
(a pattern uses less memory than wallpaper). For more information, see 
Chapter 12, "Customizing Windows." 

• If you are trying to run an MS-DOS-based application, change its PIF options. 
Descriptions of PIF Editor options follow this section. For more information 
about PIF options, see Help for PIF Editor. 

• If you are trying to run more than one MS-DOS-based application at a time 
(in 386 enhanced mode), use PIF Editor to change the multitasking options, 
Background Priority and Foreground Priority. For more information about 
these options, see Chapter 11, "MS-DOS Applications." 

• If Windows is running in 386 enhanced mode, set the PIF for each 
MS-DOS-based application so that the application does not run when 
it is in the background. When the Execution Background setting is not 
selected, the MS-DOS-based application does not run when it is in the 
background. This may temporarily free memory. 

• Make sure Windows has enough available hard-disk space to create 
and use swap files. For information about how Windows uses swap files, 
see Chapter 14, "Managing Memory and Performance." 
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• If possible, set up a permanent swap file. If Windows is running in 386 
enhanced mode, you can do this by choosing the 386 Enhanced icon in 
Control Panel and then choosing the Virtual Memory option button. For 
help with this dialog box, press Fl while using it, or see Chapter 14, 
"Managing Memory and Performance." 

Freeing Memory by Using PIF Editor: Standard Mode 
If Windows is running in standard mode and you receive an out-of-memory 
message when trying to run an MS-DOS-based application, first try the 
techniques listed in the preceding section. If you still get an out-of-memory 
message, consider changing the following PIF options. Choose the PIF Editor 
icon in the Main group to open PIF Editor. (If you upgraded from Windows 
version 3.0, PIF Editor remains in the Accessories group.) 

Option 

Video Mode 

Memory Requirements 

XMSMemory 

No Screen Exchange 

Prevent Program Switch 

Suggested change 

Under Video Mode, select the Text option button to 
reduce the amount of memory Windows sets aside to 
display the application. This makes more memory 
available to the application. However, if you change 
modes while using the application, you might not be able 
to switch from the application. 

If Windows displays an out-of-memory message when 
you try to start the application, reduce the amount 
specified in the Memory Requirements: KB Required 
box. 

If the application starts but subsequently displays an 
out-of-memory message, you might need to free more 
memory before starting Windows. For information, see 
Chapter 14, "Managing Memory and Performance." 

If the application does not need extended memory, 
make sure that XMS Memory: KB Required and XMS 
Memory: KB Limit arc set to 0. This prevents the 
application from taking up memory that another 
application coold use. 

Select this check box to prevent Windows from 
allocating memory when you copy information onto 
the Clipboard by using PRINT SCREEN or ALT +PRINT 
SCREEN. This makes more memory available to the 
application. However, you cannot take a "snapshot" 
of the MS-DOS-based application screen. 

Select this option to make more memory available to the 
application. Windows makes more memory available by 
preventing you from switching from the application. 
When this option is selected, you have to quit the 
application to return to Windows. 
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Freeing Memory by Using PIF Editor: 386 Enhanced Mode 
When Windows is running in 386 enhanced mode, Windows-based applications 
and MS-DOS-based applications share memory resources. The more memory that 
is allocated to one application, the less memory there is available to others. If you 
receive an out-of-memory message when trying to start an application, first try the 
techniques described earlier in the "You Receive an Out-of-Memory Message" 
section. 

If you still receive an out-of-memory message, try changing the PIF for the 
MS-DOS-based application. You can free memory for an application by changing 
the following PIF settings. Choose the PIF Editor icon in the Main group to open 
PIF Editor. (If you upgraded from Windows version 3.0, PIF Editor remains in the 
Accessories group.) 

Option 

Video Memory 

Memory Requirements 

Display Usage 

Execution 

Suggested change 

Under Video Memory, select the Text option button if 
you plan to use only text mode while running the 
application. Text mode requires less memory than 
graphics mode. Clear the Retain Video Memory check box 
in the Advanced Options dialog box to free memory. 

If Windows displays an out-of-memory message when you 
try to start the application, reduce the amount specified in 
the KB Required box. 

If the application starts but subsequently displays an out­
of-memory message, increase the amount specified in the 
KB Required and KB Desired boxes. (An application 
might also run out of memory if it doesn't have enough 
extended or expanded memozy. If you suspect this is the 
case, try increasing the amounts in the XMS Memory and 
EMS Memory boxes.) 

Select !he Full Screen instead of the Windowed option 
button. Runlling an application in a window requires more 
memory. 

Select the Exclusive check box to suspend other 
applications while thi.s application is in the foreground. 
This might make more memory available to the 
application, but it prevents other applications from running 
in the background. 
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If you still receive an out-of-memory message after changing the application's 
PIP, try changing the PIFs for other applications you plan to run at the same time. 
You can free additional memory for an MS-DOS-based application by changing 
the following PIP settings for other applications. 

Option 

Memory Requirements 

Display Usage 

Execution 

Lock Application Memory 

Snggested change 

Reduce the amount specified in each application's KB 
Desired box. (Do not reduce it so much that the 
applications cannot run effectively.) 

Select each application's Full Screen option button. 

Clear other applications' Background check boxes to 
prevent them from running in the background. This 
makes more memory available to the application you 
want to run but prevents the other applications from 
running at the same time. 

You might want to do this to prevent particular 
applications from running in the background. If you 
want to prevent all applications from running in the 
background, it is easier to select the foreground 
application's Exclusive check box. 

Clear each application's Lock check boxes (Lock 
Application Memory, XMS Memory: Locked, and 
EMS Memory: Locked) to free memory. This might 
make more memory available to the application you 
want to run but also might slow down the applications 
for which you clear the Lock check boxes. 

For more information about freeing memory, see Chapter 14, "Managing Memory 
and Performance." 

Using Serial Communications 
With Windows, you can have serial communications on serial ports COMl 
through COM4. The following sections describe solutions to problems you 
might have when using serial communications. 

You cannot access a serial port. 
If Terminal or another Windows-based communications application cannot access 
a modem or other device connected to a serial port, use the following checklist to 
determine the problem. 

• Determine whether another application is preventing access to the port even 
though it is not actively using it. If so, close the application so that other 
applications can gain access to the serial port. 
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• Make sure Windows is using correct base port address and hardware interrupt 
(IRQ) settings for the serial port you are trying to use. For instructions on how 
to specify these settings, see Chapter 13, "Configuring Hardware." 

The computer locks up when you try to access a serial port. 
When a serial device attempts to use a hardware interrupt (IRQ) or memory 
address that is being used by another device, your computer can lock up. If you 
encounter this problem, determine whether one of the following is the cause: 

• Serial ports COMl and COM3 are often set to use IRQ4, and serial ports 
COM2 and COM4 are often set to use IRQ3. If you are using these ports 
and your computer locks up, try including the following setting in the 
[386Enh] section of the SYSTEM.IN! file: 

COMirqSharing=true 

Note This setting works only for some systems. Many serial-communications 
adapters do not allow these ports to be used simultaneously, regardless of the 
setting in the SYSTEM.IN! file. 

• Some 8514/A display adapters and some network adapters conflict because 
they use the common address for serial port COM4 (2E8). If you are using 
either of these two devices, determine whether they are conflicting with your 
serial port. 

For information about which IRQ your device uses and how to change IRQ 
settings, see the documentation supplied with the device. For more information 
about specifying IRQ and address settings for your serial devices and ports in 
Windows, see Chapter 13, "Configuring Hardware." 

Errors occur during high-speed communications. 
The fastest communications speed possible in Windows is dependent on many 
factors, including your serial device, computer speed, communications software, 
and other programs (or applications) running on your system. If you have 
problems during communications transmissions at high speeds (9600 baud 
and higher), use the following checklist: 

• Close or adjust the background-execution priority for any MS-DOS-based 
applications running in the background. Such an application could prevent 
the active communications application from receiving information fast 
enough. For information about adjusting settings for MS-DOS-based 
applications, see Chapter 11, "MS-DOS Applications." 
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• Make sure the computer is rurming at its fastest possible speed. Some 
computers may run at slower speeds to prolong battery life. See the 
documentation supplied with your computer. 

• Use a serial port that contains a 16550A Universal Asynchronous Receiver 
Transmitter chip (UAR1). Windows uses the buffering capabilities of such 
ports so that Windows-based communications applications can achieve high 
speeds even on slow computers. For more information, see your serial-port 
documentation. 

Note Using the buffering capabilities of Windows causes problems with 
some versions of the UART. In this case, you need to disable the buffer of 
the UART by using the comxfifo setting in the SYSTEM.IN! file. For more 
information about this setting, view the SYSINI.WRI online document by 
using Write (in the Accessories group). 

Errors occur when you use MS-DOS communications 
applications. 

If you are running an MS-DOS-based application that uses the Xon/Xoff protocol 
for serial-port communications, you might lose characters or receive protection 
violations when other running applications are slowing down the system. If this 
happens, include the following setting in your SYSTEM.IN! file: 

COMxProtocol = XOFF 

where x is the number of the COM port. For information about this setting and 
how to change it, view the SYSINI.WRI online document by using Write (in the 
Accessories group). 

Using Terminal 
If you have trouble using Terminal and. a modem to connect to a remote 
computer, a number of factors could be the cause. The following sections 
describe solutions for a few common problems. 

The modem does not dial the number. 
Your hardware may be connected improperly, or the incorrect COM port is 
specified. Use this checklist: 

• Make sure the correct cables are attached to the modem and phone jack, 
and between the two computers. 
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• Make sure the proper COM port is specified in the Communications dialog 
box. Choose the Communications command from the Settings menu in 
Terminal to see how the Connector option is set. 

You cannot establish a connection. 
If the modem dials and you get an answer, but no connection is established, 
you might not have the correct settings for the remote computer. Communicating 
systems must use the same baud rate, although some modems can drop back to 
the rate of the remote modem and notify Terminal of the change. (For information 
about this feature, see your hardware documentation.) If you want to transfer data, 
both systems must also use the same settings for data bits, parity type (none, odd, 
even, mark, and space), stop bits, and flow control. 

If you do not know what settings the remote system is using, refer to its 
documentation by calling the remote system's information number (not the 
data-transmission number). Request the information, and then set Terminal to 
match the remote-system settings by using the Communications command on 
the Settings menu. 

You cannot send or receive a text file. 
Communicating systems must use the same flow-control (or handshake) method. 

To determine whether the systems use the same handshake method, you need to 
know the following information: 

• What software-handshake method, if any, the remote system uses. 

The standard method is Xon/Xoff. However, another method may be used. 

• Whether the remote system is using the hardware-handshake method. 

If it is, choose the Communications command from the Settings menu in 
Terminal, and then select the Hardware option button. 

Using Windows with a Network 
The following sections provide solutions for problems you might encounter when 
running Windows with a network. Be sure to also read the NETWORKS.WR! 
online document; you can do so by using Write (in the Accessories group). 



266 Microsoft Windows User's Gulde 

You cannot connect to a network drive. 
• If you cannot connect to a network drive or network printer from Windows, 

try making the network connection before starting Windows. If you cannot, 
it is probably not a Windows problem. 

• If you cannot connect to a network, make sure you are using the correct 
network drivers. You can find out what network driver you are using by 
choosing the Windows Setup icon in the Main group. 

You have trouble when running a shared copy of Windows. 
• If you receive a message about sharing violations while running a shared 

copy of Windows or a shared copy of another application, make sure the 
application's file attributes are set to read-only. You can view or change a 
file's attributes by using the Properties command on the File menu in File 
Manager. 

• If you have trouble running a shared copy of Windows, make sure your 
personal Windows directory and the shared Windows directory are both 
specified in your path. Your personal Windows directory must be specified 
first. 

• Make sure you are using the same letter to designate the network drive every 
time you connect to that drive. For example, if you use the drive letter W 
when you connect to the network drive to set up a shared copy of Windows, 
Windows records W as the path it should use in the future to look for the 
shared Windows files. If the next time you connect to the same network drive 
you use a letter other than W, you will not be able to start Windows correctly. 

If you do need to specify a different drive letter when you connect to a 
network drive in order to use a shared application, be sure to change the 
path that Windows uses to find the application. 

You have trouble with network software when running Windows. 
• If you cannot run Windows or other applications while your network 

software is loaded into the high memory area (HMA), the first 64K of 
extended memory, try disabling the network software's HMA options. 
For more information, see the documentation provided with the network 
software. 

• If you cannot run Windows while your network software is loaded into the 
upper memory area between 640K and 1 MB, try loading the network software 
into conventional memory. Some network software does not work when 
loaded into the upper memory area. 
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• If your system locks up when you receive a network pop-up message, 
you might need to either disable such messages or run a Windows-based 
application that properly displays them. For example, WinPopup, supplied 
with Windows, is such an application. 

Using Two Versions of Windows 
The following list describes solutions for problems you might encounter when 
you have two versions of Windows installed on your computer: 

• Make sure the PATH setting in your AUTOEXEC.BAT file specifies the 
directory that contains the version of Windows that you are currently using. 
Remove the directory of the older version from the PATH setting before you 
install the newer version. You can check the dates of files by using the All File 
Details command on the View menu in File Manager. 

• When you want to run an application, print a file, install a printer, or install 
a driver, make sure the current directory is the directory that contains the 
version of Windows that you are currently using. Windows searches the 
current directory for the application's files before searching other directories 
specified by the PATH setting. 

• Always use the device drivers for the version of Windows that you are 
current! y using. 

• If you want to use applications that are set up in the same directory as the 
earlier version of Windows (not a subdirectory of it), you probably need to 
set up those applications in the directory where the later version of Windows 
is located. In some cases, you can simply copy the files to the new directory; 
in other cases, you must set up the application again. 

• If you set up an application in Windows version 3.0, and you want to run the 
application in Windows version 3.1, you need to set up the application again 
from version 3.1. 

Additional Troubleshooting Techniques 
If you still have difficulties with Windows, you should read the following 
guidelines for additional troubleshooting techniques. 

Read the Windows text files. 
During Windows Setup, several online documents are copied to your hard 
disk and are placed in the directory where you set up your Windows files. 
The filenames end with the .TXT and .WRI extensions. The files contain 
information that was received too late to be printed in this book. They also 
contain information about the initialization files SYSTEM.IN! and WIN.INI. 
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~ To open and read the README.WRI document 

• In the Main group, choose the Read Me icon. 

Write starts and opens the README.WRI document, which contains information 
about locating and opening other Windows online documents. For information 
about using Write, press the Fl key, or choose Contents from the Help menu in 
Write. 

If you chose not to install the initialization files when you set up Windows, you 
can run the Setup program again to install them now. For more information about 
using Setup, see Chapter 1, "Setting Up Windows." 

Know your system. 
When troubleshooting your computer system, it is helpful to note anything unique 
about your system-for example: 

• The contents of your CONFIG.SYS and AUTO EXEC.BAT files. (For more 
information about the role these files play in troubleshooting, see the following 
section, "Streamline the CONFIG.SYS and AUTOEXEC.BAT Files.") 

• The drive and directory where Windows is installed. 

• The type (brand and processor) of computer you are using (for example, 
COMPAQ 386). 

• The version and type of BIOS (basic input/output system) in your computer. 

• The amount of RAM (random access memory) your computer has. 

• The size of your hard disk. 

• The type of display adapter you are using (for example, EGA or VGA). 

• The type of mouse you are using (brand, model, and whether it is a serial or 
bus type). 

• The type and layout of the keyboard you have (for example, enhanced). 

• If you are running Windows on a network; and if so, the name and version 
number of the network software you are using. 

• The printer and printer port you are using. 

• The amount of memory your printer has. 

• The names and version numbers of applications you are running with 
Windows. 

It may also be helpful if you know the type of hard-disk controller in your 
computer. 



Appendix C Troubleshooting 269 

Microsoft Diagnostics 
If you are uncertain about your computer configuration, you can use the Microsoft 
Diagnostics (MSD) program to find out. This program, provided with Windows, 
provides information about your system memory and the device drivers installed 
on your system. During the setup process, this file is placed in your Windows 
directory. 

,.. To start Microsoft Diagnostics 

• Type the following at the command prompt, and then press ENTER: 

msd 

Then follow the instructions on the screen. 

Note If Windows was not successfully set up on your hard disk, you can run 
MSD from the Windows Setup disks. 

Streamline the CONFIG.SYS and AUTOEXEC.BAT files. 
If you want to troubleshoot a problem yourself, it's best to start with a 
"minimum" Windows configuration. This means that as a test, you should 
try removing unused applications, memory-resident programs (TSRs), and 
unnecessary device drivers from your CONFIG.SYS and AUTOEXEC.BAT files. 
You can use a text editor, such as Notepad (in the Accessories group), to open 
and edit these files. When just a few applications are running with Windows, it's 
easier to isolate your problem. 

Before you make any changes, create a system disk that includes a backup 
copy of both the CONFIG.SYS file and the AUTOEXEC.BAT file. You can 
restore these files when you are finished with the troubleshooting tests. You 
also can use this disk to start your system, if necessary. 

You can make a system disk by starting File Manager (in the Main group), and 
then choosing Make System Disk from the Disk menu. Then copy your current 
CONFIG.SYS and AUTOEXEC.BAT files to the disk. These files are usually 
located in the root directory of your first hard disk drive, which is usually drive C. 
If you start your system by using a floppy disk, these files are located in the root 
directory of that disk. 

When removing command lines from your CONFIG.SYS and AUTOEXEC.BAT 
files, make one change at a time. After making one change, test it. This will help 
you isolate the problem. As a general rule, if you don't know what a particular 
command line does in the CONFIG.SYS or AUTO EXEC.BAT file, do not 
remove it. If you are using disk-partitioning software, such as DMDRVR.BIN, 
do not remove the command lines that specify it. 
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The following are examples of CONFIG.SYS and AUTOEXEC.BAT files at a 
minimum configuration. 

A streamlined CONFIG.SYS file: 

files-30 
buffers-20 
de vi ce-c: \windows\ hi mem. sys 

The files command sets the number of files MS-DOS can access at one time. 
The buffers command allocates memory for buffers when your system starts. The 
device command in this example sets up the HIMEM.SYS device driver. 

A streamlined AUTO EXEC.BAT file: 

prompt $p$g 
path c: \; c: \windows; c: \ms dos 
set temp-c: \windows\ temp 

The prompt command determines the appearance of the command prompt. The 
path command specifies the search path for MS-DOS and Windows. (Some 
versions of MS-DOS might name this directory something other than \MSDOS.) 
The set temp command specifies the directory where temporary files are stored. 
You may need to create the specified directory if it does not exist. The directory 
for temporary swap files should be a location that has at least 2 MB of available 
disk space. For more information about temporary swap files, see Chapter 14, 
"Managing Memory and Performance." 
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viewing Clipboard contents V2 96 

ClipBook 
See also ClipBook Viewer 
connecting to ClipBooks on other computers Vl 65 
copying pages to the Clipboard Vl 64 
defined Vl 61 
disconnecting from ClipBooks on other computers Vl 66 
Local Clipbook, defined Vl 61 
page, defined Vl 61 
saving Clipboard contents Vl 63 
sharing Local ClipBook pages Vl 64-65 
viewing Local ClipBnok pages Vl 62 

ClipBook Viewer 
See also online Help for ClipBook Viewer 
connecting to ClipBnoks on other computers Vl 65 
copying pages to the Clipboard Vl 64 
disconnecting from another ClipBook Vl 66 
embedding or linking objects from another computer 

Vl 66 
formats Vl 67 
illustrated Vl 62 
length of lines in pasted information . Vl 63 
password, assigning to Local ClipBook pages Vl 65 
sharing Local ClipBook pages Vl 64-65 
toolbar Vl 62--03 
viewing Clipboard contents Vl 62 
viewing Local ClipBnok pages Vl 62 



Clock speed of computer V2 206 
Clock, displaying analog or digital V2 133 
Close command, on the Control menu 

closing dialog boxes V2 72 
closing documents or windows V2 67 
described V2 61 
quitting Windows-based applications V2 88 

Closing 
applications 

MS-DOS-based applications V2 89 
Windows-based applications V2 88 

dialog boxes V2 72 
files V2 61 
files in shared directories Vt 24 
Help V2104 
menus V2 59 
windows V2 67 

. CLP filename extension Vl 63, V2 97 
CO-NET CD Vl 106 
Code page (character set), changing V2181 
Collapse Branch command, File Manager V2 112 
Collapsing a directory V2 112 
Color graphics adapter (CGA) V2 236 
Color schemes for the desktop 

changing V2 167 
choosing V2 165-167 
creating custom colors V2 168 

Colors, adjusting for improved visibility VI 104, 105 
.COM filename extension V2 82 
COM ports See Serial ports 
COMirqSharing setting, SYSTEM.IN! file V2 263 
Command buttons, in dialog boxes V2 68-69 
Command line, Windows V2 13 
Command lines in startup files 

See also AUTOEXEC.BAT file; CONFIG.SYS file 
disabling V2 193-194 

Command prompt, MS-DOS V2 83 
Commands 

canceling V2 72 
choosing from menus V2 58-59 
command buttons V2 68--<59 
dimmed commands, meaning of V2 59 
Help for dialog boxes V2102 

Communication Application Specification (CAS) modem 
Vl 44 

Communications 
remote (using Terminal) 

described V2 138 
troubleshooting V2 264-265 

Comprehensive Index 5 

Communications (continued) 
serial 

changing settings V2 188-189 
common settings V2 256 
troubleshooting V2 262-264 

Compatible networks Vl 85 
Compose Note command, Mail Vl 37 
Composing Mail messages Vl 37 
Compressed files on Setup disks, expanding V2 238 
COMxProtocol = XOFF setting, SYSTEM.IN! file V2 264 
Concentrator (hub), illustrated Vl 129 
CONFIG.SYS file 

buffers command line V2 194, 270 
changes Setup makes V2 11 
device command lines 

disabling V2193-194 
EMM386.EXE V2 208-212 
HIMEM.SYS V2 203-206 
MOUSE.SYS V2 240 
RAMDRIVE.SYS V2 206-208 

double buffering V2 215 
drivparm command, adding V2 235 
editing to free memory V2 193-194 
memory-resident programs, running V2 162 
minimum configuration Vl 154 
rem command, using to disable command lines 

V2 193-194 
shell command line V2 194 
streamlining when troubleshooting Vl 153-154 
system disk, creating V2 269 
testing V2 269 

Configuration disk for network-adapter installation Vl 109 
Configuring 

fax modems VI 44-45 
hardware See Device drivers 
memory See Managing memory and performance 
multimedia device drivers V2 185-186 
network-adapter drivers 

changing settings Vl 136-137 
installing a driver Vl 133-135 
removing a driver Vl 136 

network adapters 
See also online Help for Windows Setup 
base 1/0 port VJ 114-115 
base memory address Vl 115 
connector, specifying VJ 116 
default settings Vl 110 
DIP-switch settings Vl 112 
interrupt request level (IRQ) setting Vl 113-114 

Key VI Microsoft Workgroup Add-On for V2 Microsoft Windows User's 
Guide Windows User's Guide 
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Configuring (continued) 
network adapters (continued) 

jumper settings Vl 111 
settings, recording Vl 113 
software configuration Vl 121-122 
troubleshooting Vl 146-149 
when to configure the adapter Vl 111 

ports V2 188-189 
printers V2 126-127 

Connect command, ClipBook Viewer Vl 65, 66 
Connect Network Drive command, File Manager 

connecting to directories on network servers Vl 86, 
V2112 

connecting to shared directories Vl 22 
Connect Network Printer command, Print Manager Vl 28, 87 
Connecting 

cables 
overview Vl 122 
thick-Ethernet system Vl 125-127 
thin-Ethernet system Vl 123-125 
token-ring network Vl 130-131 
twisted-pair Ethernet system Vl 128-129 

to a post office Vl 33-34 
to ClipBooks on other computers Vl 65 
to directories on network servers Vl 86--87 
to network directories V2 112-113 
to network printers Vl 27-28, 87, V2124-125 
to other networks Vl 85-88 
to remote computers via modem V2 138 
to shared directories Vl 21-22 
to shared fax modems Vl 45-46 
to Windows NT or LAN Manager servers, troubleshooting 

Vl 145 
to workgroup computers, troubleshooting Vl 143-144 

Connector jack, illustrated Vl 123 
Connector plug, illustrated VJ 123 
Contents feature in Help V2 101 
Context-sensitive Help V2 20 
Control menu 

commands, described V2 61-62 
Control-menu box (illustrated) V2 51 
opening V2 60-61 

Control Panel 
See also online Help for Control Panel 
adjustments for impaired motion or vision Vl 104-105 
32-bit disk access Vl 81-82 
32-bit file access Vl 82-83 
color schemes for the desktop 

changing V2 167 
choosing V2 165-167 
creating custom colors V2 168 

Control Panel (continued) 
desktop settings 

patterns V2 169-170 
screen savers V2 171-172 
wallpaper V2 170-171 

device drivers, installing V2 184 
fax modems 

configuring Vl 44-45 
setting up to share a modem Vl 47 
setting up to use a shared modem Vl 45-46 
stop sharing Vl 48 

fonts 
adding VZ 174-176 
described V2 172-173 
removing V2 176-177 
TrueType V2174-176 
viewing on the screen V2 173 

keyboard shortcuts V2 225 
LAN Manager options, setting Vl 88 
logon options, changing Vl 76 
logon password, changing Vl 79-80 
MIDI Mapper V2 179-180 
multimedia drivers 

installing V2 185-186 
removing V2 186 

multitasking options V2 202 
network events, recording Vl 80 
network options, setting V2 180-181 
networking enhancements, described Vl xv 
ports, configuring V2 188-189 
sound options V2 177-180 
startup settings, changing Vl 78-79 
virtual-memory settings, changing V2 196 
Windows NT options, setting Vl 88 
workgroup settings, changing Vl 78 

Conventional memory 
avoiding for a RAM drive V2 208 
described V2 191 
disk buffers V2 194 

Conventions, typographic V2 xviii 
Conversing by using Chat Vl 70 
Copy command 

File Manager V2 114 
MS-DOS-based applications V2160 
Windows-based applications V2 94, 95 

Copy Disk command, File Manager V2 117 
Copying 

See also Object linking and embedding (OLE) 
compressed files on Setup disks V2 238 
directly to a printer port V2 250 
directories V2 114 
files V2114 



Copying (continued) 
floppy disks V2 117 
from MS-DOS-based applications V2 160 
from Windows-based applications V2 94-97 
keyboard shortcuts for V2 223 
linked objects V2 149 
Local ClipBook pages to the Clipboard Vl 64 
objects from another computer V1 66 
screen image (screen snapshot) V2 94 
vs. object linking and embedding V2 143 
window contents (window snapshot) V2 95 

Copyright of active application, checking V2 101 
Correcting typing mistakes V2 92 
Create Directory command, File Manager V2 114 
Creating 

directories V2114 
groups V2 75 
program items 

by using File Manager V2 78 
by using Program Manager V2 75-78 
by using Setup V2 79 

Current directory, changing V2 110 
Cursor 

adjusting for improved visibility Vl 105 
cursor-movement keys V2 221 
selection cursor, defined V2 68 

Custom colors, creating V2 168 
Custom Setup Vl 15, V2 4 
Customer Support Services, obtaining device drivers V2 7 
Customizing network settings 

Control Panel, using Vt 76 
described Vl 75 
enabling and disabling sharing Vl 80-81 
logon options, changing Vl 76 
logon password, changing Vl 79--80 
recording network events Vl 80 
startup settings, changing Vl 78-79 
workgroup settings, changing Vl 77-78 

Customizing Windows 
character set, changing V2 181 
color schemes 

changing V2 16 7 
choosing V2165-167 
creating custom colors V2 168 

fonts 
adding VZ 174-176 
described V2 172-173 
removing V2 176--177 
TrueTypc V2174-176 
viewing on the screen V2 173 

Comprehensive Index 7 

Customizing Windows (continued) 
MIDI settings V2 178-180 
patterns V2 169-170 
screen savers V2 171-172 
sound V2 177-180 
wallpaper V2 170-171 

Customizing Windows for Workgroups for improved 
accessibility Vl 104-105 

Cut command, Windows-based applications V2 94 
Cutting 

See also Copying; Pasting 
text or graphics from Windows-based applications V2 94 

D 
Data bits 

changing the setting V2 189 
common setting V2 256 

Data transfer 
between applications 

MS-DOS-based applications V2160--161 
Windows-based applications V2 94-95 

between computers, using Terminal V2 138 
.DCX filename extension Vl 53 
DEC Pathworks Vl 85 
Default color scheme V2 166 
Default printer, choosing Vl 30, V2 123 
Default settings for network adapters Vl 110 
_DEFAULT.PIF file V2156 
Definitions of terms in on1ine Help, displaying V2 103 
Delete command 

File Manager V2 115 
Mail Vl 40 
Program Manager V2 75 

Delete Document command, Print Manager V1 30 
Deleted Mail folder 

retrieving messages from Vl 40 
saving deleted messages when quitting Mail V1 41 

Deleting 
Clipboard contents V2 97 
commands in startup files V2 193-195 
directories V2 115 
documents from the print queue V2 122 
documents waiting to print V 1 30 
faxes, outgoing Vl 51 
files V2115 
fonts V2176-177 
groups V2 75 
links V2150 
Mail accounts Vl 96 

Key Vl Microsoft Workgroup Add-On for 
Windows User's Guide 

V2 Microsoft Windows User's 
Guide 
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Deleting (continued) 
Mail messages Vl 40, 41 
network-adapter drivers Vl 136 

DeskJet printers, Hewlett-Packard V2 255 
Desktop 

color schemes 
changing V2 167 
creating custom colors V2 168 
selecting V2165-167 

copying (capturing the screen image) V2 94 
defined V2 50, 165 
patterns V2169-170 
screen savers V2 171-172 
wallpaper V2 170-171 

Destination directory or drive, moving or copying files V2 114 
Destination document, object linking and embedding V2 142 
device command lines 

disabling unnecessary device drivers V2193-194 
EMM386.EXE V2 208-212 
HIMEM.SYS V2 203-206 
mouse driver V2 240 
RAMDRIVE.SYS V2 206-208 
SMARTDrive command for double buffering V2 215 
streamlined CONFIG.SYS file V2 270 

device commands, CONFIG.SYS file Vl 154 
Device drivers 

See also Display drivers; Keyboard drivers; Mouse drivers 
bulletin-board services V2 7 
configuring V2 184 
defined V2 183 
downloading from network services V2 7 
EMM386.EXE V2 208-212 
HIMEM.SYS V2 203-206 
installing V2 184 
Microsoft Diagnostics (MSD) program, using to get 

information about installed device drivers V2 269 
multimedia drivers VZ 185-186 
network-adapter drivers Vl 133-137 
preserved when upgrading Windows V2 6 
purchasing on disks V2 7 
RAMDRIVE.SYS V2 206-208 
SMARTDRV.EXE V2 212-215 
third-party drivers, installing V2 184 
upgraded by the Setup program V2 6 
Windows Driver Library (WDL) Vl 102, V2 7, 183 

devicehigh command, CONFIG.SYS file V2 6 
Diagnosing network problems Vl 149-150 
Diagnostics See Microsoft Diagnostics (MSD) program 
Dialog boxes 

check boxes V2 72 
closing V2 72 
command buttons V2 68-69 
Control menu, opening V2 60 

Dialog boxes (continued) 
described VZ 67-72 
Help, online V2 102 
keyboard shortcuts V2 221 
keys for selecting items in VZ 222 
list boxes 

described V2 70 
drop-down list boxes VZ 70-71 
selecting items in V2 57-58 

moving V2 67 
moving within V2 68 
option buttons V2 71 
scrolling through information in V2 66 
selecting options in VZ 68-{)9 
text boxes V2 69 

Digitally signed faxes 
digital signature, defined Vl 58 
purpose of Vl 54 
sending Vl 58 
using in a nonsecure environment Vl 55 

Dimmed command buttons V2 69 
Dimmed commands VZ 59 
DIP-switch settings for network adapters 

changing by using Windows Setup Vl 148 
changing manually Vl 112 

dir command, checking free disk space V2 200 
Directories 

CD-ROM drive, trouble sharing directories on Vl 144 
c~anging directory levels VZ 111-112 
changing the current directory V2 110 
copying V2 114 
creating V2 114 
deleting V2 115 
icon representing, illustrated V2 106 
moving V2 114 
network directories 

connecting to V2112-113 
disconnecting from V2 114 

network servers, connecting to directories on Vl 86--87 
renaming VZ 115 
searching for V2 115 
selecting V2 109 
sharing 

closing shared files Vl 24 
connecting to shared directories Vl 21-22 
described Vl xii 
disconnecting from network drives V1 22 
displaying names of people sharing files Vl 24 
how to share directories Vl 23 
how to stop sharing directories Vl 24 
passwords, assigning to shared directories Vl 23 

start-up directory for applications V2 77 
viewing in the File Manager window Vl 21 



Directory tree 
branches, changing the display of V2 lll-112 
current directory, changing V2 110 
described V2 106 

Directory windows 
current directory, changing V2 110 
customizing V2 107-108 
directory levels, changing V2 lll-112 
drive, changing Vl 21, V2 110 
icons in, illustrated V2 106 
opening V2 107 
selecting files or directories V2 109-110 
sorting files in Vl 25 
sorting the contents of V2 108 
split bar V2 106 
starting applications from V2 82 
updating V2 108 

Disabilities, products and services supporting Vl 101-106 
Disabling commands in startup files V2 193-195 
Disconnect command, ClipBook Viewer Vl 66 
Disconnect Network Drive command, File Manager Vl 22, 

V2112 
Disconnect Network Printer command, Print Manager V1 28 
Disconnecting 

from ClipBooks on other computers Vl 66 
from network directories V2 114 
from network drives VI 22 
from network printers Vl 28, V2 125 
workgroup connections, by using Net Watcher Vl 71 

Disk access, 32-bit V2 197 
checking disk-drive controller compatibility Vl 82 
setting up Vl 81 
using on battery-powered computers Vl 81 

Disk buffers V2 194 
Disk cache 

default size VJ 82 
SMARTDrive cache Vl 83 

Disk caching 
described V2 201-202 
disabling if interfering with Setup V2 235 
SMARTDrive command line V2 212-215 

Disk drives 
32-bit disk access Vl 81-82 
changing the current drive Vl 21, V2 110 
floppy disk drives, SMARTDrive cache for Vl 83 
icons for V2 106, 107 

Disk space 
amount of, determining V2 200 
conserving by preventing swapping V2 197 
Custom Setup Vl 15 

Comprehensive Index 9 

Disk space (continued) 
disk caching V2 201-202 
freeing 

by removing unnecessary files V2 20G-201 
by using the chkdsk command V2 199 

Mail messages, user accounts, and post office Vl 90 
Mail, maintaining 

checking status of shared folders Vl 9&-97 
compressing shared folders Vl 97 

PC Fax Vl 43 
recommended amount of free space V2 199 
swap files 

described V2 192 
enhanced mode V2 196-197 
standard mode V2 197-198 

system requirements for Windows for Workgroups 
Vl x,xi 

Disk-compaction programs V2 199 
Diskless workstation V2 8 
Disks 

See also System disk 
copying V2 117 
formatting V2 116 
labeling V2 116 
network-adapter installation Vl 109 

Display drivers 
CGA, obtaining V2 236 
EGA, updated by Setup V2 11 
installing or updating V2 186-188 
Super VGA V2 243, 244 

Display options, Settings command (MS-DOS-based 
applications) V2159 

Display Usage option, PIF Editor V2 261, 262 
Document conventions V2 xviii 
Document windows 

closing V2 67 
Control menu, opening V2 60 
described V2 53-54 
keys for selecting items in V2 221 

Documents 
closing V2 61 
destination document, object linking and embedding 

V2142 
icon for 

in application windows V2 55 
in directory windows V2 106 

opening VZ 89 
opening when starting applications V2 82-83 
program items for, creating V2 78 
saving V2 90 

Key Vl Microsoft Workgroup Add-On for vz Microsoft Windows User's 
Guide Windows User's Guide 
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Documents (continued) 
source document, object linking and embedding V2 142 
switching between V2 86 
text, working with V2 91-93 

Domains 
defined Vl 11 
logging on automatically when you start Windows Vl 79 
passwords Vl 79, 88 

DOS prompt See Command prompt; MS-DOS Prompt 
DOSPRMPT.PIF file V2 84, 157 
Double-buffering feature of SMARTDrive V2 11, 215 
Double-clicking with the mouse, described V2 56 
Download Service, Microsoft (MSDL) Vl 102 
Downloading device drivers V2 7 
Dragging and dropping file icons V2 87-88 
Dragging with the mouse, described V2 56 
Drawings 

creating See online Help for Paintbrush 
embedding in documents V2145 
linking to documents V2 148 

Drive bar in File Manager windows 
changing the current drive V2 110 
described V2 107 
illustrated V2 106 

Drive icons, described VZ 107 
Drive, changing the current drive Vl 21, V2 110 
Driver Library, Windows (WDL) Vl 102, V2 7, 183 
Drivers See Device drivers 
drivparm command, adding to the CONFIG.SYS file V2 235 
Drop-down list box, in dialog boxes V2 70--71 
Dvorak keyboard layouts Vl 102-103 

E 
Edit commands, MS-DOS-based applications V2 61-62 
Editing 

See also Word processing 
ASCII (text) files V2 135 
embedded objects V2 145 
linked objects V2 148 
sound files V2 137 
text 

basic techniques V2 92-93 
keys for editing text V2 222 

EFAXPUMP.INI file Vl 153 
EGA.SYS device driver, updated by Setup V2 11 
EISA bus expansion slot Vl 109 
EISA memory V2 206 
EISA network adapters, software configuration Vl 121-122 
Electronic conversations, using Chat Vl 70 
Electronic downloading service V2 7 
Electronic mail See Mail 

Ellipsis 
in command buttons V2 68 
in commands on menus VZ 59 

EMB handles V2 204 
Embedding 

See also Object linking and embedding (OLE) 
by using Object Packager V2151-152 
described V2 15, 142-145 
format of objects, changing V2150-151 
objects from another computer Vl 66 
Paintbrush drawings V2 145 

EMM386 memory manager 
command line V2 208-212 
described V2 203 
excluding shared memory used by network adapter 

V2212 
memory options V2 209 
updated by Setup V2 11 

EMM386 memory manager or provider Vl 115, 141 
EMMExclude option, starting Windows with V2 237-238 
EMMExclude setting, SYSTEM.IN! file Vl 115, 141 
Encrypted faxes 

described Vl 54, 58 
reading password-encrypted faxes Vl 55 
sending key-encrypted faxes Vl 58 
sending password-encrypted faxes Vl 54 

Enhanced features in Windows version 3.1 V2 15 
Enhanced graphics adapter (EGA) device driver V2 11 
Enhanced mode See 386 enhanced mode 
Entering text V2 91 
Environment space, modifying V2 194 
Environment variables 

effect of environment space on V2 194 
TEMP, setting to a RAM drive V2195 

EPT ports V2 127 
Erasing See Deleting 
Ethernet 

thick-Ethernet system Vl 125-127 
thin-Ethernet system Vl 123-125 
twisted-pair Ethernet system Vl 128--129 

Event log 
recording network events Vl 80 
viewing See Net Watcher 

Exchanging information 
See also Chat; Mail; PC Fax; Sharing directories; Sharing 

printers 
overview of Vl 5 

Exclusive option 
PIF Editor V2 162 
Settings command V2 159 

.EXE filename extension V2 82 
Execution option, PIF Editor V2 261, 262 



Exit And Sign Out command, Mail Vl 41 
Exit command 

applications, quitting V2 88 
Mail Vl 41 
MS-DOS Prompt, quitting V2 84 
Print Manager Vl 30 
printing, canceling V2 122 
windows, closing V2 67 

Expand All command, File Manager V2 111 
Expand Branch command, File Manager V2 111 
expand command, MS-DOS V2 238 
Expand One Level command, File Manager V2 111 
EXP AND.EXE program V2 238 
Expanded memory 

described V2 192 
EMM386 memory manager, described V2 203 

Expanded-memory managers, troubleshooting Vl 141 
Expanding a directory V2 111 
Expanding and copying files on Setup disks V2 238 
Express Setup Vl 15, V2 3-4 
Extended characters 

character set, changing V2 181 
displaying by using Character Map V2 133 

Extended Industry Standard Architecture (EISA) VI 109, 
V2206 

Extended memory 
described V2 191 
HIMEM memory manager V2 203-206 

Extended MIDI setup V2 180 
Extended-memory block (EMB) handles V2 204 
Extending selections V2 93 

F 
Fast application-switching V2 41 
Fast Printing Direct To Port option, Control Panel V2 250 
Fax application See PC Fax 
Fax modems 

active fax modem, specifying VI 46 
CAS modems VI 44 
Class I or Class 2 modems VI 44 
configuring VI 44-45 
driver for CAS modems, installing VI 44 
hardware, installing on a serial port Vl 44 
shared directory for, creating VI 47-48 
sharing 

setting up to share a modem VI 46-48 
setting up to use a shared modem VI 45-46 
stop sharing VI 48 

telephone line vs. separate line, using Vl 44 

Comprehensive Index 11 

Fax modems (continued) 
troubleshooting 

adding a shared modem VI 152 
configuring a shared modem VI 151 
fax suspended in queue VI 152 
modem speed VI 152 

Fax numbers 
See also Personal Address Book 
National Information System VI 106 
Recording for the Blind, Inc. VI 103 
Trace R&D Center VI 106 

Fax Viewer 
See also online Help for PC Fax 
viewing documents attached to faxes Vl 53 

Faxes See PC Fax 
File access, 32-bit 

improving performance with VI 83 
listing disk drives using VI 83 
setting up VI 82 
SMARTDrive cache size, reducing Vl 83 

FILE as printer port, printing to a file V2 123 
File Manager 

See also Directories; Directory windows; Files; online Help 
for File Manager 

changing the current directory V2 110 
changing the drive V2 110 
copying files or directories V2 114 
copying floppy disks V2 117 
creating a directory V2 114 
customizing the File Manager window V2 107-108 
deleting files or directories V2 115 
described V2 16-17, 105-107 
directory levels, changing V2 111-112 
directory windows 

opening V2 107 
updating V2 108 

disk space, checking the amount of V2 200 
dragging and dropping files V2 87-88 
drive bar V2 106, 107 
drive, changing VI 21 
formatting floppy disks V2 116 
icons in directory windows V2 106 
keyboard shortcuts V2 224 
mail, sending VI 25 
menu bar V2 106, 107 
moving files or directories V2 114 
new features, described Vl xii 
new items in File Manager window, illustrated Vl 20 
printing files V2 116 
renaming files or directories V2 115 

Key Vl Microsoft Workgroup Add-On for v2 Microsoft Windows User's 
Guide Windows User's Guide 
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File Manager (continued) 
searching for files or directories V2 115 
selecting files or directories V2 109-110 
sharing directories 

closing files in shared directories Vl 24 
connecting to shared directories Vl 21-22 
disconnecting from network drives Vl 22 
displaying names of people sharing files Vl 24 
how to share directories Vl 23 
how to stop sharing directories V1 24 
passwords, assigning Vl 23 

sorting files in directory windows Vl 25 
starting applications V2 82 
status bar V2 106, 107 
system disk, creating Vl 153 
toolbar 

buttons for displaying files Vl 25 
buttons for sharing directories Vl 21 

viewing different drives and directories Vl 21 
File transfer, using Terminal V2 138 
Filename extensions 

.BAT (batch file) V2 82 

.BMP (bitmap file) V2 170 

.CLP (Clipboard file) V2 97 

.COM (program file) V2 82 

.EXE (program file) V2 82 

.!NI (initialization file) V2 115 

.PIF (program information file) V2 155 

.REG (registration file) 

.SYS (system file) V2 239 

.TMP (temporary file) V2 200 

.TXT (text file) VZ 267 
using to rename files V2 115 
using to search for files VZ 115 
using to select files VZ 110 
.WAY (sound file) VZ 177 
.WR! (Write file) V2 267 

Filenames 
See also Filename extensions 
accented characters, trouble using V2 242 
changing V2 115 

Files 
See also Filename extensions 
closing V2 61 
copying V2 114 
deleting V2 115 
dragging and dropping V2 87-88 
fragmented V2 199 
icons representing, illustrated V2 106 
moving V2 114 
opening V2 89 
opening when starting applications V2 82--83 
printing See Printing 
renaming V2 115 

Files (continued) 
saving V290 
searching for V2 115 
security Vl 23 
selecting in directory windows V2109-110 
sharing 

access to shared files Vl 23 
connecting to shared directories Vl 21-22 

sorting in directory windows Vl 25, V2 108 
files command, CONFIG.SYS file Vl 154, V2 270 
Finding computers on the network, troubleshooting 

Vl 143-144 
Finding information in online Help V2101-102 
Floppy disk drives, reducing the SMARTDrive cache size 

Vl 83 
Floppy disks 

copying V2 117 
formatting V2 116 
labeling V2 116 

Flow control 
changing the setting V2 189 
common setting V2 256 
remote communications, troubleshooting V2 265 
serial port, troubleshooting V2 256 

Folders, Mail 
See also online Help for Mail 
checking status of shared folders Vl 96-97 
compressing shared folders Vl 97 

FontChangeEnable setting, SYSTEM.IN! file V2 245 
Fonts 

adding V2174-176 
adjusting for improved visibility Vl 104, 105 
cartridge fonts V2 173 
characters used with, displaying VZ 133 
copying soft fonts from port to port V2 255 
printer fonts V2 173 
printing problems 

cartridge fonts V2 253, 255 
printer capabilities, checking V2 252 
soft fonts VZ 255 
TrueType fonts V2 254-255 

removing V2 176-177 
screen fonts V2 173 
size, changing 

MS-DOS-based applications V2 160 
troubleshooting V2 244 

soft fonts V2 173 
TrueType 

adding V2174-176 
described V2 15, 174 
using exclusively V2 176 

Windows fonts V2 172-173 
Fonts command, on the Control menu V2 62, 160 
Foreground option, Settings command V2 159 



Format Disk command, File Manager V2 116 
Format of objects stored on the Clipboard, changing 

V2 15G-151 
Formatting disks V2 116 
Forwarding faxes VI 53 
Fragmented files V2 199 
Fnll Screen option, Settings command V2 159 

G 
Games group, described V2 74 
Gateways 

See also MAIL. WR! online document 
described VI 99 

General MIDI setup V2 180 
Glossary terms in Help, displaying definitions of V2 103 
Graphics mode 

printing in VI 30 
vs, text mode V2 244 

Graphics, printing problems 
insufficient printer memory V2 256 
1;'aintbrush graphics V2 257 

Grounded terminator 
thick-Ethernet system VI 127 
thin-Ethernet system VI 124 

Group icons 
adding a program item to a group V2 78 
described V2 55 

Groups 
adding program items to V2 78 
creating V2 75 
deleting V2 75 
group icons, described V2 55 
predefined, described V2 74 
preserved when upgrading Windows V2 6 
size limitation of V2 75 
starting applications from V2 81 

Guided tour of Windows operating system V2 23-44 

H 
Handicaps, products and services supporting VI 101-106 
Handles, extended-memory block (EMB) V2 204 
Handshake 

remote communications, troubleshooting V2 265 
serial port, troubleshooting V2 256 

Hardware 
configuring See Device drivers 
detection by Setup, skipping VJ 139, 141, V2 233-234, 

237 
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Hardware (continued) 
setting up to use with Windows V2 235-236 
settings 

correcting after running Setup VI 140, V2 236 
table for recording Vl 113 

system requirements Vl x, xi, V2 xvi 
Hayes modem, using Terminal with V2 138 
Help, online Vl xv 

closing V2 104 
context-sensitive V2 20 
dialog boxes, getting Help with V2 102 
finding information V2 101-102 
glossary definitions, displaying V2 103 
Help buttons, described V2 103 
Help menu commands, described V2 lOG-101 
keyboard shortcuts V2 219 
starting V2 99-100 

Hewlett-Packard 
DeskJet and LaserJet printers V2 255 
mouse driver, updated by Setup V2 11 

Hidden files 
defined V2 115 
icon representing, illustrated V2 106 

High memory area (HMA) 
described V2 192 
HIMEM command line V2 204 
network software, troubleshooting V2 266 

High-speed communications errors V2 263-264 
Highlighting text or options See Selecting 
HI:MEM memory manager 

command line V2 11, 203-206 
described V2 203 

HMA See High memory area 
Hub (concentrator), illustrated VI 129 

IBM LANServer Vl 85 
IBM mouse V2 241 
Icons 

application icons 
described V255 
illustrated V2 50 

arranging V2 87 
changing V2 80 
choosing V2 8] 
Control menu for, opening V2 60 
directory-window icons, iJlustrated V2 106 
document icons V2 55 
dragging and dropping files V2 87-88 

Key VI Microsoft Workgroup Add-On for v2 Microsoft Windows User's 
Guide Windows User's Guide 
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Icons (continued) 
drive icons V2 106, 107 
flashing to signal a message V2 88 
group icons V2 55 
label for, changing V2 76 
MORICONS.DLL file V2 80 
moving V265 
PROGMAN.EXE file V2 80 
program-item icons V2 55 
reducing windows to V2 63-64 
restoring to windows V2 65 
Up icon in directory windows 

illustrated V2 106 
using to change directories V2 110 

Impaired hearing, motion, or vision Vl 101-106 
Improving performance 

32-bit disk access Vl 81-82 
32-bit file access Vl 82-83 

Inbox in Mail, illustrated Vl 36 
Industry Standard Architecture (ISA) Vl 109 
.IN! filename extension V2 115 
Insert Object command 

troubleshooting V2 24 7 
Write V2145 

Inserting files See Object linking and embedding (OLE) 
Insertion point 

adjusting for improved visibility Vl 105 
illustrated V2 51 
in text boxes V2 69 

Installing device drivers 
methods for installing, described V2 184 
mouse, keyboard, or display drivers V2 186-188 
multimedia drivers V2 185-186 
third-party drivers V2 184 

Installing fonts V2174--176 
Installing network adapters 

configuring the adapter 
base 1/0 port Vl 114--115 
base memory address Vl 115 
connector, specifying Vl 116 
DIP-switch settings Vl 112 
hardware settings, recording Vl 113 
interrupt request level (IRQ) setting Vl 113-114 
jumper settings Vl 111 
software configuration Vl 121-122 
when to configure the adapter Vl 111 

connecting cables 
overview Vl 122 
thick-Ethernet system Vl 125-127 
thin-Ethernet system Vl 123-125 
token-ring network Vl 130-131 
twisted-pair Ethernet system Vl 128-129 

drivers for, installing Vl 133-135 
overview Vl 107 

Installing network adapters (continued) 
placing the adapter in your computer Vl 116, 118 -121 
required items Vl 108-109 
second adapter, installing Vl 107 
troubleshooting Vl 146-149 

Installing printers V2 126-128 
International format for fax numbers Vl 59 
Interrupt 15h interface V2 204 
Interrupt request level (IRQ) setting 

common setting for network adapters Vl 110 
determining fornetwork adapters Vl 113-114 
obtaining information about Vl 14 7 
specifying V2189-190 
troubleshooting 

mouse problems V2 239, 240 
printing problems V2 251 
trouble accessing a port V2 263 

Interrupting printing Vl 30, V2121-122 
Introduction to the Windows operating system V2 23--44 
!PX protocol Vl 137 
IRQ See Interrupt request level (IRQ) setting 
ISA bus expansion slot Vl 109 
ISA network adapters, software configuration Vl 122 
Italic type, usage in this guide V2 xviii 

J 
Jumper settings for network adapters 

K 

changing by using Windows Setup Vl 148 
changing manually Vl 111 

Key assignments for MIDI setups, editing V2 178-179 
Key combinations 

format in this guide V2 xviii 
troubleshooting V2 241-242 

Key encryption 
described Vl 54, 58 
sending key-encrypted faxes Vl 58 

Keyboard adjustments for impaired motion Vl 105 
Keyboard driver, installing or updating V2 186-188 
Keyboard layout 

changing the character set V2 181 
Dvorak layouts for individuals with impaired motion 

Vl 102-103 
Keyboard shortcuts 

Calculator keys V2 225 
Calendar keys V2 225 
Cardfile keys V2 226 
Clipboard Viewer keys V2 225 
closing windows V2 223 
Control Panel keys V2 225 



Keyboard shortcuts (continued) 
copying to the Clipboard V2 223 
cursor-movement keys V2 221 
dialog-box keys V2 221 
editing keys V2 222 
File Manager keys V2 224 
Help keys V2 219 
Media Player keys V2 228 
menu keys V2 220 
Notepad keys V2 226 
Object Packager keys V2 227 
Paintbrush keys V2 227 
PIF Editor keys V2 225 
Print Manager keys V2 224 
Program Manager keys V2 223 
quitting applications V2 223 
scrolling keys V2 221 
selection keys V2 93, 221 
Sound Recorder keys V2 228 
switching between applications V2 220 
Write keys V2 228 

Keys, security 
defined Vl 54 

L 

private keys, backing up or restoring Vl 58 
public keys 

exchanging Vl 56 
exporting to floppy disk Vl 57 
importing from floppy disk Vl 57 

setting up VI 55 

Labeling disks V2 116 
LAN Manager 

connecting to servers, troubleshooting Vl 145 
logging on automatically when you start Windows Vl 79 
passwords Vl 79, 88 
server not listed in Connect dialog boxes Vl 144 
setting options in Control Panel VI 88 
WinPopup, sending and receiving messages Vl 73-74 

LAPCl MIDI setup V2 180 
Laser printers, troubleshooting V2 254, 255 
LaserJet printers, Hewlett-Packard V2 255 
LCD color schemes V2 166 
Linking 

See also Object linking and embedding (OLE) 
by using Object Packager V2 151-152 
canceling or deleting links V2 150 
copying linked objects V2 149 
described V215, 142-143, 146-148 

Comprehensive Index 15 

Linking (continued) 
editing linked objects V2 148 
format of objects, changing V2 150-151 
multiple links to an object, creating V2 149 
objects from another computer VI 66 
Paintbrush drawings to documents V2 148 
restoring broken links V2 150 
updating linked objects V2 149, 248-249 

Links command, updating linked objects V2 249 
List box, in dialog boxes 

described V2 70 
drop-down V2 70-71 
selecting items in V2 57-58 

loadhigh command, AUTOEXEC.BAT file V2 6 
Local ClipBook See ClipBook 
Lock Application Memory option, PIF Editor V2 262 
Log On/Off icon, using Vl 70-71 
Logging network events VI 80 
Logging on to or off of the Microsoft Windows Network 

VI 70, 77 
Logging on to Windows for Workgroups 

how to log on VI 16-17 
startup settings, changing VI 78-79 
without a password VI 79 

Logon name VI 16, 17 
Logon options, changing Vl 76 
Logon password 

changing VI 79-80 
logging on to Windows for Workgroups Vl 17 
what to do if you forget your password VI 143 

Low vision, products and services supporting Vl 103 
LPT ports Vl 15, V2 127 
LPTl.DOS file V2 252 

M 
Macros, creating by using Recorder V2 137 
Mail 

See also Maintaining Mail; online Help for Mail 
account, creating Vl 35, 95 
adding yourself to the post office Vl 35 
administrator See Maintaining Mail 
connecting to a post office VI 33-34 
deleting messages VI 40, 41 
described Vl xiii 
disk space requirements Vl 90 
faxes 

See also PC Fax 
addressing VI 49 
sending VI 48-49 

Key Vl Microsoft Workgroup Add-On for v2 Microsoft Windows User's 
Guide Windows User's Guide 



16 Comprehensive Index 

Mail (continued) 
File Manager, sending mail from Vl 25 
fonts, adjusting Vl 104 
gateways for other message systems Vl 99 
Inbox, illustrated Vl 36 
mailbox name, assigning V1 35 
managing See Maintaining Mail 
message file Vl 41, 151 
options for deleting messages Vl 41 
password 

assigning Vl 35 
changing Vl 37 
supplying automatically Vl 36 

preparing to use Vl 33-34 
quitting Vl 41 
reading messages Vl 38-39 
replying to messages Vl 39--40 
security Vl 37 
sending messages Vl 37-38 
signing in Vl 36 
starting Vl 34 
using with other message systems Vl 99 

MAIL.WR] online document Vl xvi 
Mailbox, assigning a name for Vl 35 
Main group, described V2 74 
Maintaining Mail 

See also MAIL. WRI online document 
accounts 

creating Vl 35, 95 
modifying Vl 95 
removing Vl 96 

administrator account 
creating Vl 90-92 
restriction against removing Vl 96 

backing up the MSMAIL.MMF file Vl 98 
disk space 

checking status of shared folders Vl 96-97 
compressing shared folders Vl 97 
managing, described Vl 96 
requirements Vl 90 

MSMAIL.INI file, described Vl 98 
MSMAIL.MMF file 

backing up Vl 98 
described Vl 98 
restoring Vl 98 

post office 
adding a person's name to Vl 94-95 
creating Vl 90-92 
post office computer, leaving on at all times Vl 91 
sharing the post office directory Vl 93 

Postoffice Manager 
described Vl 89 
starting Vl 94 

Maintaining Mail (continued) 
PostOffice Upgrade for Microsoft Windows for 

Workgroups Vl 89 
system files, described Vl 97-98 
troubleshooting 

corrupted message file Vl 151 
Mail locks up when you send a fax Vl 152 
passwords Vl 151 
post office, creating Vl 150 

Make System Disk command, File Manager Vl 153, V2 269 
Managing memory and performance 

disk caching, described V2 201-202 
disk space, freeing 

removing unnecessary files V2 200-201 
using the chkdsk command V2 199 

double buffering, using V2 215 
memory configuration, identifying V2191-192 
memory managers 

described V2 203 
EMM386 V2 208-212 
HIMEM V2 203-206 
RAMDrive V2 206-208 

memory, freeing 
AlITOEXEC.BAT file, streamlining V2 193, 195 
CONFIG.SYS file, streamlining V2 193-194 
conserving memory when starting programs V2 195 
swap files, working with V2 196-198 
virtual-memory settings, changing V2196-197 

multitasking options V2 202 
"out-of-memory" message V2 259 
speed, increasing 

compacting your hard disk V2 199 
multitasking options, setting V2 202 
SMARTDrive, using V2 201-202, 212-215 
TEMP variable, setting to a RAM drive V2 195 

swap files 
enhanced mode V2196-198 
standard mode V2 197-198 

Mark command, MS-DOS-based applications V2 62, 160, 
242 

MAU (multistation access unit) Vl 131 
Maximize button 

enlarging windows to maximum size V2 64 
illustrated V2 51 

Maximize command, on the Control menu V2 61 
MCA bus expansion slot Vl 109 
MCA network adapters, software configuration Vl 121-122 
Media Player 

See also online Help in Media Player 
described V2 134 
keyboard shortcuts V2 228 

Meetings, scheduling See Schedule+ 
mem command, displaying memory information V2 192 



Memory 
See also Managing memory and performance; Memory 

managers 
386 enhanced mode, amount required for V2 t2 
available, checking the amount of V2 tot 
configuration, identifying V2 t9t-t92 
conventional memory, described V2 t9t 
expanded memory 

described V2 t92 
EMM386 memory manager V2 203, 208-2t2 

extended memory 
described V2 t9t 
HIMEM memory manager V2 203-206 

freeing 
by changing virtual-memory settings V2 t96-t97 
by streamlining the AUTOEXEC.BAT file V2 t93, 

t95 
by streamlining the CONFIG.SYS file V2 t93-t94 
by using swap files V2 t96-198 
conserving memory when starting programs V2 t95 

high memory area, described V2 t92 
Microsoft Diagnostics (MSD) program, using to get 

information about your system configuration V2 269 
net start basic command Vt t45 
"out-of-memory" message V2 259 
printer memory, insufficient V2 256 
RAM drive V2 203 
system requirements Vl x, xi, V2 xvi 
upper memory area, described V2 192 
virtual memory, described V2192 

Memory managers 
described V2 t9t ..:t92, 203 
EMM386 V2 208-212 
HIMEM V2 203-206 
RAMDrive V2 206-208 

Memory Requirements option, PIF Editor V2 260, 261, 262 
Memory-resident programs (fSRs) 

See also MS-DOS-based applications 
compatibility with Windows V2 236 
conflicting with the Setup program Vt t 40 
pop-up programs, running V2 t63 
removing when troubleshooting Vt t53 
running with other applications 
starting from WINSTART.BAT V2 t95 

Menu bar, illustrated V2 51 
Menus 

cascading menu, defined V2 59 
check marks, meaning of V2 59 
closing V2 59 
commands, choosing V2 58-59 
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Menus (continued) 
Control menu 

commands, described V2 6t-{)2 
Control-menu box (illustrated) V2 5t 
opening V2 60 

dimmed items, meaning of V2 59 
ellipsis, meaning of V2 59 
illustrated V2 58 
keyboard shortcuts V2 220 
menu bar (illustrated) V2 5t 
selecting (opening) V2 59 
shortcut-key combinations V2 59 
triangles, meaning of V2 59 

Merge Registration File command, File Manager V2 246 
Message file, Mail Vt 4t, t5t 
Message systems and gateways See MAIL.WR! online 

document 
Messages 

Chat Vt 70 
fax See PC Fax 
Mail messages 

See also online Help for Mail 
deleting Vl 40, 4 t 
reading Vl 38-39 
replying to V1 39-40 
sending Vl 37-38 

"out of memory" V2 259 
received from inactive applications V2 88 
"server unavailable" V2 246 
"sharing violation" V2 266 
startup messages, recording Vl t 40 
WinPopup Vl 73-74 

Microsoft At Work PC Fax See PC Fax 
Microsoft Customer Support Services V2 7 
Microsoft Diagnostics (MSD) program 

determining address space to exclude Vt 14t, V2 238 
getting information about your system configuration 

V2269 
running Vt t48 
starting V2 269 

Microsoft Download Service (MSDL) Vt 102, V2 7 
Microsoft Driver Library Vt 102 
Microsoft LAN Manager See LAN Manager 
Microsoft Mail PostOffice Upgrade for Microsoft Windows for 

Workgroups Vt 89 
Microsoft Network Diagnostics, running Vt 149-t50 
Microsoft Windows for Workgroups version 3.t, upgrading 

from Vt xi 
Microsoft Windows forWorkgroups version 3,11 

See Windows for Workgroups version 3.11 

Key VI Microsoft Workgroup Add-On for V2 Microsoft Windows User's 
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Microsoft Windows Network 
compatible networks Vl 85 
logging on or off Vl W--71, 77 
sharing resources on computers running other networks 

Vl 85--88 
troubleshooting Vl 143-145 

Microsoft Windows NT Advanced Server Vl 85 
Microsoft Windows NT operating system See Windows NT 

operating system 
Microsoft Windows Tutorial V2 5, 18, 45 
Microsoft Windows version 3.1, upgrading from Vl x-xi 
Microsoft Workgroup Add-On for Windows 

See also Windows for Workgroups version 3.11 
features, described Vl ix, xii-xv 
requirements, hardware and software Vl x, xi 

MIDI Mapper V2 179--180 
MIDI settings 

changing V2 178-180 
requirements for MIDI sound capabilities V2 177 

Minimize button 
illustrated V2 51 
reducing windows to icons V2 64 

Minimize command, on the Control menu V2 61 
Minimize On Use command, File Manager V2 82 
Minimizing applications, running minimized V2 77, 83 
Minimum Windows configuration V2 269--270 
Modem 

See also Fax modems 
troubleshooting V2 264--265 
using Terminal with V2 138 

Modes 
See also 386 enhanced mode; Standard mode 
checking the current mode V2 101 

Monitoring CPU or printer use Vl 73 
MORICONS.DLL file, selecting icons from V2 80 
Motion impairment, products and services supporting 

Vl 102-103 
Mouse 

adjusting for impaired motion or vision Vl 105 
basic techniques for using V2 56 
driver 

installing or updating V2 186-188 
updated by Setup V2 11 

pointer, illustrated V2 51 
support for MS-DOS-based applications V2 19 
troubleshooting 

mouse doesn't work with MS-DOS-based applications 
V2240 

mouse doesn't work with Windows V2 239 
pointer doesn't move V2 239 
pointer jumps around V2 240 

Mouse Systems mouse V2 11 
MOUSE.COM mouse driver V2 240 
MOUSE.SYS mouse driver V2 240 

Move command 
File Manager V2 114 
on the Control menu, described V2 61 

Moving 
around the screen, keys for V2 221 
dialog boxes V2 67 
files or directories V2 114 
icons V2 65 
windows V2 62 

MPC specifications V2 177 
MS-DOS-based applications 

See also Troubleshooting 
About command, checking Windows mode V2 157 
background, running in V2 162 
character set, changing V2 181 
Control menu, opening V2 60-61 
copying and pasting information V2 160-161 
defined V2 73 
386 enhanced mode V2157-162 
exclusive use of resources V2161-162 
font size, changing V2 160 
improved support for, described V2 19 
memory management 

conserving memory V2 195 
"out-of-memory" message V2 259 

memory-resident programs 
pop-up programs, running V2 163 
running with other applications V2 162 

mouse support for V2 19 
program information files (P!Fs) 

created by the Setup program V2 10 
default PIF V2 156 
manufacturer-supplied V2 155 
modifying V2 155 
multiple versions per application V2 156 

quitting V2 89 
running in 386 enhanced mode V2 157-162 
running in a window V2 157-158 
running in the background V2 162 
setting up V2 153-154 
settings, changing V2 158-160 
starting V2 157 
swap files V2197-198 
switching between a window and a full screen V2 158 
troubleshooting 

capturing a screen image (snapshot) V2 243 
font size, changing V2 244 
Mark or Select command, on Control menu V2 242 
mouse problems V2 240 
pasting from the Clipboard V2 244 
reserved key combinations V2 242 
Scroll command, on Control menu V2 242 
serial communications V2 264 

MS-DOS interrupts, printing by using V2 123 



MS-DOS operating system, required version Vt x, xi, V2 xvi 
MS-DOS Prompt 

quitting V2 84 
restrictions with MS-DOS commands V2 84 
starting applications V2 83, 157 

MSCDEX.EXE version 2.22 Vl 144 
MSD (Microsoft Diagnostics) program 

determining address space to exclude Vl 141 
running Vl 148 

msd command See Microsoft Diagnostics program 
MSD See Microsoft.Diagnostics program 
MSMAIL.INI file 

See also MAIL.WR! online document 
adjustments for impaired vision Vl 104 
described Vl 98 

MSMAIL.MMF file 
backing up Vl 98 
described Vl 98 
restoring Vl 98 

MT32 MIDI setup V2 180 
Multimedia 

features, described V218 
playing files or devices V2 134 
removing device drivers V2 186 
setting up device drivers for V2 185-186 

Multimedia Personal Computer (MPC) specifications V2 177 
Multistation access unit (MAU) Vl 131 
Multitasking options, 386 enhanced mode V2 202 
Musical Instrument Digital Interface (MIDI) 

N 

changing MIDI settings V2178-180 
MIDI sound capabilities V2 177 
playing sound files V2 134 

N-series terminator, illustrated Vl 127 
Name command, File Manager V2 108 
National Information System Vl 106 
net diag command (Microsoft Network Diagnostics) Vl 149, 

150 
net start basic command Vl 145 
net start full command Vl 145 
Net Watcher 

See also online Help for Net Watcher 
described Vl 71 
displaying names of people sharing files Vl 24 
displaying names of people sharing printers Vl 29 

NetBEUI protocol Vl 137 
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Network-adapter drivers 
changing settings Vl 136-137 
installing Vl 133-135 
removing Vl 136 

Network adapters, installing 
See also Network-adapter drivers; online Help for 

Windows Setup 
compalll>ility, checking Vl 109 
configuring the adapter 

base 1/0 port Vl 114-115 
base memory address Vl 115 
connector, specifying Vl 116 
DIP-switch settings Vl 112 
hardware settings, recording Vl 113 
interrupt request level (IRQ) setting Vl 113-114 
jumper settings Vl 111 
software configuration Vl 121-122 
when to configure the adapter Vl 111 

connecting cables 
overview Vl 122 
thick-Ethernet system Vl 125-127 
thin-Ethernet system Vl 123-125 
token-ring network Vl 130-131 
twisted-pair Ethernet system Vl 128-129 

detecting a network adapter Vl 147 
excluding the base memory address Vl 115 
overview Vl 107 
placing the adapter in your computer Vl 116, 118-121 
required items Vl 108-109 
second adapter, installing Vl 107 
troubleshooting Vl 146-149 

Network applications 
Chat Vl 70 
Log On/Off Vl 70 
Net Watcher Vl 71 
overview of Vl xiv 
Schedule+ Vl 72 
startup settings, changing Vl 79 
WinMeter Vl 73 
WinPopup Vl 73-74 

Network card See Network adapters, installing 
Network Connections command 

File Manager V2 113 
Print Manager V2 125 

Network directories 
connecting to V2 112-113 
disconnecting from V2 114 
drive letter for connections V2 232 

Network. Drivers dialog box, illustrated Vl 134 
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Network drives 
automatically reconnecting to Vl 22 
connecting to V2 112-113 
connecting to shared dfrectories Vl 21-22 
defined Vl 21, V2 112 
disconnecting from Vl 22, V2 114 
troubleshooting V2 266 

Network group Vl 69 
Network printers 

automatically reconnecting to Vl 28 
connecting to Vl 27-28, 87, V2 124-125 
disconnecting from Vl 28, V2 125 
passwords, assigning Vl 29 
port, selecting Vl 28 
troubleshooting 

can1t connect to a network printer V2 266 
can't print from Windows V2 252 
printer doesn't print V2 250 

Network servers, connecting to directories on Vl 86-87 
Network settings 

Adapter Media Type setting, checking Vl 146 
changing networks Vl 86 
customizing 

Control Panel, using Vl 76 
described Vl 75 
enabling and disabling sharing Vl 80-81 
logon options, changing Vl 76 
logon password, changing Vl 79-80 
network events, recording Vl 80 
startup settings, changing Vl 78-79 
Windows Setup, using Vl 80-81 
workgroup settings, changing Vl 78 

LAN Manager Vl 88 
Novell NetWare, checking setup for Vl 146 
Windows NT Vl 88 

Network Setup icon 
Adapter Media Type setting, checking Vl 146 
changing networks Vl 86 
enabling and disabling sharing Vl 81 
network adapters 

changing driver settings Vl 136-137 
detecting Vl 147 
installing drivers for Vl 133-135 

Novell NetWare, checking setup for Vl 146 
sharing resources, setting options for Vl 20 

Networks 
See also NETWORKS.WR! online document 
changing networks Vl 86 
compatible with Microsoft Windows Network Vl 85 
connecting to directories on network servers Vl 86-87 
connecting to network printers Vl 87 
Control Panel features, described Vl xv 
defined Vl 1 
event log, recording network events Vl 80 

Networks (continued) 
guidelines for using V2 232 
hardware requirements Vl x, xi 
new networking features, described Vl xii 
options in Control Panel, setting Vl 88 
overview of networking Vl 1-11 
port for printing V2 232 
post office, creating on a network Vl 91 
setting network options V2 180-181 
setting up Vl 85-86 
setting up to share resources Vl 20 
setting up Windows from a network V2 8-9 
supported by Windows for Workgroups Vl 14 
troubleshooting 

can1t connect to a network drive V2 266 
connecting to Novell NetWare servers Vl 145-146 
connecting to Windows NT or IAN Manager servers 

Vl 145 
diagnosing connection problems Vl 149-150 
high memory area, running network software in 

V2266 
LAN Manager server not listed Vl 144 
Microsoft Network Diagnostics, running Vl 149-150 
network adapter settings, changing Vl 148 
network features not available Vl 142 
Novell NetWare server not listed Vl 146 
other computers not listed Vl 143-144 
protocols, checking Vl 143 
"sharing violation" message V2 266 
starting the network before Windows Vl 145 
upper memory area, running network software in 

V2266 
Windows network features V2 231 

NETWORKS.WR! online docnment Vl xvi, V2 xvii, 232 
New command, on File menu 

groups, creating V2 75 
program items, creating V2 75-78 

New directories, creating V2 114 
New features in Windows version 3.1 V2 15-21 
New Window command, File Manager V2 107 
Next command, on the Control menu V2 61 
NIS (National Information System) Vl 106 
No Screen Exchange option, PIF Editor V2 260 
Non-Windows applications See MS-DOS-based applications 
Notepad 

See also online Help for Notepad 
described V2 135 
keyboard shortcuts V2 226 

Novell NetWare 
checking network settings in Windows Vl 146 
compatibility with Microsoft Windows Network Vl 85 
troubleshooting 

connecting to servers Vl 145-146 
server not listed in Connect dialog box Vl 146 



0 
Object linking and embedding (OLE) 

applications supporting OLE V2141 
canceling or deleting links V2 150 
copying linked objects V2 149 
described V215, 141-143 
destination document, defined V2 142 
editing 

embedded objects V2 145 
linked objects V2 148 

embedding 
described V2 143-145 
Paintbrush drawings in documents V2 145 

format limitations Vl 67 
format of objects, changing V2 150 
linking 

described V2 146-148 
Paintbrush drawings to documents 148 

multiple links to an object, creating V2 149 
Object Packager, using V215J-J52 
restoring broken links V2 J50 
source document, defined V2 J42 
troubleshooting 

Cardfile V2 249 
Insert Object dialog box V2 247 
Object Packager, Picture option unavailable V2 248 
Paste command gives varied results V2 247 
Paste Link commandis unavailable V2 249 
registration database V2 245-246 
server application unavailable V2 246 
sound object, Manual Update setting V2 248 
updating linked objects V2 248-249 

updating linked objects V2 J 49 
using ClipBook Viewer VJ 66 
vs, copying and pasting V2 J 43 

Object Packager 
See also online Help for Object Packager 
embedding packages in documents V2 J5J-J52 
keyboard shortcuts V2 227 
troubleshooting V2 248 

OEMSETUP.INF file V2 J84 
Online documents 

described Vl xv-xvi, V2 xvii 
opening and reading V2 268 

Online Help VJ xv 
closing V2 104 
context-sensitive V2 20 
dialog boxes, getting Help with V2 102 
findinginformation V210J-102 
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Online Help (continued) 
glossary definitions, displaying V2 103 
Help buttons, described V2 103 
Help menu commands, described V2 100-!0J 
keyboard shortcuts V2 2J9 
starting V2 99-100 

Online information services, connecting to V2 138 
Online Windows Tutorial 

described V2 5, J8 
running from within Windows V2 45 

Open command, on the File menu V2 89 
Open New Window On Connect command, File Manager 

VJ 22 
Opening 

See also Starting 
Control menu V2 60-61 
documents when starting applications V2 82-83 
files V289 
menus V259 

Optimizing See Managing memory and performance 
Option buttons, in dialog boxes V2 71 
Options command, Mail 

deleting mail, options for VJ 4 J 
sending digitally signed or key-encrypted faxes VJ 58 
setting global fax options VJ 50 

Order of files in directory windows, changing VJ 25 
"Out-of-memory" message V2 259 
Overlapping windows, switching between V2 85, 220 

p 
Packages 

See also Object Packager 
embedding in documents V2 J5J-J52 

Paintbrush 
See also online Help for Paintbrush 
described V2 J35-136 
editing embedded drawings V2 J 45 
editing linked drawings V2 148 
embedding drawings in documents V2 145 
keyboard shortcuts V2 227 
linking drawings to documents V2 J 48 
printing problem V2 257 
window, illustrated V2 136 

Parallel ports Vl J5, V2 J27 
Parallel printers, troubleshooting V2 256 
Parity 

changing the setting V2 189 
common setting V2 256 

Partial Details command, File Manager V2 J08 
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Password-list file Vl 17 
Passwords 

Depends On Password option Vl 23 
domain passwords Vl 80, 88 
fax security password Vl 56 
faxes, password-encrypted 

reading Vl 55 
sending Vl 54 

files, protecting Vl 23 
Local ClipBook pages Vl 65 
logon password 

changing Vl 79-80 
logging on to Windows for Workgroups Vl 17 
logging on without using a password Vl 79 
what to do if you forget your password Vl 143 

Mail password 
assigning Vl 35 
changing Vl 37 
supplying automatically Vl 36 
what to do if you forget your password Vl 151 

printer passwords, assigning Vl 29 
screen saver password V2 172 
shared directories, assigning passwords to Vl 23 
troubleshooting 

logon passwords Vl 143 
Mail passwords Vl 151 

Paste command 
embedding or linking objects Vl 66 
MS-DO~ased applications V2 161 
saving Clipboard contents Vl 63 
troubleshooting V2 247, 249 
Windows-based applications V2 96 

Paste Link command Vl 66, V2 249 
Paste Special command Vl 67, V2 151 
Pasting information 

into MS-DO~ased applications V2 161 
into Windows-based applications V2 96 
troubleshooting V2 244 
vs. object linking and embedding V2143 

Patch maps for MIDI setups, editing V217S-179 
Path for a shared directory, format of Vl 21 
PA1H setting, AUfOEXEC.BAT file 

minimum search path Vl 154, V2 270 
modified by Setup V2 11 
using two versions of Windows V2 267 

Patterns for the desktop V2169-170 
Pausing printers or documents Vl 30, V2 121-122 
PC Fax 

See also online Help for PC Fax 
addressing a fax Vl 49 
advanced dialing feature Vl 59 
attachments to faxes 

sending Vl 49 
viewing Vl 53 

PC Fax (continued) 
deleting outgoing faxes Vl 51 
described Vl xiii 
digital s.ignatures 

purpose of Vl 54 
using in a nonsecure environment Vl 55 

fax numbers, entering Vl 50 
forwarding faxes Vl 53 
international dialing Vl 59 
options for sending faxes, setting 

global options Vl 50 
individual fax Vl 51 

queue of faxes, using Vl 51 
reading faxes Vl 52-53 
receiving faxes Vl 52 
rescheduling outgoing faxes Vl 51 
security 

backing up or restoring private keys Vl 58 
described Vl 54 
disabling Vl 56 
exchanging security keys Vl 56 
fax security password Vl 56 
reading key-encrypted faxes Vl 59 
reading password-encrypted faxes Vl 55 
sending digitally signed faxes Vl 58 
sending key-encrypted faxes Vl 58 
sending password-encrypted faxes Vl 54 
setting np and starting security Vl 55-56 

sending faxes 
described Vl 48 
formatting in attached documents Vl 49 
from Mail Vl 4S-49 
using the Print command Vl 49 
using the Send command Vl 49 

setting up 
active fax modem, specifying Vl 46 
configuring fax modems Vl 44-45 
disk space required Vl 43 
driver for CAS modems, installing Vl 44 
fax modem hardware, installing Vl 44 
sharing fax modems Vl 45-48 

telephone line vs. separate line for fax transmissions 
Vl 44 

troubleshooting 
attaching documents to faxes Vl 152 
fax addresses, ttouble adding to the Personal Address 

Book Vl 152 
fax suspended in queue Vl 152 
Mail locks up Vl 152 
modem speed Vl 152 
shared modem, adding Vl 152 
shared modem, configuring Vl 151 
system locks up when you send a fax Vl 151 

TrueType fonts, using Vl 49 



PCL printers, number of soft fonts supported V2 255 
Performance 

See also Managing memory and performance 
32-bit disk access Vl 81-82 
32-bit file access Vl 82-83 
improvements, described V2 21 

Permanent swap file V2 196 
Personal Address Book 

See also online Help for PC Fax 
fax numbers, entering Vl 50 
international format for fax numbers Vl 59 
storing names of people you send messages to Vl 38 
trouble adding fax addresses to Vl 152 

Phone numbers See Telephone numbers 
Pictures 

creating See online Help for Paintbrush 
embedding in dncuments V2 145 
linking to documents V2 148 

PlFEditor 
See also Program information files 
defanlt PIF V2 156 
freeing memory by using V2 260-262 
keyboard shortcuts V2 225 
modifying PlFs V2 155-156 

.PlF filename extension V2 155 
PlF See Program information files 
Plasma Power Saver color scheme V2 166 
Playing animation files V2 134 
Playing back macros V2 137 
Playing sound files 

by using Media Player V2 134 
by using Sound Recorder V2 137 

Plotter fonts V2 173 
Pointer (mouse) 

illustrated V2 51 
troubleshooting V2 239, 240 

Pointing with the mouse, described V2 56 
Pop-up programs, running V2 163 
Portable computers, using 32-bit disk access Vl 81 
Ports 

See also Base 1/0 port 
configuring V2 188-189 
copying soft fonts from port to port V2 255 
described Vl 27, V2127 
enhancements for serial ports V2 21 
FILE, specifying as printer port V2 123 
LPTl.DOS file V2 252 
network printing V2 232 
parallel, defined Vl 15 
physical vs. virtual, defined V2 4 
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Ports (continued) 
selecting for network printers Vl 28 
serial, defined Vl 15 
setting up printers V2 127 
troubleshooting 

changing settings V2 256 
flow-control problem V2 256 
inaccessible port V2 262 
interrupt (IRQ) conflict V2 251, 263 
port settings conflict with printer V2 250 
Xon/Xoff protocol V2 264 

Post office 
See also MAIL.WR! online document 
adding a person's name to Vl 94-95 
connecting to Vl 33-34 
creating Vl 90-92 
disk space requirements Vl 90 
MSMAIL.INI file Vl 98 
post office computer, leaving on at all times Vl 91 
sharing the post office directory Vl 93 
troubleshooting Vl 150 
users connected to different post offices Vl 89 

Postoffice Manager 
adding a person's name to the post office Vl 95 
compressing shared folders Vl 97 
described Vl 89 
location of the Postoffice Manager command Vl 93 
modifying accounts Vl 95 
removing accounts Vl 96 
starting Vl 94 

PostOffice Upgrade for Microsoft Windows for Workgroups 
Vl 89 

PostScript printers 
changing setup options V2 257 
memory V2 257 
number of soft fonts supported V2 255 
setting up V2 126--127 
TESTPS.TXT file V2 251 
Transmission Retry setting V2 258 

Prevent Program Switch option, PlF Editor V2 260 
Print command 

File Manager V2 116 
sending a fax Vl 49 

Print file, defined V2 119 
Print Manager 

See also online Help for Print Manager 
canceling the printing of documents V2 122 
default printer, choosing Vl 30, V2 123 
deleting documents waiting to print Vl 30 
described Vl 26, V2 17, 119 
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Print Manager (continued) 
dragging file icons to print files V2 116 
FILE option, printing to a file V2 123 
keyboard shortcuts V2 224 
MS-DOS interrupts, printing with V2 123-124 
network printers 

connecting to Vl 27-28, V2 124-125 
defined Vl 26, V2 120 
disconnecting from Vl 28, V2 125 
how to share printers Vl 29 
how to stop sharing printers Vl 29 
passwords, assigning Vl 29 
reconnecting to automatically Vl 28 

new features, described Vl xii 
pausing and resuming printing Vl 30, V2121-122 
quitting Vl 30, V2 122 
removing printers V2 128 
setting up printers V2 126--128 
tool bar 

buttons for controlling documents and printers Vl 31 
buttons for sharing printers Vl 26-27 

Transmission Retry setting V2 258 
PRINT SCREEN key 

capturing a window image V2 95 
capturing the screen image V2 94 
troubleshooting V2 243 

Print servers See Network printers 
Printer driver, defined V2 119 
Printer Setup command, Print Manager 

choosing the default printer V2 123 
removing a printer V2 128 
setting up a printer V2 126--127 

Printers 
See also PRINTERS. WR! online document; Printing 
connecting to network printers Vl 27-28, 87, 

V2124--125 
default printer, choosing Vl 30, V2 123 
disconnecting from network printers Vl 28, V2 125 
fonts V2173 
installing and configuring V2 126--127 
monitoring the use of Vl 73 
network printer, defined V2 120 
passwords, assigning Vl 29 
pausing Vl 30, V2 121-122 
port, selecting for a network printer Vl 28 
Postscript 

changing setup options V2 257 
memory V2 257 
number of soft fonts supported V2 255 
setting up V2 126--127 
TESTPS.TXT file V2 251 

print queue Vl 26, V2 120--121 
printer driver, defined V2 119 
PRINTERS.WR! online document V2 xvii, 126 

Printers (continued) 
reconnecting to automatically Vl 28 
removing installed printers V2 128 
resetting V2 122 
setting up V2 126-128 
sharing Vl 29 
Transmission Retry setting V2 258 
troubleshooting See Printing 
Windows Driver Library (WD L) V2 127 

PRINTERS.WR! online document Vl xvi, V2 xvii, 126 
Printing 

canceling printing V2 122 
copying files directly to a port V2 250 
deleting documents from the print queue Vl 30, V2 122 
described Vl xii 
dragging and dropping files V2 87, 116 
File Manager, using to print files V2 116 
FILE option, printing to a file V2 123 
fonts 

printer fonts V2 173 
screen fonts V2 173 
TrueType fonts V2 174 

MS-DOS interrupts, using V2 123-124 
notification messages, receiving from WinPopup 

Vl 73-74 
pausing printers or documents Vl 30, V2 121-122 
print queue Vl 26, V2 120--121 
speed, new features that increase V2 17 
troubleshooting 

can't connect to a network printer V2 266 
can't print from Windows V2 251 
cartridge or soft fonts don't print V2 255 
format of printed page is incorrect V2 252 
page only prints partially V2 256 
Paintbrush graphics are too small when printed 

V2 257 
printer doesn't print V2 250, 258 
printer fonts differ from screen fonts V2 254 
printer loses text V2 256 
printer output is garbled V2 253 
printer runs out of memory V2 257 
TrueType fonts don't print V2 254-255 

Priority options, Settings command (MS-DOS-based 
applications) V2 159 

Private security keys 
backing up or restoring Vl 58 
defined Vl 54 
setting up Vl 55 

PROGMAN.EXE file, selecting icons from V2 80 
Program Group Properties dialog box V2 75 
Program information files (P!Fs) 

created by the Setup program V2 10, 154 
default PIF V2 156 
described V2 153 



Program information files (PIFs) (continued) 
exclusive use of resources V2 161-162 
manufacturer-supplied PIFs V2 155 
modifying V2 155 
multiple PIFs per application V2 156 
running applications in the background V2 162 

Program Item Properties dialog box V2 76 
Program items 

creating for applications 
by using File Manager V2 78 
by using Program Manager V2 75-78 
by using Setup V2 79 

creating for documents 
by using File Manager V2 78 
by using Program Manager V2 78 

icons, changing V2 80 
label, changing V2 76 
maximum number per group V2 75 
working (start-up) directories for V2 77 

Program Manager 
See also online Help for Program Manager 
groups 

creating V2 75 
deleting V2 75 
preserved when Windows is upgraded V2 6 

keyboard shortcuts V2 223 
program items, creating V2 75-78 
returning to V2 81 
shortcut-key combinations, reserving V2 77 
starting applications 

from a group V2 81 
when you start Windows V2 81 

Program-item icons 
changing V2 80 
described V2 55 

Programs 
See also Applications; MS-DOS--based applications; 

Program items 
filename extensions for program files V2 82 

prompt command, AUTOEXEC.BAT file Vl 154, V2 270 
Properties command 

File Manager 
closing files in shared directories Vl 24 
listing users of files in shared directories Vl 24 

Program Manager V2 76 
Protecting files by using passwords Vl 23 
Proteus MIDI setups V2 180 
PROTOCOL.II\'! file Vl 144 
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Protocols 
checking Vl 143 
network adapters Vl 136--137 

Public security keys 
defined Vl 54 
exchanging Vl 56 
exporting to disk Vl 57 
importing from disk Vl 57 
setting up Vl 55 

Publications on audio cassettes and floppy disks Vl 103 
.PWL filename extension Vl 143 

Q 
Queue command, Mail Vl 51 
Queues 

fax Vl 51 
print Vl 26, V2 120-121 

Quick format, defined V2 116 
Quitting 

R 

applications 
keyboard shortcuts V2 223 
MS-DOS--based applications V2 89 
Windows-based applications V2 88 

Help V2104 
Mail Vl 41 
Print Manager Vl 30, V2 122 
Windows operating system V2 44 

RAM See also Random-access memory 
RAM address space, excluding Vl 141, V2 238 
RAM drive 

avoiding conventional memory V2 208 
creating in extended memory V2 207 
setting the TEMP variable to V2 195 
size of V2 207 
using for swap files V2 198 

RAM start address for network adapters Vl 115 
RAMDrive program 

command line V2 206--208 
described V2 203 
updated by Setup V2 11 

Random-access memory (RAM). excluding address space 
Vl 141, V2 238 

Read-only memory (ROM), excluding address space Vl 141, 
V2238 
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Reading faxes Vl 52-53 
Reading Mail messages Vl 38-39 
README.WRl online document Vl xvi, V2 xvii, 268 
Rearranging application windows or icons V2 87 
Receiving faxes Vl 52 
Receiving messages 

See also Receiving faxes 
Chat Vl 70 
Mail Vl 38-39 
WinPopup Vl 73-74 

Recorder 
See also online Help for Recorder 
described V2 137 

Recording for the Blind, Inc. Vl 103 
Recording sound files V2 137 
Reference disk for network-adapter installation Vl 109 
Refresh command, File Manager V2 108 
.REG filename extension V2 246 
REG.DAT file V2 246 
REGBDIT.EXE file V2 246 
Registration database, restoring V2 245-246 
Registration Info Editor V2 246 
rem command, using to disable commands in startup files 

V2193-194 
Remote communications See Terminal 
Removing 

Clipboard contents V2 97 
commands in startup files V2 193-194 
directories V2 115 
documents from the print queue Vl 30, V2 122 
faxes, outgoing Vl 51 
files V2115 
foots V2 176-177 
groups V2 75 
links V2150 
Mail accounts Vl 96 
Mail messages Vl 40, 41 
multimedia device drivers V2 186 
network-adapter drivers Vl 136 
printers V2 128 

Rename command, File Manager V2 115 
Renaming files or directories V2 115 
Replacing text, basic techniques V2 93 
Reply command, Mail Vl 40 
Replying to Mail messages Vl 39-40 
Requirements, hardware and software Vl x, xi, V2 xvi 
Rescheduling outgoing faxes Vl 51 
Reserve Shortcut Key option, PIF Editor V2 243 
Resetting your printer Vl 30 
Resources, sharing 

See also Sharing directories; Sharing printers 
connecting to resources, described Vl 8-10 
overview of Vl 6-7 

Restore button 
illqstrated V2 51 
restoring windows to previous size V2 65 

Restore command, on the Control menu V2 61 
Restoring 

broken links V2 150 
MSMAIL.MMF file Vl 98 
private security keys Vl 58 

Reverse video with LCD monitors V2 166, 167 
RFB (Recording for the Blind, Inc.) Vl 103 
RJ-45 connector, illustrated Vl 128 
ROM 

See also Read-only memory 
address space, excluding Vl 141, V 238 

ROUTE.COM, removing from the AUTOEXEC.BAT file 
Vl 146 

Run command, using to start applications V2 82-83 
Run Minimized option for applications V2 77, 83 

s 
Save As command, on the File menu V2 90 
Save command, on the File menu V2 90 
Save Settings On Exit command, File Manager V2 108 
Saving Clipboard contents Vl 63, V2 97 
Saving files V2 90 
SCHDPLUS.INI file Vl 105 
Schedule+ 

See also online Help for Schedule+ 
colors, adjusting Vl 105 
described Vl xiii, 72 
fonts, adjusting Vl 105 
quitting Mail while running Vl 41 

Scheduling appointments See Schedule+ 
Scheduling options, 386 enhanced mode V2 202 
Screen colors, changing V2167 
Screenfonts V2172-174 
Screen images, capturing 

copying onto the Clipboard V2 94-95 
troubleshooting V2 243 

Screen readers, obtaining Vl 103 
Screen savers 

described V2 20 
using V2171-172 

Screen-enlargement utilities, obtaining Vl 103 
Scroll bars 

how to use V2 66 
illustrated V2 51 

Scroll command, MS-DOS-based applications V2 62, 242 
Scrolling keys V2 221 
SCSI hard disk V2 215 
Search command, File Manager V2 115 
Search feature in online Help V2 102 



Search Results window in File Manager V2 115 
Searching 

for files or directories V2 115 
for information in Help V2 101-102 

Security 
See also Passwords 
file access Vl 23 
Mail Vl 37 
PC Fax 

backing up or restoring private keys Vl 58 
described Vl 54 
disabling security Vl 56 
exchanging security keys Vl 56 
fax secmity password Vl 56 
reading key-encrypted faxes Vl 59 
reading password-encrypted faxes Vl 55 
sending digitally signed faxes Vl 58 
sending key-encrypted faxes Vl 58 
sending password-encrypted faxes Vl 54 
setting up and starting security Vl 55-56 

Select command, MS-DOS-based applications V2 242 
Select Computer dialog box, ClipBook Viewer Vl 65, 66 
Select Files command, File Manager V2 110 
Selecting 

check boxes V2 72 
current directory V2110 
directories in directory windows V2 109 
files in directory windows V2 109-110 
list items V2 57-58 
menu items V2 58-59 
menus V259 
option buttons V2 71 
text 

basic techniques V2 92-93 
extending selections V2 93 
in dialog boxes V2 69 
keyboard methods V2 93, 221 

vs. choosing, defined V2 57 
Selection cursor 

adjusting for improved visibility Vl 105 
defined V2 68 

Sending faxes 
described Vl 48 
formatting in attached documents Vl 49 
from Mail Vl 48-49 
key-encrypted or digitally signed Vl 58 
password-encrypted Vl 54 
Print command, using Vl 49 
Send command, using Vl 49 
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Sending faxes (continued) 
troubleshooting 

adding a shared modem Vl 152 
fax suspended in queue Vl 152 
Mail locks up Vl 152 
modem speed Vl 152 
system locks up Vl 151 

TrueType fonts, using Vl 49 
Sending messages 

See also Sending faxes 
Chat Vl 70 
Mail Vl 37-38, 39-40 
WinPopup Vl 73-74 

Serial mouse, troubleshooting V2 239 
Serial ports 

See also Serial printers 
assigning to a printer V2 127 
configuring V2 188-189 
defined Vl 15 
enhancements, described V2 21 
serial mouse, using with V2 239 
troubleshooting 

errors during high-speed communications 
V2 263-264 

trouble accessing a port V2 262-263 
Serial printers, troubleshooting 

flow-control problem V2 256 
interrupt interrupt (IRQ) conflict V2 251 
port settings conflict with printer V2 250 
printer output is garbled V2 253 

"Server unavailable" message V2 246 
Servers 

connecting to directories on Vl 86-87 
defined Vl 11 

set command Vl 154, V2 194, 270 
Set Default Printer command, Print Manager Vl 30 
Set Up Applications command, Setup program V2 79, 154 
Setting up applications 

See also Setnp program 
by using File Manager V2 78 
by using Program Manager V2 75-78 
by using Setup V2 79, 153-154 

Setting up Mail 
See also Maintaining Mail 
creating an account Vl 35, 95 

Setting up network adapters 
base 1/0 port Vl 114-115 
base memory address Vl 115 
connector, specifying Vl 116 
default settings Vl 110 
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Setting up network adapters (continued) 
DIP-switch settings Vl 112 
hardware settings, recording Vl 113 
interrupt request level (IRQ) setting Vl 113-114 
jumper settings Vl 111 
software configuration Vl 121-122 
troubleshooting Vl 146-149 

Setting up networks Vl 85-116 
Setting up PC Fax 

active fax modem, specifying Vl 46 
configuring fax modems Vl 44-45 
disk space required Vl 43 
driver for CAS modems, installing Vl 44 
hardware for fax modems, installing Vl 44 
sharing fax modems 

setting up to share a modem Vl 46-48 
setting up to use a shared modem Vl 45-46 

telephone line vs. separate line, using Vl 44 
Setting up printers V2 126-128 
Setting up sharing Vl 19-20 
Setting up the workgroup post office (WGPO) Vl 90-92 
Setting up Windows 3.1 

copying and expanding files on Setup disks V2 238 
Custom Setup V2 4--5 
Express Setup V2 3-4 
network setup V2 8-9 
running Setup V2 5 
troubleshooting 

incompatible memory-resident programs V2 236 
setting up special hardware V2 235-236 
Setup repeatedly prompts for the same disk V2 235 
Setup stops before it is complete V2 233-234 
Windows won't start V2 236 

upgrading from Windows version 3.0 V2 6-7 
Setting up Windows for Workgroups 3.11 

Custom Setup Vl 15 
Express Setup Vl 15 
for use with other networks Vl 85-116 
running Setup Vl 13-14 
setting options for sharing resources Vl 20 
troubleshooting Vl 140-141 

Settings command, MS-DOS-based applications V2 158-160 
setup command Vl 14, V2 5 
setup /a command V2 10 
setup /i command Vl 139, 141, V2 234, 237 
setup /n command V2 9 
Setup disks, copying and expanding files V2 238 
Setup program 

applications, setting up V2 79, 153-154 
AUTOEXEC.BAT file, changes Setup makes V2 11 
character se~ changing V2 181 
CONFIG.SYS file, changes Setup makes V2 11 
Custom Setup Vl 15, V2 4--5 
deleting unnecessary Windows files V2 200--201 

Setup program (continued) 
device drivers 

adding or updating V2 186-188 
installing V2 184 

Express Setup Vl 15, V2 3-4 
hardware detection, skipping Vl 139, 141 
network setup V2 8-9 
program items, creating for applications V2 79 
results of upgrading from Windows version 3.0 

V2 6, 10-11 
running Vl 13-14, V2 5 
summary of results V2 10 
troubleshooting 

conflicting memory-resident program (TSR) Vl 140, 
V2236 

setting up special hardware V2 235-236 
Setup repeatedly prompts for the same disk V2 235 
Setup stops before it is complete V2 233-234 
Windows won't start after Setup Vl 140-141 
your system locks up during Setup Vl 139 

SETUP.REG file V2 246 
SETUP .TXT online document Vl xvi, V2 xvii, 234 
Share As command, File Manager 

sharing directories and setting options for sharing Vl 23 
sharing the post office Vl 93 

Share command, ClipBook Viewer Vl 64 
Share name, format of Vl 21 
Share Printer As command, Print Manager Vl 29 
Shared copy of Windows 

setting up V2 8 
trouble using V2 266 

Shared Mail folders 
checking the status of Vl 96-97 
compressing Vl 97 

Sharing ClipBook pages 
embedding or linking objects from another computer 

Vl 66 
how to share Local ClipBook pages Vl 64 
how to stop sharing Local ClipBook pages Vl 65 

Sharing directories 
CD-ROM drive Vl 144 
closing shared files Vl 24 
connecting to shared directories Vl 21-22 
described Vl xii 
disconnecting from a network drive Vl 22 
displaying names of people sharing files Vl 24 
enabling and disabling sharing Vl 80-l!l 
fax modem, creating a shared directory for Vl 47-48 
File Manager window, illustrated Vl 20 
how to share directories Vl 23 
how to stop sharing directories Vl 24 
network servers, connecting to directories on Vl 86-117 
passwords, assigning Vl 23 
setting up sharing Vl 19-20 



Sharing fax modems 
creating a shared directory for a fax modem Vl 47-48 
setting up to share a modem Vl 46--48 
setting up to use a shared modem Vl 45-46 
stop sharing Vl 48 

Sharing information 
See also Chat; Mail; PC Fax; Sharing directories; Sharing 

printers 
oveiview of Vl 5 

Sharing printers 
connecting to network printers VI 27-28, 87 
described Vl xii 
disconnecting from a network printer Vl 28 
displaying names of people sharing printers VI 29 
enabling and disabling sharing Vl 80--Sl 
how to share printers Vl 29 
how to stop sharing printers Vl 29 
network printers, connecting to Vl 87 
passwords, assigning Vl 29 
setting up sharing Vl 19-20 

Sharing re_sources, multitasking options for V2 202 
"Sharing violation" message V2 266 
shell command, CONFIG.SYS file V2 194 
Shortcut-key combinations 

See also Keyboard shortcuts 
for commands on menus V2 59 
reserving for an application V2 77 
troubleshooting V2 241-242 

Sight impairment, products and services supporting Vl 103 
Signing in to Mail Vl 36 
Single-handed typing, keyboard layouts for Vl 102-103 
Size command, on the Control menu V2 61 
Size of windows, changing V2 63-65 
Small computer system interface (SCSI) hard disk V2 215 
SMARTDrive cache Vl 83 
SMARTDrive program 

command line, AUTOEXEC.BAT file V2 212-215 
disabling if interfering with Setup V2 235 
disk caching, described V2 201-202 
double buffering V2 11, 215 

Snapshot of the screen 
copying onto the Clipboard V2 94-95 
troubleshooting V2 243 

Soft fonts 
printing problems V2 255 
using V2173 

Software requirements Vl x, xi, V2 xvi 
Sort By Date command, File Manager V2 108 
Sort By Name command, File Manager V2 108 
Sort By Size command, File Manager V2 108 
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Sort By Type command, File Manager V2 108 
Sorting contents of directory windows V2 108 
Sorting files in directory windows Vl 25 
Sound 

assigning to system events V2177-178 
multimedia features, described V2 18 

Sound Blaster port V2 180 
Sound cards 

MIDI sound capabilities V2 177 
setting up device drivers for V2185-186 
specifications V2 177 

Sound files 
assigning to system events V2177-178 
playing 

by using Media Player V2 134 
by using Sound Recorder V2 137 

recording or editing V2 137 
. WA V filename extension V2 177 

Sound objects, linked V2149, 248 
Sound Recorder 

See also online Help for Sound Recorder 
described V2 137 
keyboard shortcuts V2 228 

Source directory or file, moving or copying files V2 114 
Source document, object linking and embedding V2 142 
SPART.PAR file V2 196 
Speed of c_omputer system, increasing 

See also Managing memory and performance 
by compacting your hard disk V2 199 
by setting multitasking options V2 202 
by setting TEMP to a RAM drive V2 195 
by using SMARTDrive V2 201-202, 212-215 

Speed of printing, new features that increase V2 l 7 
Speeding up applications 

32-bit disk access Vl 81--82 
32-bit file access Vl 82--83 

Split bar in directory windows V2 106 
Standard mode 

freeing memory by using PIF Editor V2 260 
memory required for running Windows V2 12 
starting Windows in V2 13 
swap files V2 197-198 
system requirements for using V2 xvi 

Starting 
applications 

by using MS-DOS Prompt V2 83, 157 
by using the Run command V2 82--83 
from a directory window V2 82 
from a group V2 81 
from the StartUp group V2 81 
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Starting (continued) 
applications (continued) 

MS-DOS-based applications V2 157 
"out-of-memory" message V2 259 

Help V2 99-100 
Mail Vl 34 
memory-resident programs V2 162, 195 
Postoffice Manager Vl 94 
Windows 

enhanced mode V2 12 
from the AUTOEXEC.BAT file V2 12 
network, starting before Windows V2 232 
sample command lines V2 13 
specifying an application or MS-DOS command 

V213 
standard mode V2 12 
troubleshooting V2 236-237 
without command-line options V2 12 

Windows for Workgroups 
network features, troubleshooting Vl 140, 142 
starting and logging on Vl 16-17 
starting the network before Windows Vl 145 
without the network Vl 140 

Windows Tutorial from within Windows V2 45 
WinPopup Vl 7 4 

Startup disk 
creating when troubleshooting V2 269 
formatting V2 116 

Startup files 
See also AUTOEXEC.BAT file; CONFIG.SYS file 
streamlining V2193-195 
testing V2 269 

Startup group 
described V2 74 
starting applications V2 81 

Startup messages, recording Vl 140 
Startup options for LAN Manager or Windows NT Vl 88 
Startup settings, changing Vl 78-79 
Status bar, File Manager V2 106, 107 
Status messages See Messages 
Stop bits 

changing the setting V2 189 
common setting V2 256 

Stop Sharing command 
ClipBook Viewer Vl 65 
File Manager Vl 24 

Stop Sharing Printer command, Print Manager Vl 29 
Subdirectories, displaying V2 111 
Super VGA display driver V2 243, 244 
Support services for individuals with disabilities Vl 101-106 
Support Services, Customer V2 7 

Swap files 
386 enhanced mode V2196-!97 
standard mode V2 197-198 
troubleshooting application problems 

"out-of-memory" message V2 259 
slow-running application V2 243 

Swapdisk setting, SYSTEM.IN! file V2 197 
Swapfile program, Windows version 3.0 V2 196 
Switch To command, on the Control menu 

described V2 61 
opening Task List V2 86 

Switchbox, printing problems when using V2 250 
Switching 

between a window and a full screen V2 158, 220 
between applications V2 85, 220 
between documents V2 86 
fast application-switching, described V2 41 
to and from pop-up programs V2 163 
to Program Manager V2 81 

Synthesizers 
device drivers, setting up V2 185-186 
MIDI setups for V2179-180 

.SYS filename extension V2 239 
SYSINl.WRI online document Vl xvi, V2 xvii 
System disk 

creating VI 153 
creating before modifying startup files V2 193 
creating when troubleshooting V2 269 
formatting V2 116 

System files 
icon representing, illustrated V2 106 
renaming V2 115 

System Information screen, correcting hardware settings 
Vl 140 

System performance 
See also Managing memory and performance 
improvements, described V2 21 

System requirements, hardware and software Vl x, xi, V2 xvi 
System settings 

changing V2 186-188 
preserved when upgrading Windows V2 6 

SYSTEM.IN! file 
See also SYSINI.WRI online docmnent 
adjustments for impaired motion or vision Vl 104 
COMirqSharing setting V2 263 
COMxProtocol = XOFF setting V2 264 
documentation for V2 xvii 
EMMExclude setting Vl 115, 141, V2 237-238 
FontChangeEnable setting V2 245 
password list, creating Vl 143 
swapdisk setting V2 197 
UART buffer setting V2 264 
Virtua!HDirq setting Vl 141, V2 238 



T 
T-connector, illustrated Vl 123 
Tables 

base 1/0 port numbers Vl 114-115 
hardware settings Vl 113 
interrupt request level (IRQ) settings Vl 113 
thick-Ethernet system components Vl 126-127 
thin-Ethernet system components Vl 123-124 
token-ring network components Vl 131 
twisted-pair Ethernet system components Vl 128--129 
Workgroup Add-On requirements Vl x, xi 

Task List 
arranging icons V2 87 
arranging windows V2 87 
opening V2 86 
switching between applications V2 85--86 

Tasking options, Settings command (MS-DOS-based 
applications) V2 159 

Telephone numbers 
filing in Cardfile V2 131-132 
Microsoft Customer Support Services V2 7 
Microsoft Download Service (MSDL) Vl 102, V2 7 
National Information System Vl 106 
Recording for the Blind, lnc. Vl 103 
Trace R&D Center Vl 106 

TEMP directory, created by Setup V2 11 
TEMP environment variable 

printing problems V2 251 
set by the Setup program V2 11 
setting to a RAM drive V2 195 

Temporary files, removing V2 200 
Terminal 

See also online Help for Terminal 
described V2 138 
troubleshooting V2 264-265 

Terminate option, Settings command (MS-DOS-based 
applications) V2160 

Terminators 
thick-Ethernet system Vl 126-127 
thin-Ethernet system Vl 124 

Testing AUTOEXEC.BAT and CONFIG.SYS files Vl 154, 
V2269 

TESTPS.TXTfile V2251 
Text 

copying 
from MS-DOS-based applications V2 160 
from Windows-based applications V2 94-97 

deleting V2 93 
editing V2 92-93, 222 
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Text (continued) 
entering (typing) V2 91 
moving within V2 91 
pasting 

into MS-DOS-based applications V2 161 
into Windows-based applications V2 96 

replacing V2 93 
selecting 

basic techniques V2 92-93 
canceling selections V2 92 
extending selections V2 93 
in dialog boxes V2 69 
keyboard methods V2 93, 221 

Text box, in dialog boxes V2 69 
Text editor (Notepad) V2 135 
Text files (Windows online documents) 

described Vl xvi, V2 xvii · 
opening and reading V2 268 

Text mode vs. graphics mode V2 244 
Thick-Ethernet system Vl 125-127 
Thicknet system Vl 125-127 
Thin-Ethernet system Vl 123-125 
Thinnet system Vl 123-125 
Third-party device drivers, installing V2 184 
Tile command, Task List V2 87 
Time, analog or digital clock V2 133 
Title bar 

flashing to signal a message V2 88 
illustrated V2 51 

.TMP filename extension V2 200 
Token-ring network Vl 13(}-131, 146 
Toolbar, ClipBook Viewer 

buttons, illustrated and descnbed Vl 62-63 
connecting to another ClipBook Vl 65 
copying Local ClipBook pages Vl 64 
disconnecting from another ClipBook Vl 66 
embedding or linking objects Vl 66 
saving Clipboard contents Vl 63 
sharing Local ClipBook pages Vl 64 
stop sharing Local ClipBook pages Vl 65 

Toolbar, File Manager 
buttons for displaying files Vl 25 
buttons for sharing directories Vl 21 
connecting to directories on network servers Vl 86 
connecting to shared directories Vl 22 
disconnecting from shared directories VI 22 
drive, changing Vl 21 
mail, sending Vl 25 
sharing directories and setting options for sharing Vl 23 
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Toolbar, File Manager (continued) 
sharing the post office Vl 93 
stop sharing a directory Vl 24 

Toolbar, Mail 
deleting a Mail message Vl 40 
replying to a Mail message Vl 40 
sending a fax Vl 48 
sending a Mail message Vl 37 
sending a password-encrypted fax Vl 54 

Toolbar, Print Manager 
buttons for controlling documents and printers Vl 31 
buttons for sharing printers Vl 26--27 
canceling printing Vl 30 
connecting to network printers Vl 28, 87 
default printer, selecting Vl 30 
disconnecting from network printers Vl 28 
sharing printers and setting options for sharing Vl 29 
stop sharing a printer Vl 29 

Toolbox in Paintbrush V2 136 
Tour of Windows operating system V2 23-44 
Trace R&D Center Vl 106 
Transceiver, thick-Ethernet system Vl 126, 127 
Transferring information 

See also Chat; Mail; PC Fax; Sharing directories; Sharing 
printers 

between computers, using Terminal V2 138 
between MS-DOS-based applications V2160-161 
between Windows-based applications V2 94-97 
overview of Vl 5 

Transmission Retry setting, Print Manager V2 258 
Triangle on menus, meaning of V2 59 
Troubleshooting 

application problems 
application quits unexpectedly V2 245 
application stops responding V2 242 
capturing a screen image (snapshot) V2 243 
font size, changing V2 244 
key or key combination doesn't work V2 241-242 
pasting into MS-DOS-based applications V2 244 
slow-running application V2 243 
Super VGA display driver V2 243 

AUTOEXEC.BAT file 
streamlining Vl 153-154 
testing V2 269 

computer restarts or stops unexpectedly V2 245 
CONFIG.SYS file 

streamlining Vl 153-154 
testing V2 269 

copying and expanding files on Setup disks V2 238 
expanded-memory managers Vl 141 
Mail 

corrupted message file Vl 151 
passwords Vl 151 
post office, creating Vl 150 

Troubleshooting (continued) 
memory management V2 258-262 
messages from startup, recording Vl 140 
Microsoft Diagnostics (MSD) program, using V2 269 
Microsoft Network Diagnostics, running Vl 148 
mouse problems 

mouse doesn't work with MS-DOS-based applications 
V2240 

mouse doesn1t work with Windows V2 239 
pointer doesn1t move V2 239 
pointer jumps around V2 240 

MSD (Microsoft Diagnostics) program, running Vl 148 
network adapters 

DIP-switch settings Vl 148 
interrupt request level (IRQ) Vl 147 
jumper settings Vl 148 
overview Vl 146--147 

network connections Vl 149-150 
network features 

CD-ROM drive, sharing directories Vl 144 
connecting to a Windows NT or LAN Manager seiver 

Vl 145 
LAN Manager server not listed Vl 144 
logon password, what to do if you forget it Vl 143 
network features not available Vl 142 
other computers not listed Vl 143-144 
starting the network before Windows Vl 145 

networks 
can't connect to a network drive V2 266 
guidelines for using V2 232 
high memory area, running network software in 

V2266 
"sharing violation" message V2 266 
upper memory area, running network software in 

V2266 
Novell NetWare 

connecting to servers Vl 145-146 
server not listed in Connect dialog box Vl 146 

object linking and embedding 
Cardfile V2 249 
Insert Object dialog box V2 247 
Object Packager, Picture option unavailable V2 248 
Paste command gives varied results V2 247 
Paste Link command unavailable V2 249 
server application unavailable V2 246 
sound object, Manual Update setting V2 248 
updating linked objects V2 248-249 

passwords 
logon password Vl 143 
Mail passwords Vl 151 

PC Fax 
attaching documents to faxes Vl 152 
fax addresses, trouble adding to the Personal Address 

Book Vl 152 ' 



Troubleshooting (continued) 
PC Fax (continued) 

fax suspended in queue Vl 152 
Mail locks up Vl 152 
modem speed Vl 152 
shared modem, adding Vl 152 
shared modem, configuring Vl 151 
system locks up when you send a fax Vl 151 

printing problems 
can't connect to a network printer V2 266 
can't print from Windows V2 251 
cartridge or soft fonts don't print V2 255 
fonts on screen differ from printed fonts V2 254 
format of printed page is incorrect V2 252 
page only prints partially V2 256 
Paintbrush graphics are too small when.printed 

V2257 
printer doesn't print V2 250, 258 
printer loses text V2 256 
printer output is garbled V2 253 
printer runs out of memory V2 257 
TrueType fonts don't print V2 254-255 

registration database V2 245-246 
serial communications 

errors during high~speed communications 
V2 263-264 

MS-DOS-based applications V2 264 
trouble accessing a port V2 262-263 

setting up Windows 3.1 
incompatible memory-resident programs V2 236 
setting up special hardware V2 235-236 
Setup repeatedly prompts for the same disk V2 235 
Setup stops before it is complete V2 233-234 

setting up Windows for Workgroups 3.11 
conflicting memory-resident program (TSR) Vl 140 
Setup program stops before completing Vl 139 
Windows won't start after Setup Vl 140-141 
your system locks up Vl 139 

starting the network before Windows Vl 145 
starting Windows 

enhanced mode not available V2 237-238 
Windows won't start V2 236-237 
without the network Vl 140 

starting Windows for Workgroups Vl 140-141 
system disk, creating V2 269 
system stops responding V2 245 
Terminal V2 264-265 
testing your Windows configuration V2 269 
two versions of Windows, using V2 267 

Comprehensive Index 33 

TrueType fonts 
adding V2174-176 
described V2 15, 174 
printing problems V2 254-255 
removing V2176--177 
using exclusively V2 176 
using with PC Fax Vl 49 

Tutorial for Windows 
described V2 5, 18 
running from within Windows V2 45 

Twisted-pair Ethernet system Vl 128-129 
.TXT filename extension V2 267 
Typing with a single hand, keyboard layouts for Vl 102-103 
Typing with motion impairment, keyboard layouts for 

Vl 102-103 
Typographic conventions V2 xviii 

u 
UART (Universal Asynchronous Receiver Transmitter) chip 

V2264 
UMBs See Upper memory blocks 
Underlined terms in online Help V2 103 
Undo command, on application Edit menus V2 93 
Undoing changes in text V2 93 
Up icon in directory windows V2 106, 110 
Update command, Paintbrush V2 145 
Updating directory windows V2 108 
Updating linked objects V2 149, 248-249 
Upgrading 

from Windows for Workgroups version 3.1 Vl xi 
from Windows version 3.0 V2 6-7 
from Windows version 3.1 Vl x-xi 

Upper memory area 
described V2 192 
network software, troubleshooting V2 266 
providing access to V2 203, 212 
settings preserved when upgrading Windows V2 6 

Upper memory blocks (UMBs) 
defined V2 192 

v 

preventing EMM386 from loading into V2 208 
preventing SMARTDrive from loading into V2 214 

Version of active application, checking V2 101 
Video Memory option, PIF Editor V2 261 
Video Mode option, PIF .Editor V2 244, 260 
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Videodisc players 
playing by using Media Player V2 t34 
setting up device drivers for V2 t85-t86 

Virtual memory 
changing swap-file settings V2 t96-197 
described V2 192 
enabling 32-bit disk access Vt 81 
enabling 32-bit file access Vt 82 

VirtualHDirq option, starting Windows with V2 237-238 
VirtualHDirq setting, SYSTEM.INI file Vt t4t 
Vision impairment, products and services supporting Vl 103 
Voice-output screen readers, obtaining Vt 103 

w 
Wallpaper 

displaying V2 170-t 71 
memory management V2 259 

.WAV filename extension V2 t77 
WDL (Windows Driver Library) Vt 102, V2 7, 183 
WGPO See Workgroup post office 
Wildcards 

renaming files or directories V2 115 
searching for files or directories V2 115 
selecting a group of files V2 110 

win command V2 t2 
creating the BOOTLOG.TXT file Vl 140 
EMMExclude option Vt t40 
using without command-line options Vt t6 
VirtualHDirq option Vt 14t 

win /3 command V2 13 
win/bcommand Vt t40 
win /d:v command Vt 14t, V2 237 
win /d:x command Vt t40, V2 237 
win /n command Vt 140 
win /s command V2 13 
WIN.INifile 

See also WININI.WRI online document 
adjustments for impaired motion or vision Vl t04 
documentation for V2 xvii 
LPTl.DOS port V2 252 
size limitation V2 255 

WIN386.SWP file V2 t%, 20t 
Window 

application windows 
arranging V2 87 
described V2 53-54 
illustrated V2 50 

borders V2 5t, 52 
closing V2 67 
dialog boxes V2 67-72 
document window, described V2 53-54 
elements of V2 5t-52 
moving V262 

Window ( continu.ed) 
opening See Opening files; Starting applications 
scrolling through information in V2 66 
size, changing 

by dragging a border or comer V2 63-65 
by enlarging to maximum size V2 64 
by reducing to an icon V2 63-64 
by restoring to previous size V2 65 

snapshot 
copying onto the Clipboard V2 95 
troubleshooting V2 243 

switching between a window and a full screen V2 220 
title bar (illustrated) V2 5t 

Window option, Settings command V2 159 
Window title, changing V2 76 
Windows command line V2 t3 
Windows Driver Library (WDL) Vt t02, V2 7, t83 
Windows for Workgroups version 3.t, upgrading from Vt xi 
Windows for Workgroups version 3.11 

See also Improving performance; Troubleshooting 
Access Pack for Windows, obtaining Vl 102 
adjustments for impaired motion or vision Vt t04-105 
described Vt ix 
Dvorak keyboard layouts, obtaining Vl 102-103 
logging on 

how to log on Vt t6-t 7 
startup settings, changing Vt 78-79 
without a password Vt 79 

new features, descnbed Vl ix, xii-xv 
overview of networking Vt t-11 
setting up 

Custom Setup Vl t5 
Expresa Setup Vl t5 
for use with other networks Vt 85416 
running Setup Vt t3-t 4 
setting options for sharing resources Vt 20 
troubleshooting Vt t39-t4t 

starting Vl 16 
starting without the network Vl 140 

Windows NT Advanced Server Vt 85 
Windows NT operating system 

connecting to servers, troubleshooting Vl t 45 
logging on to a domain automatically Vt 79 
passwords Vl 79, 88 
setting options in Control Panel Vt 88 
sharing resources Vl 85 
WinPopup, sending and receiving mesaages Vl 73-74 

Windows Online Tutorial 
described V2 5, t8 
running from within Windows V2 45 

Windows Setup icon 
network adapter settings, changing Vt t48 
protocols, checking Vt 143 



Windows Setup program See Setup program 
Windows text files (online documents) 

described Vl xvi, V2 xvii 
opening and reading V2 268 

Windows Tutorial 
described V2 5, 18 
running from within Windows V2 45 

Windows version 3.0, upgrading from V2 6-7 
Windows version 3.1 

configuration, minimum V2 269 
guided tour V2 23-44 
mode, determining V2 101 
new features V2 15-21 
problems See Troubleshooting 
quitting V2 44 
requirements, hardware and software V2 xvi 
setting up 

Custom Setup V2 4-5 
Express Setup V2 3-4 
network setup V2 8-9 
running Setup V2 5 
troubleshooting V2 233-239 

starting 
from the AUTOEXEC.BAT file V2 12 
mode, specifying V2 12 
network, starting before Windows V2 232 
sample command lines V2 13 
specifying an application or MS-DOS command 

V213 
troubleshooting V2 236-237 
without command-line options V2 12 

upgrading from Vl x-xi 
upgrading from Windows version 3.0 V2 6-7 
nsing two versions of Windows V2 267 

Windows-based applications See Applications 
WININI.WRI online document Vl xvi, V2 xvii 
WinMeter, described Vl 73 
WinPopup 

See also online Help for WinPopup 
described Vl 73-74 
starting Vl 74 
startup setting for Vl 79 

WINSTART.BAT batch file V2 195 
Word processing with Write V2 138 
Workgroup Add-On for Windows 

See also Windows for Workgroups version 3.11 
features, descnbed Vt ix, xii-xv 
requirements, hardware and software Vl x, xi 
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Workgroup post office (WGPO) 
See also MAIL. WR! online document 
adding a person's name to Vl 94-95 
computer, leaving on at all times Vl 91 
connecting to Vl 33-34 
creating Vl 90-92 
disk space requirements Vl 90 
MSMAIL.INI file Vl 98 
sharing the post office directory Vl 93 
troubleshooting Vl 150 
users connected to different post offices Vl 89 

Workgroups 
Chat messages, .exchanging Vl 70 
closing files in shared directories Vl 24 
defined Vl 2 
monitoring connections and shared resources Vl 71 
monitoring CPU or printer use Vl 73 
overview of Vl 'lr-7 
setting up sharing of resources Vl 19-20 
settings, changing Vl 78 
sharing directories 

connecting to shared directories Vl 21-22 
discormecting from network drives Vl 22 
displaying names of people sharing files Vl 24 
how to share directories Vl 23 
how to stop sharing directories Vl 24 
passwords, assigning Vl 23 

sharing printers 
connecting to network printers Vl 27-28 
disconnecting from a network printer Vl 28 
how to share printers Vl 29 
how to stop sharing printers Vl 29 
passwords, assigning Vl 23 

Working directory for an application V2 77 
Workstation, diskless V2 8 
. WR! filename extension V2 267 
Write 

x 

See also online Help in Write 
described V2 138 
editing embedded objects V2 145 
editing linked objects V2 148 
embedding objects in documents V2 145 
keyboard shortcuts V2 228 
linking objects to documents V2 148 

XMS Memory option, PIF Editor V2 260 
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